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序文

本書では、Sun StorEdge 3510 FC アレイおよび 3310 SCSI アレイを構成、監視、管理
するために Sun StorEdge™ Configuration Service プログラムをインストールして使
用する方法について説明します。

特別な指定がない限り、ここでは Sun StorEdge 3510 FC アレイおよび 3310 SCSI ア
レイをアレイと呼びます。また、本書では Sun StorEdge 3000 Family Diagnostic
Reporter にもふれています。これは、ホストおよびアレイからシステム メッセージ
を送受信するために使用する Sun StorEdge Configuration Service プログラムの併用
ユーティリティです。Sun StorEdge Diagnostic Reporter のインストール方法と使用
方法は、『Sun StorEdge 3000 Family Diagnostic Reporter ユーザ ガイド』を参照し
てください。

本書は、Sun™ のハードウェアおよびソフトウェア製品の使用に習熟した上級のシス
テム管理者を対象として書かれています。

本書の構成
本書では次のトピックを扱っています。

第 1 章: Sun StorEdge Configuration Service の機能について紹介します。

第 2 章: Sun StorEdge Configuration Service のインストールと使用の前に、アレイが
正しく構成されていることを確認する手順を提供します。

第 3 章: Solaris™ 動作環境でのシステムにおける、Sun StorEdge Configuration Service
コンソールおよびエージェントのシステム要件とインストール手順を提供します。

第 4 章: Windows NT/2000 システムにおける、Sun StorEdge Configuration Service
コンソールおよびエージェントのシステム要件とインストール手順を提供します。
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第 5 章: Linux 動作環境でのシステムにおける、Sun StorEdge Configuration Service
コンソールおよびエージェントのシステム要件とインストール手順を提供します。

第 6 章: Sun StorEdge Configuration Service のセットアップ手順を提供します。

第 7 章: アレイの構成手順を提供します。

第 8 章: 同じストレージを共有する大規模なファイバ チャネル ネットワークを維持
するための LUN フィルタの作成方法を説明します（ファイバ チャネルのみ）。

第 9 章: アレイの監視方法を説明します。

第 10 章 : アレイの保全性を維持する方法を説明します。

第 11 章: 現在のアレイ構成を変更または追加する方法を説明します。

付録 A: RAID に関する基本的な情報を提供します。

付録 B: スタンドアロン JBOD を監視し、これにファームウェアをダウンロードする
方法を説明します（SCSI のみ）。

付録 C: クラスタ構成のセットアップに関する情報を提供します（SCSI のみ）。

付録 D: Solaris 動作環境および Windows NT を実行するシステム上でホストのワール
ドワイド ネーム（WWN）を決定する方法を説明します（ファイバ チャネルのみ）。

付録 E: イベント完全監視機能と電子メール通知機能のセットアップ方法を説明します。

付録 F: トラブルシューティングに関し、症状の一覧と対応策を提供します。

付録 G: Sun StorEdge Configuration Service のエラーコードとメッセージの一覧です。

用語集: 製品文書全体にわたって使われる RAID 技術用語とその定義を解説します。
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UNIX コマンドの使用
基本的な UNIX® コマンドに関する情報や、システムのシャットダウンと起動、デバ
イスの構成などの手順は、本文書では説明されていない場合があります。

必要に応じて、以下の文書を参照してください。

■ 『Solaris Handbook for Sun Peripherals』
■ Solaris 動作環境用 AnswerBook2™ オンライン文書
■ 各システムに付属のその他のソフトウェア文書

表記規約

書体*

* これらの書体は、使用しているブラウザの設定により異なる場合があります。

意味 例

AaBbCc123 コマンド、ファイル、ディレク
トリの名前。画面に表示される
コンピュータ出力。

.login ファイルを編集します。

 ls -a を使って、全ファイルを一覧
表示します。

% You have mail.

AaBbCc123 画面上のコンピュータ出力と区
別し、ユーザが入力する内容。

% su

Password:

AaBbCc123 書名、新しい用語、語句の強
調。コマンド ライン変数に対し
て入力する実際の名前または
値。

『ユーザ ガイド』の第 6 章を参照して
ください。

これらはクラス オプションと呼ばれま
す。

この操作を行うには、スーパーユーザ
でなければなりません。

ファイルを削除するには、rm ファイル
名と入力します。
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シェル プロンプト

関連マニュアル

シェル プロンプト

C シェル machine-name%

C シェルのスーパーユーザ machine-name#

Bourne シェルと Korn シェル $

Bourne シェルと Korn シェルのスーパーユーザ #

製品名 タイトル 部品番号

Sun StorEdge 3310 SCSI アレイのみ 『Sun StorEdge 3310 SCSI Array リリース ノート』 816-7292

『Sun StorEdge 3000 Family 適使用法マニュアル』 817-2989

『Sun StorEdge 3000 Family RAID ファームウェア 3.25 ユー
ザ ガイド』

816-7966

『Sun StorEdge 3000 Family 導入・運用・サービス マニュア
ル』

816-7958

Sun StorEdge 3510 FC アレイのみ 『Sun StorEdge 3510 FC Array リリース ノート』 817-2777

『Sun StorEdge 3000 Family 適使用法マニュアル』 817-2761

 『Sun StorEdge 3000 Family RAID ファームウェア 3.27 
ユーザ ガイド』

817-2764

『Sun StorEdge 3000 Family 導入・運用・サービス マニュア
ル』

817-2758

Sun StorEdge 3310 SCSI アレイ
と
Sun StorEdge 3510 FC アレイ
の両方

『Sun StorEdge 3000 Family Diagnostic Reporter 1.2 ユーザ 
ガイド』

817-2774

『Sun StorEdge 3000 Family ラック インストール ガイド』 817-2768

『Sun StorEdge 3000 Family FRU インストール ガイド』 817-2765

『Sun StorEdge 3000 Family Safety, Regulatory and 
Compliance Manual』

816-7930
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テクニカル サポート
新の技術情報やトラブルシューティングに関するヒントは、ご使用のアレイのリ

リース ノートを、次の適切なディレクトリから入手してください。

www.sun.com/products-n-solutions/
hardware/docs/Network_Storage_Solutions/Workgroup/

本製品に関する技術的な疑問で、本書で回答が得られないものについては、次の
URL にアクセスしてください。

http://www.sun.com/service/contacting

アメリカでのサービス リクエストの開始またはお問い合わせは、次の Sun サポート
にご連絡ください。

800-USA4SUN

国際テクニカル サポートについては、次のサイトから該当国のセールス オフィスに
ご連絡ください。

www.sun.com/service/contacting/sales.html

Sun 文書へのアクセス
Sun StorEdge 3000 FC Family に関する文書はすべて、PDF および HTML 形式で、
次の URL からオンラインで入手できます。

http://www.sun.com/products-n-solutions/
hardware/docs/Network_Storage_Solutions/Workgroup/

広範な Sun 文書類は、次のサイトから表示、印刷、または購入することができます。

http://www.sun.com/documentation

Sun StorEdge 3000 Family マニュアルの印刷版は、次のサイトからご注文になれます。

http://corppub.iuniverse.com/marketplace/sun
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508 アクセシビリティ機能
Sun StorEdge 文書は、視覚障害を持つ方の支援テクノロジ プログラムと共に使用で
きる、508 条に準拠した HTML ファイルで入手できます。これらのファイルは、使
用する製品の文書 CD に収められているほか、前述の「Sun 文書へのアクセス」に記
載されている Web サイトでも入手できます。さらに、ソフトウェア アプリケーショ
ンとファームウェア アプリケーションではキーボード ナビゲーションとショート
カットも使用可能です。これらに関する説明はユーザ ガイドに記載されています。

本書に対するご意見
Sun では、よりよいマニュアル作成のため、皆様からのご意見やご提案を歓迎します。
コメントがありましたら下記へお送りください。

http://www.sun.com/hwdocs/feedback

フィードバックには、下記に示すご使用のマニュアルのタイトルと部品番号をお書き
添えください。『Sun StorEdge 3000 Family Configuration Service 1.3 ユーザ ガイ
ド』、部品番号 817-2771-11
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第 1 章

はじめに

このセクションでは、Sun StorEdge Configuration Service の機能の概要を簡単に説
明します。

注 – 簡潔に記述するために、Sun StorEdge Configuration Service は、本書全体でプ
ログラムとも呼んでいます。

Sun StorEdge Configuration Service は、Java™ プログラミング言語に基づく高性能
プログラムであり、アレイを集中管理するため、ストレージの構成、保守、および監
視ツールを 1 つのアプリケーションにまとめています。

ネットワーク上の 1 つのコンソールから、システム管理者はネットワーク ストレー
ジの初期化、構成の変更、ステータスの監視、定期保守のスケジュールなどを、直感
的なグラフィカル ユーザ インターフェイス（GUI）から実行できます。

管理者は、ネットワーク全般のストレージ需要の変動に伴い絶えず変化するストレー
ジ要件に合わせて、容量を動的に割り振り、再割り振り、または拡張することができ
ます。 

ステータスに変化があると、プログラムはコンソール画面、電子メール、または英数
字ページャを使って、アラートを送信します。また、HP OpenView などの任意の簡
易ネットワーク管理プロトコル（SNMP）エンタープライズ マネージャにアラート
を送信することもできます。 
1



Sun StorEdge Configuration Service は次の 2 つのコンポーネントで構成されます。

■ Sun StorEdge Configuration Service エージェント – Solaris 8 および Solaris 9 動
作環境、Windows NT および Windows 2000、Sun™ Linux 5.0 および Red Hat
Linux 7.2 および 7.3 動作環境。

エージェントは、接続されているディスク記憶装置を監視し、これらの装置の状
態をコンソールに報告します。エージェント ソフトウェアは、ネットワーク内の 
Sun StorEdge Configuration Service を構成する各サーバにインストールする必要
があります。インストールは、ネットワーク上のリモートの単一ワークステー
ションから実行できます。 

■ Sun StorEdge Configuration Serviceコンソール – Solaris 8 および Solaris 9 動作環
境、Windows NT および Windows 2000、Sun™ Linux 5.0 および Red Hat Linux
7.2 および 7.3 動作環境。

コンソールには、Sun StorEdge Configuration Service の GUI 部分が含まれてお
り、エージェントによって報告される情報を表示します。また、コンソールを
使って、1 つのワークステーションからリモートでデバイスを構成、管理すること
ができます。コンソールは、ネットワーク上のサーバを管理するコンピュータに
インストールする必要があります。
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第 2 章

インストール前に

この章では、Sun StorEdge Configuration Service をインストールして使い始める前
に確認しなければならない重要な事項について説明します。この章には以下の項目が
含まれます。

■ 3 ページの「画面の例」
■ 3 ページの「Solaris 動作環境」
■ 4 ページの「Windows NT/2000 オペレーティング システム」
■ 4 ページの「スーパーユーザ / 管理者の特権」

画面の例
本書ではプログラムの例を示すために、全体を通じて多数の画面が例として使用され
ています。これらの画面は、Sun StorEdge 3310 アレイまたは Sun StorEdge 3510 アレ
イのいずれかから出力したものです。機能とその画面の例が Sun StorEdge 3510 FC ア
レイのみに該当すると特記されない限り、機能は両方のアレイに該当します。

Solaris 動作環境
Solaris 動作環境のシステムに Sun StorEdge Configuration Service をインストールす
る前に、以下の事項を確認してください。

■ Sun StorEdge Configuration Service エージェントをインストールするホスト サー
バーが、プライマリ ID が割り当てられたチャネルに接続されていること。コント
ローラのデフォルト値と初期構成情報については、『Sun StorEdge 3000 Family 導
入・運用・サービス マニュアル』を参照してください。
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■ Sun StorEdge 3310 SCSI アレイの場合、同じ ID を持つ複数の LUN が動作環境で
認識できることを確認してください。ホスト LUN を追加して割り当てるには、
/kernel/drv/sd.conf の修正が必要になることがあります。このファイルの修
正方法の詳細は、使用しているアレイ用の『Sun StorEdge 3000 Family 導入・運
用・サービス マニュアル』を参照してください。sd.conf ファイルを変更した場
合は、変更を有効にするためにワークステーションをリブートする必要があります。

Windows NT/2000 オペレーティング 
システム
Microsoft Windows 動作環境のシステムに Sun StorEdge Configuration Service をイ
ンストールする前に、以下の事項を確認してください。

■ Sun StorEdge Configuration Service  エージェントをインストールするホスト サーバー
が、プライマリ ID が割り当てられたチャネルに接続されていること。コントローラ
のデフォルト値と初期構成情報については、『Sun StorEdge 3000 Family 導入・運
用・サービス マニュアル』を参照してください。

■ サーバーがオペレーティング システムに接続されていて、サーバーがストレージを認識
すること。

スーパーユーザ / 管理者の特権
Sun StorEdge Configuration Service をインストールして、コンソールを実行するに
は、スーパーユーザ / 管理者の特権が必要です。
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第 3 章

Solaris 動作環境システムでの Sun 
StorEdge Configuration Service の
インストール

この章では、Solaris 動作環境のシステムに Sun StorEdge Configuration Service コン
ソールおよびエージェントをインストールする手順を説明します。この章でふれるト
ピックは以下のとおりです：

■ 5 ページの「システム要件」
■ 6 ページの「Sun StorEdge Configuration Service のインストールの前に」
■ 7 ページの「ソフトウェアのインストール」
■ 14 ページの「ユーザとパスワード」
■ 16 ページの「Sun StorEdge Configuration Service のアンインストール」
■ 17 ページの「構成の復元」

システム要件
■ Netscape™ 4.0 以降 - オンライン ヘルプの表示用。

■ コンソール用の TCP/IP 準拠のネットワーク インターフェイス - 各コンソールに
は TCP/IP 準拠のネットワーク インターフェイス（イーサネット、トークン リン
グ ネットワーク カード、またはモデム付きのシリアル ラインなど）が必要です。

■ コンソールは、解像度 1024 x 768 ピクセルで 256 色のモニターを使用すると 適
な表示になります。コンソールのその他の要件は、下表を参照してください。
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■ エージェント用の TCP/IP 準拠のネットワーク インターフェイス - 各エージェン
トには、TCP/IP 準拠のネットワーク カード インターフェイスと（オペレーティ
ング システムに含まれる）ドライバ セットが必要です。エージェントのその他の
要件は、下表を参照してください。

Sun StorEdge Configuration Service の
インストールの前に
プログラムとその関連ソフトウェア コンポーネントをインストールする前に、以下の必
要な手順と追加オプションを確認してください。

■ 使用しているアレイ用のリリース ノートを必ずお読みください。

■ 動作環境のアップデートをインストールしてください。Sun StorEdge Configuration
Service を Solaris 動作環境で使用するには、Solaris 8 および Solaris 9 動作環境用の

新の Sun 推奨動作環境パッチと Java パッチをインストールする必要があります。
（Sun 推奨パッチのリストは、使用しているアレイ用のリリース ノートを参照。） 

■ 動作環境にエンタープライズ管理コンソールが含まれている場合、オプションとし
て、SNMP サービスを使用してトラップ イベントをコンソールに送信するように、
エージェントを構成することができます。SNMP サービスは動作環境に含まれてお
り、TCP/IP プロトコル スタックのインストール後にインストールされます。

表 3-1 コンソールのシステム要件 

Solaris 動作環境バージョン メモリ ディスク空き容量

Sun 推奨パッチ付き Solaris 
8 および Solaris 9
（Sun 推奨パッチのリスト
は、使用しているアレイ用の
リリース ノートを参照。）

64 MB 推奨 小 16 MB のディスク空き容量

表 3-2 エージェントのシステム要件 

Solaris 動作環境バージョン メモリ ディスク空き容量

Solaris 8 および Solaris 9 小 128 MB 1 MB のディスク空き容量
小
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■ ネットワーク上のサーバからエンタープライズ管理コンソールに SNMP トラップを
送信する方法の詳細は、223 ページの「電子メールと SNMP」を参照してください。

■ オプション。Sun StorEdge Configuration Service の併用ユーティリティであり、ス
トレージ システムのイベントを指定の電子メール アドレスに通知する Sun StorEdge
Diagnostic Reporter のインストールと使用方法は、『Sun StorEdge 3000 Family
Diagnostic Reporter ユーザ ガイド』を参照してください。

■ オプション。マルチパスを使用するには、Solaris 動作環境用 Sun StorEdge Traffic
Manager ソフトウェア（Sun StorEdge SAN Foundation ソフトウェアに含まれ
る）が必要です。詳細は、使用しているアレイのリリース ノートにある「サポートさ
れている他のソフトウェア」を参照してください。

注 – Sun StorEdge Configuration Service をインストールして、コンソールを実行す
るには、スーパーユーザの特権が必要です。

ソフトウェアのインストール
Sun StorEdge Configuration Service は、以下のコンポーネントから構成されます。

■ Sun StorEdge Configuration Service エージェント。

■ Sun StorEdge Configuration Service コンソール。

■ Diagnostic Reporter（オプションのユーティリティ）- インストールと使用方法
は、『Sun StorEdge 3000 Family Diagnostic Reporter ユーザ ガイド』を参照して
ください。

■ コマンド行インターフェイス（CLI） - インストールについては、使用しているア
レイの『Sun StorEdge 3000 Family 導入・運用・サービス マニュアル』を参照し
てください。
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インストール パッケージ

Sun StorEdge Configuration Service エージェントおよびコンソールのインストール
パッケージは、Sun StorEdge 3000 Family Professional Storage Manager CD に収録
されています。このプログラムは 4 つの言語をサポートしています。次の表にそれぞ
れの言語に必要なファイルを示します。

注 – 各言語では、コンソールとエージェント用に英語版のインストール パッケージ
が必要です。

▼ エージェントおよびコンソールをインストールす
るには

Sun StorEdge Configuration Service を構成する各サーバーにエージェントをインス
トールしてください。コンソールは、ストレージ システムの維持管理に使用するコ
ンピュータとワークステーションにインストールしてください。

コンソールはサーバまたは任意のクライアント システムにインストールできます。エー
ジェントは、ストレージが接続されるサーバにインストールする必要があります。

エージェント、コンソール、またはその両方をインストールするには、以下の手順を
完了してください。プログラムを実行するには、少なくとも 1 つのエージェントと 1
つのコンソールをインストールする必要があります。

注 – Sun StorEdge Configuration Service のインストール先のコンピュータまたは
ワークステーション上に Java Runtime Environment 1.2 以降がインストールされて
いることを確認してください。

表 3-3 Solaris 動作環境で必要な Sun StorEdge Configuration Service のインストール 
パッケージ

英語版 フランス語版 日本語版 中国語版（簡体字）

エージェント SUNWscsd SUNWscsd
SUNWfscsd

SUNWscsd
SUNWjscsd

SUNWscsd
SUNWcscsd

コンソール SUNWscsu SUNWscsu
SUNWfscsu

SUNWscsu

SUNWjscsu

SUNWscsu
SUNWcscsu
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注 – コンソールまたはエージェントをアップグレードする場合は、Sun StorEdge
Configuration Service をアンインストールする必要があります。アンインストールの
詳細は、16 ページの「Sun StorEdge Configuration Service のアンインストール」を
参照してください。

注 – フランス語、日本語、中国語（簡体字）の言語サポートを追加する場合は、英
語版のプログラムを最初にインストールする必要があります。

1. Sun StorEdge 3000 Family Professional Storage Manager CD を挿入し、次のように
入力します。

2. パッケージを次のいずれかの方法でインストールします。

a. エージェント（英語版）だけをインストールする場合は、次のように入力します。

b. フランス語、日本語、または中国語（簡体字）の言語サポートを追加するには、
次のように入力します。

インストールする言語によって上記の x は c、j、または f になります。パッケー
ジの名前については、8 ページの「Solaris 動作環境で必要な Sun StorEdge
Configuration Service のインストール パッケージ」を参照してください。

c. コンソール（英語版）だけをインストールする場合は、次のように入力します。

# cd /cdrom/cdrom0/product/solaris

# pkgadd -d SUNWscsd

# pkgadd -d SUNWxscsd

# pkgadd -d SUNWscsu
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d. フランス語、日本語、または中国語（簡体字）の言語サポートを追加するには、
次のように入力します。

インストールする言語によって上記の x は c、j、または f になります。インストー
ル パッケージ名については、8 ページの「Solaris 動作環境で必要な Sun StorEdge
Configuration Service のインストール パッケージ」を参照してください。

e. 全部のパッケージをインストールする場合は、次のように入力します。

f. インストールするパッケージをメニューから選択する場合は、次のように入力し
ます。

g. 英語版の両エージェント（Sun StorEdge Configuration Service と Sun StorEdge 
Diagnostic Reporter）のみをインストールする場合は、次のように入力します。

h. 両エージェント（Sun StorEdge Configuration Service と Sun StorEdge 
Diagnostic Reporter）のみをフランス語、日本語、または中国語（簡体字）の言
語サポートで追加する場合は、次のように入力します。

インストールする言語によって上記の x は c、j、または f になります。インストー
ル パッケージ名については、8 ページの「Solaris 動作環境で必要な Sun StorEdge
Configuration Service のインストール パッケージ」を参照してください。Sun StorEdge
Diagnostic Reporter のパッケージ名については、『Sun StorEdge 3000 Family Diagnostic
Reporter ユーザ ガイド』を参照してください。

3. 標準インストール プロンプトのそれぞれに対して、適切な応答を入力します。

インストール プロンプトは、インストールするパッケージの選択と、（スーパーユー
ザ特権での）スクリプトの処理方法に関する標準の pkgadd -d プロンプトです。

# pkgadd -d SUNWxscsu

# pkgadd -d . all

# pkgadd -d .

# pkgadd -d . SUNWscsd SUNWscsa

# pkgadd -d . SUNWxscsd SUNWxscs
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a. Select packages プロンプトで、インストール方法に応じた適切な応答を入力
します。

たとえば、上記で 2a または 2b を選択した場合は、1 を入力して Return キーを押
します。

b. 以前にエージェントをインストールしていた場合、その構成を復元するかどうか
尋ねられます。

構成を復元するには、y と入力します。n と入力した場合は、管理サーバを再度有
効にする必要があります。

注 – Sun StorEdge Configuration Service をアンインストールすると、ユーザ パス
ワードは削除されます。以前の構成が存在する場合、14 ページの「ユーザとパス
ワード」での説明のとおり、ssmon、ssadmin および ssconfig の各パスワードを
再度入力する必要があります。

c. 以前にコンソールをインストールしていた場合、その構成を復元するかどうか尋
ねられます。

構成を復元するには、y を押します。n と入力した場合は、サーバ情報を再度追加
する必要があります。

Select package(s) you wish to process (or ‘all’ to process all 
packages). (default:all) [?,??,q]: 1

The previous configuration was saved. User passwords must be 
reentered. Do you want to restore the configuration [y,n,?,q]: y

The previous configuration was saved. Do you want to restore the 
configuration [y,n,?,q]: y
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d. インストールを続行するには、y を入力して Return キーを押します。

エージェントのインストールが完了したら、エージェントのインストールが成功
し、起動したことを示す次のメッセージが表示されます。

インストール プログラムによって、Java Runtime Environment 1.2 以降がインス
トールされていることが確認されます。見つからない場合、パスを指定するよう求め
られます。Java runtime environment 1.2.2、1.3、または 1.4 がインストールされて
いることが分かっていてもインストール プログラムがそれを見つけられない場合、
/usr ディレクトリをチェックし、Java から Java 1.1 以外の 新バージョンの Java
へのリンクがあることを確認します。リンクの作成方法は、237 ページの「トラブル
シューティング」を参照してください。

エージェントおよびコンソールは、次のディレクトリにインストールされます。
/opt/SUNWsscs/sscsconsole

4. オンライン ヘルプにアクセスするには、Web ブラウザ（Netscape 4.0 以降）へのパ
スを指定する必要があります。

a. /opt/SUNWsscs/sscsconsole に移動し、次のように入力します。

b. Web ブラウザへの絶対パスを入力します。

注 – ブラウザのパス名はいつでも構成できますが、いずれかの時点で指定しないと
オンライン ヘルプにアクセスできません。

5. Sun StorEdge 3310 SCSI アレイについては、次の場合に /kernel/drv/sd.conf 
を編集します。

Do you want to continue with the installation [y,n,?] y

Configuring and starting Sun StorEdge(tm) Configuration Service 
agent daemons:
       The configuration is complete.
       Sun StorEdge(tm) Configuration Service agent server daemon 
has started.
       Sun StorEdge(tm) Configuration Service agent monitor daemon 
has started.
Sun StorEdge(tm) Configuration Service agent startup is complete.

Installation of <SUNWscsd> was successful.

./config_sscon
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■ 複数のドライブと複数の LUN でサードパーティ HBA（ホスト バス アダプタ）を
使用する。

■ ファイバ デバイスを使用する。
■ すべての LUN が同じ ID を持つ。

構成に応じて論理ユニット番号（LUN）の行を追加します。LUN には 0-31 の番号を
付けることができます。LUN を定義すると、ストレージが接続されていない場合で
も各 SCSI バスがスキャンされてしまいます。その時間を削減するためにも計画して
いる以上に LUN を定義しないことが通常は推奨されます。sd.conf ファイルの修
正方法の詳細は、使用しているアレイ用の『Sun StorEdge 3000 Family 導入・運用・
サービス マニュアル』を参照してください。

6. sd.conf ファイルを編集した場合のみ、再構成を反映するためにリブートを行います。

▼ エージェントを起動または停止するには

エージェントは、/etc/init.d/ssagent にある実行コマンド スクリプトを使っ
て、手動で停止および起動できます。

1. エージェントを起動するには、次のように入力します。

注 – エージェントを起動するには、スーパーユーザの特権を持っている必要があり
ます。

初に stop を使用せずに、start を使った場合、スクリプトは、停止されていた
任意のエージェントを再起動します。すべてのエージェントが（たとえば stop オプ
ションで）停止されていた場合、スクリプトはランタイム環境を再設定してからエー
ジェントを再起動します。

2. エージェントを停止するには、次のように入力します。

3. エージェントが実行されているか確認するには、次のように入力します。

ssmon と ssserver の両方が出力に表示されます。SNMP トラップ生成を有効にし
てあった場合は、その名前 sstrapd も表示されます。

# /etc/init.d/ssagent start

# /etc/init.d/ssagent stop

# ps -e | grep ss
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4. 最初のリブート後にストレージ システムが表示されなかった場合は、エージェント
を停止し、コマンド プロンプトで次のコマンドを実行します。

5. 目的のディスクにラベルを付けたあと、エージェントを再起動します。

ユーザとパスワード
以下のセクションではユーザとパスワードの作成方法について説明します。

管理（ユーザ）セキュリティ レベルと
ガイドライン

Solaris 動作環境のシステムでプログラムを実行する場合、管理セキュリティ レベル
はインストール プロセスで自動的に作成されます。必要な操作は、許可レベルに応
じてパスワードを設定し、ユーザを割り当てることだけです。

管理機能では、管理者が、ほかのクライアントやホストに属するストレージ リソー
スを許可なく再割り当てしたり削除したりすることのないように、アクセス ログイ
ンとパスワードが要求されます。

プログラムの 3 つのセキュリティ レベルに個別のパスワードを割り当ててくださ
い。これを行うには、プログラムで管理されるストレージ デバイスを持つエージェ
ントに 3 つのユーザをセットアップします。この 3 つのユーザは、エージェントのイ
ンストール時に自動的に追加されます。

セキュリティ レベルの名前は、次のとおりでなければなりません。

■ ssmon

ソフトウェアの監視レベルを表します。

■ ssadmin

ソフトウェアの管理レベルを表します。リビルド、パリティ チェック、およびパ
リティ チェックのスケジュールの機能へのアクセスと、監視機能を提供します。

■ ssconfig

ソフトウェアの構成レベルを表します。インストール者に、構成機能およびプロ
グラムのその他の関連機能への直接アクセスを提供します。

# format
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3 つのセキュリティ レベルにはこれらのログイン名が必要です。インストールの後、
各セキュリティ名にパスワードを割り当てる必要があります。

ssmon、ssadmin、および ssconfig は、プログラムのセキュリティ レベルのみに
対応するログイン名です。UNIX 動作環境（Solaris または Linux OE）では、ユーザ
ID が対話的なログインに使用されることを防ぐために、これらのアカウントのデ
フォルト シェルは /bin/false に割り当てられます。

Sun StorEdge Configuration Service は、ユーザが ssmon パスワードを入力せずに監
視機能を実行できるようにセットアップできます。これを行うには、コンソールで
サーバを Managed Servers リストに追加するときに、Auto Discovery オプションを
選択します。この 3 つのログインとパスワードは各サーバー上でローカルにセット
アップできます。（必要であれば、これらのアカウントにサーバーごとに異なるパス
ワードを設定することもできます。） 

管理するエージェントにこの 3 つのログイン名をセットアップしたあと、システム管
理者は通常、タスクの完了に必要なセキュリティ レベルに基づいてユーザに適切な
パスワードを割り当てることにより、プログラムへのユーザ アクセスを提供しま
す。たとえば、特定のサーバに対する管理特権を持つものは全員、ユーザ ssadmin
用に確立された同じパスワードが割り当てられます。

注 – Managed Servers リストにサーバーを追加する方法は、42 ページの「サーバを
追加するには」を参照してください。

▼ パスワードと許可を作成するには

各新規ユーザにパスワードを作成するには、次のように入力します。

# passwd ユーザ名
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管理者はグループ許可を変更することもできます。グループ許可は、インストール時
の /opt/SUNWsscs/sscsconsole ディレクトリにある svrlist.dat ファイルで
定義されています。

コンソールは Java プログラム ベースのユーティリティであるため、Sun StorEdge
Configuration Service が作成するファイルの許可や所有権を制御する機能は提供しま
せん。svrlist.dat ファイルは、各種の ASCII テキスト プロセッサで容易に読み
取ることができます。このファイルには、ユーザ ssmon の暗号化されたパスワード
が含まれており、解読可能です。

注 – 監視するエージェントをすべて追加したあとで、svrlist.dat の許可とグルー
プ所有権を変更しないでください。

Sun StorEdge Configuration Service の
アンインストール 
コンソールまたはエージェントをアップグレードする場合は、Sun StorEdge Configuration
Service をアンインストールする必要があります。一部のファイルは削除されません
が、その理由はこれらがインストールの後に作成され、アップグレード環境でも有効
だからです。

▼ Sun StorEdge Configuration Service をアンイン
ストールするには

pkgrm  コマンドの後に、アンインストールするパッケージを指定します。

注 –フランス語、日本語、または中国語（簡体字）の言語サポートを追加している場
合は、英語版パッケージをアンインストールする前に、それらのパッケージをアンイ
ンストールする必要があります。

xxxxx は、アンインストールするパッケージです。パッケージの名前については、
8 ページの「Solaris 動作環境で必要な Sun StorEdge Configuration Service のイン
ストール パッケージ」を参照してください。

# pkgrm SUNWxxxxx
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構成の復元
エージェントまたはコンソールを再インストールする場合、インストールの実行中に
構成を復元するかどうか尋ねられます。構成を復元するように選択した場合、以下の
ファイルから情報が復元されます。

■ /var/opt/SUNWsscs/sscsagt.cfg.tar - Sun StorEdge Configuration Service エー
ジェント

■ /var/opt/SUNWsscs/sscscon.cfg.tar - Sun StorEdge Configuration Service コン
ソール

注 – Sun StorEdge Configuration Service を永久に削除する場合は、これらのファイ
ルを手動で削除してもかまいません。しかし、プログラムを再インストールする場合
は、これらが削除されていると、エージェントの構成およびコンソールの構成を復元
できなくなります。
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第 4 章

Microsoft Windows NT または Windows 
2000 オペレーティング システムでの 
Sun StorEdge Configuration Service 
のインストール

この章では、Windows NT/2000 動作環境のシステムに Sun StorEdge Configuration
Service コンソールおよびエージェントをインストールする手順を説明します。この
章でふれるトピックは以下のとおりです：

■ 19 ページの「システム要件」
■ 20 ページの「Sun StorEdge Configuration Service のインストールの前に」
■ 21 ページの「ソフトウェアのインストール」
■ 23 ページの「ユーザとパスワード」
■ 25 ページの「Sun StorEdge Configuration Service のアンインストール」

システム要件
■ Netscape 4.0 以降または Microsoft Internet Explorer 4.0 以降 - オンライン ヘルプ

の表示用。

■ コンソール用の TCP/IP 準拠のネットワーク インターフェイス - 各コンソールに
は TCP/IP 準拠のネットワーク インターフェイス（イーサネット、トークン リン
グ ネットワーク カード、またはモデム付きのシリアル ラインなど）が必要です。

■ コンソールは、解像度 1024 x 768 ピクセルで 256 色のモニターを使用すると 適
な表示になります。コンソールのその他の要件は、下表を参照してください。
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■ エージェント用の TCP/IP 準拠のネットワーク インターフェイス – 各エージェン
トには、TCP/IP 準拠のネットワーク カード インターフェイスと（オペレーティ
ング システムに含まれる）ドライバ セットが必要です。エージェントのその他の
要件は、下表を参照してください。

Sun StorEdge Configuration Service の
インストールの前に
プログラムとその関連ソフトウェア コンポーネントをインストールする前に、以下
の必要な手順と追加オプションを確認してください。

■ 使用しているアレイ用のリリース ノートを必ずお読みください。

■ 動作環境にエンタープライズ管理コンソールが含まれている場合、オプションとし
て、SNMP サービスを使用してトラップ イベントをコンソールに送信するよう
に、エージェントを構成することができます。SNMP サービスは動作環境に含まれ
ており、TCP/IP プロトコル スタックのインストール後にインストールされます。

■ ネットワーク上のサーバからエンタープライズ管理コンソールに SNMP トラップ
を送信する方法の詳細は、223 ページの「電子メールと SNMP」を参照してくだ
さい。

表 4-1 コンソールのシステム要件

OS バージョン メモリ ディスク空き容量

Windows NT 4.0 （SP 3 以降）

Windows 2000
小 32 MB

64 MB 推奨

小 20 MB のディスク空き容量

40 MB 推奨

表 4-2 エージェントのシステム要件

OS バージョン メモリ ディスク空き容量

Windows NT 4.0（Service 
Pack 3、4、5、または 6）
Windows 2000

小 32 MB、または 64 MB 以上を推奨。
要件は、データベースなど、ほかの大型
アプリケーション プログラムにより決定
される。

2 MB のディスク
空き容量
20 Sun StorEdge 3000 Family Configuration Service 1.3 ユーザ ガイド • 2003 年 6 月



■ オプション。Sun StorEdge Configuration Service の併用ユーティリティであり、
ストレージ システムのイベントを指定の電子メール アドレスに通知する Sun
StorEdge Diagnostic Reporter のインストールと使用方法は、『Sun StorEdge
3000 Family Diagnostic Reporter ユーザ ガイド』を参照してください。

■ オプション。マルチパスを使用するには、Sun StorEdge Traffic Manager ソフト
ウェア（Sun StorEdge SAN Foundation ソフトウェアに含まれる）が必要です。
詳細は、使用しているアレイのリリース ノートにある「サポートされている他の
ソフトウェア」を参照してください。

注 – Sun StorEdge Configuration Service をインストールし、コンソールを実行する
には、管理者の特権が必要です。

ソフトウェアのインストール
Sun StorEdge Configuration Service は、以下のコンポーネントから構成されます。

■ Sun StorEdge Configuration Service エージェント。

■ Sun StorEdge Configuration Service コンソール。

■ Diagnostic Reporter（オプションのユーティリティ）- インストールと使用方法
は、『Sun StorEdge 3000 Family Diagnostic Reporter ユーザ ガイド』を参照して
ください。

■ コマンド行インターフェイス（CLI） - インストールについては、使用しているア
レイの『Sun StorEdge 3000 Family 導入・運用・サービス マニュアル』を参照し
てください。

Sun StorEdge Configuration Service によってストレージが管理される各サーバにエー
ジェントをインストールしてください。コンソールは、ストレージ システムの維持管
理に使用するコンピュータとワークステーションにインストールしてください。

インストール パッケージ

Configuration Service インストール パッケージ（setup.exe）は、Sun StorEdge
Professional Storage Manager CD にあり、以下のファイルが含まれています。

■ Sun StorEdge Configuration Service エージェント
■ Sun StorEdge Configuration Service コンソール
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▼ エージェントおよびコンソールをインストールす
るには

Sun StorEdge Configuration Service で管理されるストレージを持つ各 Windows NT
または Windows 2000 サーバーにエージェントをインストールする必要があります。

注 – コンソールのインストール先のコンピュータまたはワークステーション上に Java
Runtime Environment 1.2 以降がインストールされていることを確認してください。

1. ソフトウェア インストール ユーティリティ機能が最適に動作するように、動作中の
すべての Windows アプリケーションを終了します。

2. Sun StorEdge 3000 Family Professional Storage Manager CD を挿入し、\product\
windows ディレクトリに移動します。

3. setup.exe をダブルクリックし、インストールするソフトウェア コンポーネントとし
て SUNWsscs Agent または SUNWsscs Console を選択します。

4. Choose Destination Location ウィンドウで、デフォルト フォルダをインストール
し、Next をクリックします。エージェントは、C:\Program Files\Sun\ssagent
にインストールされ、コンソールは C:\Program Files\Sun\sscs にインストー
ルされます。

別のフォルダにインストールするには、Browse をクリックしてそのフォルダを選択
し、Next をクリックします。

インストールが完了したら、エージェントは自動的に起動します。

▼ Windows NT サーバでエージェントを起動または
停止するには

サーバでエージェントを起動するには、サーバをリブートするか、設定→コントロー
ル パネル→サービスで SUNWscsd Startup、SUNWscsd Server、および SUNWscsd
Monitor という Sun StorEdge Configuration Service の 3 つのサービスを開始します。

エージェントを停止するには、設定→コントロール パネル→サービスにアクセスし、
停止するエージェントを選択して停止をクリックします。
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▼ Windows 2000 サーバでエージェントを起動また
は停止するには

1. スタート→管理サービス→コンピュータの管理を選択します。

2. サービスとアプリケーションをクリックします。

3. 起動または停止するサービス（SUNWscsd Monitor、SUNWscsd Server、または
SUNWscsd Startup）を右クリックします。

別の方法として、スタート→設定→コントロール パネル →管理ツール→ コンピュー
タの管理を使用することもできます。

ユーザとパスワード
以下のセクションではユーザとパスワードの作成方法について説明します。

管理者（ユーザ）セキュリティ レベルとガイドラ
イン

管理機能では、管理者が、ほかのクライアントやホストに属するストレージ リソースを
許可なく再割り当てしたり削除したりすることのないように、アクセス ログインとパス
ワードが要求されます。

3 つのセキュリティ レベルに別々のパスワードを割り当ててください。これを行うに
は、プログラムで管理されるストレージ デバイスを持つエージェントに 3 つのユー
ザをセットアップします。

セキュリティ レベルの名前は、次のとおりでなければなりません。

■ ssmon

ソフトウェアの監視レベルを表します。

■ ssadmin

ソフトウェアの管理レベルを表します。リビルド、パリティ チェック、およびパ
リティ チェックのスケジュールの機能へのアクセスと、監視機能を提供します。

■ ssconfig

ソフトウェアの構成レベルを表します。インストール者に、構成機能およびプロ
グラムのその他の関連機能への直接アクセスを提供します。
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3 つのセキュリティ レベルにはこれらの名前が必要です。インストールの後、各セ
キュリティ名にパスワードを割り当てる必要があります。

ssmon、ssadmin、および ssconfig は、プログラムのセキュリティ レベルのみに
対応するログイン名です。

Sun StorEdge Configuration Service は、ユーザが ssmon パスワードを入力せずに監
視機能を実行できるようにセットアップできます。このためには、コンソールでサー
バを Managed Servers リストに追加するときに、Auto Discovery オプションを選択
します。この 3 つのログインとパスワードは各サーバー上でローカルにセットアップ
できます。（これらのアカウントにサーバーごとに異なるパスワードを設定すること
もできます。） 

管理するエージェントにこの 3 つのログイン名をセットアップしたあと、システム管
理者は通常、タスクの完了に必要なセキュリティ レベルに基づいてユーザに適切な
パスワードを割り当てることにより、プログラムへのユーザ アクセスを提供します。
たとえば、特定のサーバーに対する管理特権を持つものは全員、ユーザ ssadmin 用
に確立された同じパスワードが割り当てられます。

注 – Managed Servers リストにサーバを追加する方法は、42 ページの「サーバを追
加するには」を参照してください。

複数サーバーに対するグローバル パスワード

大規模ネットワークを使用しているため個々のログインをセットアップしたくない場
合で、複数のサーバーが同じパスワードを持つことが許可されているときは、この 3
つのログインを Microsoft Windows でのドメイン サーバー上に確立することができ
ます。これにより、この Microsoft Windows ドメイン内のほかのすべてのサーバが、
それぞれのパスワードを使って 3 つのログインにアクセスできるようになります。

▼ Windows NT ユーザを作成するには

1. NT User Manager プログラムを使ってユーザを追加します。

2. Policies を選択して、User Rights を選択します。

3. Show Advanced User Rights を選択します。

4. NT ユーザ管理者に、Rights to Act  as a part of the operating system の権限を与え
ます。

5. User Properties で、User Must Change Password at Next Login を選択解除します。
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6. User Properties で、User Cannot Change Password（ユーザはパスワードを変更で
きない）と Password Never Expires（パスワードを無期限にする）を選択します。

7. 複数のサーバ設定を必要としないようにドメイン サーバ上にユーザ名をセットアッ
プする場合は、被管理のサーバが、Sun StorEdge Configuration Service ユーザ アカ
ウントが確立されたドメインに属していることを確認してください。

詳細は、Windows NT の説明書を参照してください。

▼ Windows 2000 ユーザを作成するには

1. 設定→コントロール パネル→管理ツール→コンピュータの管理→システム ツール→
ローカル ユーザとグループにアクセスし、ユーザを選択します。

2. Users フォルダを右クリックし、新しいユーザ を選択して 3 人のユーザ（ssmon、
ssconfig、 および ssadmin）を追加します。

3. ユーザ名にユーザの 1 人を追加します。必要であれば、説明にその説明を入力します。

4. パスワードを入力し、必要であれば、ユーザはパスワードを変更できないとパスワー
ドを無期限にするを選択します。

Sun StorEdge Configuration Service の
アンインストール
Sun StorEdge Configuration Service を Microsoft Windows コンソールから削除するに
は、Window のアプリケーションの追加と削除ユーティリティを使用してください。

▼ Sun StorEdge Configuration Service をアンイン
ストールするには

1. スタート→設定→コントロール パネル→アプリケーションの追加と削除にアクセス
します。

2. Sun StorEdge Configuration Service エージェントを選択し、追加と削除を選択しま
す。プロンプトに対して適切に答えます。

3. Sun StorEdge Configuration Service コンソールを選択し、追加と削除を選択します。
プロンプトに対して適切に答えます。
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第 5 章

Linux 動作環境システムでの Sun 
StorEdge Configuration Service の
インストール

この章では、Sun Linux または Red Hat Linux 動作環境のシステムに Sun StorEdge
Configuration Service コンソールおよびエージェントをインストールする手順を説明
します。この章でふれるトピックは以下のとおりです：

■ 27 ページの「システム要件」
■ 28 ページの「Sun StorEdge Configuration Service のインストールの前に」
■ 29 ページの「ソフトウェアのインストール」
■ 33 ページの「ユーザとパスワード」
■ 35 ページの「Sun StorEdge Configuration Service のアンインストール」

システム要件
■ Netscape™ 4.0 以降 - オンライン ヘルプの表示用。

■ コンソール用の TCP/IP 準拠のネットワーク インターフェイス - 各コンソールに
は TCP/IP 準拠のネットワーク インターフェイス（イーサネット、トークン リン
グ ネットワーク カード、またはモデム付きのシリアル ラインなど）が必要です。 

■ コンソールは、解像度 1024 x 768 ピクセルで 256 色のモニターを使用すると 適
な表示になります。コンソールのその他の要件は、下表を参照してください。
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■ エージェント用の TCP/IP 準拠のネットワーク インターフェイス – 各エージェン
トには、TCP/IP 準拠のネットワーク カード インターフェイスと（オペレーティ
ング システムに含まれる）ドライバ セットが必要です。エージェントのその他の
要件は、下表を参照してください。

Sun StorEdge Configuration Service の
インストールの前に
プログラムとその関連ソフトウェア コンポーネントをインストールする前に、以下
の必要な手順と追加オプションを確認してください。

■ 使用しているアレイ用のリリース ノートを必ずお読みください。

■ 動作環境にエンタープライズ管理コンソールが含まれている場合、オプションと
して、SNMP サービスを使用してトラップ イベントをコンソールに送信するよう
に、エージェントを構成することができます。 

■ ネットワーク上のサーバからエンタープライズ管理コンソールに SNMP トラップを
送信する方法の詳細は、223 ページの「電子メールと SNMP」を参照してください。

■ オプション。Sun StorEdge Configuration Service の併用ユーティリティであり、ス
トレージ システムのイベントを指定の電子メール アドレスに通知する Sun StorEdge
Diagnostic Reporter のインストールと使用方法は、『Sun StorEdge 3000 Family
Diagnostic Reporter ユーザ ガイド』を参照してください。

表 5-1 コンソールのシステム要件 

Linux のバージョン メモリ ディスク空き容量

Sun Linux 5.0
Red Hat Linux 7.2 および 7.3

小 256 MB 10 MB

表 5-2 エージェントのシステム要件 

Linux のバージョン メモリ ディスク空き容量

Sun Linux 5.0
Red Hat Linux 7.2 および 7.3

小 128 MB 1 MB
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■ オプション。マルチパスを使用するには、Sun StorEdge Traffic Manager ソフト
ウェア（Sun StorEdge SAN Foundation ソフトウェアに含まれる）が必要です。
詳細は、使用しているアレイのリリース ノートにある「サポートされている他の
ソフトウェア」を参照してください。

注 – Sun StorEdge Configuration Service をインストールして、コンソールを実行す
るには、スーパーユーザの特権が必要です。

ソフトウェアのインストール
Sun StorEdge Configuration Service ソフトウェアは、以下のコンポーネントから構
成されます。

■ Sun StorEdge Configuration Service エージェント。

■ Sun StorEdge Configuration Service コンソール。

■ Diagnostic Reporter（オプションのユーティリティ）- インストールと使用方法
は、『Sun StorEdge 3000 Family Diagnostic Reporter ユーザ ガイド』を参照して
ください。

■ コマンド行インターフェイス（CLI） - インストールについては、使用しているア
レイの『Sun StorEdge 3000 Family 導入・運用・サービス マニュアル』を参照し
てください。

インストール パッケージ

インストール パッケージは、Sun StorEdge 3000 Family Professional Storage Manager
CD にあり、以下のファイルが含まれています。

■ SUNWscsu.rpm - Sun StorEdge Configuration Service コンソール
■ SUNWscsd.rpm - Sun StorEdge Configuration Service エージェント

▼ エージェントおよびコンソールをインストールす
るには

Sun StorEdge Configuration Service を構成する各サーバーにエージェントをインス
トールしてください。コンソールは、ストレージ システムの維持管理に使用するコ
ンピュータとワークステーションにインストールしてください。
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Sun StorEdge Configuration Service コンソール パッケージ SUNWscsu.rpm は、サー
バまたは任意のクライアントにインストールできます。Sun StorEdge Configuration
Service エージェント パッケージ SUNWscsd.rpm は、ストレージが接続されるサーバ
にインストールする必要があります。

エージェント、コンソール、またはその両方をインストールするには、以下の手順を
完了してください。プログラムを実行するには、少なくとも 1 つのエージェントと 1
つのコンソールをインストールする必要があります。

注 – Sun StorEdge Configuration Service のインストール先のコンピュータまたは
ワークステーション上に Java Runtime Environment 1.2 以降がインストールされて
いることを確認してください。 

1. Sun StorEdge Configuration Service のインストール先のコンピュータまたはワーク
ステーション上に Java Runtime Environment 1.2 以降がインストールされていない
場合は、ただちにインストールします。

2. ファイル システムに CD ROM がマウントされていない場合は、マウントします。

3. Sun StorEdge 3000 Family Professional Storage Manager CD を挿入し、次のように
入力します。

4. パッケージを次のいずれかの方法でインストールします。

a. エージェントだけをインストールする場合は、次のように入力します。

b. コンソールだけをインストールする場合は、次のように入力します。

5. オンライン ヘルプにアクセスするには、コンソールをインストールするシステムに 
Web ブラウザがインストールされている必要があります。Web ブラウザが検出されな
い場合、Web ブラウザ（Netscape 4.0 以降）へのパスを指定するよう求められます。

# cd mount /dev/cdrom /mnt/cdrom

# cd /mnt/cdrom/product/linux

# rpm -ivh SUNWscsd.rpm

# rpm -ivh SUNWscsu.rpm
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a. /opt/SUNWsscs/sscsconsole に移動し、次のように入力します。 

b. Web ブラウザへの絶対パスを入力します。

注 – ブラウザのパス名はいつでも構成できますが、いずれかの時点で指定しないと
オンライン ヘルプにアクセスできません。

エージェントのインストールが完了したら、コンポーネントのインストールが成
功し、起動したことを示す次のメッセージが表示されます。 

コンソールのインストールが完了したら、コンポーネントのインストールが成功し、
起動したことを示す次のメッセージが表示されます。

エージェントおよびコンソールは、次のディレクトリにインストールされます。
/opt/SUNWsscs/sscsconsole

▼ エージェントを起動または停止するには

エージェントは、/etc/init.d/ssagent にある実行コマンド スクリプトを使っ
て、手動で停止および起動できます。

1. エージェントを起動するには、次のように入力します。

./config_sscon

# rpm -ivh SUNWscsd.rpm Preparing...
########################################### [100%] 1:SUNWscsd
########################################### [100%] add user ssmon 
add user ssadmin add user ssconfig Configuring and starting Sun 
StorEdge(tm) Configuration Service daemons[ OK ] 
Starting Sun StorEdge(tm) Configuration Service agent daemon[ OK ] 
Starting Sun StorEdge(tm) Configuration Service agent monitor 
daemon[ OK ]

# rpm -ivh SUNWscsu.rpm Preparing...
########################################### [100%] 1:SUNWscsu
########################################### [100%] 
Installation completed successfully!

# /etc/init.d/ssagent start
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または

注 – エージェントを起動するには、スーパーユーザの特権を持っている必要があり
ます。

初に stop を使用せずに、start を使った場合、スクリプトは、停止されていた
任意のエージェントを再起動します。すべてのエージェントが（たとえば stop オプ
ションで）停止されていた場合、スクリプトはランタイム環境を再設定してからエー
ジェントを再起動します。

2. エージェントを停止するには、次のように入力します。

3. エージェントが実行されているか確認するには、次のように入力します。

または

ssmon と ssserver の両方が出力に表示されます。SNMP トラップ生成を有効にし
てあった場合は、その名前 sstrapd も表示されます。

# service ssagent start

# /etc/init.d/ssagent stop

# ps -e | grep ss

# service ssagent status
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ユーザとパスワード
以下のセクションではユーザとパスワードの作成方法について説明します。

管理（ユーザ）セキュリティ レベルとガイドライ
ン

Solaris 動作環境のシステムでプログラムを実行する場合、管理セキュリティ レベル
はインストール プロセスで自動的に作成されます。必要な操作は、許可レベルに応
じてパスワードを設定し、ユーザを割り当てることだけです。 

管理機能では、管理者が、ほかのクライアントやホストに属するストレージ リソー
スを許可なく再割り当てしたり削除したりすることのないように、アクセス ログイ
ンとパスワードが要求されます。 

プログラムの 3 つのセキュリティ レベルに個別のパスワードを割り当ててくださ
い。これを行うには、プログラムで管理されるストレージ デバイスを持つエージェ
ントに 3 つのユーザをセットアップします。この 3 つのユーザは、エージェントのイ
ンストール時に自動的に追加されます。

セキュリティ レベルの名前は、次のとおりでなければなりません。 
■ ssmon

ソフトウェアの監視レベルを表します。

■ ssadmin

ソフトウェアの管理レベルを表します。リビルド、パリティ チェック、およびパ
リティ チェックのスケジュールの機能へのアクセスと、監視機能を提供します。 

■ ssconfig

ソフトウェアの構成レベルを表します。インストール者に、構成機能およびプロ
グラムのその他の関連機能への直接アクセスを提供します。 

3 つのセキュリティ レベルにはこれらの名前が必要です。インストールの後、各セ
キュリティ名にパスワードを割り当てる必要があります。

ssmon、ssadmin、および ssconfig は、プログラムのセキュリティ レベルのみに
対応するログイン名です。UNIX 動作環境（Solaris または Linux OE）では、ユーザ
ID が対話的なログインに使用されることを防ぐために、これらのアカウントのデ
フォルト シェルは /bin/false に割り当てられます。

Sun StorEdge Configuration Service は、ユーザが ssmon パスワードを入力せずに監
視機能を実行できるようにセットアップできます。これを行うには、コンソールで
サーバを Managed Servers リストに追加するときに、Auto Discovery オプションを
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選択します。この 3 つのログインとパスワードは各サーバー上でローカルにセット
アップできます。（必要であれば、これらのアカウントにサーバーごとに異なるパス
ワードを設定することもできます。） 

管理するエージェントにこの 3 つのログイン名をセットアップしたあと、システム管
理者は通常、タスクの完了に必要なセキュリティ レベルに基づいてユーザに適切な
パスワードを割り当てることにより、プログラムへのユーザ アクセスを提供しま
す。たとえば、特定のサーバに対する管理特権を持つものは全員、ユーザ ssadmin
用に確立された同じパスワードが割り当てられます。

注 – Managed Servers リストにサーバーを追加する方法は、42 ページの「サーバを
追加するには」を参照してください。

▼ パスワードと許可を作成するには

各新規ユーザにパスワードを作成するには、次のように入力します。

管理者はグループ許可を変更することもできます。グループ許可は、インストール時
の /opt/SUNWsscs/sscsconsole ディレクトリにある svrlist.dat ファイルで
定義されています。 

コンソールは Java ベースのユーティリティであるため、Sun StorEdge Configuration
Service が作成するファイルの許可や所有権を制御する機能は提供しません。
svrlist.dat ファイルは、各種の ASCII テキスト プロセッサで容易に読み取るこ
とができます。このファイルには、ユーザ ssmon の暗号化されたパスワードが含ま
れており、解読可能です。 

# passwd ユーザ名
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注 – 監視するエージェントをすべて追加したあとで、svrlist.dat の許可とグルー
プ所有権を変更しないでください。
第 5 章 Linux 動作環境システムでの Sun StorEdge Configuration Service のインストール 35



Sun StorEdge Configuration Service の
アンインストール 
コンソールまたはエージェントをアップグレードする場合は、Sun StorEdge Configuration
Service をアンインストールする必要があります。一部のファイルは削除されませんが、
その理由はこれらがインストールの後に作成され、アップグレード環境でも有効だか
らです。

▼ Sun StorEdge Configuration Service をアンイン
ストールするには

rpm -e コマンドの後に、アンインストールするパッケージ SUNWscsu.rpm（コン
ソール）または SUNWscsd.rpm（エージェント）を指定します。 

# rpm -e SUNWscsu.rpm

# rpm -e SUNWscsd.rpm
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第 6 章

Sun StorEdge Configuration Service 
のセットアップ

この章では、Sun StorEdge Configuration Service の一般的なセットアップ手順を説
明します。この章には以下の項目が含まれます。

■ 38 ページの「Sun StorEdge Configuration Service の起動」
■ 38 ページの「Solaris / Linux 動作環境で Sun StorEdge Configuration Service

を起動するには」
■ 39 ページの「 初の使用の前と後のメイン ウィンドウ」

■ 42 ページの「サーバを追加するには」 
■ 48 ページの「ログインとログアウト」
■ 49 ページの「コントローラを管理するサーバーを選択するには」 
■ 53 ページの「エージェントのパラメータを構成するには（オプション）」 
■ 56 ページの「ストレージの構成を確認する」 
■ 58 ページの「論理ドライブの構成を保存するには」 
■ 60 ページの「Solaris 動作環境のシステムでサーバにパーティションを作成する

には」 
■ 62 ページの「Windows 2000 オペレーティング システムでサーバにパーティ

ションを作成するには」
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Sun StorEdge Configuration Service の
起動

注 – コンソールを実行するには、スーパーユーザ / 管理者の特権が必要です。

注 – コンソールは実行していない限りイベント アラートを受信しません。したがっ
て、アレイを構成したあと、コンソール ワークステーション上で、Sun StorEdge
Configuration Service をその最小モードで常に実行状態にしておく必要があります。コ
ンソールをフォアグラウンドで常時実行する代わりに、Sun StorEdge Configuration
Service の併用ユーティリティである Sun StorEdge Diagnostic Reporter を使用するこ
とができます。このユーティリティはバックグラウンド サービスとして実行され、指
定された電子メール アドレスにホストおよびアレイからのメッセージを送信します。
詳細は、『Sun StorEdge 3000 Family Diagnostic Reporter ユーザ ガイド』を参照し
てください。イベント アラートを受信する別の方法については、235 ページの「Sun
StorEdge Configuration Service を使用せずに SNMP トラップを送信するには」を参
照してください。

注 – Sun StorEdge Configuration Service でアレイを表示、管理するには、各 HBA カード
がプライマリ コントローラに接続されている必要があります。

▼ Solaris / Linux 動作環境で Sun StorEdge 
Configuration Service を起動するには

コマンド プロンプトで、次のように入力します。

# ssconsole
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▼ Microsoft Windows NT/2000 オペレーティング 
システムで Sun StorEdge Configuration Service 
を起動するには

スタート→プログラム→ Sun StorEdge 3000 Family → Configuration Service を選択
します。

最初の使用の前と後のメイン ウィンドウ
プログラムを 初に初期化するときのメイン ウィンドウは空白です。表示される Add
Server ウィンドウから、使用しているコンソールの Managed Servers リストにサー
バを追加できます。サーバーの追加の詳細は、42 ページの「サーバを追加するには」を
参照してください。

プログラムを初めて起動したあとで、Managed Servers を選択しておくと、プログラ
ムを起動するたびに、Managed Servers リストにあるサーバのアイコンがメイン
ウィンドウに表示されます。OK または Cancel をクリックして、続行します。

新しいアレイを構成してワークステーションをブートした後、論理ドライブがラベル
付けされるまでプログラムがそのアレイを認識しない場合があります。これは、Sun
StorEdge Configuration Service がネイティブの Sun ドライバを使用するためです。

コンソールが使用中にロックした場合

Solaris または Linux 動作環境のシステムでコンソールが使用中にロックした場合は、
Sun StorEdge Configuration Service を停止したあと、ウィンドウをいったん閉じてから
再度開くと、エージェントに影響を与えずに済みます。

▼ Sun StorEdge Configuration Service を停止するには

1. コマンド プロンプトで、次のように入力します。

2. プログラムを再実行します。

エージェントに影響を与えずに、ウィンドウが再び表示されます。

# ssconsole stop
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メニュー、ツールバー、およびタブ

メイン ウィンドウにあるメニューバー、タブ、ツールバーを確認してください。これら
は、主な機能にアクセスするために使用します。

メニューバー

下図は、メイン メニューにあるオプションを示しています。

ツールバー

メニュー バーの下にあるツールバーには、よく使用する機能にすばやくアクセスで
きるアイコンが並んでいます。アイコンを選択すると、その機能がアクティブになり
ます。ツールバーのアイコンは、メイン ウィンドウで使用可能なリソースに応じて、ア
クティブまたは無効（灰色）として表示されます。

Login

Logout

Server List Setup

Save Report

Exit

View Report

View Group

View Server

View Controller

View Logical Drive

View Physical Drive

View Enclosure 

View FRU

Event Log

File View

Configure Host/WWN (Fibre Channel only) 

LUN Filter Properties (Fibre Channel only)

Save Configuration

Load Configuration

Standard Configure

Custom Configure

Configuration Array Administration

Controller Assignment

Controller Maintenance

Download FW for Devices

View Peripheral Device

Rebuild

Parity Check

Schedule Parity Check

Contents

About sscsConsole

Help

Array Admin Progress

Agent Options Management

Display HDD under LD
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アイコン 説明

Server List Setup。コンソールが管理するサーバの追加、サーバ
情報の編集、または使用可能なサーバが管理されていることの
指定を行います。

Event Log。ストレージ デバイスのステータス変化、ハード
ウェアのステータス変化、動作に関する通知などのイベントを
表示します。

Save Event Log。Event Log ウィンドウを使用せずにイベント 
ログを保存できる Save Event Log File ダイアログ ボックスを表
示します。

Delete Event Log。eventlog.txt ファイルの内容を手動で削除し
ます。（プログラムは、イベントを 大 10,000 件まで蓄積しま
す。イベント数が 10,000 件に達すると、自動的にイベント ログ
のサイズを 新の 500 件に減らします。）

Save Report。選択したサーバの各ストレージ コンポーネントに
関する、現在の日付のデータが含まれるテキスト ファイルを作
成します。

Standard Configuration。選択したアレイ コントローラ上に、1 
つの RAID レベルで 1 つまたは複数の論理ドライブを作成しま
す。構成の事前定義が必要な場合に使用します。構成を事前定
義しておくと、Sun StorEdge Configuration Service によって自
動的にストレージが構成されます。

Custom Configuration。選択したアレイ コントローラで、さま
ざまな RAID レベルの論理ドライブまたは論理ボリュームを構
成または再構成する複数のオプションを提供します。コント
ローラ ID およびパラメータの設定または変更、RAID セットお
よびスタンバイ ドライブの定義または修正を含め、手動で構成
を定義する必要がある場合に使用します。
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タブ 
ツールバーの下にあるタブを使って、Sun StorEdge Configuration Service のほかの
表示にすばやく移動できます。

物理（ハード）ドライブ

アレイの構成が完成されるにつれ、メイン ウィンドウに複数のコンポーネントが表示さ
れます。デフォルトでは、論理ドライブを構成する物理ドライブが表示されます。し
かし、Configuration Service メイン ウィンドウでナビゲートしやすくするために、
View → Display HDD under LD を選択解除して、物理（ハード）ドライブを表示し
ないように選択することができます。

ナビゲーション

プログラムでは、標準 Java プログラミング言語のキーボードとナビゲーション方法
を使用します。

▼ サーバを追加するには

サーバを監視または構成するには、Server List Setup を使って、まずそのサーバを
Managed Servers リストに追加する必要があります。

タブ 説明

クリックすると Sun StorEdge Configuration Service メイン ウィ
ンドウに移動します。

クリックすると Resource Allocation View に移動します。（将来
の使用のため予約済み。）

クリックすると LUN Filter View に移動します。（ファイバ チャ
ネルのみ。）
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1. Sun StorEdge Configuration Service がまだ実行されていない場合は、起動します。

2. File → Server List Setup を選択します。

Server List Setup ウィンドウが表示されます。

3. サーバーをグルーブ分けします。

a. Server List Setup ウィンドウで Groups をクリックします。

Group List Setup ウィンドウが表示されます。

b. Group Name フィールドに名前を入力し、Add をクリックします。

c. グループを削除するには、Available Groups リストからグループ名を選択し、
Delete をクリックします。

d. グループの追加と削除が終了したら、OK をクリックします。

Server List Setup ウィンドウが表示されます。

4. サーバーを追加します。
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a. Available Servers リストの下にある Add をクリックします。

Add Server ウィンドウが表示されます。

b. Server name フィールドにサーバの名前を入力して Return キーを押します。

これは、サーバーを識別するための名前です。使用しているネットワークのネー
ム サーバ データベースにこの名前がある場合、Sun StorEdge Configuration
Service はこのサーバの IP アドレスを判断して、IP Address フィールドに表示し
ます。

プログラムがこの名前の IP アドレスを検出できなかった場合は、名前が間違って
入力されたか、名前がサーバのネーム データベースに記録されていません。

c. 必要に応じて、サーバの TCP/IP アドレスを IP Address フィールドに入力します。

例: 192.168.100.1。

プログラムにより（上のステップで説明したように）、IP アドレスが表示されな
かった場合は、IP アドレスを手動で入力します。

プログラムが IP アドレスを検索して自動的に表示する別の方法として、IP
Address フィールドの下にある Get IP Address by Name を選択することもできま
す。上のステップで説明したように、この方法は、ネットワークにネーム サーバ
データベースがあり、そのデータベースに記録されているとおりにサーバ名を入
力した場合にのみ有効です。そうでなければ、IP アドレスを手動で入力する必要
があります。

5. サーバの Automatic Discovery を選択または選択解除します。
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a. サーバ インベントリへのアクセスも制限するような高いセキュリティを必要とす
る環境では、Auto Discovery に No を選択します。

No を選択すると、プログラムは起動時にサーバ情報を取り出しません。サーバの
アイコンは（アクティブを示す紫ではなく）白色で表示され、発見されていないこ
とを示します。発見されていないサーバをダブルクリックすると、Sun StorEdge
Configuration Service は ssmon  ユーザ パスワードの入力を求めます。オプション
として、サーバを選択して、File → Login を選択することもできます。

Auto Discovery に Yes を選択すると、コンソールの起動時に、このサーバについ
て使用可能な情報がすべて取り出されます。

b. Auto Discovery に Yes を選択した場合、ssmon ユーザをセットアップしたときに
サーバ（ドメインまたは DNS ツリーがある場合はサーバ グループ）に入力した
ものと同じ監視用パスワードを入力します。

Auto Discovery を使ってサーバを確立した後は、Sun StorEdge Configuration Service
にログインするときに ssmon パスワードを入力する必要はありません。監視特権
は自動的に与えられます。

ただし、管理または構成活動を実行するコマンドを選択するとかならずログイン
ダイアログボックスが表示され、以前に確立された ssadmin または ssconfig ユー
ザのパスワードを入力して、セキュリティ レベルを変更するよう求められます。

c. OK をクリックします。

6. 電子メール アドレスを設定します。

a. Sun StorEdge Configuration Service からイベント メッセージを電子メールで受け
取るようにするには、Mailing Lists タブを選択し、以下の手順に従います。

サーバー上のクリティカルなイベントに関する情報を受け取るため、自身の電子メー
ル アドレスと、選択したほかのユーザのアドレスを入力することができます。

注 – コンソールをフォアグラウンドで常時実行する代わりに、Sun StorEdge 
Configuration Service の併用ユーティリティである Sun StorEdge Diagnostic 
Reporter を使用することができます。このユーティリティはバックグラウンド サー
ビスとして実行され、指定された電子メール アドレスにホストおよびアレイからの
メッセージを送信します。詳細は、『Sun StorEdge 3000 Family Diagnostic Reporter 
ユーザ ガイド』を参照してください。Sun StorEdge Configuration Service で電子
メールを受け取ることができるようにするには、223 ページの「電子メールと 
SNMP」でトラップの設定方法を参照してください。アラートを受信する別の方法に
ついては、235 ページの「Sun StorEdge Configuration Service を使用せずに SNMP 
トラップを送信するには」を参照してください。
第 6 章 Sun StorEdge Configuration Service のセットアップ 45



b. 各ユーザについて、Mail Address フィールドに電子メール アドレスを入力します。

c. Severity リストボックスで、重要度レベルのリストをスクロールし、次のように
選択します。

Critical - ネットワーク管理者による介入を必要とするメッセージ。たとえば、デ
バイス、電源、ファンなどの故障。

Warning - 一般に内部プログラム イベントを示す警告メッセージ。このメッセー
ジが頻繁に発生する場合は、サーバーまたはネットワークに問題があることを示
している可能性があります。

Informational - サーバー上のデバイスについて、ネットワーク管理者による介入
を必要としないメッセージ。

どのレベルを選択した場合でも、そのレベルと、それより重要度の高いほかの全
レベルのイベント メッセージを受け取ります。たとえば、Informational を選択し
た場合は、すべての障害が通知されます。これに対し、クリティカルな状況につ
いてだけ通知を受けたい場合は、Critical を選択すれば、Informational や Warning
のイベントは通知されません。

d. Add to List をクリックします。

リストからユーザを削除するには、その電子メール アドレスを選択し、Delete
from List をクリックします。

e. 使用するメール サーバーを指定します。

Setup Mail Server ボタンの表示は、電子メール サーバが定義済みであるかどうか
によって、Change Mail Server と切り替わることに注意してください。

新規セットアップでは、Setup Mail Server をクリックします。次に示すような
Mail Server Setup ウィンドウが表示されます。
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f. 前のステップで指定した宛先アドレスに電子メール メッセージを配信する簡易メー
ル転送プロトコル（SMTP）メール サーバの IP アドレスまたは名前を入力します。

g. Mail Server ウィンドウでの情報の入力が完了したら、OK をクリックします。

Add Server ウィンドウが開き、Mailing Lists タブが表示されます。

7. Add Server 操作を完了します。

a. このサーバをグループの一部として使用する場合は、Grouping タブを選択します。

Add Server ウィンドウが表示されます。

b. リストボックスをクリックすると、選択肢が表示されます。

c. 必要なグループを選択し、マウス ボタンを放します。

d. OK をクリックして変更を保存します。

8. さらにサーバーを追加する場合は、各サーバーについて、ステップ 3～7 を繰り返し
ます。

9. このコンソールで管理するサーバを Managed Servers リストに移動します（42 ペー
ジの「サーバを追加するには」を参照）。
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■ 使用可能なすべてのサーバーをこのコンソールで管理する場合は、ダイアログ
ボックスの上部にある Add All をクリックします。

■ 個々のサーバを managed 列に移動するには、各サーバを選択して 2 つのリスト
ボックスの間にある Add をクリックします。

■ サーバの追加操作中に変更の必要が生じた場合は、186 ページの「サーバー エン
トリを編集する」を参照してください。

10. サーバーの追加が終了したら、OK をクリックしてメイン ウィンドウへ戻ります。

注 – アレイが複数のホストに接続され、エージェントが各ホストにインストールさ
れている場合は、各ホストの IP アドレスを入力して Managed Servers リストに追加
する必要があります。

▼ ログインとログアウト

ログイン機能とログアウト機能は、プログラム内でのセキュリティを提供します。セ
キュリティ レベルは、3 つのユーザ、ssmon、ssadmin、および ssconfig をパス
ワード付きで設定することにより確立されます。

■ ssmon はソフトウェアの監視レベルを表します。コントローラからのアラートを
表示します。

■ ssadmin はソフトウェアの管理レベルを表します。再構築、パリティ チェック、
パリティ チェックのスケジュールの機能へのアクセスと、監視機能を提供します。

■ ssconfig は構成レベルを表します。構成コマンドとプログラムの全要素へのア
クセスを提供します。

1. ログインするには、File → Login を選択します。

監視ユーザとしてのみ連続アクセスを維持してください。管理または構成レベルを必
要とするコマンドを選択すると、ログイン ダイアログボックスが表示され、適切な
パスワードでそのレベルにログインする必要があります。操作を完了したら、ログア
ウトします。
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2. ログアウトするには、File → Logout を選択します。

管理レベルまたは構成レベルからログアウトするとき、監視レベルへログインする
か、サーバーから完全にログアウトするかのオプションが与えられます。

▼ コントローラを管理するサーバーを選択するには

アレイを管理、監視するためには、エージェントは、アレイのプライマリ コントローラ
に割り当てられた論理ドライブのパーティションにマップされているホスト LUN に
アクセスする必要があります。

エージェントは、アレイの冗長構成内のセカンダリ コントローラに割り当てられた論
理ドライブのパーティションにマップされているホスト LUN はすべて無視します。

注 – 論理ドライブと LUN の説明は、189 ページの「RAID の基本」を参照してください。

1 つのアレイに複数のサーバが接続されている場合、これらのサーバ上で動作してい
るエージェントがそれぞれ、この同じアレイの管理と監視を試みる可能性がありま
す。アレイ コントローラに監視コマンドを送信できるのは一度に 1 つのサーバだけ
という制限により、監視コマンドが複数のサーバから同時に送られた場合、コマンド
の中には実行されないものもあります。この場合は、報告が不正確であったり、プロ
セスが応答を停止することがあります。このような状態を避けるため、サーバ上での
アレイの監視を有効 / 無効にするようにエージェントを構成できます。

コンソールからコントローラを割り当てる

以下の手順は、コントローラを制御するサーバをコンソールから割り当てる方法です。

1. 直接接続されているすべてのサーバーが、42 ページの「サーバを追加するには」の
指示どおりに追加されたことを確認します。

これにより、両方のホスト名が Controller Assignments に確実に表示されます。
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2. メイン ウィンドウで、Array Administration → Controller Assignment を選択します。

Assign Server to Manage a RAID Controller ウィンドウが表示されます。

3. Server to manage this controller リストからサーバを選択し、Apply をクリックします。

これにより、選択したサーバーがアレイ コントローラを管理するようになります。
同時に、リスト内のほかの全サーバーがこのアレイを管理できないようになります。

4. Close をクリックして、この表示を閉じます。

メイン ウィンドウでは、このアレイの監視が有効になっているサーバの下にのみ、
アレイ コントローラ デバイスのアイコンが表示されます。
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サーバ割り当ての変更 

コントローラを管理するサーバを割り当てると、管理サーバに関する情報が作成され
ます。プログラムは、コントローラ上にこの情報を格納し、管理サーバを追跡するた
めにこれを使用します。たとえば保守などのためにサーバをシャットダウンする場
合、コントローラを管理するために別のサーバを割り当てようとすると、プログラム
はコントローラから格納された情報を読み取り、コントローラがすでに管理されてい
るという警告を表示します。

注 – 強制的に新規サーバを割り当てる場合、現在のサーバ割り当てを上書きできます。

ファームウェア アプリケーション メニューで view and edit Host luns → Edit Host-ID/
WWN Name List を選択すると、管理サーバ名を表示できます。
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たとえばアレイを新しい場所に移動する場合など、サーバ割り当てを変更する際に
は、アレイを移動する前に、52 ページの「管理サーバの割り当てを解除するには」
の手順に従って管理サーバの割り当てを解除する必要があります。

アレイをすでに移動した場合には、アレイを起動する際に、コントローラが別のサー
バによって管理されている、という警告メッセージが表示されます。53 ページの
「端末ウィンドウを使用して手動でサーバを削除するには」の手順に従って、サーバ
を手動で削除する必要があります。ファームウェア アプリケーションにアクセスする方
法は、使用しているアレイ用の『Sun StorEdge 3000 Family RAID ファームウェア
ユーザ ガイド』を参照してください。

▼ 管理サーバの割り当てを解除するには

1. メイン ウィンドウで、Array Administration → Controller Assignment を選択します。

2. サーバ割り当てを解除するアレイ コントローラを選択します。

3. Server to manage this controller: リストボックスから none を選択します。

選択したコントローラが今後サーバによって管理されないことを確認する以下の警告
メッセージが表示されたら、Close をクリックします。

4. 50 ページの「コンソールからコントローラを割り当てる」の手順に従って、コント
ローラを管理するサーバを選択します。

サーバ名は、
ASCII 文字セットの 16 進値で
格納します。
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▼ 端末ウィンドウを使用して手動でサーバを削除するには

ファームウェア アプリケーションにアクセスする方法は、使用しているアレイ用の『Sun
StorEdge 3000 Family RAID ファームウェア ユーザ ガイド』を参照してください。

1. メイン メニューから view and edit Host luns を選択して Return キーを押します。

2. Edit Host-ID/WWN Name List を選択して、Return キーを押します。

3. Name List から sscsMgr を選択して、Return キーを押します

4. Delete Host-ID/WWN Name List を選択して、Return キーを押します。

5. Yes を選択して Return キーを押します。

▼ エージェントのパラメータを構成するには（オプ
ション）

このセクションでは、ポーリング時間、定期デバイス発見時間、SMART 監視、アウ
トオブバンド ストレージ管理などのエージェント パラメータの構成手順を説明しま
す。構成には View → Agent Options Management コマンドを使用します。

1. メイン ウィンドウから View → Agent Options Management を選択します。

Agent Options Management ウィンドウが表示されます。

注 – 1 つまたは複数のグループが構成されていて、その 1 つがメイン ウィンドウで
選択されている場合、Agent Options Management は使用できないことがあります。
有効にするには、グループ以外のアイコンを選択し、View をクリックします。
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2. Monitoring Frequency in Seconds で、希望の間隔（秒単位）を入力します。

この値は、エージェントによる監視で、デバイス、アレイ コントローラ、格納装置のス
テータス変化を調べるための連続ポーリングの間隔です。デフォルト値は 60 秒です。コ
ンソールで、デバイス ステータス変化をより頻繁に更新したい場合は、この値を小
さくします。

注 – ポーリング間隔を増加すると、I/O 負荷が重い場合に、エラー メッセージの出
力に悪い影響をおよぼす可能性があります。

3. Periodic Device Discovery で、新しいデバイスがないかチェックする希望の間隔（分
単位）を入力します。

Periodic Device Discovery の値は、新しいデバイスを検出するため各デバイス ID を
スキャンする頻度を指定します。デフォルト値の 0 は、新しいデバイスをスキャンし
ないことを意味します。この数値が大きいほど、デバイス ID のスキャン頻度が少な
くなることに注意してください。

逆に、この数値が小さいほど、デバイス ID がより頻繁にスキャンされます。 小値
は 5 分間です。
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4. Interval of trap generation で、トラップ メッセージの送信間隔（秒単位）を入力し
ます。

この値が 60 秒以上である場合、イベントがクリアまたは修正されるまで、指定され
た時間間隔でその特定のトラップについてメッセージが送信されます。たとえば、
ファンが故障した場合、故障が修理されるまでの間、ファン故障のメッセージが 60
秒おきに送信されます。

この値がゼロであると、Sun StorEdge Configuration Service（および Sun StorEdge
Diagnostic Reporter）はその特定のイベントについてメッセージを 1 回だけ送信しま
す。たとえば、ファンが故障した場合、電子メールが 1 通だけ送信されます。

5. Timeout of heartbeat lost で、故障サーバのメッセージの送信間隔（分単位）を入力
します。

デフォルト値は 15 分で、値の範囲は 1～30 分です。

6. SMART 監視を有効にするには、Enable SMART Monitoring チェックボックスを選択
します。

SMART 監視とは、予想される故障をハード ドライブが報告するための手法です。ほ
とんどのディスク ベンダーは、この機能を搭載したドライブを供給しています。エー
ジェントは、非請求の要求センスを発行してこの機能を監視します。この要求が基礎
ホスト動作環境またはシステム デバイス ドライバと競合する場合は、SMART 監視
をオフにすることができます。SMART 監視の詳細は、使用しているアレイの『Sun
StorEdge 3000 Family RAID ファームウェア ユーザ ガイド』を参照してください。

7. JBOD サポートを有効にするには、56 ページの「JBOD サポートを有効にするには
（SCSI のみ）」を参照してください。

8. Password フィールドなどの Controller Primary Agent Information のパラメータはアウ
トオブバンド管理に属します。これらのパラメータの構成についての詳細は 127 ページ
の「アウトオブバンド ストレージ管理を使用する」を参照してください。

9. 上記いずれかのオプションを選択したあと、OK をクリックして変更を保存します。

サーバの TCP/IP アドレスを示す Setting Agent Options 通知メッセージ ボックスが
表示されます。

10. OK をクリックして手順を終了します。
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▼ JBOD サポートを有効にするには（SCSI のみ）

Sun StorEdge 3310 SCSI アレイでは、JBOD（Just a Bunch Of Disks – 単なるディス
クの束）のサポートは、JBOD がワークステーションに直接接続されている場合にだ
け使用します。この機能を使用すると、周辺デバイスの状態とイベントを監視できま
す。JBOD が RAID アレイに接続されている場合、RAID コントローラにより JBOD
の状態とイベントが監視されます。

注 – JBOD サポートを有効にすると、I/O に影響がおよぶ可能性があります。

1. 53 ページの「エージェントのパラメータを構成するには（オプション）」の手順に
従います。

2. Enable JBOD support を選択します。

JBOD の監視の詳細は、205 ページの「JBOD の監視（SCSI のみ）」を参照してくだ
さい。

▼ ストレージの構成を確認する

Sun StorEdge Configuration Service をインストールし、管理するストレージのサー
バをすべて追加した後、ストレージの構成を確認する必要があります。

注 – ほとんどのアレイは、出荷前に構成されています。既存の構成をすべて削除
し、構成し直す場合は、65 ページの「フル構成」を参照してください。現在の構成
に対して変更や追加を行う場合は、147 ページの「構成の更新」を参照してください。

1. サーバー アイコンがオンライン（つまり、サーバー記号が紫色）であることを確認
します。

電源投入時に、Sun StorEdge Configuration Service が自動的に起動します。

2. メイン ウィンドウに表示されるストレージ構成をチェックします。

3. 複数のサーバーを管理している場合は、チェックしたいサーバーを選択します。

サーバ アイコンが紫でない場合、サーバの状態を確認します（表 9-1 参照）。サー
バ アイコンに衛星ディッシュが付いている場合 、サーバは発見プロセス にある
可能性があり、しばらくしてから使用できます。

4. ストレージをチェックしたいサーバーの左に表示されるコンテナ記号  をクリッ
クします。

下図に示すように、サーバに接続されている各アレイ コントローラがグラフィック
で表示されます。
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5. 詳細情報を見るには、ストレージをチェックするホスト アダプタまたはアレイ コン
トローラの横にあるコンテナ記号  をクリックします。

アレイがまだ構成されていない場合、論理ドライブ（コントローラの LUN）は表示さ
れません。

アレイが完全に構成されている場合、選択されたアレイ コントローラに関連付けられた
デバイスと論理ドライブが表示されます。下図は、デバイスが表示された画面例です。

論理ドライブの左にあるコンテナ記号  をクリックすると、それに割り当てられた
物理ドライブが表示されます。
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注 – View → Display HDD under LD を選択または選択解除することで、論理ドライブを
構成する物理（ハード）ドライブの表示と非表示を選択できます。

インストールされているアレイ製品によって、実際の構成は上図に示す構成とは大き
く異なる場合があります。

アレイが構成されていない場合は、65 ページの「フル構成」の構成手順を参照して
ください。

6. RAID レベルと論理ドライブの構造をチェックします。

7. アレイが構成済みで、その構成が希望どおりのものであれば、次のセクションへ進ん
でください。

構成を変更する場合は、65 ページの「フル構成」を参照してください。

▼ 論理ドライブの構成を保存するには

論理ドライブの構成情報がアレイ コントローラと、それに接続された物理ドライブ
に保存されていても、火災などの災害が発生した場合にコントローラとドライブの両
方が破壊されることがあります。現在の論理ドライブ（LUN）の構成のバックアッ
プ コピーを、ディスケットなどのアレイ以外のほかの外部メディアに複数作成して
ください。少なくとも 1 つのバックアップ コピーをサイト外の金庫または安全な場
所に保管しておきます。構成のバックアップ コピーを使用すれば、アレイを完全に
再構成する必要なく、新しいコントローラに構成を復元できます。現在の構成のバッ
クアップ コピーがないと、データが失われることがあります。

以下の場合には、アレイ コントローラの構成を必ずファイルに保存してください。

■ 新しいストレージ システム格納装置をインストールする、または既存の格納装置
内のコントローラの SCSI ID を変更する場合

■ アレイ コントローラを交換する場合

■ アレイ コントローラを再構成する、または論理ドライブをアレイ コントローラに
追加する場合

■ 故障ドライブからスタンバイ ドライブにデータを再構築する場合

構成をファイルから復元する方法は、140 ページの「論理ドライブの構成を復元す
る」を参照してください。

1. 保存したい構成を持つコントローラを選択します。

2. Configuration → Save Configuration を選択します。

Save Configuration ウィンドウが表示されます。
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3. 必要なドライブとフォルダにナビゲートし、更新する構成ファイル（.cfg 拡張子で
示される）を見つけます。

構成ファイルをディスケットまたはアレイ外部のドライブに保存します。つまり、こ
れらの構成ファイルのコピーをサイト外に保管してください。

4. 構成ファイルの名前を指定し、Save をクリックします。

Save Configuration  ウィンドウが表示されます。

5. 保存している構成の説明を入力し、OK をクリックします。

構成情報は .cfg ファイルに保存されます。
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▼ Solaris 動作環境のシステムでサーバにパーティ
ションを作成するには

ストレージが希望どおりの構成となった後、各動作環境でのストレージ アレイを
パーティションすることができます。

以下の手順は一般的なガイドラインです。詳細手順は、Sun Solaris OE のマニュアル
でパーティションとファイル システムの説明を参照してください。

1. 新しい LUN をラベル付けするため、次のように入力します。

format コマンドは、システム ディスクと、アレイに接続されているほかのドライブ
を表示します。

新しい LUN は、アレイで使用するためのセットアップ用に、先に format コマンド
を使ってラベル付けする必要があります。format コマンドを実行すると、使用可能
な LUN とハード ディスクが表示されます。

2. 使用するデバイスを選択します。

プロンプトに応じて、デバイスにラベルを付けます。

3. partition と入力し、既存のパーティション テーブルを表示します。

4. 必要に応じてパーティション テーブルを編集し、変更を行った場合はラベルを付け
ます。

5. newfs コマンドを使って、パーティション上にファイル システムを作成します。

# format
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6. mount コマンドを使用するか、または /etc/vfstab を編集して mountall コマン
ドを使用することにより、ファイル システムをマウントします。

▼ Windows NT オペレーティング システムでサー
バにパーティションを作成するには

このセクションの手順を始める前に、Windows NT が新しいストレージ容量を認識
するようにコンピュータをリブートする必要があります。以下の手順は一般的なガイ
ドラインです。詳細手順は、Windows NT の説明書を参照してください。

注 – このステップはリモートでは実行できません。サーバーから実行する必要があ
ります。

1. スタート→プログラム→管理ツール→ディスク アドミニストレータを選択します。

2. 各 Disk Administrator メッセージボックスで、はいを選択します。

3. カーソルを水平バーに移動して論理ドライブを選択し、マウスを左クリックします。

4. Disk Administrator Partition → Create を選択します。

プロンプト ウィンドウが開き、論理ドライブ全体のデフォルト容量を持つパーティ
ションを作成するかどうか尋ねられます。

5. 論理ドライブ上に複数のパーティションを作成する場合は、希望のパーティション
サイズを入力します。

全部の論理ドライブ容量が使用されるまで、このステップを繰り返します。

6. Disk Administrator Partition → Commit Changes Now を選択します。

この機能を使用すると、Windows NT オペレーティング システムをリブートせずに、
論理ドライブをフォーマットして使用できます。

7. 新規作成したドライブ パーティションを選択します。

8. Disk Administrator Tools → Format を選択します。NTFS（NT ファイル システム）
形式を選択します。

ステップ 7 と 8 を繰り返して、論理ドライブ上に作成した各パーティションをフォー
マットします。

9. フォーマットが完了したら、ディスク アドミニストレータを終了します。
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▼ Windows 2000 オペレーティング システムでサー
バにパーティションを作成するには

以下の手順は一般的なガイドラインです。詳細手順は、Windows 2000 の説明書を参
照してください。

1. 設定→コントロール パネル→管理ツール→コンピュータの管理→ディスクの管理を
選択します。

ディスクの管理の下にディスク アイコン  が付いた新しいドライブが表示されてい
ることを確認します。

2. 署名するディスクを右クリックして、Write Signature を選択します。

3. パーティションを作成するディスクを選択して、OK をクリックします。

4. （ドライブの容量が表示されている）ドライブを右クリックして、Create Partition を選
択します。

5. パーティション ウィザード プロンプトに対して適切に応答します。

署名するディスクを

右クリックします。

パーティションを作成する
ドライブを右クリックします。
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次に行うタスク

これで、Sun StorEdge Configuration Service（コンソールとエージェント）のイン
ストールとセットアップが完了し、使用できるようになりました。次に行うタスクに
ついては、以下の各章を参照してください。

■ 97 ページの「アレイの監視」は、 Sun StorEdge Configuration Service を使用し
てストレージ デバイスを監視する方法を説明しています。

■ 133 ページの「アレイの保守」は、アレイの保守方法を説明しています。パリティ
チェック、パリティ チェックのスケジュール、故障ドライブの再構築、バック
アップ ファイルからの構成の復元についての詳細が含まれています。

■ 147 ページの「構成の更新」は、ストレージ アレイの構成の更新方法を説明して
います。コントローラ機能の変更、スタンバイ ドライブの作成と変更、使用可能
なサーバーの情報の編集方法も含まれています。
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第 7 章

フル構成

アレイの論理ドライブは、Sun にて事前構成されて発送されます。この章は、アレイ
がまだ構成されていない場合、または、既存の構成を完全に削除して構成し直す場合
にのみお読みください。既存の構成を一部変更する場合は、147 ページの「構成の更
新」を参照してください。

フル構成に関するトピックは、次のとおりです。

■ 66 ページの「論理ドライブと論理ボリュームの構成」

■ 66 ページの「標準構成を使って論理ドライブを構成するには」

■ 69 ページの「カスタム構成を使って論理ドライブと論理ボリュームを構成する
には」

■ 79 ページの「論理ボリュームを作成してパーティションに分割するには」

■ 81 ページの「構成をクリアするには」

■ 82 ページの「構成レベルからログアウトするには」

■ 82 ページの「ホスト LUN の割り当て」

■ 82 ページの「ホスト LUN を追加（マップ）するには」

■ 84 ページの「ホスト LUN を削除（マップ解除）するには」

■ 84 ページの「構成ファイル」

■ 85 ページの「構成をバックアップ ファイルに保存するには」

Sun StorEdge 3310 SCSI アレイでクラスタ構成をセットアップする場合は、213 ペー
ジの「クラスタ構成の使用（SCSI のみ）」を参照してください。

Configuration メニューのコマンドとツールバーのアイコンは、パリティ チェックな
どのアレイ管理プロセスが実行中の場合に一時的に無効になる場合があります。メ
ニュー コマンドは、コンソールがサーバ上でインベントリをリフレッシュしている
間も使用不可になります。リフレッシュ プロセスの間はサーバー アイコンに衛星
ディッシュ記号が付いて表示されます。
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注意 – アレイの構成を始める前に、既存のすべてのデータを外部デバイスにバック
アップしてください。再構成により、既存の論理ドライブ構成がすべて上書きされま
す。既存の論理ドライブ構成を上書きすると、事実上すべてのデータが消去されます。

論理ドライブと論理ボリュームの構成
RAID レベルを使用するかどうかにより、標準構成またはカスタム構成を使用して論
理ドライブを構成できます。論理ボリュームの構成は、カスタム構成でのみ使用でき
ます。

注 – Sun StorEdge 3310 SCSI アレイでは、1 論理ドライブあたり 大 32 パーティ
ションを含む論理ドライブを 大 8 つ作成できます。LUN は 大 128 まで割り当て
可能です。1 つの論理ボリュームは、 大 32 個 のパーティションに分割できます。
Sun StorEdge 3510 FC アレイでは、1 論理ドライブあたり 大 128 パーティションを
含む論理ドライブを 大 8 つ作成できます。LUN の割り当ては 大 1024 です（各ホ
スト ID への LUN の割り当ては 大 32 です）。1 つの論理ボリュームは、 大 128
個 のパーティションに分割できます。

▼ 標準構成を使って論理ドライブを構成するには

Standard Configuration Options では、アレイ コントローラに接続されたすべてのス
トレージを 1 つの RAID レベルで簡単に接続できます。必要な操作は、RAID コント
ローラ、 適化モード、および RAID レベルを指定することだけです。スタンバイ
ドライブが必要かどうかも指定します。Sun StorEdge Configuration Service により
ストレージが自動的に構成され、指定した RAID レベルと使用可能なドライブの台数
に応じて 1 つまたは複数の論理ドライブが作成されます。ライトバック キャッシュ
はデフォルトで自動的に選択されます。構成結果が表示され、完了する前に構成を承
認または拒否することができます。

注意 – 標準構成を使用する前に、既存のすべてのデータを外部デバイスにバックアッ
プしてください。標準構成により、既存の論理ドライブ構成がすべて上書きされます。
既存の論理ドライブ構成を上書きすると、事実上すべてのデータが消去されます。

1. ssconfig ユーザとしてログインします。

2. メイン ウィンドウで、目的の RAID コントローラを選択します。
66 Sun StorEdge 3000 Family Configuration Service 1.3 ユーザ ガイド • 2003 年 6 月



3. 論理ドライブの最適化モードとして Sequential I/O （デフォルト）または Random
I/O のいずれかを選択します。1 つの最適化モードを RAID アレイを構成するすべて
の論理ドライブに適用しなければなりません。選択した最適化モードによって、アレ
イを構成する最大ディスク数も決まります。

適化は Change Controller Parameters ウィンドウの Cache タブで設定します。
Sequential I/O と Random I/O の詳細および 適化の設定手順については、174 ペー
ジの「Cache タブ」を参照してください。

4. Configuration → Standard Configure を選択します。

Standard Configuration Warning メッセージが表示されます。OK をクリックして、
続行します。

Standard Configuration Options ウィンドウが表示されます。ここで ssconfig とし
てログインしていない場合は、ログイン ダイアログが表示されます。
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ウィンドウに表示されるオプションの中には、使用可能なドライブの台数、および
Windows NT オペレーティング システムと Solaris 動作環境のどちらのシステムを使
用しているかによって、無効になっているものがあります。

NT Cluster オプションでは、定足の RAID 5 論理ドライブ（100 メガバイト）が作成
された後、残り容量が 2 つの大容量の RAID 5 論理ドライブに割り当てられます。こ
のオプションの場合、3 台以上の物理ドライブが必要です。

5. ウィンドウ上部に表示されるサーバとコントローラ ID が正しいかどうか確認します。

ウィンドウ上部に表示されたサーバとコントローラが正しくない場合は、Cancel を
クリックして、構成ウィンドウを終了し、メイン ウィンドウに戻ります。必要なデ
バイスを選択し、このウィンドウを再度選択します。

6. ドライブの 1 つをスタンバイ ドライブとして使用するかどうか指定します。

Use a standby drive を選択すると、スタンバイ ドライブを使用しない RAID レベル
が非アクティブになります。（たとえば、RAID 0 はフォールト トレランスがないた
め、スタンバイ ドライブを使用しても効果がありません。）

7. 使用可能になった RAID レベルから、構成している論理ドライブに適切な RAID レベ
ルを選択します。

RAID レベル定義については、189 ページの「RAID の基本」を参照してください。

RAID 3 または RAID 5 を選択すると、標準構成では通常、大容量の論理ドライブが
1 つ作成されます。ただし、アレイに 31 を超える物理ドライブが含まれる場合、論
理ドライブは複数作成されます。また、RAID 3 または RAID 5 を使用するには、少
なくともドライブが 3 つ必要です。

RAID 1 を選択する場合、それぞれの論理ドライブには 低 2 つの物理ドライブが必
要です。4 つ以上のドライブを選択する場合、RAID 1+0 レベルの論理ドライブが作
成されます。

36 以上のドライブが含まれるアレイで RAID 0 を選択すると、論理ドライブは複数
作成されます。

8. （Solaris OE のみ）新しい論理ドライブを自動的にラベル付けして動作環境でその
ドライブを使用できるようにするには、Write a new label to the new LD をクリック
します。

9. RAID レベルを選択して、OK をクリックします。

Confirm Configuration Operation ウィンドウが開き、新しい構成が表示されます。
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10. 表示された構成を受け入れる場合は、OK をクリックします。受け入れない場合は、
Cancel をクリックしてコンソールに戻ります。

▼ カスタム構成を使って論理ドライブと論理ボ
リュームを構成するには

カスタム構成では、さまざまな RAID レベルおよびその他の RAID パラメータで論理
ドライブを構成または再構成するための複数のオプションが提供されます。また、新
しく作成した論理ドライブを論理ボリュームに追加するオプションも提供されます。

1. ssconfig ユーザとしてログインします。

2. メイン ウィンドウで、目的の RAID コントローラを選択します。

3. Configuration → Custom Configure を選択します。

Custom Configuration Options ウィンドウが表示されます。
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■ New Configuration - さまざまな RAID レベルおよび他の RAID パラメータを使用
して、新しい論理ドライブを構成し、論理ボリュームに追加できます。New
Configuration コマンドは、アレイ コントローラ上の以前の構成を消去します。

■ Add LDs/LVs to the Current Configuration - 既存の構成に新しい論理ドライブま
たは論理ボリュームを追加します。このコマンドは、コントローラ上のほかの構
成済み論理ドライブを消去しません。

■ Dynamically Grow and/or Reconfigure LDs/LVs - 論理ドライブおよび論理ボ
リュームの容量を拡張したり、既存の論理ドライブおよび論理ボリュームに SCSI
ドライブを追加したり、すべてのメンバ ドライブをより大きい容量のドライブに
コピーして交換したりできます。

■ Make or Change Standby Drives - アレイ コントローラに関連付ける新しいスタン
バイ ドライブを 1 つまたは複数追加できます。

■ Change Host LUN Assignments - 既存の論理ドライブ、論理ボリューム、および
パーティションをホスト チャネルに割り当てることができます。

■ Change Controller Parameters - コントローラ パラメータを変更できます。
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■ Manage Existing LDs/LVs and Partitions - 個々の論理ドライブまたは論理ボ
リュームを削除したり、既存の論理ドライブおよび論理ボリュームでパーティ
ションを作成または削除したりできます。

■ Configure Web Server（Sun StorEdge Enterprise Storage Manager Topology
Reporter ソフトウェアが必要） - Web ブラウザを通してアレイを管理、監視でき
るように Web サーバを構成できます。

この章では、New Configuration オプションについて詳しく説明します。Configure
Web Server については、130 ページの「Web によるストレージの管理」で説明して
います。その他のオプションについては、 147 ページの「構成の更新」で説明してい
ます。

New Configuration オプション

New Configuration オプションを使い、論理ドライブの構成を使用環境のニーズに合
わせてカスタマイズできます。さまざまな RAID レベルで、1 つまたは複数の論理ド
ライブのパーティションを作成できます。その後、（パーティションが作成されてい
ない）1 つの論理ボリュームに 2 つ以上の論理ドライブを追加して、SCSI では 大
32 まで、ファイバ チャネルでは 大 128 までパーティションを作成できます。

注 – Solaris 動作環境のシステムでコンソールが使用中にロックした場合は、そのプ
ロセス番号を取得して、39 ページの「コンソールが使用中にロックした場合」で説
明するように、ウィンドウをいったん閉じてから再度開くことができます。

New Configuration を使用する前に

初めて New Configuration を使用して論理ドライブまたは論理ボリュームを作成す
る前に、次のステップをよく理解しておいてください。この情報をあらかじめ知って
いると、論理ドライブまたは論理ボリュームを容易に作成できます。

1. 論理ドライブの最適化モードとして Sequential I/O （デフォルト）または Random
I/O のいずれかを選択します。1 つの最適化モードを RAID アレイを構成するすべて
の論理ドライブに適用しなければなりません。選択した最適化モードによって、アレ
イを構成する最大ディスク数も決まります。

適化は Change Controller Parameters ウィンドウの Cache タブで設定します。
Sequential I/O と Random I/O の詳細および 適化の設定手順については、174 ペー
ジの「Cache タブ」を参照してください。
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2. 論理ドライブ内に含める物理ディスクの合計台数を決定します。この数は選択した最
適化モードによって異なります。

データのセキュリティが重要である場合は、残りのディスクをスタンバイ ドライブにし
ます。

ランダム 適化およびシーケンシャル 適化の論理ドライブごとの 大ディスク数と
大使用可能容量については、175 ページの「ランダム 適化およびシーケンシャル
適化で使用可能な 大ディスク数と 大ディスク容量」を参照してください。

注 – 論理ドライブのサイズが 253 ギガバイトを超える場合は、73 ページの「253 ギ
ガバイトより大きい論理ドライブを準備するには」を参照してください。

3. スタンバイ（スペア）ドライブをローカルにするか、グローバルにするかを決定します。

スタンバイ ドライブとは、論理ドライブに関連付けられた物理ドライブが故障した
場合に自動データ再構築をサポートするスペアとして指定されているドライブです。
別のドライブと交換するスタンバイ ドライブは、少なくとも故障したドライブと同
じサイズでなくてはなりません。また、故障したドライブは RAID 1、3、または 5
である必要があります。

ローカル スペア ドライブは、1 つの指定論理ドライブに割り当てられるスタンバイ
ドライブです。この指定論理ドライブのメンバー ドライブが故障すると、ローカル
スペア ドライブは自動的にメンバー ドライブとなりデータの再構築を始めます。

グローバル スペア ドライブは、指定した 1 つの論理ドライブだけのスタンバイとし
て働くのではありません。任意の論理ドライブのメンバ ドライブが故障すると、グ
ローバル スペア ドライブはその論理ドライブのメンバとなり、自動的にデータの再
構築を始めます。

4. RAID レベルを選択します。その RAID レベルで作成できる最大サイズの論理ドライ
ブが自動的に計算されます。

5. 論理ドライブのパーティションを分割するかどうか決定します。

パーティションとは、論理ドライブ（または論理ボリューム）を論理的に分割したも
のです。パーティションにより、ファイル管理、複数のユーザ、その他の目的に、そ
れぞれ別個の論理ドライブ（または論理ボリューム）が存在しているかのような外観
を与えます。

注 – パーティションは、初期構成時、または論理ドライブの作成後に分割できます。

注 – 論理ドライブのパーティションを作成したあとは、論理ボリュームに追加でき
ません。

6. New Configuration ウィンドウに表示されるディスク容量について理解します。
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■ Max Drive Size (MB) - 選択した物理ディスク（各ディスクの合計容量）あたりの
大サイズが表示されます。

この値を小さくすれば、より小さい論理ドライブを作成できます。残り容量は、
後にドライブを拡張した場合に使用できます（158 ページの「論理ドライブまたは
論理ボリュームの容量を拡張する」の説明を参照）。

■ Available Size (MB) - 論理ドライブまたは論理ボリュームの合計サイズである全
ディスクの合計容量が表示されます。

注 – 論理ドライブの 大使用可能容量は、 小の物理ディスク サイズに等しくなり
ます。たとえば、18 ギガバイトのディスクを追加した後に 70 ギガバイトのディスク
を論理ドライブの一部として追加した場合、 大使用可能容量はドライブあたり 18
ギガバイトです。

7. 論理ドライブを論理ボリュームの一部にするかどうか決定します。

注 – 論理ドライブのパーティションを作成したあとは、論理ボリュームに追加でき
ません。

8. 論理ボリュームのパーティションを分割するかどうか決定します。

注 – パーティションは、初期構成時に、または論理ボリュームの作成後に分割でき
ます。

9. バックグラウンド レートを決定します。バックグラウンド レートとは、アレイ管理
活動（故障ドライブの再構築、パリティ チェック、初期化など）に割り当てられ
た、使用可能なアレイ コントローラ CPU 時間のパーセンテージです。

バックグラウンド レートが 100% に設定されている場合、アレイ管理活動がほかの
システム活動よりも優先されます。0% の場合は、アレイ コントローラにほかの活動
がないときにのみアレイ管理活動が実行されます。

▼ 253 ギガバイトより大きい論理ドライブを準備するには

Solaris 動作環境では、newfs を含むさまざまな操作のために、ディスク ジオメトリ
が必要です。253 ギガバイトより大きい論理ドライブに適切なドライブ ジオメトリを
Solaris 動作環境で実現するには、ファームウェア アプリケーションを使用して、ホ
スト シリンダ / ヘッド / セクタのマッピング構成を構成する必要があります。
ファームウェア アプリケーションにアクセスする方法は、使用しているアレイ用の
『Sun StorEdge 3000 Family RAID ファームウェア ユーザ ガイド』を参照してくだ
さい。

1. ファームウェア アプリケーションのメイン メニューで、view and edit Configuration
parameters を選択します。
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2. Host-Side SCSI Parameters を選択します。

3. Host Cylinder/Head/Sector Mapping Configuration を選択します。

4. Sector Ranges を選択して、255 を指定します。

5. Head Ranges を選択して、64 を指定します。

6. Cylinder Ranges を選択して、<65536 を指定します。

▼ New Configuration を使用して論理ドライブを作成しパー
ティションを分割するには

初めて New Configuration を使用して論理ドライブを作成し、パーティションを分
割する前に、71 ページの「New Configuration を使用する前に」の手順を見直して
ください。

以下のステップは、新しい論理ドライブに新しい構成を適用する例です。3 つの論理
ドライブを選択し、RAID 5 論理ドライブとして構成します。小さい論理ドライブが
作成され、パーティションに分けられます。

注意 – New Configuration コマンドを使用する前に、既存のすべてのデータを外部
デバイスにバックアップしてください。Sun StorEdge Configuration Service は、ア
レイ コントローラに定義された論理ドライブを自動的に初期化します。

1. ssconfig ユーザとしてログインします。

2. メイン ウィンドウで、目的の RAID コントローラを選択します。

3. Configuration → Custom Configure を選択します。

4. New Configuration をクリックします。

New Configuration Warning メッセージボックスが表示されます。

5. OK をクリックします。
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6. ウィンドウ上部に表示されるサーバとコントローラが正しいかどうか確認します。

表示されたサーバとコントローラが正しくない場合は、Cancel をクリックして、New
Configuration ウィンドウを終了し、メイン ウィンドウに戻ります。適切なディスク コ
ントローラを選択し、New Configuration を再度選択します。

7. 必要であれば、コントローラの Background Rate を選択します。

8. Select disks for Logical Drive リストボックスで、最初のディスクを選択し、Add Disk を
クリックします。

さらに 2 つディスクを選択し、3 つのディスクが下のリストボックスに表示されるよ
うにします。

選択を間違えた場合や変更したい場合は、ドライブのリストからそのドライブを選択
し、Remove Disk をクリックします。

注 – 論理ドライブはまだパーティションが分割されていないため、Part Size (MB) と
Available Size (MB) は同じです。単一の論理ドライブが、単一のパーティションと見
なされています。
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9. RAID レベルを選択します。この例では、RAID Level 5 を選択します。

これは、この論理ドライブ内の全部のディスクに適用されます。

この例では、新しい論理ドライブは 3 つの物理ディスクから構成され、合計サイズは
Available Size (MB) フィールドに示されるように 103428 メガバイトです。

2U アレイの場合、各 RAID レベルの論理ドライブあたりディスク 大台数は次のと
おりです。

■ RAID 0 - 36
■ RAID 1 - 2
■ RAID 1+ 0 - 36
■ RAID 3 または 5 - 31

RAID 1 では、ドライブを 4 つ以上選択すると、RAID 1+0 レベルの論理ドライブが
作成されます。

10. Max Drive Size を設定します。

Max Drive Size には、各ディスクの合計容量が表示されます。この値を小さくすれ
ば、より小さい論理ドライブを作成できます。

Max Drive Size - 
各ディスクの合計容量
を表示します。

Available Size - 
全ディスクの合計容量
（論理ドライブの合計
サイズ）を表示します。
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注 – Max Drive Size は変更せずに Partition Size を変更した場合、指定されたパー
ティション サイズで新しいパーティションが作成されます。論理ドライブ サイズの
残り容量は 後のパーティションに移動されます。残り容量は、後にドライブを拡張
した場合に使用できます（158 ページの「論理ドライブまたは論理ボリュームの容量
を拡張する」の説明を参照）。パーティションが作成された後はドライブ容量を編集
することはできません。

11. Channel リストボックスと SCSI ID リストボックスから、新しい論理ドライブをマップ
する先のホスト チャネルと SCSI ID を選択します。

注 – この時点で論理ドライブをマップしたくない場合は、Channel リストボックス
から Do Not Map を選択します。

注 – Sun StorEdge 3310 SCSI アレイでは、1 論理ドライブあたり 大 32 パーティ
ションを含む論理ドライブを 大 8 つ作成できます。LUN は 大 128 まで割り当て
可能です。1 つの論理ボリュームは、 大 32 個 のパーティションに分割できます。
Sun StorEdge 3510 FC アレイでは、1 論理ドライブあたり 大 128 パーティションを
含む論理ドライブを 大 8 つ作成できます。LUN は 大 1024 まで割り当て可能です
（各ホスト ID へは 大 32 まで LUN を割り当て可能）です。1 つの論理ボリューム
は、 大 128 個 のパーティションに分割できます。

12. 次に何をするかによってこのステップは異なります。

■ 別の論理ドライブを作成するには、New LD をクリックしてステップ 1 ～ 11 を繰
り返してください。

■ この論理ドライブを論理ボリュームに追加するには、Add to LV をクリックして、
79 ページの「論理ボリュームを作成してパーティションに分割するには」を参照
してください。

■ 論理ドライブにパーティションを作成するには、次のステップを行います。この
例では、小さい論理ドライブが作成され、パーティションに分割されます。

13. 小さい論理ドライブを作成するには、Max Drive Size フィールドに 2000 を入力します。

注 – 論理ドライブのサイズには、6000 メガバイトではなく、4000 メガバイトが表示
されます。これは、このドライブが RAID 5 レベルであるため、1 ドライブ分の容量
（2000 メガバイト）がパリティ用に割り当てられるからです。
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14. パーティションを作成するため、Part Size フィールドに 1000 を入力し、Add Partition
をクリックします。

注 – 論理ドライブを論理ボリュームに追加する予定がある場合、論理ドライブを
パーティションに分けないでください。論理ドライブのパーティションを分割する
と、論理ボリュームに追加できません。

同じサイズのパーティションを複数作成するには、作成するパーティションの数だけ
Add Partition をクリックします。Part Size フィールドにパーティションのサイズを
入力し、100*128 のように、作成するパーティションの数を掛けてサイズを指定する
こともできます。この指定サイズの残りの容量は、 後のパーティションに追加され
ます。

パーティションを追加するたび、Available Size (MB) に表示される残りの容量は、追
加したパーティションのサイズ分減少します。

次の例に示すように、元の 4000 メガバイトのうち 1000 メガバイトが Partition 0 に
割り当てられた場合、残りの 3000 メガバイトは自動的に Partition 1 に移動されま
す。残りの使用可能容量は、Available Size (MB) に表示されます。
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15. （Solaris OE のみ）新しい論理ドライブを自動的にラベル付けして動作環境でその
ドライブを使用できるようにするには、Write a new label to the new LD をクリック
します。

16. Commit をクリックして論理ドライブの構成を終了するかまたは、New LD をクリッ
クして別の論理ドライブを構成します。

New LD をクリックすると、未使用のディスクがすべて表示されます。

このアレイの論理ドライブの構成が完了したのち、Commit をクリックして、OK を
クリックします。完成した構成が表示されます。

注 – OK をクリックしたあとで論理ドライブの構成を変更することはできません。

注 – 初期化中には、LD と LV のサイズは 0 メガバイトと表示されます。
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▼ 論理ボリュームを作成してパーティションに分割
するには 
1 つの論理ボリュームは 2 つ以上の論理ドライブから構成され、SCSI では 32 まで、
ファイバ チャネルでは 128 まで、パーティションに分割できます。動作時にホスト
は、パーティションで分割されていない論理ボリューム 1 つ、または論理ボリューム
のパーティション 1 つを単一の物理ドライブとして認識します。

1. 74 ページの「New Configuration を使用して論理ドライブを作成しパーティションを
分割するには」のステップ 1 ～ 11 の説明のとおり、論理ドライブを作成します。

注 –論理ボリュームに追加する論理ドライブのパーティションを分けないでください。
パーティションが分けられた論理ドライブは、論理ボリュームに追加できません。

2. Commit をクリックする前に、論理ドライブを論理ボリュームに追加するには、Add
to LV をクリックします。

論理ドライブが、LV Definition ボックスに追加されます。論理ボリュームの合計サ
イズが、Available Size (MB) フィールドに表示されます。

注 – 論理ボリュームはまだパーティションが分割されていないため、Part Size (MB)
と Available Size (MB) は同じです。単一の論理ボリュームが、単一のパーティショ
ンと見なされます。
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3. 論理ボリュームに追加する別の論理ドライブを作成するには、New LD をクリックし
ます。

4. 論理ドライブを作成し、Add to LV をクリックしてその論理ドライブを論理ボリュー
ムに追加します。

論理ボリュームに追加するすべての論理ドライブについて、このステップを繰り返し
ます。

5. パーティションを作成するには、Part Size フィールドにパーティションのサイズを
入力して Add Partition をクリックします。

同じサイズのパーティションを複数作成するには、作成するパーティションの数だけ
Add Partition をクリックします。Part Size フィールドにパーティションのサイズを
入力し、100*128 のように、作成するパーティションの数を掛けてサイズを指定する
こともできます。

パーティションを追加するたび、Available Size (MB) に表示される残りの容量は、追
加したパーティションのサイズ分減少します。

6. 論理ドライブを論理ボリュームに追加したあと、別の論理ボリュームや単独の論理ド
ライブを作成するには、Commit LV をクリックします。

論理ボリュームの作成が終了し、単独の論理ドライブを作成しない場合、Commit を
クリックします。

論理ドライブは

論理ボリュームに追加
されるので、LV Definition 
に表示されます。

Available Size –
全ディスクの合計容量

（論理ドライブの合計
サイズ）を表示します。
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注 – 論理ボリュームを作成し終わり、New Configuration ウィンドウを終了すると
きに、Commit ではなく誤って Commit LV をクリックすると、さらに別の論理ドラ
イブを作成しなければならなくなります。作成しない場合は、Cancel をクリックし
て論理ドライブを再度構成しなければなりません。

既存の構成に論理ボリュームを追加または削除する方法、または既存の構成で論理ボ
リュームのパーティションを分割する方法は、147 ページの「構成の更新」を参照し
てください。

▼ 構成をクリアするには

New Configuration ウィンドウでの構成プロセス中に構成が気に入らない場合は、そ
れをクリアすることができます。

1. Clear をクリックすると、すべての物理ドライブと論理ドライブが表示から消えます。

2. New LD をクリックして新しい論理ドライブを定義するか、Commit をクリックします。

3. Commit をクリックすると、警告プロンプトが表示されます。OK をクリックします。

Sun StorEdge Configuration Service は、選択されたアレイ コントローラの全構成を
初期化します。

注 – ホスト LUN は、論理ドライブの初期化が完了した後で自動的にマップされます。

▼ 構成レベルからログアウトするには

構成操作が終了したら、ログアウトしてプログラムの監視レベルに戻ります。

1. File → Logout を選択します。

2. Logout to monitoring mode を選択し、OK をクリックします。
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ホスト LUN の割り当て
サーバが論理ドライブまたは論理ボリュームを認識するには、まずホスト チャネル / ID
にマップされなければなりません。論理ドライブまたは論理ボリュームがホスト
チャネル / ID にマップされると、LUN になります。次のセクションでは、論理ドラ
イブまたは論理ボリュームをホスト チャネルにマップする方法および削除する方法
を説明します。

注 – 論理ドライブまたは論理ボリュームを 初に作成する場合、Do Not Map が選
択されていない限り、論理ドライブまたは論理ボリュームの初期化が完了したあとで
ホスト LUN は自動的にマップされます。

注 – Sun StorEdge 3310 SCSI アレイでは、1 論理ドライブあたり 大 32 パーティ
ションを含む論理ドライブを 大 8 つ作成できます。LUN は 大 128 まで割り当て
可能です。1 つの論理ボリュームは、 大 32 個 のパーティションに分割できます。
Sun StorEdge 3510 FC アレイでは、1 論理ドライブあたり 大 128 パーティションを
含む論理ドライブを 大 8 つ作成できます。LUN は 大 1024 まで割り当て可能です
（各ホスト ID へは 大 32 まで LUN を割り当て可能）です。1 つの論理ボリューム
は、 大 128 個 のパーティションに分割できます。

▼ ホスト LUN を追加（マップ）するには

1. Configuration → Custom Configure を選択します。

2. Custom Configuration Options メニューから、Change Host LUN Assignments を選
択します。
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Change Host LUN Assignments ウィンドウが表示されます。

3. Select Host Channel and SCSI ID リストボックスを使い、LUN を割り当てるチャネ
ルと ID を選択します。

使用可能な LUN がすべて Partitions の下に表示されます。参考のために、指定した
チャネルに使用される LUN のリストは Used LUNs に表示され、パーティションが
割り当てられたチャンネル、ID、および LUN のリストは Partition Assignment に表
示されます。

注 – 論理ドライブまたは論理ボリュームが追加または作成されると、プライマリ コン
トローラまたはセカンダリ コントローラとして割り当てられます（コントローラの割り
当て）。その後、論理ドライブまたは論理ボリュームは初期化され、プライマリまたは
セカンダリ チャネル ID にマップされます。論理ドライブまたは論理ボリュームをマッ
プ解除し、異なるコントローラが割り当てられている別のホスト チャネル ID に再度
マップする場合、コントローラはリセットする必要があります。論理ドライブまたは論
理ボリュームをマップ解除し、同じコントローラが割り当てられている別のホスト チャ
ネル ID に再度マップする場合、コントローラをリセットする必要はありません。論理
ドライブまたは論理ボリュームにマップされているパーティションが残っている場合、
マップ解除されているパーティションのみを、同じコントローラが割り当てられている
ホスト チャネル ID にマップできます。
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4. 必要なパーティションを LDs/LVs フィールドから選択し、Assign Host LUN をク
リックして変更を適用します。

複数のパーティション（ 大 32 まで）をマップするには、 後のパーティションま
でスクロールし、Shift キーを押しながら間にある項目をすべて選択します。Assign
Host LUN をクリックします。

Delete Host LUN がアクティブになります。

5. 終了したら、OK をクリックして変更を保存し、メイン メニューへ戻ります。

注 – ホスト チャネルのマップ中にエラー メッセージが表示された場合は、ステップ
1 ～ 5 を繰り返してください。

▼ ホスト LUN を削除（マップ解除）するには

1. Change Host LUN Assignments ウィンドウが表示された状態で、削除する LUN を
Host LUN Assignments フィールドから選択します。

2. Delete Host LUN をクリックします。

3. 終了したら、OK をクリックして変更を保存し、メイン メニューへ戻ります。

構成ファイル
現在の構成のバックアップ コピーを、ディスケットやアレイ以外のほかの外部メディ
アに保存してください。構成情報がアレイ コントローラと、それに接続された物理ドラ
イブに保存されていても、火災や洪水などの災害が発生した場合にコントローラとド
ライブの両方が破壊されることがあります。構成のバックアップ コピーを使用すれば、
ストレージ アレイを完全に再構成する必要なく、新しいコントローラに構成を復元でき
ます。

以下の場合には、アレイ コントローラの構成を必ずファイルに保存してください。

■ 新しいストレージ システム格納装置をインストールする、または既存の格納装置
内のコントローラの SCSI ID を変更する場合

■ アレイ コントローラを交換する場合

■ 論理ドライブを再構成する、またはアレイ コントローラに追加する場合

■ 故障ドライブからスタンバイ ドライブにデータを再構築する場合
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▼ 構成をバックアップ ファイルに保存するには

1. 保存したい構成を持つコントローラを選択します。

2. Configuration → Save Configuration を選択します。

Save Configuration  ウィンドウが表示されます。

3. 必要であれば、構成ファイルを保存する先のドライブとフォルダへナビゲートします。

構成ファイルをディスケットまたはアレイ外部のドライブに保存します。

4. 構成ファイルの名前を指定し、Save をクリックします。

Save Configuration  ウィンドウが表示されます。

5. 保存する構成の説明を入力します。

6. OK をクリックします。

構成情報は .cfg ファイルに保存されます。
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構成のロード

ドライブまたはコントローラが損傷したため交換する必要が生じた場合は、140 ペー
ジの「論理ドライブの構成を復元する」を参照してください。構成ファイルをロード
し、論理ドライブの構成を復元する方法が説明されています。
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第 8 章

LUN フィルタリング（ファイバ 
チャネルのみ） 

この章では、Sun StorEdge 3510 ファイバ チャネル アレイ用の LUN フィルタを作成
して、同じストレージを共有する大規模なファイバ チャネル ネットワークを維持す
る方法を説明します。この章には以下の項目が含まれます。

■ 87 ページの「概要」
■ 89 ページの「LUN フィルタの割り当て」

■ 89 ページの「LUN Filter View にアクセスする」
■ 90 ページの「HBA デバイスを手動で追加するには」
■ 92 ページの「標準ホスト マッピングを削除するには」
■ 93 ページの「論理ドライブをホストにマップするには」
■ 96 ページの「LUN フィルタを削除するには」

概要
ストレージ インフラを効果的に維持するには、データが常時どの程度アクセス可能で
安全であるかが重要な要素となります。Sun StorEdge Configuration Service では、
LUN フィルタリング サポートを使用して、安全で一元化されたストレージへのアク
セスを管理します。

LUN フィルタリングは、同じアレイに接続されている複数のサーバに、1 台のサー
バから 1 つの論理ドライブへの専用パスを提供します。同じ論理ドライブに接続して
いるほかのサーバには、その論理ドライブは隠されているか、認識またはアクセスで
きません。つまり、LUN フィルタは、アレイ デバイスがホスト デバイスによってア
クセスおよび認識される方法を管理します。通常、1 つのアレイ デバイスを 1 台のホ
スト デバイスのみにマップして、ほかのホストが同じアレイ デバイスにアクセスし
て使用できないようにします。また、LUN フィルタリングを使用すると、複数の論理
ドライブまたはパーティションを同じ LUN 番号にマップできるので、必要な場合、
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異なるサーバが固有の LUN 0 を持ってブートできるようになります。LUN フィルタ
リングはまた、各 HBA が通常ハブを通じて 2 倍の数の論理ドライブを認識してしま
うのを、マッピングで明確にする貴重な役割を果たします。

各ファイバ チャネル デバイスには、ワールドワイド ネーム（WWN）と呼ばれる一
意の識別子が割り当てられます。WWN は IEEE によって割り当てられるもので、IP
の MAC アドレス、またはインターネット上の URL に類似しています。これらの
WWN は、デバイスの存続期間中使われます。LUN フィルタリングではこの WWN
を使って、特定の論理ドライブが排他的に使用するサーバを指定します。各論理ドラ
イブを WWN で識別される 1 台のホストのファイバ チャネルの HBA カードにマッ
プするには、簡単なドラッグ アンド ドロップ方式が使用されます。

次の例で示すように、LUN 01 をホスト チャネル 0 にマップして WWN1 を選択する
と、サーバ A はその論理ドライブへの専用パスを持つことになります。サーバに対
するフィルタを作成しない限り、すべてのサーバは LUN 02 と LUN 03 を認識し、こ
れらにアクセスし続けます。

図 8-1 LUN フィルタリングの例

LUN フィルタリングの利点は、LUN セキュリティを維持しながら、Windows NT
などの多くのホストを共通のファイバ チャネル ポートを通じてアレイに接続できる
ことです。

02 03

WWN
(1) 210000E08B021D15

(2) 210000E08B02DE2F

(3) 210000E08B22DE2F

LUN ID LUN ID LUN ID
01 XX XX

XX 02 XX

XX XX 03

WWN1 WWN2 WWN3

A: B C

01
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LUN フィルタの割り当て
LUN フィルタを割り当てるには、以下の手順を実行する必要があります。

■ LUN フィルタ ウィンドウにアクセスする

■ HBA デバイスを手動で追加する（必要な HBA が認識できない場合）

■ 標準のマッピングを削除する

■ 論理ドライブをホストにマップする

▼ LUN Filter View にアクセスする

1. Filter View タブをクリックし、LUN Filter View にアクセスします。

2. コンテナ記号  をクリックすると、デバイス ツリーが展開され、左側にサーバの
詳細、右側にアレイ デバイスの詳細が表示されます。
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▼ HBA デバイスを手動で追加するには

表示されるホストの下に目的の HBA がない場合、Configure Host/WWN ウィンド
ウから手動でこれを追加します。

1. Configuration → Configure Host/WWN を選択します。

2. Available Hosts リストから、追加する HBA デバイスを持つホストを選択し、Edit を
クリックします。

ホストが Connected Hosts リスト内に表示されている場合は、そのホストを選択し
て Remove をクリックし、Available Hosts リストに移動します。

3. Add/Edit Host ボックスで、Add をクリックします。
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4. 次の Add/Edit HBA ボックスで、新しい Adapter Name と適切な WWN を入力し、
OK をクリックします。

WWN の決定の詳細は、219 ページの「ホストのワールドワイド ネームの決定
（ファイバ チャネルのみ）」を参照してください。

5. 編集したホストを Configure Host/WWN ウィンドウで選択して、Add をクリック
し、編集したホストを Connected Hosts リストに移動して OK をクリックします。

LUN Filter 表示に戻ると、新しい HBA デバイスは灰色で表示され、LUN フィルタ
リングに使用できるようになっています。
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▼ 標準ホスト マッピングを削除するには

標準マッピングを使用すると、すべてのホストが標準マッピングされたすべての論理
ドライブを認識できるようになります。LUN フィルタリングによって、特定のホス
トへのマッピングが制限されます。LUN フィルタを割り当てる前に、標準ホスト マッ
ピング（M ラベル  で表示）をアレイから削除する必要があります。

1. All Hosts の各項目をクリックし、Storage Pools までドラッグ アンド ドロップしま
す。

2. OK をクリックすると次のメッセージが表示されます。

標準ホスト LUN マッピングの削除に成功したことを確認するメッセージが表示され
ます。

3. ホストがアレイのプライマリ エージェントでない場合に、デバイスをそのホストに
マップするには、そのデバイスを選択し、Configuration → Configure Host/WWN を
選択します。

4. Available Hosts リストから目的のホストを選択し、Add をクリックしてそのホスト
を Connected Hosts リストに追加します。

ホスト サーバが追加されたことを確認するメッセージが表示されます。

5. Close をクリックして構成情報を保存し、ウィンドウを終了します。

6. 複数のホストを 1 つのアレイにマップしたい場合には、Configuration → LUN Filter 
Properties を選択して、そのアレイをプルダウン メニューから選択します。

7. Hardware Filter チェックボックスと Map to Multiple Hosts チェックボックスを選択
し、OK をクリックします。

注 – Hardware Filter チェックボックスを選択解除すると、フィルタ マッピングは作
成できず、標準マップのみを作成できます。

Operation will delete all standard maps of Logical Drive X 
Partition X. Do you want to continue?
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▼ 論理ドライブをホストにマップするには

1. LUN Filter 表示をしていることを確認します。そうでない場合、Filter View タブをク
リックします。

2. Storage Pools から論理ドライブを選択し、Hosts の下にある適切な HBA カードまで
ドラッグ アンド ドロップします。

アレイに接続されている HBA カードが分からない場合、その論理ドライブをホスト
までドラッグ アンド ドロップします。

プログラムは、ホスト内の各 HBA カードのアレイをフィルタするように求めるプロ
ンプトを表示します。（これは、接続されている HBA カードにはそれが認識されて
おり、ほかの HBA カードについてはそれが表示されていないことを意味します。）
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3. マッピングの確認を求めるプロンプトが表示されたら、OK をクリックします。

Specify Map Information ウィンドウが表示されます。複数の HBA カードが存在す
る場合、プログラムは自動的に、ホストの先頭にある HBA カードに論理ドライブを
マップします。

4. 必要なチャネルと LUN ID 番号を使用して、論理ドライブをプライマリ コントロー
ラまたはセカンダリ コントローラに割り当てたら、OK をクリックします。

HBA カードをプライマリ コントローラまたはセカンダリ コントローラに割り当てる
のは、 初の LUN フィルタ割り当て時に選択され、その LUN フィルタ割り当てを
削除してやり直さない限り、変更できません。

LUN フィルタを 1 つのアレイの 2 台目のホストに適用するには、90 ページの「HBA
デバイスを手動で追加するには」のステップ 6 から93 ページの「論理ドライブをホ
ストにマップするには」のステップ 3 までを繰り返してください。

2 人のユーザが同時に同じ論理ドライブにアクセスすると、データの破損が発生する
可能性があることを知らせる警告プロンプトが表示されます。OK をクリックして、
2 台目のホストを追加します。

次の例では、Sun StorEdge 3510 ファイバ チャネル デバイスには、2 台の別のホスト
に対する LUN フィルタ（フィルタを表す文字 F に注意）機能があります。
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▼ LUN フィルタを削除するには

1. 関連付けられた WWN を選択します。

2. その WWN を Storage Pools までドラッグ アンド ドロップします。

3. マッピングを削除していいか確認を求めるプロンプトが表示されたら、OK をクリッ
クします。

4. 再確認を求める 2 つ目のプロンプトに対し、OK をクリックします。
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第 9 章

アレイの監視 

この章では、Sun StorEdge Configuration Service を使ってアレイを監視する方法を
説明します。メイン ウィンドウと、メイン ウィンドウからアイコンをダブルクリッ
クすると表示されるコンポーネント表示ウィンドウについて説明します。また、
Event Log の動作と報告機能の使用方法についても説明します。この章には以下のセ
クションが含まれます。

■ 97 ページの「メイン ウィンドウ」
■ 103 ページの「詳細デバイス情報の表示」
■ 118 ページの「Event Log」
■ 122 ページの「Save Report」
■ 125 ページの「View Report」
■ 125 ページの「アウトオブバンド ストレージ管理」
■ 130 ページの「Web によるストレージの管理」

メイン ウィンドウ
メイン ウィンドウからは、すべてのアレイ デバイスのステータスを一目で確認でき
ます。コンソールにより監視されるサーバに接続されたデバイスと論理ドライブのス
テータスが表示されます。デバイスには、アレイ コントローラ、ディスク ストレー
ジ格納装置、物理ディスク ドライブ、およびその他の SCSI デバイスが含まれます。

このウィンドウのツリー構造は、各サーバに接続されているすべてのデバイスの詳細
を提供します。ツリーの左側にある  または  のコンテナ記号は、そのデバイス
が展開表示であるか縮小表示であるかを示します。  コンテナ記号をクリックする
と、下層にあるデバイスが表示されます。 コンテナ記号は、そのレベル及び下層
のデバイスがすべて表示されていることを示します。
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下図は、メイン ウィンドウでの展開表示の例です。

 

注 – SN# はアレイの固有 ID を表します。

下図は、縮小表示の例です。

 

詳細情報を見るには、アイコンをダブルクリックしてコンポーネント表示ウィンドウ
を開きます。コンポーネント表示については、この章の後の方で説明しています。
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メイン ウィンドウのほかの特徴は、デバイスの状態が色と記号で区別されているため、
注意を要するデバイスを容易に識別できることです。ステータスはデバイス ツリーに
沿って伝播されるので、障害をデバイス レベルまで追跡することができます。デバイス
ステータスの詳細は、表 9-1 を参照してください。

オンライン ヘルプ

オンライン ヘルプにアクセスするには、Help → Contents を選択します。オンライ
ン ヘルプは HTML 形式で、Internet Explorer または Netscape から実行できます。
オンライン ヘルプには、プログラムの主要機能に関する情報が含まれています。

製品構成のツリー表示

各サーバ（またはサーバ グループ）について、デバイスは階層構造のツリーとして表示
されます。サーバ（またはグループ）が 上層に、アレイ コントローラがその下層に表
示されます。残りのデバイス（論理ドライブ、物理ドライブ、および格納装置）がど
のように表示されるかは、表示されるアレイとコントローラによって多少異なる場合
があります。このセクションでは、ツリー表示でのウィンドウ表示の例を示します。

表 9-1 デバイス ステータス状態

色 記号 状態

紫 なし グループ、サーバー、またはデバイスがオンライン。

白 なし ユーザがこのサーバーにログインしていない。

黄色 このグループまたはサーバーの 1 つまたは複数のコン
ポーネントが正常に動作していないが、アレイは機能し
ている。たとえば、1 台の物理ドライブが故障した論理
ドライブが性能低下状態で動作している。

赤 このグループまたはサーバーの 1 つまたは複数のコン
ポーネントが動作していない。論理ドライブの 2 台の
ディスク ドライブが故障した場合、または格納装置の 3 
つのファンが故障した場合は、クリティカル状態とな
る。

灰色 グループ、サーバー、またはデバイスが応答しない。

?
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グループ

グループは、デバイス ツリー内のサーバーの論理上の集合です。この新しいデータ オブ
ジェクトにより、複数のサーバーを 1 つのカテゴリにまとめることができます。

グループ オブジェクト  はほかのツリー オブジェクトと同様に表示され、同様
に操作できます。グループ オブジェクトはアイコンで表示され、通常はそのサーバーと
同じステータスを受け継ぎます。下図は、グループ アイコンが展開され、従属または下
層のサーバー オブジェクトを表示した画面です。

グループは、複数のサーバを 1 つのカテゴリにまとめるための新しいデータ オブ
ジェクトです。グループの概念はドメインに類似しています。グループを使用する
と、サーバが管理しやすくなります。管理する全サーバをリニア ツリーで表すので
はなく、サーバを類似セットまたはグループとして整理できます。

グループはサーバーと同様、色と記号で状態が区別されます。この方法では、各状態
を表す色の優先度は次のようになります。

■ クリティカル - 赤（ 高）
■ 応答なし - 灰色
■ 低下 - 黄色
■ 適 - 紫
■ ログインなし - 白 

サーバー アイコンは、そのストレージ システム内で も高い状態の色を受け継ぎま
す。同様に、グループ アイコンは、そのサーバーの中で も高い状態の色を受け継
ぎます。ただし、次のような応答なし、またはログインなしのサーバーの場合を除き
ます。

グループ アイコンが無効（非アクティブ）である場合、そのグループに接続された
すべてのサーバーが応答していないことを意味します。グループ内の全サーバーより
少ない数のサーバーが非応答の場合、そのグループ アイコンは赤で表示され、クリ
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ティカル状態であることを示します。たとえば、グループ内に 4 台のサーバーがある
場合に 3 台以下のサーバーが応答していないと、そのグループ アイコンが赤色にな
ります。

グループ アイコンが白色（ログインしていない）の場合、グループ内の 1 台以上の
サーバが完全に構成されていないか、ステータスが移行中であることを示していま
す。表 9-2 には、2 台のサーバ グループのアイコンの色の例を示しています。

グループは必須ではありません。たとえば、グループなしで 15 台のサーバを持つよ
うに、または 10 台のサーバーから成る 1 つのグループとトップ レベルにさらに 5 台
のサーバを持つように設定できます。任意の組み合わせが可能です。

グループの数と 1 つのグループ内に許可されるサーバーの数は、使用可能なシステム
メモリーによってのみ制限されます。サーバがあるグループのメンバーであり、ユー
ザがそのグループをグループ リストボックスから削除した場合、そのグループ内の
全サーバは、「グループなし」カテゴリに再割り当てされます。ツリーはメイン
ウィンドウで再マップされます。

表 9-2 2 台のサーバーによるグループの色

サーバー 1
アイコンの色

サーバー 2
アイコンの色 グループ アイコンの色

灰色
灰色

灰色
黄色、赤、紫、または白

灰色（応答なし）
赤（クリティカル）

白 白 白（ログインなし）

白 黄色 黄色（低下）

白 赤 赤（クリティカル）

白
赤

紫
任意の色

紫（ 適）
赤（クリティカル）

黄色 
紫

黄色または紫
紫

黄色（低下）
紫（ 適）
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監視プロセス 
コンソールはサーバ上のエージェントと通信して、ネットワーク上のストレージ デ
バイスを監視します。

プログラムが起動すると、コンソール ソフトウェアは、被管理サーバのうち、Auto
Discovery を指定して構成されたサーバ上のエージェントとの通信確立を開始しま
す。Auto Discovery を指定しなかったサーバについては、各サーバをダブルクリッ
クしてパスワードを入力し、そのサーバの発見プロセスを開始する必要があります。

コンソールと、各サーバ上のエージェントとの間に TCP/IP 接続を確立し、インベン
トリ情報を受け取るには、ネットワークの複雑さに応じて数分かかることがありま
す。このプロセス中、メイン ウィンドウでは、サーバ アイコンの右側に衛星ディッ
シュが表示されます。インベントリのリフレッシュが終了すると、衛星ディッシュ記
号がアクティブ サーバー記号に変わります。

各サーバ上のエージェントは、そのインベントリを定期的にスキャンして変更がない
か調べます。変更があった場合、エージェントはコンソールにイベントを送信しま
す。イベントに応じて、コンソールは、メイン ウィンドウでのサーバの表示を更新
するため、そのサーバの 後のスキャンからのインベントリを要求することがありま
す。このプロセス中はサーバー アイコンに衛星ディッシュ記号が付き、リフレッ
シュ プロセスが完了してコンソールのメイン ウィンドウが更新されるまでは、構成
やアレイ活動コマンドを実行できません。

プログラムが実行中でサーバ エージェントとコンソールが接続されている場合、エー
ジェントはサーバのステータスを確認するためコンソールに定期的に信号を送信しま
す。コンソールがエージェントから特定の数の応答を連続して受信（ハンドシェイ
ク）しなかった場合、コンソールはそのサーバーをオフラインとみなし、サーバーか
ら切断します。このサーバのアイコンは非アクティブとなり、横に疑問符が付いて表
示されます。

非アクティブのサーバが Auto Discovery 機能を介してアクティブになっていた場
合、コンソールは定期的にサーバとの通信の再確立を試みます。

定期ステータス スキャンの間に、サーバーのインベントリを実行したい場合もありま
す。これを行うには、サーバのアイコンをダブルクリックして Server View ウィンド
ウを表示し、Rescan をクリックします。
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Auto Discovery オプション

Auto Discovery オプションを（サーバを Managed Servers リストに追加するプロセス
で、44 ページの「サーバの Automatic Discovery を選択または選択解除します。」を
参照）選択してあると、自動的にそれらのサーバがスキャンされ、インベントリが実
行されます。プログラムから提供される情報を取り出すために監視用パスワードを入
力する必要はありません。ネットワークの複雑さとサーバーの数に応じて、発見プロ
セスが完了するまでに数分かかることがあります。

これに対し、起動時に Auto Discovery オプションを使用しないように選択した場合
は、サーバのアイコンが白で表示され、現在使用可能な情報はないことが示されま
す。この場合は、各サーバー アイコンをダブルクリックして、適切な監視パスワー
ドを入力する必要があります。

File → Login を選択することもできます。サーバのパスワードが入力されると、発見
プロセスが開始され、選択されたサーバのインベントリが実行されます。

注 – サーバ インベントリへのアクセスも制限するような高いセキュリティが必要な
環境では、Auto Discovery に No を選択します（44 ページの「サーバの Automatic
Discovery を選択または選択解除します。」を参照）。

詳細デバイス情報の表示 
Sun StorEdge Configuration Service は、各エージェントまたはサーバ、および接続
されているアレイ デバイスについて詳細情報を提供します。これらの各表示で示される
フィールドは、ディスク コントローラの能力によって異なります。

このセクションで説明するコマンドおよびウィンドウのうち、File メニューの下にある
Save Report と View Report 以外のものには、View メニューからアクセスできます。

■ View Group
■ View Server
■ View Controller Configuration
■ View Logical Drive 
■ View Physical Drive 
■ View Enclosure
■ View FRU
■ Array Administration Progress
■ Agent Options Management
■ Save Report
■ View Report
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View Group 

View Group は、メイン ウィンドウで選択されているグループを構成するサーバを 
表示します。

View Group にアクセスするには、メイン ウィンドウでグループ アイコン  をダ
ブルクリックするか、またはグループ アイコンを選択して、View → View Groupを
選択します。

Server List には、指定したグループに接続されている全サーバが表示されます。

 

表示されたサーバの詳細を見るには、リスト内の該当のステータス レコードを選択して
View をクリックするか、ステータス レコードをダブルクリックします。選択したサー
バーについて説明するウィンドウが表示されます。
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View Server 

View Server は、メイン ウィンドウで選択されたサーバの機能を表示します。

View Server にアクセスするには、メイン ウィンドウでサーバ アイコン  をダブ
ルクリックするか、またはサーバ アイコンを選択して、View → View Server を選択
します。

 

注 – デュアル ポート HBA は、デバイスの接続用に個別のチャネルを持つため、個
別のエントリとして表示されます。

TCP/IP ネットワークの一部であるソケット ポートによりサーバーとクライアントが
接続されます。

■ Rescan - 選択されたサーバに対して、既存のインベントリを再スキャンし、コン
ソールをリフレッシュするようコマンドを送信します。通常、各被管理サーバー
は、そのインベントリの定期スキャンを行い、変更があった場合にコンソールを
更新します。割り当てられている全デバイスの診断を実行する場合は、Rescan を
クリックします。このボタンの選択は、定期および自動のステータス更新より優
先されます。
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■ Probe - 選択されたサーバに対して、新しいインベントリ（たとえば、RAID コン
トローラ、JBOD、拡張ユニットなど）を探すようコマンドを送信します。新しい
デバイスが追加された場合やデバイス名が変更された場合、変更をただちにメイ
ン ウィンドウのツリー表示に表示するには、Probe をクリックします。

■ Card List - 指定されたサーバにインストールされている、または接続されている
ホスト アダプタとアレイ コントローラを表示します。表示されたホスト アダプタ
またはアレイ コントローラの詳細を見るには、リスト内の該当のステータス レ
コードを選択して View をクリックするか、ステータス レコードをダブルクリッ
クします。選択したアダプタまたはアレイ コントローラについて説明するウィン
ドウが表示されます。

View Controller Configuration

View Controller Configuration は、アレイを形成するコンポーネントを表示します。

View Controller Configuration にアクセスするには、メイン ウィンドウでアレイ ア
イコン  をダブルクリックするか、またはアレイ アイコンを選択して View →
View Controller を選択します。
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バッテリが故障すると、アレイはメイン ウィンドウに黄色（低下）のデバイス ス
テータス記号を表示し、Battery フィールドに Bad と示します。

ウィンドウ下部にあるタブには、RAID コントローラの LUN、それに接続された物
理デバイス、コントローラが配置されている格納装置、さらに周辺デバイスの構成に
ついての詳細情報が表示されます。別のタブの情報を表示するには、そのタブをク
リックします。

Controllers タブ

このウィンドウにアクセスするには、メイン ウィンドウでアレイ アイコン  を
ダブルクリックするか、またはアレイ アイコンを選択して View → View Controller
を選択します。次に、Controller  タブをクリックします。

Controller タブには、2 つのコントローラが表示されます。どちらかのコントローラ
の詳細情報を見るには、必要なコントローラをダブルクリックするか、またはコント
ローラを選択して View をクリックします。コントローラがプライマリであるかセカ
ンダリであるかによって、View Primary または View Secondary Controller 
Configuration ウィンドウが表示されます。110 ページの「View Primary/Secondary 
Controller Configuration」を参照してください。
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Physical Drives タブ

このウィンドウにアクセスするには、メイン ウィンドウでアレイ アイコン  を
ダブルクリックするか、またはアレイ アイコンを選択して View → View Controller
を選択します。次に、Physical Drives タブをクリックします。

下図は、View Controller Configuration で Physical Drives タブが表示された画面です。

Physical Drives タブには、アレイに関連付けられた物理ドライブが表示されます。
表示されたドライブの詳細を見るには、そのドライブをダブルクリックするか、また
はドライブを選択して View をクリックします。View Physical Drive ウィンドウが
表示されます。
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View Physical Drive の詳細は、113 ページの「View Physical Drive」を参照してく
ださい。

Enclosure Info タブ

このウィンドウにアクセスするには、メイン ウィンドウの Enclosure アイコン
をダブルクリックするかまたは、アレイ アイコン  を選択して、View → View
Controller を選択します。Enclosure Info タブを選択します。格納装置を選択し、
View をクリックします。

Enclosure Info タブに表示される情報には、電源、ファン、格納装置温度のステータ
スなどがあります。View Enclosure の詳細は、115 ページの「View Enclosure」を参
照してください。

View FRU

Sun StorEdge 3310 SCSI Array の場合のみ、アレイの現場交換可能ユニット（FRU ID）
情報を表示するには、View FRU をクリックします。FRU ID 情報の例は、116 ページの
「View FRU」を参照してください。

View Controller Parameters

View Controller Parameters をクリックすると、チャネル、RS 232、キャッシュ、ディ
スク アレイ、ドライブ I/F、ホスト I/F、冗長性などの詳細情報が表示されます。情報
を見るには、表示したい項目のタブをクリックします。コントローラのパラメータを
変更する方法は、169 ページの「コントローラのパラメータを変更する」を参照して
ください。
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View Primary/Secondary Controller Configuration

View Primary Controller Configuration ウィンドウおよび View Secondary Controller
Configuration ウィンドウは、メイン ウィンドウで選択された RAID コントローラの
機能を表示します。プライマリ コントローラの機能を表示するには、メイン ウィン
ドウでプライマリ コントローラを選択して View → View Controller を選択するか、
プライマリ コントローラをダブルクリックします。

下の 2 つの図は、プライマリ コントローラの表示例です。

下の 2 つの図は、セカンダリ コントローラの表示例です。

View FRU は
Sun StorEdge 3510
Fibre Channel Array 
では表示されません。
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Logical Drives タブ

この表示ウィンドウにアクセスするには、メイン ウィンドウでプライマリまたはセカン
ダリ RAID コントローラ アイコン  をダブルクリックするか、またはコントロー
ラ アイコンを選択して View →Controller を選択します。

View FRU は
Sun StorEdge 3510
Fibre Channel Array 
では表示されません。
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RAID Controller Parameters ウィンドウで編集可能なコンポーネント パラメータを
表示するには、View Controller Params をクリックします。

論理ドライブを表示するには、Logical Drives タブでドライブを選択してダブルクリッ
クするか、またはドライブを選択して View をクリックします。

View Logical Drive

View Logical Drive は、メイン ウィンドウで選択された論理ドライブの機能を表示
します。

この表示ウィンドウには、次のいずれかの方法でアクセスします。

■ メイン ウィンドウで、論理ドライブ アイコン をダブルクリックします。

■ 論理ドライブ アイコンを選択し、View → View Logical Drive を選択します。

■ RAID コントローラ アイコン をダブルクリックし、リストボックスから論理
ドライブを選択して、View をクリックします。

表示されたドライブの詳細を見るには、そのドライブのステータス レコードをダブ
ルクリックするか、またはドライブを選択して View をクリックします。View Physical
Drive ウィンドウが表示されます。
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View Physical Drive 

View → View Physical Drive を選択すると、選択した物理ドライブの機能が表示さ
れます。表示ウィンドウに示されるタイトルは、選択されたデバイスによって異なり
ます。

■ ディスク ドライブ  の場合は、View Physical Drive ウィンドウと呼びます。
■ テープ ドライブ  の場合は、View Tape ウィンドウと呼びます。
■ CD-ROM  の場合は、View CD-ROM ウィンドウと呼びます。

これらのウィンドウのいずれかにアクセスするには、メイン ウィンドウで物理デバイス
をダブルクリックするか、またはデバイスを選択して View → View Physical Drive
を選択します。

■ Associated Partitions -  選択したデバイスが 1 つまたは複数の論理ドライブ パー
ティションに関連付けられている場合にのみ表示されます。

■ View - 関連付けられた論理ドライブがある場合にアクティブになります。

上図は、選択した物理ドライブが 1 つのパーティションに関連付けられている場
合の View Physical Drive ウィンドウの例です。

■ Remaining Size - ディスク ドライブの容量の一部が 1 つまたは複数の論理ドライ
ブに使用されている場合の残りの未使用容量。
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■ RPM - 物理ドライブの毎分回転数。

■ SMART Drive - ドライブが障害予知機能を備えているかどうかを示します。

物理ドライブを選択して View を選択することもできます。View Logical Drive ウィ
ンドウ（テーブルなし）が表示されます。

View Tape ウィンドウと View CD-ROM ウィンドウは上図のウィンドウに似ていま
すが、表示されるカテゴリは多少異なります。

View Enclosure

View Enclosure ウィンドウには、メイン ウィンドウで選択したアレイ格納装置のコ
ンポーネントとアラームの特性が表示されます。（SCSI では、EMU は Sun StorEdge
3310 A という名前で識別され、Id は常に 14 または 15 です。ファイバ チャネルで
は、SES はSun StorEdge 3510 A という名前で識別され、Id は SES を含む格納装置の

後の Id です。）

1. EMU（SCSI）アイコンまたは SES（Fibre Channel）アイコン  を選択します。

2. View → View Enclosure を選択します。

ウィンドウ上部にある 2 つのセクションに、格納装置の識別と関連情報が表示されま
す。アレイに複数の格納装置がある場合、Enclosure Number リストボックス（ウィ
ンドウの右上隅にある）を使って、同じアレイ コントローラに接続されている別の格納
装置を表示することができます。

アレイ内の FRU ID と全 FRU に関する情報を表示するには、View FRU をクリック
します。
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ウィンドウの Alarm State セクションは、アレイに SCSI Accessed Fault-Tolerant
Enclosure（SAF-TE）カードまたは SCSI Enclosure Services（SES）（Fibre Channel
Array の場合）カードがインストールされている場合にのみ適用されます。

■ Alarm State フィールドに Alarm! が表示され、Reset ボタンがアクティブになっ
ている場合は、ドライブ、ファン、電源、またはバッテリの故障、あるいは格納
装置内の異常温度が原因のアラーム状態が存在することを意味します。装置の可
聴アラームが鳴ります。

■ このアラーム状態の発生後、監視を続行するには、このウィンドウの Reset をク
リックするか、またはアレイ格納装置の Reset ボタンを押す必要があります。

■ 構成レベルのセキュリティ特権が与えられているユーザだけがアラームをリセッ
トできます。故障したコンポーネントを交換するか、または装置内部の温度が異
常でないかチェックしてください。

ウィンドウの下部には、ウィンドウに表示されているコンポーネントのステータスが
示されます。スロット内にデバイスがインストールされていると、そのデバイスを表
すドライブ アイコンが表示され、デバイスの状態が色と記号で示されます。
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View FRU

FRU とは、現場交換可能ユニットです。FRU は、新しいシステムの組み立てや、 現
場でのシステムの修理に使用する部分です。Sun FRU ID（現場交換可能ユニット識
別）プログラムは、FRU に存在する FRU 特定の構成、診断、および故障情報を取り
込み、送信し、解析するための Sun ソリューションです。

アレイ内の FRU ID とすべての FRU に関する情報を表示するには、View → View FRU
を選択します。Serial Number（シリアル番号）、Model（モデル名）、Description
（説明）、Vendor ID（ベンダー ID）、Time（FRU がプログラムされた日時）、お
よび Location（場所）が表示されます。

注 – View Controller Configuration ウィンドウ、View Primary Controller Configuration
ウィンドウ、および View Secondary Controller Configuration ウィンドウでも、View
FRU をクリックすると特定のコントローラの FRU を表示できます。

Array Administration Progress

Array Admin Progress は、新しい論理ドライブの初期化の進行状況を表示します。
このコマンドにアクセスするには、View → Array Admin Progress を選択します。
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Agent Options Management

Agent Options を使い、ポーリング時間、定期デバイス発見時間、SMART 監視など
のエージェントのオプションをカスタマイズできます。

Agent Options にアクセスするには、View → Agent Options Management を選択しま
す。詳細は、53 ページの「エージェントのパラメータを構成するには（オプション）」
を参照してください。

Event Log
コンソールは、被管理サーバが生成するイベントと、コンソール自身が生成するイベ
ントを受信、記録、表示します。

イベントのほとんどは、被管理サーバ上のエージェントによって、以下の場合に生成
されます。

■ サーバー自身も含め、被管理サーバー上のデバイスのステータス変化（デバイス
の故障、誤動作、切断などが原因）

■ インベントリの変更（デバイスの追加または削除）

■ 構成の変更（初期構成セットアップおよび後の構成変更）

■ サーバーで実行されるアレイ プロセス（初期化、パリティ チェック、再構築）

アレイ プロセスはコンソールにより開始されますが、プロセスがサーバ上で開始された
後に動作通知イベントを生成するのはサーバ エージェントです。

コンソールははるかに少ない数のイベントを生成します。たとえば、被管理サーバか
ら特定の数のハートビートを連続して受信しなかった場合にイベントを生成します。

コンソールはイベントを受信すると、それを Event Log ファイル eventlog.txt に
記録し、Event Log ウィンドウに表示します。また、イベントがサーバ上で発生した
場合は、イベントの通知がサーバの動作環境／システムのイベント ログに送られま
す。NT サーバーでは、NT イベント ログに送られます。さらに、イベントがサー
バー上で発生した場合で、そのサーバーが SNMP エンタープライズ管理コンソール
（HP OpenView など）にトラップを送信するようにセットアップされていた場合、
サーバー エージェントはそのコンピュータにもトラップ メッセージを送信します。

受信したイベントに応じて、関連サーバの 後の定期スキャンからのインベントリを
要求するため、コンソールがリフレッシュ プロセスを開始することがあります。こ
れは、コンソールがメイン ウィンドウのサーバのインベントリを更新できるように
するためです。
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このリフレッシュ プロセス中はサーバ アイコンに衛星ディッシュ記号が付き、リフ
レッシュ プロセスが完了してメイン ウィンドウが更新されるまでは、構成やアレイ
活動コマンドを実行できません。

Event Log ファイル

Event Log ウィンドウには 大 500 個のイベントを同時に表示できます。500 を超え
るイベントがある場合は、 新の 500 のイベントだけが Event Log ウィンドウに表示
されます。ただし、記録されたイベント数が 10,000 に達するまでイベントは Event Log
ファイル eventlog.txt から削除されません。

■ イベント数が 10,000 に達すると、Event Log ファイルのサイズは 新の 500 イベン
トに切り詰められ、ふたたび 10,000 の制限に達するまでイベントが蓄積されます。

■ 各イベント レコードのフィールドはセミコロンで区切られているため、このファイ
ルを容易にデータベースにインポートできます。

■ eventlog.txt は、コンソール プログラムのファイルがインストールされているディ
レクトリにあります。

注 – 管理されているアレイのイベントの中に、イベント ログに表示されないものが
ある場合、コンソールをいったん閉じてから再度開いてください。

エージェントからのイベント ログは、コンソールが実行されていなくても、エー
ジェントがインストールされているホストのシステム ログに記録されます。Solaris
動作環境では、イベント ログは /var/adm/messages に記録され、コンソール上に
表示されます。Linux 動作環境では、イベント ログは /var/log/messages に記録
されます。Windows NT および 2000 では、イベント ログはシステムのアプリケー
ション ログに記録されます。これは、イベント ビューアを使って表示できます。
/opt/SUNWsscs/sscsconsole/eventlog.txt ファイルから直接イベント ログを
読むこともできます。
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Event Log ウィンドウ

Event Log にアクセスするには、View → Event Log を選択します。このウィンドウ
は、Close をクリックすることにより、表示内容を失わずに閉じることができます
（View メニューを使い再表示できます）。

コンソールは、Event Log ウィンドウが開いているかどうかに関わらず、コンソール
が実行中であればイベントを受信します。

1. ログ ファイルを削除するには、Delete Logfile をクリックします。

確認ウィンドウが開き、ログ ファイルを保存するかどうか尋ねられます。

2. 次のいずれかのオプションを選択します。

■ プロンプトで yes を選択し、フォルダとファイル名を選択してログ ファイルを保
存します。

■ プロンプトで no を選択します。

ログ ファイルの内容が削除されます。

注 – ツールバーの Save Event Log アイコンと Delete Event Log アイコンを使用して
も、eventlog.txt ファイルの内容を保存および削除できます。
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各イベント レコードには、下表に示すフィールドが含まれています。

重要度レベル
■ Critical。ネットワーク管理者による介入を必要とするメッセージ。たとえば、デ

バイス、電源、ファンなどの故障。

■ Warning。一般に内部プログラム イベントを示す警告メッセージ。このメッセー
ジが頻繁に発生する場合は、サーバーまたはネットワークに問題があることを示
している可能性があります。

■ Informational。サーバー上のデバイスについて、ネットワーク管理者による介入
を必要としないメッセージ。

選択したレベルと、それより上の重要度レベルのアラームの通知を受け取ります。つ
まり、Informational を選択した場合はすべてのアラーム状態が通知されます。これ
に対し、Critical を選択した場合は Critical アラームだけを受け取ります。

メッセージの詳細は、237 ページの「トラブルシューティング」を参照してください。

表 9-3 イベント レコードのフィールド

日付 イベントが発生したときのサーバーの日付。

時刻 イベントが発生したときのサーバーの時刻。

サーバ サーバーの IP アドレスとサーバー名。

カード イベントのカード名（該当する場合）。

重要度
次の 3 つの重要度レベルのうちの 1 つ。Critical、Warning、または  
Informational。（これらについては次のサブセクションを参照。）

エラー コード ダッシュで区切られた基本エラー コードと拡張エラー コード。

テキスト 
メッセージ

イベントを説明するテキスト メッセージ。
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Save Report 
Save Report オプションを使用すると、特定のアレイに関してプログラムで使用可能
なすべての情報が含まれるテキスト ファイルを作成できます。

1. File → Save Report を選択します。

サーバの ID 確認のための Report ダイアログボックスが表示されます。Exportable
to spreadsheets オプションを使用すると、スプレッドシートにエクスポートできる
区切り記号（コンマ、セミコロン、タブ、コロン、および垂直バー）付きレポートを
保存できます。

2. Save report を選択します。

Save Report File ウィンドウが表示されます。
第 9 章 アレイの監視 121



3. ファイルを識別するファイル名を入力して、Save をクリックします。

選択されたサーバとそのデバイスに関するインベントリとステータスのレポートが作
成されます。

レポート ファイルのデフォルトの保存場所はインストール ディレクトリです。また、
ファイルのデフォルトの拡張子は .xml です。インストール ディレクトリが煩雑に
ならないように、レポートの保存用にサブディレクトリを作成すると便利です。

レポートには次の情報が含まれます。

■ 一般的なアレイの詳細
■ アレイの名前、ステータス、製造元、モデル名
■ ファームウェア バージョン
■ ブート レコードのバージョン
■ MAC、IP、ネットマスク、およびゲートウェイ アドレス
■ コントローラの製造番号

■ 一般的なアレイ構成の概要
■ 論理ドライブ、論理ボリューム、およびパーティションの総数

■ コントローラ パラメータ 
■ ホストおよびドライブのチャネル設定と ID

■ 各論理ドライブの詳細リスト
■ RAID レベル
■ 論理ドライブ内の物理ドライブの数とサイズ
■ 論理ドライブごとのパーティションの数とサイズ、およびそれらのマッピング

■ SAF-TE/SES 情報
■ FRU のリスト
■ 物理（ハード）ドライブの詳細
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以下は、.xml 形式の Sun StorEdge 3510 Fibre Channel Array のレポート例からの抜
粋です。これは、別のプログラムへの入力ファイルとして使用できます。

コード例 9-1 Sun StorEdge 3510 Fibre Channel Array のレポートからの抜粋

<raidbaseview>
    <raidsystem>

        <name> SUN StorEdge 3510 A-A　アレイ SN#000198 </name>
        <status>クリティカル</status>
        <manufacturer>SUN</manufacturer>
        <model>StorEdge 3510</model>
        <firmware_version>3.27K</firmware_version>
        <bootrecord_version>1.31H</bootrecord_version>
        <mac_address>00:C0:FF:00:01:98</mac_address>
        <ip>206.235.238.198</ip>
        <netmask>255.255.255.0</netmask>
        <gateway>206.235.238.1</gateway>
        <primary_sn>3341275</primary_sn>
        <secondary_sn>3341258</secondary_sn>
        <controller_name>198</controller_name>
        <unique_id>198</unique_id>
        <id_of_nvram_defaults>327K 3510 v2.39</id_of_nvram_defaults>
        <total_logical_drives>8</total_logical_drives>
        <total_logical_volumes>0</total_logical_volumes>
        <total_partitions>278</total_partitions>
        <total_physical_drives>24</total_physical_drives>
        <total_safte_ses_devices>1</total_safte_ses_devices>
        <cache_size>1024MB ECC SDRAM</cache_size>
        <cpu>PPC750</cpu>

        <battery>良好</battery>
        <node_name>206000C0FF000198</node_name>
        <fru>
            <idx>0</idx>
            <item></item>
            <serial_number></serial_number>
            <revision></revision>
            <vendor_jedec_id></vendor_jedec_id>
            <manufacturing_date></manufacturing_date>
            <manufacturing_location></manufacturing_location>
第 9 章 アレイの監視 123



View Report
View Report オプションを使い、作成されたレポートを表示します。

1. File → View Report を選択します。

レポートを選択するための Open ダイアログボックスが表示されます。

2. 表示するレポートを選択し、Open をクリックします。

アウトオブバンド ストレージ管理 
アウトオブバンド ストレージ管理能力により、TCP/IP を使用するネットワーク上のア
レイを監視、管理することができます。ストレージに物理的に接続されたサーバ上で
エージェントが実行されることを必要とするインバンド ストレージ管理（ストレージ管
理の標準メソッド）とは異なり、アウトオブバンド ストレージ管理では、ストレージに
物理接続されたサーバ上でエージェントが実行している必要はありません。アウトオブ
バンド ストレージ管理では、ストレージに接続されたサーバがシャットダウンしていて
も、監視と保守機能は影響を受けません。
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下図は、インバンドとアウトオブバンドのストレージ管理構成の例です。

図 9-1 インバンド管理

図 9-2 アウトオブバンド ストレージ管理
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▼ アウトオブバンド ストレージ管理を使用する

注 – コントローラ、SAF-TE、およびドライブのファームウェアは、アウトオブバン
ド管理を通してアップグレードすることはできません。

1. アレイの静的または動的 IP アドレスをセットアップしてあることを確認してください。

インバンドでアレイを管理するようにプログラムを構成済みである場合は、Change
Controller Parameters を使用して IP アドレスを設定できます。IP アドレスを設定す
るには、182 ページの「Network タブ」を参照してください。プログラムの構成がま
だ済んでいない場合は、RS-232 端末を通して IP アドレスを設定できます。使用する
アレイの『Sun StorEdge 3000 Family 導入・運用・サービス マニュアル』を参照し
てください。

2. IP アドレスの設定が終了したら、コントローラをリセットします。

Array Administration → Controller Maintenance を選択して、Issue Reset to the
Controller をクリックします。

3. サーバーを選択します。

4. View → Agent Options Management を選択します。

5. Agent Options Management ウィンドウで、Out-Of-Band Agent preferred over 
In-Band にチェックマークを付けます。

注 – このオプションが選択されていると、ストレージ管理方法としてアウトオブバ
ンドが優先されます。アウトオブバンド構成が削除された場合、サービスが起動／再
起動したあと、インバンドの管理と監視に戻ります。

6. IP Address フィールドにアレイの IP アドレスを入力し、Add をクリックします。

7. アレイのパスワードが作成済みであれば、そのパスワードを Password フィールドに
入力し、Verify Password フィールドにもう一度入力します。

注 –デフォルトでは、アレイ用にパスワードは設定されていません。パスワードの作成
または変更方法は、ご使用のアレイ用の 『Sun StorEdge 3000 Family RAID ファーム
ウェア ユーザ ガイド』を参照してください。
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8. プログラムでアウトオブバンド アレイを認識して、メイン ウィンドウにそのアレイ
を表示するために、サーバを選択します。

9. View → View Server を選択します。

10. Probe をクリックします。
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11. 目的のアレイを管理するための構成がまだ済んでいない場合は、コントローラを管理
するためにサーバを割り当てる必要があります。

Array Administration → Controller Assignment を選択します。Server to manage
this controller リストからサーバを選択し、Apply をクリックします。

メイン ウィンドウにアウトオブバンドの HBA が表示されます。

注 – ウィンドウにアウトオブバンド HBA が表示されない場合はコントローラをリ
セットします。
128 Sun StorEdge 3000 Family Configuration Service 1.3 ユーザ ガイド • 2003 年 6 月



▼ アレイをアウトオブバンド管理から削除する

1. サーバーを選択します。

2. View → Agent Options Management を選択します。

3. Managed Primary Agent リストから削除するアレイを選択し、Remove を選択します。

HBA はメイン ウィンドウに表示されたままです。表示から削除するには、サービス
をいったん停止してから再起動する必要があります。

Web によるストレージの管理 
Web ベースのストレージ管理能力を利用すると、Sun StorEdge Configuration Service
パッケージ全体をロードしなくても、Web を通してアレイを管理できるので便利です。
このセクションでは、Web ベースの管理用にアレイをセットアップし、Web ブラウザ
を通してアレイにアクセスする方法を説明します。

注 – この機能を Solaris ホストにインストールするには Sun StorEdge Enterprise
Storage Manager Topology Reporter（Sun StorEdge Enterprise Storage Manager ソ
フトウェアに同梱）が必要です。詳細は、使用しているアレイの『Sun StorEdge
3000 Family リリース ノート』にある「サポートされている他のソフトウェア」セク
ションを参照してください。
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注 – この機能は Linux ではサポートされません。つまり、Linux 動作環境で実行さ
れるシステムにエージェントをインストールしている場合、Custom Configure ウィ
ンドウの Configure Web Server オプションは使用できません。コンソールをロード
するために Linux Web ブラウザを使用できますが、エージェントは Solaris 動作環境
を実行するシステムにインストールされている必要があります。

Web ブラウザの要件 
Sun StorEdge Enterprise Storage Manager Topology Reporter は、同一ネットワーク
に接続されている任意のマシンから URL を指定すれば参照できます（Slaris 動作環
境マシンでのアカウントが必要です）。

Solaris/Linux 動作環境
■ Netscape 4.79
■ Java Plug-in 1.2.2_02

Windows NT/2000 オペレーティング システム

■ Internet Explorer 5.0 以降
■ Java Plug-in 1.2.2_02

または

■ Netscape 4.76
■ Java Plug-in 1.2.2_02

アレイのセットアップ

Web からアレイにアクセスするために使用するコンピュータ上に、Sun StorEdge
Configuration Service パッケージ全体をロードする必要はありませんが、いくつかのプ
ログラム ファイルは必要です。したがって、別のサーバに Sun StorEdge Configuration
Service 全体をインストールして、ここからアレイにファイルを転送できるようにし
ておく必要があります。以下の手順では、Web 管理をセットアップするために必要
なファイルをうまく転送する方法を説明します。

1. ネットワークとアレイをつなぐ Ethernet 接続が存在することと、アレイ用の IP アド
レスを確立していることを確認します。

2. Sun StorEdge Configuration Service パッケージ全体をインストールしたサーバから、
Configuration → Custom Configure を選択します。
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3. Configure Web Server を選択します。

4. ストレージに直接接続されたサーバ上で実行されている管理エージェントの IP アド
レスを確認します。

5. ファイルの転送先のアレイの IP アドレスを入力し、OK をクリックします。

注 – デフォルトでは、アレイ用にパスワードは設定されていません。ファームウェア
アプリケーションを使用してパスワードを作成した場合、これを入力する必要がありま
す。パスワードの作成または変更方法は、ご使用のアレイ用の 『Sun StorEdge 3000
Family RAID ファームウェア ユーザ ガイド』を参照してください。

ファイルの転送に成功したら、確認メッセージが表示され、Web を通じてコンソールに
アクセスできるようになります。

▼ Web ブラウザからコンソールにアクセスする

1. Web ブラウザを開きます。

2. 次の URL アドレスを入力します。

3. 本書の該当の章の説明を参照して、ストレージの監視、管理、更新などの操作を続け
ます。

http:// ワークステーションの IP アドレス/esm.html
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第 10 章

アレイの保守 

本章では、Array Administration を使用してアレイの完全性を保持する方法について
説明します。この章でふれるトピックは以下のとおりです：

■ 133 ページの「Array Administration 活動」
■ 134 ページの「パリティ チェックを実行する」
■ 135 ページの「パリティ チェックをスケジュールする」

■ 137 ページの「故障ドライブ」
■ 137 ページの「スタンバイ ドライブを使ってドライブを自動的に再構築する」
■ 138 ページの「スタンバイ ドライブなしでドライブを再構築する」
■ 138 ページの「再構築プロセスの進行状況をチェックする」
■ 139 ページの「故障ドライブを手動で再構築する」
■ 140 ページの「論理ドライブの構成を復元する」
■ 143 ページの「コントローラをリセットする」
■ 143 ページの「コントローラのビープ音を消音する」
■ 144 ページの「故障コントローラをオンラインに戻す」
■ 146 ページの「Performance Statisticsを表示する」

Array Administration 活動
Array administration の活動であるアレイの初期化、ドライブの再構築、パリティ
チェックなどは、必要な論理ドライブまたは物理ドライブのサイズによって、時間が
かかることがあります。

これらのいずれかのプロセスを開始すると、Controller Array Progress ウィンドウが
表示されます。このウィンドウを閉じる場合、進行状況を表示しておくには、
Progress Indicator アイコン  をクリックします。
または、View → Array Admin Progress を選択します。
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▼ パリティ チェックを実行する    
パリティ チェックとは、フォールト トレラント論理ドライブまたは LUN（RAID 3
と 5）の冗長データの保全性をチェックするプロセスです。

1. パリティ チェックを実行する論理ドライブを選択します。

2. Array Administration → Parity Check を選択します。

注 – このメニューのオプションにアクセスするには、ssadmin または ssconfig と
してログインする必要があります。

3. Logical Drive Parity Check ウィンドウが表示されたら、パリティ チェックを実行す
る論理ドライブを選択します。
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パリティ チェックを複数のドライブに対して実行するには、Array Administration → 
Schedule Parity Check コマンドを使って、パリティ チェックを後で（たとえば 3 分以
内に）実行するようにスケジュールします。スケジュールされたパリティ チェックが
実行されるとき、複数のパリティ チェックが自動的に順に実行されます。

4. Parity Check ボタンをクリックして、パリティ チェック プロセスを開始します。

パリティ チェックが開始されると、Progress Indicator が表示されます。このウィン
ドウを閉じた場合、再度開くには、View →Array Admin Progress を選択するか、
Progress Indicator をクリックします。ウィンドウが開き、各アレイについての完了
状況がパーセンテージで示されます。

▼ パリティ チェックをスケジュールする      
特定の論理ドライブ アレイに対して実行時間（たとえば、オフタイムなど）をスケ
ジュールしてパリティ チェックを実行するには、Array Administration → Schedule
Parity Check を選択します。

■ 被管理サーバーに構成されている論理ドライブを何台でもスケジュール用に選択
できますが、1 つのアレイ コントローラにつき 1 つのスケジュールしか設定でき
ません。

■ 複数の論理ドライブがスケジュールされている場合、パリティ チェックは論理ドライ
ブの番号の小さいものから大きいものへと順に実行されます。

■ 1 回のパリティ チェックには平均で 1 ギガバイトのストレージあたり 5 分かかり
ます。

■ パリティ チェックに割り当てるシステム リソースの量は、バックグラウンド レー
トを変更することにより制御できます。

■ パリティ チェックを開始した後で停止することができます。停止した結果、データが
破損することはありません。

注 – このメニューのオプションにアクセスするには、ssadmin または ssconfig と
してログインする必要があります。

1. パリティ チェックをスケジュールしたいコントローラを選択します。

2. Array Administration → Schedule Parity Check を選択します。

Schedule Parity Check ウィンドウが表示されます。
第 10 章 アレイの保守 135



3. このウィンドウの必要なフィールドで値を選択します。

■ Listed Logical Drives - 使用可能なフォールト トレラント論理アレイのリストで
す。複数のドライブを選択する場合は Shift キーを使用します。

■ Background Rate - アレイ管理活動に割り当てられた、使用可能なアレイ コント
ローラ CPU 時間のパーセンテージです。バックグラウンド レートを変更するに
は、Custom Configuration Options ウィンドウで Change Controller Parameters
を選択します。

■ How Often - パリティ チェックの実行頻度を指定します。

■ Starting Day - このスケジュールを開始する曜日を指定します。

■ Starting Time - このスケジュールの開始日における開始時刻を指定します。

■ Existing Schedule - 現在のパリティ スケジュール（論理ドライブ、頻度、開始日、
および時刻）。

■ Next Parity Check - 次のパリティ チェックの開始日と時刻。

4. 希望どおりのスケジュールとなったら、OK をクリックします。
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故障ドライブ 
このセクションでは、ドライブの故障からの回復手順をスタンバイ ドライブがある場合
とない場合について説明します。何らかの理由でこれらの手順による再構築プロセスが
開始されなかった場合は、手動による再構築プロセスの開始方法も提供されています。

注意 – 故障が発生する前に各論理ドライブ アレイにインストールされ構成された、
ローカルまたはグローバルのスタンバイ ドライブをインストールしてください。使用し
ている RAID レベルと実装されているアーカイブ プロシージャによっては、1 つま
たは複数のドライブが故障した場合に多大なデータ損失が起こる可能性があります。
さらに、誤動作が発生した場合の即時交換用に、テスト済みのスペア ドライブをすぐに
使用できるようサイトに用意しておいてください。

▼ スタンバイ ドライブを使ってドライブを自動的に
再構築する

スタンバイ ドライブをグローバルまたはローカル ドライブとして事前にインストー
ルして構成しておけば、フォールト トレラント論理ドライブに関連付けられたドライブ
が故障しても、故障したドライブが自動的に交換され、指定のスペア ドライブを使って
そのデータが再構築されます。これがスムーズに行われるには、かならずスペア ドライ
ブの容量が、交換される故障ドライブの容量以上であることが必要です。

再構築プロセスは通常 1～2 分以内に開始されます。このプロセスはバックグラウン
ドで実行され、コントローラ上にほかの活動がない場合に 1 ギガバイトあたり約 8 分
かかります。

自動再構築プロセスの間、通常の活動は継続可能ですが、パフォーマンスが低下する
ことがあります。パフォーマンス低下の度合いは、コントローラに設定されたバック
グラウンド レートに依存します。

再構築プロセスの進行状況を表示するには、View → Array Admin Progress を選択
します。

1. 故障ドライブを交換して自動再構築機能を確立し直します。手順については、使用し
ているアレイの『Sun StorEdge 3000 Family 導入・運用・サービス マニュアル』を
参照してください。
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2. 故障ドライブを取り出した後、少なくとも 60 秒待ってから新しいドライブを挿入し
ます。

交換用ドライブが、少なくとも格納装置内の 大のドライブの容量に等しいことを確認
してください。故障ドライブと同じスロット（ドライブ ベイ）に交換用ドライブをイン
ストールします。これで、交換用ドライブが新しいスタンバイ ドライブになります。

3. 再構築プロセスが完了し、論理ドライブがオンラインに戻った後、アレイ コントローラ
の構成を、外部ドライブまたはディスケット上のファイルにバックアップします。

58 ページの「論理ドライブの構成を保存するには」を参照してください。

▼ スタンバイ ドライブなしでドライブを再構築する

アレイにスタンバイ ドライブがない場合は、自動再構築プロセスを開始するには、先に
故障ドライブを交換する必要があります。

1. スタンバイ ドライブがない場合にドライブの故障から回復するには、故障ドライブを交
換します。手順については、ご使用のアレイ用の『Sun StorEdge 3000 Family 導入・
運用・サービス マニュアル』を参照してください。

2. 故障ドライブを取り出した後、少なくとも 60 秒待ってから新しいドライブを挿入し
ます。

交換用ドライブの容量が、少なくとも故障ドライブの容量に等しいことを確認してだ
さい。故障ドライブと同じアドレス（ドライブ ベイ）に交換用ドライブをインス
トールします。

3. 故障ドライブがそのスロット内で交換された後、そのドライブをスキャンする必要が
あります。

ドライブのスキャン方法は、163 ページの「新しいハード ドライブをスキャンする」
を参照してください。

4. ドライブをスキャンした後、Array Administration → Rebuild を選択して、ドライブ
を手動で再構築する必要があります。

▼ 再構築プロセスの進行状況をチェックする

1. View → Array Admin Progress を選択するか、ウィンドウ右上隅にある Progress
Indicator アイコンをクリックします 。

Controller Array Progress ウィンドウが開き、再構築の完了パーセンテージが表示さ
れます。ただし、複数のコントローラ上でアレイ活動（初期化、再構築、パリティ 
チェックなど）が進行中の場合は、Select Controller Progress ウィンドウが 初に表
示されます。
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2. 進行状況を表示するコントローラを選択し、OK をクリックします。

Controller Array Progress ウィンドウが開き、選択したコントローラのアレイの進行
状況が表示されます。133 ページの「Array Administration 活動」を参照してくださ
い。

▼ 故障ドライブを手動で再構築する

ほとんどの場合、交換用ドライブは自動的に再構築されるため、手動による再構築プ
ロセスを使用する必要はありません。

故障発生時にスペアが存在しなかった場合や、何らかの理由でドライブが再構築され
なかった場合は、Rebuild を使って手動で再構築プロセスを開始できます。また、再
構築プロセスがリセットにより中断された場合に、Rebuild を使って再構築プロセス
を再開できます。

1. 故障ドライブを交換します。手順については、ご使用のアレイ用の『Sun StorEdge 3000
Family 導入・運用・サービス マニュアル』を参照してください。

2. 故障ドライブを取り出した後、少なくとも 60 秒待ってから新しいドライブを挿入し
ます。

交換用ドライブの容量が、少なくとも格納装置内の 大のドライブの容量に等しいこ
とを確認してださい。

3. Array Administration → Rebuild を選択します。

Rebuild ウィンドウが表示されます。
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4. 交換用ドライブのステータス レコードを選択します。

5. OK をクリックして再構築プロセスを開始します。

再構築プロセスはバックグラウンドで実行され、アレイ コントローラ上にほかの活
動がない場合に 1 ギガバイトあたり約 8 分かかります。再構築の間、通常の活動は継
続可能ですが、パフォーマンスが低下することがあります。パフォーマンス低下の度
合いは、コントローラに設定されたバックグラウンド レートに依存します。

6. 再構築プロセスの進行状況をチェックするには、View → Array Admin Progress を選
択するか、ウィンドウ右上隅にある Progress Indicator アイコンをクリックします。

Controller Array Progress ウィンドウが開き、再構築の完了パーセンテージが表示さ
れます。

複数のコントローラ上でアレイ活動（初期化、再構築、パリティ チェックなど）が
進行中の場合は、Select Controller Progress ウィンドウが 初に表示されます。

7. 進行状況を表示するコントローラを選択し、OK をクリックします。

Controller Array Progress ウィンドウが開き、そのコントローラのアレイ再構築の状
況が表示されます。

▼ 論理ドライブの構成を復元する 
このセクションでは、アレイの構成情報をバックアップ ファイルから復元する方法を説
明します。Save コマンドを使ってバックアップ ファイルが既に保存されていなけれ
ばなりません（85 ページの「構成ファイル」を参照）。アレイ コントローラとその
ドライブが損傷した場合、ストレージ アレイを完全に再構成する必要なく、アレイの構
成を新しいコントローラに復元できます。

注意 – 構成ファイルが 新のものである場合にのみ、アレイ構成をファイルから復
元してください。古い情報や誤った構成が復元されるとデータが喪失します。

バックアップ ファイルに確実に正しいアレイ構成情報が含まれている場合は、以下の手
順を実行して構成を復元してください。

1. 適切なアレイのコントローラを選択します。

2. Configuration → Load Configuration を選択します。

Select Configuration File ウィンドウが表示されます。
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3. バックアップ構成ファイルの名前と場所を指定し、Open をクリックします。

Load Configuration ウィンドウが表示されます。構成のツリー表示を見るには、
Configuration View タブをクリックします。

Saveset Description タブには、構成ファイルを作成したときに指定したファイルの説
明が表示されます。
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4. （Solaris OE のみ）論理ドライブに自動的にラベルを付け、動作環境でそのドライブ
を使用できるようにするには、Write a new label to the new LD をクリックします。

5. 保存されている構成をロードするには、OK をクリックします。

Load Configuration Confirmation ウィンドウが表示されます。

続行する前に、Load Configuration Confirmation ウィンドウに表示される情報を注
意して確認してください。
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6. この構成をロードするには Apply をクリックします。この操作をキャンセルするには
Cancel をクリックします。

Apply をクリックすると、構成操作が続行され、進行状況ウィンドウが表示されます。

注 –  アレイの構成バックアップ ファイルの内容を復元した後で LUN を初期化
しないでください。

7. Windows NT の場合、オペレーティング システムをシャットダウンしてからリブー
トしてください。

オペレーティング システムの再初期化は、論理ドライブ構成が Windows NT によっ
て認識されるようにするため必要です。

▼ コントローラをリセットする

コントローラのパラメータを変更するたびに、変更を有効にするためコントローラをリ
セットするかどうか尋ねられます。複数の変更を行うときは、1 つ変更するたびに中断
してコントローラをリセットしたくない場合もあります。Issue Reset to the Controller
オプションを使用すると、複数のパラメータ変更を行った後、コントローラを手動で
リセットできます。

1. メイン ウィンドウでストレージ アイコンをどれか選択します。

2. Array Administration → Controller Maintenance を選択します。

3. ssconfig としてログインしていない場合は、パスワードを求めるプロンプトが表示
されます。ssconfig パスワードを入力します。

Controller Maintenance Options メニューが表示されます。

4. Issue Reset to the Controller をクリックします。

注 – Sun StorEdge 3310 SCSI Array のコントローラをリセットすると、パリティ エ
ラーや同期化エラーなどのエラーがホスト側で発生したことを示すメッセージが表示
されることがありますが、コントローラの再初期化が完了すれば、この状態は修正さ
れるので、特に処置する必要はありません。

▼ コントローラのビープ音を消音する

コントローラがビープ音を発するようなイベントが発生した場合、たとえば、再構築
中や SCSI ドライブの追加中に論理ドライブが故障した場合、コントローラのビープ
音を下記のいずれかの方法で消音することができます。
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1. メイン ウィンドウでコントローラのアイコンを選択します。

2. Array Administration → Controller Maintenance を選択します。

3. ssconfig としてログインしていない場合は、パスワードを求めるプロンプトが表示
されます。ssconfig パスワードを入力します。

Controller Maintenance Options メニューが表示されます。

4. Mute Controller Beeper をクリックします。

または

1. メイン ウィンドウで、必要なコントローラのアイコンを選択します。

2. Configuration → Custom Configure を選択します。

3. Change Controller Parameters を選択します。

4. Mute Beeper を選択します。

▼ 故障コントローラをオンラインに戻す

コントローラに障害が発生した場合、以下の 2 つの手順のいずれかでコントローラを
オンラインに戻します。

1. メイン ウィンドウで、必要なコントローラのアイコンを選択します。

2. Array Administration → Controller Maintenance を選択します。

3. ssconfig としてログインしていない場合は、パスワードを求めるプロンプトが表示
されます。ssconfig パスワードを入力します。

Controller Maintenance Options メニューが表示されます。

4. Deassert Failed Redundant Controller をクリックします。

または

1. メイン ウィンドウで、必要なコントローラのアイコンを選択します。

2. Configuration → Custom Configure を選択します。

3. Change Controller Parameters を選択します。

4. Redundancy タブを選択します。

5. Set Controller Config フィールドで、Redundant Deassert Reset を選択します。
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▼ デュアル コントローラ アレイからシングル コン
トローラ アレイへの交換

デュアル コントローラ構成で 1 台のコントローラが故障した場合、コンソールにア
レイの機能が低下したことが表示されないように、コントローラ 1 台だけで長時間稼
動させることが必要になる場合があります。

1. 取り外すコントローラの製造番号を必ず調べておいてください。

故障したコントローラの製造番号はイベント ログで調べることができます。また、
プライマリ コントローラの製造番号は、コンソールを調べれば記録できます。

2. 残っているコントローラの冗長性設定を無効に変更します。

コントローラの冗長性を無効にするにはファームウェア アプリケーションを使用する必
要があります。ファームウェア アプリケーションにアクセスする方法は、使用している
アレイの『Sun StorEdge 3000 Family RAID ファームウェア ユーザ ガイド』を参照
してください。その後、以下のステップに進みます。

a. メイン メニューから view and edit Peripheral devices を選択して Return キーを
押します。

b. Set Peripheral Device Entry を選択して Return キーを押します。

c. Redundant Controller - Primary を選択して Return キーを押します。

d. Disable redundant controller を選択して Return キーを押します。

3. 使用している動作環境やシステムのインストールの章に説明されている手順でエー
ジェントを停止します。

4. /var/opt/SUNWsscs/ssagent に移動し、sscontlr.txt ファイルを編集します。

このファイルの 終行に両方のコントローラの製造番号が記載されています。故障し
たコントローラの製造番号をその行から削除します。

5. 使用している動作環境やシステムのインストールの章に説明されている手順でエー
ジェントを起動します。

6. 上記の手順を行っている間にコンソールが開かれた場合は、コンソールを再スキャン
します。

# RAID_CONTROLLER=Enable:3197861:3179746
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▼ Performance Statisticsを表示する

Performance Statistics を使用して、データ転送率、つまりアレイが実行されるスピード
を決定できます。

1. Array Administration → Controller Maintenance を選択します。

2. ssconfig としてログインしていない場合は、パスワードを求めるプロンプトが表示
されます。ssconfig パスワードを入力します。

Controller Maintenance Options メニューが表示されます。

3. Performance Statistics をクリックします。

Performance Statistics ウィンドウが表示されます。
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第 11 章

構成の更新

この章は、現在の構成に対して変更や追加を行う場合に参照してください。この章に
は以下のタスクが含まれます。

■ 148 ページの「論理ドライブを追加する、または新しい論理ドライブから論理ボリュー
ムを追加する」

■ 152 ページの「論理ドライブまたは論理ボリュームを削除する」

■ 155 ページの「パーティションを作成する」

■ 157 ページの「パーティションを削除する」

■ 158 ページの「論理ドライブまたは論理ボリュームの容量を拡張する」

■ 160 ページの「SCSI ドライブを既存の論理ドライブに追加する」

■ 161 ページの「メンバー ドライブをコピーして交換する」

■ 163 ページの「新しいハード ドライブをスキャンする」

■ 164 ページの「RAID コントローラ ファームウェアをダウンロードする」

■ 166 ページの「ファームウェアとブート レコードをアップグレードする」

■ 167 ページの「ハード ドライブのファームウェアをアップグレードする」

■ 168 ページの「SAF-TE/SES デバイスのファームウェアをアップグレードするには」

■ 169 ページの「コントローラのパラメータを変更する」

■ 170 ページの「変更した値を保存するには」

■ 183 ページの「コントローラのビープ音を消音する」

■ 184 ページの「スタンバイ ドライブを指定または変更する」

■ 186 ページの「サーバー エントリを編集する」

Configuration メニューのコマンドとツールのアイコンは、パリティ チェックなどの
アレイ管理プロセスが実行中の場合に一時的に無効になる場合があります。メニュー
コマンドは、コンソールがサーバ上でインベントリをリフレッシュしている間も使用
不可として表示されます。リフレッシュ プロセスの間はサーバー アイコンに衛星ディッ
シュ記号が付いて表示されます  。
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構成オプションを使用するには、ssconfig パスワードを使って、ソフトウェアの
ssconfig セキュリティ レベルでログインする必要があります。構成操作が終了し
たら、ログアウトしてプログラムの監視レベルへ戻ります。

▼ 論理ドライブを追加する、または新しい論理ドラ
イブから論理ボリュームを追加する

既存の RAID セットの構成に 1 つ以上の論理ドライブを追加したり、新しい論理ド
ライブから論理ボリュームを追加するには、このオプションを使用します。既存の
論理ドライブから 1 つの論理ボリュームを追加する方法は、151 ページの「既存の論
理ドライブから論理ボリュームを追加する」を参照してください。

注 – 論理ドライブのサイズが 253 ギガバイトを超える場合は、73 ページの「253 ギ
ガバイトより大きい論理ドライブを準備するには」を参照してください。

1. 適切なアレイを選択します。

2. Configuration → Custom Configure を選択します。

注 – 使用可能な物理ドライブがあるアレイが選択されていない限り、この選択項目
は非アクティブです。

3. Custom Configuration Option ウィンドウから、Add LDs/LVs to the Current 
Configuration を選択します。

4. ウィンドウ上部に表示されるサーバとコントローラが正しいかどうか確認します。

5. 新しい論理ボリュームに含めるディスクを選択し、Add Disk をクリックします。

選択を間違えた場合や変更したい場合は、そのドライブを選択し、Remove Disk を
クリックします。

6. RAID レベルを選択します。

RAID レベル定義は、189 ページの「RAID の基本」を参照してください。

7. Channel リストボックスと SCSI ID リストボックスから、新しい論理ドライブの
マップ先とするホスト チャネルと SCSI ID を選択します。

8. Max Drive Size を設定します。

Max Drive Size には、各ディスクの合計容量が表示されます。この値を小さくすれば、
より小さい論理ドライブを作成できます。
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注 – Max Drive Size は変更せずに Partition Size を変更した場合、指定されたパー
ティション サイズで新しいパーティションが作成されます。論理ドライブ サイズの
残り容量は 後のパーティションに移動されます。残り容量は、後にドライブを拡張
した場合に使用できます（158 ページの「論理ドライブまたは論理ボリュームの容量
を拡張する」の説明を参照）。パーティションが作成された後はドライブ容量を編集
することはできません。

注 – 同じコントローラ上に論理ドライブをさらに作成する場合は、New LD をク
リックします。定義した論理ドライブが作成されます。その後ウィンドウ上部に戻る
ので、別の論理ドライブを作成できます。Sun StorEdge 3310 SCSI アレイでは、1 論
理ドライブあたり 大 32 パーティションを含む論理ドライブを 大 8 つ作成できま
す。Sun StorEdge 3510 FC アレイでは、1 論理ドライブあたり 大 128 パーティショ
ンを含む論理ドライブを 大 8 つ作成できます。

9. この論理ドライブを論理ボリュームに追加するには、New LD をクリックして、150
ページの「論理ドライブを論理ボリュームに追加する」を参照してください。

10. このウィンドウでの選択が希望どおりになり、これ以上論理ドライブを定義する必要
がなければ、Commit をクリックします。

確認ウィンドウが開き、新しい構成が表示されます。OK をクリックして構成を受け
入れます。

11. Cancel を選択してコンソールに戻ります。

これにより追加のフォールト トレランスが提供されます。必要な場合に常にドライブの
状態を使用可能に変更できます。
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注 – OK をクリックしたあとで論理ドライブの構成を変更することはできません。

注 – 初期化中には、LD と LV のサイズは 0 メガバイトと表示されます。

▼ 論理ドライブを論理ボリュームに追加する 

1 つの論理ボリュームは 2 つ以上の論理ドライブから構成され、 大 32 個のパー
ティションに分割できます。動作時にホストは、パーティションで分割されていない
論理ボリューム 1 つ、または論理ボリュームのパーティション 1 つを単一の物理ドラ
イブとして認識します。

1. 148 ページの「論理ドライブを追加する、または新しい論理ドライブから論理ボリュー
ムを追加する」のステップ 1 ～ 8 で説明するように、論理ドライブを作成します。

注 –論理ボリュームに追加する論理ドライブのパーティションを分けないでください。
パーティションが分けられた論理ドライブは、論理ボリュームに追加できません。

2. Commit をクリックする前に、論理ドライブを論理ボリュームに追加するには、Add
to LV をクリックします。

論理ドライブが、LV Definition ボックスに追加されます。論理ボリュームの合計サ
イズが、Available Size (MB) フィールドに表示されます。

注 – 論理ボリュームはまだパーティションが分割されていないため、Part Size (MB)
と Available Size (MB) は同じです。単一の論理ボリュームが、単一のパーティショ
ンと見なされます。

3. 論理ボリュームに追加する別の論理ドライブを作成するには、New LD をクリックし
ます。

4. 論理ドライブを作成し、Add to LV をクリックしてその論理ドライブを論理ボリュー
ムに追加します。

論理ボリュームに追加するすべての論理ドライブについて、このステップを繰り返し
ます。

5. パーティションの作成方法は、155 ページの「パーティションを作成する」を参照し
てください。

6. 論理ドライブを論理ボリュームに追加したあと、別の論理ボリュームや単独の論理ド
ライブを作成するには、Commit LV をクリックします。

論理ボリュームの作成が終了し、単独の論理ドライブを作成しない場合、Commit を
クリックします。
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注 – 論理ボリュームを作成し終わり、New Configuration ウィンドウを終了すると
きに、Commit の代わりに誤って Commit LV をクリックすると、さらに別の論理ド
ライブを作成しなければならなくなります。作成しない場合は、Cancel をクリック
して論理ドライブを再度構成しなければなりません。

▼ 既存の論理ドライブから論理ボリュームを追加する

注 – 既存の論理ドライブから論理ボリュームを追加する前に、論理ドライブをマッ
プ解除する必要があります。

1. 適切なアレイを選択します。

2. Configuration → Custom Configure を選択します。

注 – 使用可能な物理ドライブがあるアレイが選択されていない限り、この選択項目
は非アクティブです。

3. Custom Configuration Option ウィンドウから、Add LDs/LVs to the Current Configuration
を選択します。

4. ウィンドウ上部に表示されるサーバとコントローラが正しいかどうか確認します。

5. Use existing LDs to create LVs を選択します。

Select a Logical Drive の下に論理ドライブが表示されない場合、論理ドライブがマッ
プ解除されておらず、そのために選択できません。まず、論理ドライブをマップ解除
する必要があります。

6. 論理ドライブを 1 つ選択して、Add to LV をクリックします。

7. 論理ドライブを論理ボリュームに追加したあと、別の論理ボリュームや単独の論理ド
ライブを作成するには、Commit LV をクリックします。

論理ボリュームの作成が終了し、単独の論理ドライブを作成しない場合、Commit を
クリックします。

注 – 論理ボリュームを作成し終わり、New Configuration ウィンドウを終了すると
きに、Commit の代わりに誤って Commit LV をクリックすると、さらに別の論理ド
ライブを作成しなければならなくなります。作成しない場合は、Cancel をクリック
して論理ドライブを再度構成しなければなりません。
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▼ 論理ドライブまたは論理ボリュームを削除する

このオプションを使い、既存の RAID セットの構成から 1 つまたは複数の論理ドラ
イブまたは論理ボリュームを削除します。

注 – 論理ドライブまたは論理ボリュームを削除するには、先にすべての割り当て済
み LUN をマップ解除する必要があります。

1. 適切なアレイを選択します。

2. 削除する論理ドライブまたは論理ボリュームを表示します。

3. いずれかの論理ドライブまたは論理ボリュームにホスト LUN が割り当てられている場
合はステップ 4 へ進みます。割り当てられていない場合はステップ 8 へ進みます。

4. Configuration → Custom Configure を選択します。

5. Change Host LUN Assignments を選択します。

Use existing LDs to create 
LVs を選択して論理ドライブ
を作成しても論理ドライブが
リストに表示されない場合、
その論理ドライブのマップは
解除されていません。まず
論理ドライブのマップを解除
する必要があります。
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6. マップ解除する論理ドライブまたは論理ボリュームに割り当てられているホスト
LUN を選択し、Unmap Host LUN をクリックします。

7. OK をクリックして、Close をクリックします。

8. Configuration → Custom Configure を選択します。

9. Custom Configuration Options ウィンドウで Manage Existing LDs/LVs and Partitions
を選択します。

10. LDs/LVs タブを選択します。

11. 削除する論理ドライブまたは論理ボリュームを選択して Delete をクリックし、OK をク
リックします。

論理ボリュームを削除するとき、Delete をクリックすると論理ボリュームは削除され
ますが、論理ドライブを構成する論理ドライブは表示されます。

12. Confirm Configuration Operation ウィンドウで、OK をクリックして操作を完了し、
Close をクリックします。

論理ドライブ／論理ボリューム番号

各論理ドライブを参照する論理ドライブ／論理ボリューム番号は動的で、論理ドライ
ブの作成および削除時に変更されます。この番号は、Dynamically Grow and/or
Reconfigure LDs/LVs ウィンドウ、Change Host LUN Assignments ウィンドウ、
Manage Existing LDs/LVs and Partitions ウィンドウ、メイン ウィンドウなど、いく
つかのウィンドウの論理ドライブ（LDs/LVs）フィールドに表示されます。
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この番号は、論理ドライブを視覚的に追跡するためのプレースホルダとしてのみ使用
され、コントローラにとっては意味がありません。つまり、コントローラはこの番号
を使って論理ドライブまたは論理ボリュームについて報告はしません。たとえば、4
つ論理ドライブがある場合、LD2 が削除されると、既存の LD3 は LD2 に、LD4 は
LD3 に動的に変更されます。LD/LV 番号だけが変わります。LUN マッピングと論
理ドライブ上のデータはすべてそのままで変わりません。

LD/LV フィールドに表示される実際の LD/LV 番号は無意味です。コントローラは
論理ドライブの合計数について報告し、この場合は 3 です。この例では、新しい論理
ドライブが作成された場合、削除された論理ドライブの LD 番号がこのドライブの番
号となり、コントローラは合計 4 つの論理ドライブがあると報告します。既存の論理
ドライブはすべて、元のプライマリ／セカンダリ指定に戻ります。

注 – 次の例で示すように、ファームウェア端末のメニュー オプション View and Edit
Logical Drives 上の LG 番号は、視覚的に動的ではありません。論理ドライブが削除
された後、空のプレースホルダが表示されます。コンソールまたは端末から論理ドラ
イブを作成すると、この空のプレースホルダーに新しい論理ドライブが表示されます。

Manage Existing LDs/LVs and Partitions ウィンドウ（右側）の LD フィールドは動的です。
これは、論理ドライブが作成および削除されるときに変更されます。この例では、LD2 が削除され、

Drives（左側）で、LG フィールドは動的ではありません。空のスロットは、LD2 が削除されたこと
LD4 が LD3 になり、LD2 が LD1 になります。端末メニュー オプション View and Edit Logical 

を示します。
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▼ パーティションを作成する

注 – パーティションを作成するには、先にすべての割り当て済み LUN をマップ解除
する必要があります。

1. 適切なアレイを選択します。

2. パーティションを作成する論理ドライブを表示します。

3. いずれかの論理ドライブにホスト LUN が割り当てられている場合はステップ 4 へ進
みます。割り当てられていない場合はステップ 8 へ進みます。

4. Configuration → Custom Configure を選択します。

5. Change Host LUN Assignments を選択します。

6. パーティションを分割する論理ドライブに接続しているホスト LUN を選択し、Unmap
Host LUN をクリックします。

7. OK をクリックして、Close をクリックします。

8. Configuration → Custom Configure を選択します。

9. Custom Configuration Options ウィンドウで Manage Existing LDs/LVs and Partitions
を選択します。

10. Partitions タブを選択します。

11. パーティションする論理ドライブまたは論理ボリュームを選択します。

12. Partition Size をメガバイトで指定し、Create をクリックします。

同じサイズのパーティションを複数作成するには、作成するパーティションの数だけ
Add Partition をクリックします。Part Size フィールドにパーティションのサイズを
入力し、100*128 のように、作成するパーティションの数を掛けてサイズを指定する
こともできます。この指定サイズの残りの容量は、 後のパーティションに追加され
ます。

パーティションを追加するたび、Available Size (MB) に表示される残りの容量は、追
加したパーティションのサイズ分減少します。

13. 作成したパーティションのサイズを変更するには、その論理ドライブまたは論理ボ
リュームを選択し、Modify Size をクリックします。

14. Partition Size フィールドで、新しいサイズをメガバイトで指定し、OK をクリックし
ます。
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15. Confirm Configuration Operation ウィンドウで、OK をクリックして操作を完了し、
Close をクリックします。

論理ドライブまたは論理ボリュームのパーティションを分割した後、メイン ウィン
ドウで論理ドライブまたは論理ボリュームを開くと、そのパーティションが表示され
ます  。

論理ドライブ／論理ボリューム番号

Manage Existing LDs/LVs and Partitions ウィンドウの LDs/LVs フィールドに表示
される論理ドライブ／論理ボリューム番号に関する重要な情報は、154 ページの「論
理ドライブ／論理ボリューム番号」を参照してください。
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▼ パーティションを削除する

注 – 論理ドライブまたは論理ボリューム上のパーティションを削除するには、すべ
ての割り当て済み LUN をマップ解除する必要があります。

1. 適切なアレイを選択します。

2. パーティションを削除する論理ドライブまたは論理ボリュームを表示します。

いずれかのドライブ上のパーティションにホスト LUN がマップされている場合はス
テップ 3 へ進みます。マップされていない場合はステップ 7 へ進みます。

3. Configuration → Custom Configure を選択します。

4. Change Host LUN Assignments を選択します。

5. 削除する論理ドライブまたは論理ボリュームにマップされている LUN を選択し、Unmap
Host LUN をクリックします。

6. OK をクリックして、Close をクリックします。

7. Configuration → Custom Configure を選択します。

8. Custom Configuration Options ウィンドウで Manage Existing LDs/LVs and Partitions
を選択します。

9. Partitions タブを選択します。

10. 論理ドライブまたは論理ボリューム内で変更または削除するパーティションを選択し
ます。論理ドライブまたは論理ボリューム内の最後のパーティションから選択を開始
します。

11. Delete をクリックして、OK をクリックします。
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12. Confirm Configuration Operation ウィンドウで、OK をクリックして操作を完了し、
Close をクリックします。

▼ 論理ドライブまたは論理ボリュームの容量を拡張
する

このオプションを使い、既存の論理ドライブまたは論理ボリュームの容量を拡張しま
す。たとえば、18 ギガバイトのドライブがあり、その 9 ギガバイトだけを選択して
論理ドライブを構築してあったとします。残りの 9 ギガバイトを使用するには、論理
ドライブを拡張する必要があります。

注 – 論理ボリュームを拡張するには、まずその論理ドライブを構成する論理ドライ
ブを拡張する必要があります。

1. 適切なアレイを選択します。

2. Configuration → Custom Configure を選択します。

3. Custom Configuration Options ウィンドウで Dynamically Grow and/or Reconfigure
LDs/LVs を選択します。

4. 拡張する論理ドライブまたは論理ボリュームを選択します。

5. Expand LD/LV タブを選択します。
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6. Maximum Drive Expand Capacity フィールドで、論理ドライブまたは論理ボリュー
ムを拡張する容量をメガバイトで指定し、OK をクリックします。

Maximum Drive Expand Capacity に指定する値は、Maximum Available Drive Free
Capacity を超えることはできません。

7. Confirm Configuration Operation ウィンドウで、OK をクリックして操作を完了し、
Close をクリックします。

論理ドライブ／論理ボリューム番号

Dynamically Grow and/or Reconfigure LDs/LVs ウィンドウの LD/LV フィールド
に表示される論理ドライブ／論理ボリューム番号に関する重要な情報は、154 ページ
の「論理ドライブ／論理ボリューム番号」を参照してください。

▼ SCSI ドライブを既存の論理ドライブに追加する 
1. 適切なアレイを選択します。

2. Configuration → Custom Configure を選択します。

論理ドライブの作成時に
その全容量を使用すると、
0 が表示され、別の
論理ドライブを追加しない限り

拡張する領域がないことが
示されます。
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3. Custom Configuration Options ウィンドウで Dynamically Grow and/or Reconfigure
LDs/LVs を選択します。

4. SCSI ドライブを追加する論理ドライブを選択します。

5. Add SCSI Drives タブを選択します。

6. Available disks リストから、論理ドライブに追加するドライブを選択します。

7. Add Disk をクリックします。

選択したドライブが Add disk(s) to LD リストに移動されます。

選択を間違えた場合や変更したい場合は、Add disk(s) to LD リストからそのディス
クを選択し、Remove をクリックします。

8. SCSI ドライブの追加が終了したら、OK をクリックします。

9. Confirm Configuration Operation ウィンドウで、OK をクリックして操作を完了し、
Close をクリックします。

論理ドライブ／論理ボリューム番号

Dynamically Grow and/or Reconfigure LDs/LVs ウィンドウの LD/LV フィールド
に表示される論理ドライブ／論理ボリューム番号に関する重要な情報は、154 ページ
の「論理ドライブ／論理ボリューム番号」を参照してください。
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▼ メンバー ドライブをコピーして交換する 
既存のメンバー ドライブをより大きい容量のドライブにコピーして交換できます。たと
えば、18 ギガバイトの容量の 3 つのメンバ ドライブを含む論理ドライブが 1 つあっ
たとします。下図に示すように、この論理ドライブを、それぞれ 36 ギガバイトの容
量の新しいメンバ ドライブと交換することができます。

図 11-1 メンバー ドライブのコピーと交換

1. 適切なアレイを選択します。

2. Configuration → Custom Configure を選択します。

3. Custom Configuration Options ウィンドウで Dynamically Grow and/or Reconfigure
LDs/LVs を選択します。

4. コピーと交換操作を行う対象の論理ドライブを選択します。

5. Dynamically Grow and/or Reconfigure LDs/LVs ウィンドウで Copy and Replace
Drive タブを選択します。

6. Drive to Copy Data From リストから、新しいハード ドライブを選択します。

7. Drive to Copy Data To リストから、交換されるハード ドライブを選択し、OK をク
リックします。

18 GB18 GB18 GB
新しい

36 GB

36 (GB)36 (GB) 36 (GB)

RAID5 (4 GB)

使用中

未使用

新しい

36 GB

新しい

36 GB

RAID5 (4 GB)

ドライブ ドライブ ドライブ
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新しいドライブで提供される追加容量を使用する方法は、158 ページの「論理ドライ
ブまたは論理ボリュームの容量を拡張する」を参照してください。

8. Confirm Configuration Operation ウィンドウで、OK をクリックして操作を完了し、
Close をクリックします。

9. 操作が完了したら、進行状況ウィンドウを閉じます。

論理ドライブ／論理ボリューム番号

Dynamically Grow and/or Reconfigure LDs/LVs ウィンドウの LD/LV フィールド
に表示される論理ドライブ／論理ボリューム番号に関する重要な情報は、154 ページ
の「論理ドライブ／論理ボリューム番号」を参照してください。

▼ 新しいハード ドライブをスキャンする        
ハード ドライブは、アレイをシャットダウンせずに、スキャンして使用可能にすること
ができます。
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1. 適切なアレイをダブルクリックします。

2. View Controller Configuration ウィンドウが表示されます。

3. Physical Drives タブを選択し、Scan SCSI Drive をクリックします。

4. ドライブの正しい入力チャネルと ID を選択します。

スキャンに成功すると、そのドライブが正しく表示され、使用可能になります。
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▼ RAID コントローラ ファームウェアをダウンロー
ドする

コントローラ ファームウェアをアップグレードするための次の手順は、単一コントロー
ラ構成と冗長コントローラ構成の両方に使用できます。

1. メイン ウィンドウで、必要なコントローラのアイコンを選択します。

2. Array Administration → Controller Maintenance を選択します。

3. ssconfig としてログインしていない場合は、パスワードを求めるプロンプトが表示
されます。ssconfig パスワードを入力します。

Controller Maintenance Options メニューが表示されます。

 

4. ファームウェアだけ（ブート レコードを含まない）をアップグレードする場合は、
Download Firmware オプションを選択します。

Select Firmware File ウィンドウが表示されます。
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5. ダウンロードするファームウェアを選択し、Open をクリックします。

確認を求める Confirmation Dialog プロンプトが表示されます。

6. Yes をクリックします。

ファームウェアを RAID コントローラへダウンロードする進行状況バーが表示されます。

7. 進行状況バーが 100% に達したら、OK をクリックします。

8. ファームウェアがダウンロードされた後、設定が正しいことを確認してください。
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▼ ファームウェアとブート レコードをアップグレー
ドする

1. Array Administration → Controller Maintenance を選択します。

2. ssconfig としてログインしていない場合は、パスワードを求めるプロンプトが表示
されます。ssconfig パスワードを入力します。

Controller Maintenance Options メニューが表示されます。

3. Download Firmware with Boot Record を選択します。

Select Boot Record File ウィンドウが表示されます。

4. ブート レコードを選択し、Open をクリックします。

5. 必要なファームウェア ファイルを選択します。

Select Firmware File ウィンドウが表示されます。

6. Open をクリックします。

Confirmation Dialog ウィンドウが表示されます。

7. 前のサブセクションのステップ 6～8 を繰り返します。
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デバイスのファームウェアのダウンロード
このオプションを使い、ハード ドライブと SAF-TE/SES デバイスのファームウェア
をアップグレードします。

▼ ハード ドライブのファームウェアをアップグレー
ドする

1. 適切なアレイを選択します。

2. Array Administration → Download FW for Devices を選択します。

3. Download FW for Disks タブをクリックします。

4. To All disks under Controller を選択してメニューからアレイを選択するか、または
To All disks under LD を選択してメニューから論理ドライブを選択します。

■ 新しいファームウェアをダウンロードしたくないドライブがある場合は、それら
を Selected Disks リストから選択し、Remove をクリックします。

■ 追加する論理ドライブがある場合は、それらを Available Disks リストから選択し、
Add をクリックします。

■ 異なる製品 ID を持つ複数のドライブがある場合は、ファームウェアをダウンロー
ドするドライブの製品 ID を Product ID リストボックスから選択する必要があり
ます。
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5. Browse をクリックし、ダウンロード ファームウェア ファイルを探します。

Open をクリックします。

6. ダウンロード ファームウェア ファイルを選択し、Open をクリックして、OK をク
リックします。

ファームウェアのダウンロードが開始されます。

7. 進行状況が 100% に達したら、OK をクリックします。

8. ファームウェアが正しくダウンロードされたことを確認するには、View → View Physical
Drive を選択し、Product Revision フィールドのファームウェア バージョンが更新さ
れたことを確認します。

▼ SAF-TE/SES デバイスのファームウェアをアップ
グレードするには 

注 – SAF-TE デバイスは、SCSI アレイによって使用され、SES デバイスはファイバ
チャネル アレイによって使用されます。

1. アレイを選択します。

2. Array Administration → Download FW for Devices を選択します。
168 Sun StorEdge 3000 Family Configuration Service 1.3 ユーザ ガイド • 2003 年 6 月



3. Download FW for SAFTE/SES Devices タブをクリックします。

■ デバイスを追加するには、それを Available SAF-TE Devices リストから選択し、
Add をクリックします。

■ デバイスを削除するには、それを Selected SAF-TE Devices リストから選択し、
Remove をクリックします。

4. Browse をクリックし、ダウンロード ファームウェア ファイルを探します。

5. ダウンロード ファームウェア ファイルを選択し、Open をクリックして、OK をク
リックします。

ファームウェアのダウンロードが開始されます。

6. 進行状況が 100% に達したら、OK をクリックします。

7. ファームウェアが正しくダウンロードされたことを確認するには、View → View Enclosure
を選択し、 Firmware Rev フィールドのファームウェア バージョンが更新されたことを確
認します。

▼ コントローラのパラメータを変更する

1. メイン メニューから適切なアレイ コントローラを選択します。

2. Configuration → Custom Configure を選択します。

必要であれば、ssconfig パスワードを使って、プログラムの構成レベルにログイン
します。Custom Configuration Options ウィンドウが表示されます。
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3. Custom Configuration Options ウィンドウで、Change Controller Parameters を選択
します。

Change Controller Parameters ウィンドウが開き、Channel タブが表示されます。

注 – Sun StorEdge 3510 FC アレイでは、CurClk は 2.0 GHz です。

■ Controller Name - コントローラ名を設定する場合は、Controller Name を選択
し、希望の名前を入力します。OK をクリックして変更を保存します。

■ Controller Unique ID - この ID は自動的に設定されます。

▼ 変更した値を保存するには

Change Controller Parameters ウィンドウのオプションの中には、変更を有効にする
ためにコントローラのリセットを必要とするものもあります。変更後、コントローラ
のリセットが必要な場合は、ウィンドウの左下に次のメッセージが表示されます。

[Controller reset is required for changes to take effect.]

コントローラをリセットし、変更値を保存するには、変更時に Issue Controller Reset
チェック ボックスをオンにするか、Controller Maintenance ウィンドウを使用して
コントローラを後でリセットします（143 ページの「コントローラをリセットする」
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を参照）。複数の変更を行うときは、1 つ変更するたびに中断してコントローラをリ
セットしたくない場合もあります。Issue Controller Reset チェック ボックスを選択
せずに変更して、リセットが必要な場合は、OK をクリックすると警告メッセージが
表示されます。

1. Issue Controller Reset チェック ボックスを選択します。

2. 変更を加え、OK をクリックします。

または

1. Issue Controller Reset チェック ボックスを選択せずに、

2. 変更を加え、OK をクリックします。

3. 143 ページの「コントローラをリセットする」に記載された手順でコントローラをリ
セットします。

Channel タブ

1. Channel Settings タブで、編集するチャネルを選択します。

2. Change Settings をクリックします。

Change Channel Settings ウィンドウが表示されます。サーバがアレイを認識するに
は、ホスト チャネルの ID を論理ドライブに割り当て、論理ドライブをそのホスト
チャネルと ID にマップしなければなりません。このウィンドウを使用すると、ホス
ト／ドライブ チャネルを構成できます。
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3. Channel Mode リストボックスから、Host または Drive を選択します。

Drive チャネルは、ドライブが接続されるチャネル（内部または外部）です。Host チャ
ネルは、サーバに接続されるチャネルです。

注 – コントローラの構成によっては、次の手順で説明するように、プライマリとセ
カンダリ両方のチャネル ID を選択する必要がある場合があります。

4. Available SCSI IDs リストボックスから、PID と呼ばれるプライマリ チャネル ID を
選択します。Add PID をクリックします。

5. コントローラが 2 つある場合は、Available SCSI IDs リストボックスからセカンダリ
ID を選択し、Add SID をクリックします。

6. 変更を有効にするには、コントローラをリセットします。

ファイバ構成内のホスト ID を変更する

1. 15 より上の ID を使用する場合は、Select SCSI ID Range をクリックし、希望の範
囲を選択します。

注 – 各チャネルの ID は同じ範囲内にある必要があります。

2. Remove をクリックして、PID または SID を削除します。
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3. 選択を終えたら、OK をクリックして前のウィンドウに戻ります。

RS 232 タブ

1. チャネル設定をすべて終了した後、Change Controller Parameters ウィンドウで、RS
232 タブを選択します。

2. 必要なポートを選択し、Change Settings をクリックします。

Change RS232 Port Settings ウィンドウが表示されます。

3. デフォルト設定の 9600 も含め、希望の任意のボーレートを選択し、OK をクリック
して前のウィンドウに戻ります。
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Cache タブ

Optimization

Cache タブから論理ドライブの 適化モードを選択できます。このモードで、アレイ
内の各ドライブにわたって書き込まれるデータの量を指定します。Sequential I/O は、
大きなデータ ブロック（128KB）を示します。Random I/O は、小さなデータ ブ
ロック（32KB）を示します。

アレイを使用するアプリケーションのタイプによって、ランダムとシーケンシャルのう
ち、どちらの I/O を適用すべきかが決まります。ビデオ/画像アプリケーションの I/O
サイズは 128 KB、256 KB、512 KB、または 1 MB なので、アプリケーションはドライ
ブとの間でデータを大きなブロックのシーケンシャル ファイルで読み書きします。デー
タベース / トランザクション処理アプリケーションでは、このファイルが小さなブロッ
クのランダム アクセス ファイルになります。

適化モードには、次の 2 つの制限が適用されます。

■ 1 つの 適化モードを RAID アレイを構成するすべての論理ドライブに適用しなけ
ればなりません。

■ いったん 適化モードを選択してデータが論理ドライブに書き込まれると、 適
化モードを変更するには、すべてのデータのバックアップを別の場所に取って各
ドライブの論理構成をすべて削除し、論理ドライブを新しい 適化モードで再構
成してアレイを再起動する、という方法しか取れなくなります。

注 – Sequential I/O 用に 適化された論理ドライブの 大サイズは、2 TB です。ラ
ンダム I/O 用に 適化された論理ドライブの 大サイズは、512 GB です。これらの
上限を超える論理ドライブを作成しようとすると、エラー メッセージが表示されます。
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ランダム最適化およびシーケンシャル最適化で使用可能な最大ディ
スク数と最大ディスク容量

ランダム 適化とシーケンシャル 適化のどちらを使用するか選択すると、アレイを
構成する 大ディスク数と論理ドライブの 大使用可能容量も決まります。次の表
は、論理ドライブあたりの 大ディスク数と論理ドライブの 大使用可能容量を示し
ています。

注 – アレイを 1 個と拡張ユニットを 2 個使用すると、 大 8 個の論理ドライブと
大 36 個のディスクを使用できます。

注 – 146 ギガバイトのディスクを 36 台使用すると、データ用として使用できないディ
スクが発生することがあります。これらのディスクはスペア用として使用できます。

ライトバック キャッシュ

ライトバックは、キャッシュ書き込み手法の 1 つです。コントローラが、ディスクに
書き込むデータを受け取り、これをメモリー バッファに格納し、データが実際にディス
ク ドライブに書き込まれるまで待たず直ちに、書き込み操作が完了したという信号をホ

表 11-1 2U アレイの論理ドライブあたり 大ディスク数

ディスク
容量（GB）

RAID 5 
ランダム

RAID 5 
シーケン
シャル

RAID 3 
ランダム

RAID 3 
シーケン
シャル

RAID 1 
ランダム

RAID 1 
シーケン
シャル

RAID 0 
ランダム

RAID 0 
シーケン
シャル

36.2 14 31 14 31 28 36 14 36

73.4 7 28 7 28 12 30 6 27

146.8 4 14 4 14 6 26 3 13

表 11-2 2U アレイの論理ドライブあたり 大使用可能容量（GB）

ディスク
容量

RAID 5 
ランダム

RAID 5 
シーケン
シャル

RAID 3 
ランダム

RAID 3 
シーケン
シャル

RAID 1 
ランダム

RAID 1 
シーケン
シャル

RAID 0 
ランダム

RAID 0 
シーケン
シャル

36.2 471 1086 471 1086 507 543 507 1122

73.4 440 1982 440 1982 440 1101 440 1982

146.8 440 1908 440 1908 440 1908 440 1908
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スト動作環境に送信します。ライトバック キャッシングでは、書き込み操作とコント
ローラ カードのスループットが向上します。ライトスルーは、キャッシュ書き込み
手法の 1 つで、コントローラはディスク ドライブへのデータ書き込みが完了してか
ら、ホスト動作環境にプロセスが完了したことを送信します。ライトスルー機能は下
位の書き込み機能で、万一停電が発生した場合には、より安全であるといえます。
バッテリ モジュールが組み込まれているため、メモリにキャッシュされたデータに
は停電時も電源が引き続き供給され、キャッシュされた書き込みは電源復旧時に完了
されます。

1. Change Controller Parameters ウィンドウで、Cache タブを選択します。

2. リストボックスから Optimization を選択するか、現在の設定を受け入れます。

3. Write Back キャッシュを指定するには、そのリストボックスをクリックして、Enabled
を選択します。

Write Back が無効な場合は、キャッシュ書き込み手法として Write-Through が選択
されます。

4. 変更を有効にするには、コントローラをリセットします。

Disk Array タブ

1. Change Controller Parameters ウィンドウで、Disk Array タブを選択します。
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2. 3 つの Write Verify リストボックスから、Disabled または Enabled を選択します。

通常、エラーはハード ドライブへの書き込み時に発生します。書き込みエラーを防
ぐため、ハード ドライブが書き込まれたデータを検証するようにコントローラで強
制できます。

■ Write Verify on Initialization - 論理ドライブの初期化中に書き込み後の検証を実行
する。

■ Write Verify on Rebuild - 再構築プロセス中に書き込み後の検証を実行する。

■ Write Verify on Normal - 通常の I/O 要求時に書き込み後の検証を実行する。

3. Rebuild Priority リストボックスで、使用可能な 4 つのオプションである、Low、
Normal、Improved、または High から選択します。

RAID コントローラは、バックグラウンドでの再構築機能を提供します。つまり、コ
ントローラは、論理ドライブの再構築中にほかの I/O 要求を処理できます。ドライ
ブの再構築に要する時間は主に、再構築する論理ドライブの合計容量に依存します。
また、再構築処理はホスト コンピュータまたは動作環境から完全にトランスペアレ
ントです。

■ Low - デフォルト設定。コントローラの 小のリソースを再構築に使用する。

■ Normal - 再構築プロセスを速める。

■ Improved - 再構築プロセスにより多くのリソースを割り当てる。

■ High - コントローラのリソースを 大限に使って 短時間で再構築処理を完了する。
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Drive I/F タブ

1. Change Controller Parameters ウィンドウで、Drive I/F タブを選択します。

2. SCSI Motor Spin Up フィールドで、Disabled または Enabled を選択します。

SCSI Motor Spin Up は、ディスク アレイ内の SCSI ドライブの始動方法を指定しま
す。同時に電源投入されたハード ドライブとコントローラに電源装置が十分な電流
を供給できない場合、ハード ドライブを順次にスピンアップするのが、電源投入時
の消費電流を低下させる 良の方法の 1 つです。デフォルトでは、電源投入時に全部
のドライブがスピンアップします。

3. Power Up SCSI Reset フィールドで、Enabled または Disabled を選択します。

コントローラは、電源が入るとデフォルトで SCSI バス リセット コマンドを SCSI バ
スに送ります。これを無効化すると、コントローラは次回電源投入時に SCSI バス リ
セット コマンドを送信しません。

デュアル ホスト コンピュータを同じ SCSI バスに接続すると、SCSI バス リセットは、
実行中のすべての読み取り／書き込み要求に割り込みます。これにより、動作環境ま
たはホスト コンピュータが誤動作することがあります。このような状態を避けるた
め、電源投入時の Power Up SCSI Reset は無効（Disable）に設定してください。

4. Disk Access Latency を設定します。

この機能は、電源投入後にコントローラがハード ドライブにアクセスを試みるまでの遅
延時間を設定します。デフォルトは 15 秒です。

5. Tag Count Per drive を設定します。

これは、各ドライブに同時に送信できるタグの 大数です。ドライブには内蔵キャッ
シュがあり、ドライブはこれを使用して、受け取るすべての I/O 要求（タグ）を分
類するので要求をより速く完了できます。

キャッシュ サイズとタグ 大数は、ドライブのブランドとモデルにより異なります。デ
フォルト設定の 32 を使用します。 大タグ カウントを Disable に変更すると、ドラ
イブの内部キャッシュは無視されます（使用されなくなります）。

コントローラは、1～128 の調節可能タグ カウントのタグ コマンドをキューに入れて
処理できます。

6. SAF-TE Polling Period (Sec) フィールドで、リストボックスからさまざまな時間オプ
ションを選択するか、または 0.0 を選択してこのオプションを無効にします。無効に
した場合、インストール済みのすべてのイベント報告モジュール（ERM）はポーリ
ングされません。
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7. SCSI I/O Timeout (Sec) フィールドで、0.5～10 秒の値を選択します。

SCSI I/O Timeout は、コントローラがドライブからの応答を待つ時間間隔です。コ
ントローラがドライブに対して読み取りや書き込みを試みたときに、ドライブが
SCSI I/O タイムアウト値内に応答しない場合、そのドライブは故障ドライブと見な
されます。

SCSI I/O Timeout のデフォルト設定はファイバ チャネルで 7 秒、SCSI で 15 秒で
す。この設定は変えないでください。これより低いタイムアウト値を設定すると、ド
ライブがまだ処理を再試行中の場合や、ドライブがまだ SCSI バスと調停できていな
い場合でもコントローラがドライブを故障していると判断してしまう恐れがありま
す。また、上記より高いタイムアウト値を設定すると、コントローラのドライブ待機
中にホスト側がタイムアウトしてしまう恐れが出てきます。

ドライブ盤からの読み取り中にドライブがメディア エラーを検出すると、ドライブは前
の読み取りを再試行するか、ヘッドを再調整します。ドライブは、メディア上に不良
ブロックを見つけると、その不良ブロックを同じディスク ドライブ上の別のスペア ブ
ロックに再割り当てします。ただし、この処理は時間がかかります。これらの操作実
行にかかる所要時間はドライブのブランドとモデルにより異なります。

SCSI バス調停の際、より高い優先順位のデバイスがバスを 初に使用します。より
低い優先順位のデバイスは、優先順位の高いデバイスがバスを使い続けていると、
SCSI I/O Timeout を受け取ることがあります。

8. Drive Check Period (Sec) フィールドで、0.5～30 秒の値を選択します。

Periodic Drive Check Time は、SCSI バス上のドライブをコントローラが確認する時
間間隔です。デフォルト値は Disabled です。これは、バス上で何も活動がない場合、
コントローラからはドライブの故障や削除を認識できないことを意味します。この間
隔を設定すると、アレイ活動がないときでもドライブの故障を検出できます。ただ
し、パフォーマンスが低下します。
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Host I/F タブ

1. Change Controller Parameters ウィンドウで、Host I/F タブを選択します。

2. Max Queued IO Count を設定します。

この機能を使い、コントローラがホスト コンピュータから受け入れることができる I/O
キューの 大サイズをバイト単位で設定します。デフォルトは 256 バイトです。定義済み
の範囲は 1～1024 バイトですが、Auto Computer（自動的に設定する）モードを選択する
こともできます。

3. LUNs Per Host を設定します。

この機能は、ホスト SCSI ID あたりの LUN 数を変更するために使います。デフォル
ト設定は 32 LUN で、使用可能な事前定義された範囲は 1 ～ 32 LUN です。

4. 変更を有効にするには、コントローラをリセットします。
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Redundancy タブ

1. Change Controller Parameters ウィンドウで、Redundancy タブを選択します。

3 つの読み取り専用のフィールド、Controller Configuration、Controller Status、お
よび Secondary Serial No. が表示されます。

2. Set Controller Config フィールドで、オプションを選択します。

■ Redundant Deassert Reset - 故障したコントローラをオンラインに戻す場合。

■ Redundant Force Sec Fail - セカンダリ コントローラを強制的に故障させる場合。

■ Redundant Force Pri Fail - プライマリ コントローラを強制的に故障させる場合。
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注 – 冗長プライマリ構成で両方のコントローラを設定してください。両方を設定し
ておくと、どれがプライマリでどれがセカンダリであるかコントローラによって判断
され、コントローラ間の競合を防ぐことができます。

3. 変更を有効にするには、コントローラをリセットします。

4. Close をクリックして、メイン メニューに戻ります。

Network タブ

1. Change Controller Parameters ウィンドウで、Network タブを選択します。

2. IP アドレス、サブネット マスク、またはゲートウェイ アドレスを手動で設定するに
は、Change Settings をクリックします。

3. DHCP/RARP サーバの環境でアレイを設定してある場合、Enable Dynamic IP Assignment
を選択して、アレイでネットワークから自動的に IP アドレスを取得できます。
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▼ コントローラのビープ音を消音する

コントローラがビープ音を発するようなイベントが発生した場合、たとえば、再構築
中や SCSI ドライブの追加中に論理ドライブが故障した場合、ビープ音を下記のいず
れかの方法で消音することができます。

1. メイン ウィンドウで、必要なコントローラのアイコンを選択します。

2. Array Administration → Controller Maintenance を選択します。

3. ssconfig としてログインしていない場合は、パスワードを求めるプロンプトが表示
されます。ssconfig パスワードを入力します。

Controller Maintenance Options メニューが表示されます。

4. Mute Controller Beeper をクリックします。

または

1. メイン ウィンドウで、必要なコントローラのアイコンを選択します。

2. Configuration → Custom Configure を選択します。
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3. Change Controller Parameters を選択します。

4. Mute Beeper を選択します。

▼ スタンバイ ドライブを指定または変更する

スタンバイ ドライブは、フォールト トレラント（非 RAID 0）論理ドライブが故障
した場合にデータの自動再構築をサポートするスペアとして機能します。別のドライ
ブに取って代わるスタンバイ ドライブは、故障したドライブと少なくとも同じサイズで
なければなりません。また、故障したディスクに従属するすべての論理ドライブが冗
長（RAID 1、3、5、または 1+0）でなければなりません。

この機能を使い、グローバルまたはローカルのスタンバイ ドライブを指定することや、
準備完了ドライブの状態をスタンバイに変更したり、スタンバイ ドライブの状態を準備
完了に変更したりできます。グローバル スペアとして指定されているドライブは、既存
のどのドライブのメンバーが故障した場合でも再構築します。アレイ コントローラ
に 1 つまたは複数のスタンバイ ドライブを関連付けることができます。ローカル ス
ペアは、特定の論理ドライブに割り当てる必要があり、その論理ドライブ内のメン
バー用にのみ再構築します。

1. メイン ウィンドウで、目的のアレイ コントローラを選択します。

2. Configuration → Custom Configure を選択するか、Custom Configuration ツールをク
リックします。

必要であれば、ssconfig パスワードを使って、プログラムの構成レベルにログイン
します。Custom Configuration Options ウィンドウが表示されます。

3. Custom Configuration Options ウィンドウで Make or Change Standby Drives を選択
します。

Make or Change Standby Drives ウィンドウが表示されます。
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4. ウィンドウ上部に表示されるサーバーとコントローラ ID を確認します。

別のサーバまたはコントローラを選択する場合は、Cancel をクリックして メイン
ウィンドウに戻り、必要なサーバまたはコントローラを選択してからステップ 2 と 3
を繰り返します。

5. 指定または変更するドライブを選択します。

6. ドライブの状態を、Ready（準備完了）、Global StandBy（グローバル スタンバイ）、
または StandBy for LD#（ローカル）から選択して指定または変更します。

7. Modify をクリックします。

8. Apply をクリックして、Close をクリックします。

9. 構成を変更した場合は必ず、新しい構成をファイルに保存してください。（詳細は、
85 ページの「構成ファイル」を参照してください。） 

使用可能サーバー
Server List Setup ウィンドウの Available（使用可能）リストまたは Managed Servers
（被管理サーバ）リストのエントリを削除または変更することが必要な場合もあります。
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▼ サーバー エントリを編集する

1. File → Server List Setup を選択します。Server Setup ウィンドウが表示されます。

必要に応じて、Server List Setup ウィンドウで、サーバ名を Managed Servers リス
トから Available Servers リストに移動します。編集できるのは、Available Servers
リストに表示されているサーバだけです。

 

2. Available Servers リストからサーバ名を選択し、Edit をクリックします。

Edit Server ウィンドウが表示されます。
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3. 必要な変更を行います。OK をクリックして変更を保存します。

このウィンドウのフィールドの説明は、42 ページの「サーバを追加するには」を参照し
てください。Add Server ウィンドウと Edit Server ウィンドウに表示されるフィール
ドは同じです。

IP アドレス ショートカット: ネットワーク アドレスが変更されている場合は、Get IP
Addr by Name をクリックします。サーバーの名前はネットワークで使用するネーム
サービスによって記録されているため、サーバー名を入力すると、その正しい IP ア
ドレスが検索され、表示されます。

サーバに使用する名前がサーバのネットワーク名と同じでない場合や、ネーム サー
ビスがまだ更新されていない場合は、そのサーバを削除して追加し直します。

4. サーバ名を Managed Servers リストに戻します。

5. OK をクリックして Edit Server ウィンドウを終了します。
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付録 A

RAID の基本

この付録では、RAID 用語の概要や RAID レベルなど、RAID に関する基本知識を提
供します。取り上げるトピックは以下のとおりです。

■ 189 ページの「RAID 用語の概要」
■ 195 ページの「RAID レベル」
■ 202 ページの「ローカル スペア ドライブとグローバル スペア ドライブ」

RAID 用語の概要
RAID（独立ディスクの冗長アレイ）は、ストレージ システムの処理能力の改善に使
われるストレージ テクノロジです。このテクノロジでは、ディスク アレイ システム
の信頼性を確保し、単一ディスク ストレージ上の複数のディスク アレイが提供する
パフォーマンスの向上を得ることができます。

RAID には以下の 2 つの基本的概念があります。 

■ 複数のハード ドライブ上にデータを分散させ、パフォーマンスを向上させる。

■ 複数のドライブを適切に使用することで、どのドライブが故障してもデータの損
失やシステム ダウンタイムが発生しないようにする。

ディスク障害が発生した場合でも、ディスクへのアクセスは正常に継続され、障害は
ホスト システムに透過的です。
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論理ドライブ

論理ドライブは、独立した物理ドライブのアレイです。論理ドライブの作成により、
より優れた可用性、容量、およびパフォーマンスが実現されます。論理ドライブは、
ホストにとってローカル ハード ディスク ドライブと同様に認識されます。 

図 A-1 複数の物理ドライブを含む論理ドライブ

論理ボリューム

論理ボリュームは、複数の論理ドライブによって構成されます。論理ボリュームは、
SCSI では 大 32 のパーティションに、ファイバ チャネルでは 大 128 のパーティ
ションに分割できます。動作時にホストは、パーティションで分割されていない論理
ボリューム 1 つ、または論理ボリュームのパーティション 1 つを単一の物理ドライブ
として認識します。

ローカル スペア ドライブ

ローカル スペア ドライブは、１つの指定論理ドライブに割り当てられるスタンバイ
ドライブです。この指定論理ドライブのメンバー ドライブが故障すると、ローカル
スペア ドライブは自動的にメンバー ドライブとなりデータの再構築を始めます。

グローバル スペア ドライブ

グローバル スペア ドライブは、指定した 1 つの論理ドライブだけのスタンバイとし
て働くのではありません。任意の論理ドライブのメンバー ドライブが故障すると、
グローバル スペア ドライブはその論理ドライブのメンバーとなり、自動的にデータ
の再構築を始めます。
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SCSI チャネル

SCSI チャネル（SCSI バス）は、ワイド機能（16 ビット SCSI）が使用可能な場合、
大 15 のデバイス（コントロール自身を除く）に接続できます。ファイバ チャネル

を使用すると、ループあたり 大 125 のデバイスを接続できます。各デバイスは固有
の SCSI ID を 1 つ持っています。

図 A-2は、この概念を図式化したものです。たとえば文書をキャビネットに保管する
とき、いずれかの引出しに入れる必要があります。SCSI から見ると、SCSI ID はキャ
ビネットのようなもので、引出しが LUN（論理ユニット）に相当します。各 SCSI
ID は 32 個の LUN を使用できます。データは SCSI ID の LUN の 1 つに保存できま
す。ほとんどの SCSI ホスト アダプタは LUN を別の SCSI デバイスのように扱います。

図 A-2 SCSI ID/LUN

論理ドライブは、SCSI またはファイバ チャネル ドライブのグループで構成されます。
同じ論理ドライブ内の物理ドライブが、同じ SCSI チャネルに接続されている必要はあ
りません。また、各論理ドライブを、異なる RAID レベルに構成することも可能です。
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ドライブは、1 つの論理ドライブ専用のローカル スペア ドライブとして指定するこ
とも、グローバル スペア ドライブとして指定することもできます。スペアは、デー
タ冗長性を持たないドライブ（RAID 0）には使用できません。 

図 A-3 論理ドライブ構成内のドライブの割り当て

ドライブ チャネル 0

論理ドライブ 1

グローバル スペア LD1 のローカル スペア

論理ドライブ 0

ドライブ チャネル 1

4
GB

4
GB

2
GB

2
GB

4
GB

4
GB

2
GB

2
GB

ID5 ID0

ID6 ID1 ID0 ID14

ID3 ID2

RAID 5
8 GB

RAID 3
6 GB
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論理ドライブまたは論理ボリュームを複数のパーティションに分割することや、論理
ドライブ全体を 1 つのパーティションとして使用することができます。

図 A-4 論理ドライブ構成内のパーティション

論理ドライブ 0

RAID 5（8 GB）

論理ドライブ 1

RAID 3（6 GB）

パーティション 0 2 GB

パーティション 1 1 GB

パーティション 2 5 GB

パーティション 0 2.5 GB

パーティション 1 1.5 GB

パーティション 2 2 GB
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各パーティションは、ホスト SCSI ID 下の LUN、またはホスト チャネル上の ID に
マップされます。各 SCSI ID/LUN は、ホスト コンピュータにとって 1 つの個別の
ハード ドライブとして機能します。

図 A-5 パーティションからホスト ID/LUN へのマッピング

ID 0 ID 1

LUN 0 LUN 0

LUN 1 LUN 1

LUN 2 LUN 2

論理ドライブ 1
パーティション 0

論理ドライブ 0
パーティション 1

論理ドライブ 1
パーティション 2

論理ドライブ 0
パーティション 2

論理ドライブ 1
パーティション 1

論理ドライブ 0
パーティション 0

2.5 GB

1 GB

5 GB

1.5 GB

2 GB

2.5 GB
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図 A-6 パーティションを ID 下の LUN にマップする

RAID レベル
RAID アレイを実装する場合、ミラーリング、ストライピング、デュプレキシング、
パリティ テクノロジを適宜組み合わせたいくつかの方法があります。これらの手法
を RAID レベルといいます。レベルごとに、パフォーマンス、信頼性、およびコスト
が異なります。フォールト トレランスを実装するために、レベルごとに異なるアル
ゴリズムが採用されています。

RAID レベルには、RAID 0、1、3、5、1+0、3+0（30）、および 5+0（50）という 7
つの選択肢があります。このうち、RAID レベル 1、3、5 がもっとも一般的に使用さ
れています。

次の表は、RAID レベルについて簡単にまとめたものです。 

表 A-1 RAID レベルの概要

RAID レベル 説明
サポートされている
ドライブ数 容量 冗長性

0 ストライピング 2–36 N No

1 ミラーリング 2 N/2 Yes

1+0 ミラーリングとスト
ライピング

4 ～ 36（偶数のみ） N/2 Yes

ID 0

LUN 0LUN 1LUN 2LUN 3LUN 4LUN 5

論理ドライブ 0 論理ドライブ 1

ホスト SCSI チャネル

論理ドライブ 1

論理ドライブ 1
パーティション 0

論理ドライブ 0
パーティション 2

論理ドライブ 0
パーティション 0

パーティション 1パーティション 1 パーティション 2

4.5 GB 5 GB 2 GB

1 GB 1.5 GB 2 GB
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容量とは、データ ストレージとして利用可能な物理ドライブの合計数（N）です。た
とえば、容量が N-1 で、論理ドライブ内のディスク ドライブ合計数が 36 MB のドラ
イブ 6 台の場合、ストレージに利用可能なディスク容量はディスク ドライブ 5 個分
に等しくなります。つまり、5 x 36 MB（180 MB）です。この -1 は全 6 ドライブの
内のストライピング量を示しています。これがデータの冗長性を確保し、サイズは
ディスク ドライブ 1 つ分と同じです。 

RAID 3+0（30）と 5+0（50）の容量は、ボリューム内の各論理ドライブにつき、物
理ドライブの総数（N）から 1 を引いたものです。たとえば、論理ドライブ内に 36
M バイトのディスク ドライブが合計 20 台あり、論理ドライブの総数が 2 台である場
合、ストレージに使用できるディスク空き容量は、ディスク ドライブ 18 個分（18 x
36 MB = 648 M バイト）となります。

RAID 0 

RAID 0 はブロック ストライピングを実装します。ブロック ストライピングでは、
データが複数の論理ブロックに分割されて、いくつかのドライブの間でストライピン
グされます。他の RAID レベルと異なり、冗長性の機能はありません。ディスク障害
が発生した場合は、データが失われてしまいます。

ブロック ストライピングでは、ディスク容量の合計はアレイ内の全ドライブの総容
量と等しくなります。このドライブの組合せは、システムには単一の論理ドライブと
して認識されます。

RAID 0 は 高のパフォーマンスを提供します。これは、アレイ内のすべてのディス
ク間で同時にデータを転送できるからです。さらに、他の独立したドライブへの読み
取り/書き込みも同時に処理できます。

3 専用パリティを持つ
ストライピング

3–31 N-1 Yes

5 分散パリティ付きス
トライピング

3–31 N-1 Yes

3+0 (30) RAID 3 論理ドライ
ブのストライピング

2 ～ 8 台の論理ドラ
イブ

N: 論理ドラ
イブの数

Yes

5+0 (50) RAID 5 論理ドライ
ブのストライピング

2 ～ 8 台の論理ドラ
イブ

N: 論理ドラ
イブの数

Yes

表 A-1 RAID レベルの概要 （続き）

RAID レベル 説明
サポートされている
ドライブ数 容量 冗長性
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図 A-7 RAID 0 構成

RAID 1 

RAID 1 はディスク ミラーリングを実装します。この場合は、同一データのコピーが
2 つのドライブに記録されます。別のディスクにデータのコピーを 2 つ保持すること
で、ディスク障害からデータを保護できます。RAID 1 アレイ内のディスクに障害が
発生した場合、もう一方の正常なディスク（コピー）が必要なすべてのデータを提供
するので、ダウンタイムを回避できます。

ディスク ミラーリングでは、使用可能な容量合計は RAID 1 アレイ内の 1 つのドラ
イブの容量に等しくなります。したがって、たとえば 1 GB のドライブを 2 つ組み合
わせると、使用可能な容量合計が 1 GB の論理ドライブが 1 つ作成されます。このド
ライブの組合せは、システムには単一の論理ドライブとして認識されます。

注 – RAID 1 は拡張できません。RAID レベル 3 および 5 では、既存のアレイにドラ
イブを追加することで拡張が可能です。

論理ドライブ（Logical drive）。

物理ディスク

ストライピング

ブロック 1

ブロック 2

ブロック 3

ブロック 5

ブロック 7

ブロック 1ブロック 3

ブロック 4

ブロック 5

ブロック 6

ブロック 7

ブロック 8

ブロック 4

ブロック 6

ブロック 8

ブロック 2
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図 A-8 RAID 1 構成

RAID 1 ではデータ保護だけでなく、パフォーマンスの向上も実現します。複数の並
行 I/O が発生する場合は、ディスク コピー間でその I/O を分散させて有効なデータ
アクセス時間合計を減らすことができます。

論理ドライブ（Logical drive）。

物理ディスク

ブロック 1

ブロック 2

ブロック 3

ブロック 4

ブロック 5

ブロック 6

ブロック 7

ブロック 8

ブロック 2

ブロック 3

ブロック 4

ブロック 1

ブロック 2

ブロック 3

ブロック 4

ブロック 1
ミラーリング
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RAID 1+0

RAID 1+0 は RAID 0 と RAID 1 の機能、つまりミラーリングとディスク ストライピ
ングを組み合わせたものです。RAID 1+0 を使用すると、1 回のステップで多数の
ディスクをミラーリング用に構成できるため、時間を節減できます。これはユーザが
選択できる標準の RAID レベル オプションではないので、コントローラによってサ
ポートされる RAID レベル オプションのリストには表示されません。RAID 1 論理ド
ライブ用に選択されたハード ディスク ドライブが 4 つ以上ある場合は、自動的に
RAID 1+0 が実行されます。

図 A-9 RAID 1+0 構成

物理ディスク

ミラーリング

ストライ

ミラーリング

論理ドライブ

ブロック 1

ブロック 2

ブロック 3

ブロック 4

ブロック 5

ブロック 6

ブロック 7

ブロック 8

ブロック 2

ブロック 3

ブロック 4

ブロック 1

ブロック 2

ブロック 3

ブロック 4

ブロック 1

ブロック 6

ブロック 7

ブロック 8

ブロック 5

ブロック 6

ブロック 7

ブロック 8

ブロック 5

ピング

（Logical drive）。
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RAID 3 

RAID 3 では専用パリティ付きブロック ストライピングが実装されます。この RAID
レベルでは、データが論理ブロック（ディスク ブロックのサイズ）に分割され、さ
らにこれらのブロックが複数のドライブにストライピングされます。１つのドライブ
がパリティ専用になります。ディスクに障害が発生した場合、パリティ情報と残りの
ディスク上の情報を使用して元のデータを再構築できます。

RAID 3 では、ディスク容量の合計は、パリティ ドライブを除く組み合わせ内の全ド
ライブの総容量と等しくなります。したがって、たとえば 1 GB のドライブを 4 つ組
み合わせると、使用可能な容量合計が 3 GB の論理ドライブが 1 つ作成されます。こ
の組み合わせは、システムには単一の論理ドライブとして認識されます。

RAID 3 では、データを小さなチャンクで読み込んだり、シーケンシャルに読み込む
と、データ転送率が高くなります。ただし、書き込み操作がすべてのドライブで行わ
れるとは限らない場合は、新しいデータが書き込まれるたびに、パリティ ドライブ
に保存された情報を再計算して再書き込みしなければならないため、同時 I/O が制
限されて、パフォーマンスは低下します。

図 A-10 RAID 3 構成

論理ドライブ（Logical drive）。

ブロック 1

ブロック 2

ブロック 3

ブロック 1

ストライピング

パリティ（1.2）

パリティ（3.4）

物理ディスク

専用パリティ

ブロック 3

ブロック 4

ブロック 5

ブロック 6

ブロック 7

ブロック 8

ブロック 7

ブロック 5

ブロック 4

ブロック 2

ブロック 8

ブロック 6 パリティ（5.6）

パリティ（7.8）
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RAID 5 

RAID 5 では分散パリティ付きの複数ブロック ストライピングが実装されます。この
RAID レベルでは、アレイ内の全ディスクに分散したパリティ情報による冗長性が提
供されます。データとそのデータのパリティは、同じディスク上には保存されませ
ん。ディスクに障害が発生した場合、パリティ情報と残りのディスク上の情報を使用
して元のデータを再構築できます。

図 A-11 RAID 5 構成

RAID 5 では、データに大きなチャンクでアクセスしたり、ランダムにアクセスした
場合、データ転送率が高くなり、同時に多数の I/O サイクルが行われる場合、デー
タ アクセス時間が減少します。

論理ドライブ（Logical drive）。 物理ディスク

ストライピング + 非専用パリティ

ブロック 1

ブロック 2

ブロック 3

ブロック 4

ブロック 5

ブロック 6

ブロック 7

ブロック 8

ブロック 4

ブロック 1

ブロック 7

パリティ（5.6）

パリティ（3.4）

ブロック 2

ブロック 8

ブロック 5

パリティ（3.4）

ブロック 3

ブロック 6

パリティ（7.8）
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高度な RAID レベル

高度な RAID レベルでは、アレイに内蔵されたボリューム マネージャを使用する必
要があります。これらを組み合わせた RAID レベルは、RAID 1、3、または 5 の保護
上の利点と RAID 1 のパフォーマンスを兼ね備えています。高度な RAID を使用する
には、まず 2 つ以上の RAID 1、3、または 5 のアレイを作成して、そのあとでアレ
イを結合します。以下の表に、高度な RAID レベルの説明を示します。

ローカル スペア ドライブとグローバル 
スペア ドライブ
外部 RAID コントローラは、ローカル スペア ドライブ機能とグローバル スペア ド
ライブ機能の双方を提供します。ローカル スペア ドライブは指定したドライブだけ
に使いますが、グローバル スペア ドライブはアレイ内のどの論理ドライブにも使用
できます。 

ローカル スペア ドライブは常にグローバル スペア ドライブより高い優先順位を持つ
ため、ドライブの故障時、両タイプのスペアが同時に利用可能な場合や、故障ドライ
ブ以上のサイズが必要な場合は、ローカル スペア ドライブが使用されます。

RAID 5 論理ドライブでドライブが故障した場合は、故障ドライブを新しいドライブ
と交換して論理ドライブの運用を継続します。故障ドライブの識別については、ご使
用のアレイの『Sun StorEdge 3000 Family RAID ファームウェア ユーザ ガイド』を
参照してください。

注意 – 故障ドライブを取り外そうとして誤ったドライブを取り外してしまうと、故
障ドライブ以外のドライブを故障させてしまうことになるため、その論理ドライブに
はアクセスできなくなります。

ローカル スペア ドライブは、１つの指定論理ドライブに割り当てられるスタンバイ
ドライブです。この指定論理ドライブのメンバ ドライブが故障すると、ローカル ス
ペア ドライブは自動的にメンバ ドライブとなりデータの再構築を始めます。

表 A-2 高度な RAID レベル

RAID レベル 説明

RAID 3+0
（30）

アレイの内蔵ボリューム マネージャを使用して結合された RAID 3 論理
ドライブ

RAID 5+0
（50）

アレイのボリューム マネージャを使用して結合された RAID 5 論理ドラ
イブ
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ローカル スペア ドライブは常にグローバル スペア ドライブより高い優先順位を持ち
ます。すなわち、ドライブの故障時にローカル スペアとグローバル スペアの両方が
利用可能であると、ローカル スペア ドライブのほうが使われます。 

図 A-12 ローカル（専用）スペア

グローバル スペア ドライブは、1 つの論理ドライブのみに対応するのではなく、す
べての論理ドライブに対して使用可能です（図 A-13 を参照）。任意の論理ドライブ
のメンバ ドライブが故障すると、グローバル スペア ドライブはその論理ドライブの
メンバとなり、自動的にデータの再構築を始めます。

ローカル スペア ドライブは常にグローバル スペア ドライブより高い優先順位を持ち
ます。すなわち、ドライブの故障時にローカル スペアとグローバル スペアの両方が
利用可能であると、ローカル スペア ドライブのほうが使われます。 

図 A-13 グローバル スペア

ローカル スペア 
ドライブ

論理ドライブ 0

グローバル スペア ドライブ

論理ドライブ 1 論理ドライブ 2

グローバル スペア ドライブ
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ローカル スペア ドライブとグローバル スペア ド
ライブの双方の使用

図 A-14 では、論理ドライブ 0 のメンバ ドライブは 9 GB のドライブで、論理ドライ
ブ 1 および 2 のメンバ ドライブはすべて 4 GB ドライブです。 

図 A-14 ローカル スペア ドライブとグローバル スペア ドライブの混在

ローカル スペア ドライブは常にグローバル スペア ドライブより高い優先順位を持ち
ます。すなわち、ドライブの故障時にローカル スペアとグローバル スペアの両方が
利用可能であると、ローカル スペア ドライブのほうが使われます。 

図 A-14 では、4 GB グローバル スペア ドライブは容量不足のため論理ドライブ 0 の
メンバになることはできません。論理ドライブ 0 内のドライブが故障した場合には、
9 GB のローカル スペア ドライブが故障ドライブの代わりに使われます。論理ドライ
ブ 1 または 2 内のドライブが故障した場合には、4 GB グローバル スペア ドライブが
直ちに故障ドライブの代わりに使われます。

ローカル スペア ドライブ グローバル スペア ドライブ

(4GB)(9GB)

(9GB)

(9GB)

(4GB)

(4GB)

(4GB)

論理ドライブ 0 論理ドライブ 1 論理ドライブ 2

(9GB)
(4GB)

(4GB)(4GB)
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付録 B

JBOD の監視（SCSI のみ）

この付録では、Sun StorEdge 3310 SCSI アレイでスタンドアロンの JBOD を監視し、
そのファームウェアをダウンロードする方法を説明します。アレイのすべての機能が
JBOD をサポートしているわけではありません。この付録には以下の手順が含まれま
す。

■ 205 ページの「JBOD サポートを有効にする」
■ 207 ページの「コンポーネントとアラームの機能を表示する」
■ 208 ページの「ハード ドライブのファームウェアをアップグレードするには」
■ 209 ページの「SAF-TE デバイスのファームウェアをアップグレードするには」
■ 210 ページの「故障ドライブを交換する」

▼ JBOD サポートを有効にする

周辺デバイスの状態と JBOD のイベントを監視するには、JBOD サポートを有効にす
る必要があります。 

1. View → Agent Options Management を選択します。 

Agent Options Management ウィンドウが表示されます。

2. Enable JBOD Support チェックボックスを選択します。

3. JBOD をメイン ウィンドウに直接表示するには、新しいインベントリを検出する必
要があります。View → View Server を選択し、Probe をクリックします。

4. OK をクリックします。 

メイン ウィンドウに JBOD が表示されます。

シングルバス構成では、下図に示すように、JBOD の両ポートがサーバ上の 1 つの
HBA に接続されています。
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デュアルバス構成では、下図に示すように、各ポートが自身の HBA に接続されてい
ます。

注 – デュアルバス構成では、各ポートが異なるサーバに接続されている場合、プロ
グラムはポート B に接続されたサーバからのみ JBOD を監視できます。
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▼ コンポーネントとアラームの機能を表示する

View Enclosure ウィンドウには、JBOD のコンポーネントとアラームの特性が表示さ
れます。

1. EMU（SCSI）アイコンまたは SES（ファイバ チャネル）アイコン  を選択します。

2. View → View Enclosure を選択します。

FRU ID 情報を表示するには、View FRU をクリックします。
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デバイスのファームウェアのダウンロード
このオプションを使い、JBOD のハード ドライブと SAF-TE デバイスのファームウェ
アをアップグレードします。

▼ ハード ドライブのファームウェアをアップグレー
ドするには

1. 任意の JBOD コンポーネントを選択します。

2. Array Administration → Download FW for Devices を選択します。

3. Download FW for Disks タブをクリックします。

4. ダウンロードする新しいファームウェアを適用するドライブを Available Disks リス
トから選択し、Add をクリックします。

削除する論理ドライブがある場合は、それらを Selected Disks リストから選択し、
Remove をクリックします。
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5. Browse をクリックし、ダウンロード ファームウェア ファイルを探します。そのファイ
ルを選択し、Open をクリックして OK をクリックします。

ファームウェアのダウンロードが開始されます。

6. 進行状況が 100% に達したら、OK をクリックします。

7. プログラムを更新するため、View → View Server を選択します。

8. Probe をクリックし、OK をクリックします。

9. ファームウェアが正しくダウンロードされたことを確認するには、View → View
Physical Drive を選択し、Product Revision フィールドのファームウェア バージョン
が更新されたことを確認します。

▼ SAF-TE デバイスのファームウェアをアップグ
レードするには

1. 任意の JBOD コンポーネントを選択します。

2. Array Administration → Download FW for Devices を選択します。

3. Download FW for SAFTE Devices タブをクリックします。

4. デバイスを追加するには、それを Available SAF-TE Devices リストから選択し、Add
をクリックします。

デバイスを削除するには、それを Selected SAF-TE Devices リストから選択し、Remove
をクリックします。
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5. Browse をクリックし、ダウンロード ファームウェア ファイルを探します。そのファイ
ルを選択し、Open をクリックして OK をクリックします。 

ファームウェアのダウンロードが開始されます。

約 70% 完了すると、アレイがビープ音を発し、LED が点滅し始めます。

6. 進行状況が 100% に達したら、OK をクリックします。

7. プログラムを更新するには、View → View Serverを選択し、Probe をクリックします。

8. OK をクリックします。

9. ファームウェアが正しくダウンロードされたことを確認するには、View → View
Enclosure を選択し、 Firmware Rev フィールドのファームウェア バージョンが更新
されたことを確認します。

▼ 故障ドライブを交換する

ドライブの故障は、赤のステータス記号  で示されます。故障したドライブを交
換した後、以下の手順を実行してください。 
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Solaris 動作環境

1. ドライブが自動的にオンラインに戻った（つまり、赤のデバイス ステータス記号が
消えた）場合は、次のコマンドを実行します。

2. 次のコマンドを実行します。

3. ドライブが自動的にオンラインに戻らない（つまり、赤のデバイス ステータス記号
が消えない）場合は、次のコマンドを入力して、再構成リブートを実行します。

Windows NT/2000 オペレーティング システム

1. 新しいドライブをインストールします。手順については、使用しているアレイの『Sun
StorEdge 3000 Family 導入・運用・サービス マニュアル』を参照してください。

2. View → View Server を選択し、Rescan をクリックします。

3. プログラムが新しいドライブを認識することを確認するには、そのドライブをメイン
ウィンドウで選択します。

4. View → View → Physical Drive を選択し、情報を確認します。

# devfsadm

# format

# reboot -- -r
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付録 C

クラスタ構成の使用（SCSI のみ）

Sun StorEdge 3310 SCSI アレイで Windows NT を使用している場合は、Sun StorEdge
Configuration Service で共有 SCSI ストレージを監視できます。この付録には以下の
項目が含まれます。

■ 213 ページの「クラスタ構成の計画」
■ 214 ページの「クラスタ構成の要件」

■ 214 ページの「クラスタ構成をセットアップするには」
■ 214 ページの「クラスタ構成をセットアップするには」

まず、適切なハードウェアでクラスタ構成をセットアップする必要があります。これ
には、Windows NT Server Enterprise Edition と Service Pack 3 または 4、および
Microsoft Cluster Server（MSCS）ソフトウェアが必要です。

クラスタ構成をセットアップする場合は、この付録を必ずお読みください。

クラスタ構成の計画
クラスタ構成の種類は 初にストレージをどのように構成するかに影響するため、ク
ラスタ構成をセットアップする前に、その種類を決定する必要があります。

クラスタ構成には主に次の 2 種類があります。 

■ ホット スタンバイ サーバ クラスタでは、すべての LUN がクラスタ内の 2 台の
サーバのどちらかに属します。LUN を所有するサーバが故障した場合、LUN は、そ
の時点までアイドル状態であった第 2 サーバに移動されます。この構成には 小 2
つの LUN が必要です。

■ 負荷バランス クラスタでは、一部の LUN が 1 台のサーバで管理され、ほかの
LUN がもう 1 台のサーバで管理されます。両方のサーバがデータを同時に処理し
ますが、それぞれ異なる LUN の I/O を処理します。
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小 3 つの LUN を定義する必要があります。これにより、1 つの小さい LUN を定
足ディスク用に確立でき、より大きな LUN をクラスタ内の各サーバに使用できま
す。定足ディスクは、サーバに障害が発生した際にクラスタを回復するために必要な
クラスタ構成データを維持します。

クラスタ構成の要件
MSCS ソフトウェアをインストールするとき、クラスタ情報を維持する定足ディスク
として使用するディスクを確認してください。

クラスタ構成では、プログラムは一度に 1 台のサーバ（定足ディスクを持つサーバ）
でのみ実行できます。Sun StorEdge Configuration Service を実行しているサーバに
障害が発生した場合、Cluster Administrator によって第 1 サーバのディスク負荷が
第 2 サーバに自動的に移動され、そのサーバ上でサービスが起動されます。

2 台のサーバによるクラスタ構成では、クラスタ自身がその IP アドレスを使って Managed
Servers リストにある被管理サーバになります。クラスタ セットアップ手順の 後の
ステップに示すように、クラスタを Managed Servers リストに追加します。

▼ クラスタ構成をセットアップするには

以下は、2 台のサーバによるクラスタ構成にアレイをセットアップするための概要手
順です。

1. サーバをセットアップします。

a. それぞれのサーバが PCI バスと、共有 SCSI ストレージの一部ではないブート
ディスクを備えた 2 台のサーバをセットアップします。

b. 各サーバに Ultra-Wide や差動ホスト アダプタなどのホスト アダプタ カードをイン
ストールし、共有 SCSI バス上の各ホスト アダプタに固有 SI ID を設定します。

c. 各サーバに 2 枚のネットワーク アダプタ カードをインストールします。

d. 各サーバのブート ディスクに、Windows NT Server Enterprise Edition ソフト
ウェアと Windows NT Service Pack 3 以降をインストールします。

2. デュアル アクティブアクティブ ストレージ サブシステムをインストールし、これを
両ホスト アダプタに接続します。 

インストール手順については、該当の説明書を参照してください。

3. 各サーバにエージェントをインストールします。 
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a. もう 1 台のサーバにサービスをインストールする前に、そのサービスを実行している
サーバ上でそのサービスを停止します。 

b. サービスを実行しているサーバが、プライマリ コントローラに割り当てられた論
理ドライブにマップされたホスト LUN にアクセスできることを確認します。

c. エージェントのインストール手順は、インストールについての該当の章を参照し
てください。 

エージェントをインストールした後、リブートする必要はありません。ただし、
エージェントのインストール後、サーバ上のサービスは必ず停止してください。

注 – 次の 2～3 のステップでは、例として 1 台のサーバだけを対象とします。

4. コンソール ソフトウェアをインストールします。

コンソールは、サーバの 1 つ、またはサーバが存在するネットワーク上の任意のコン
ピュータにインストールできます。プログラムを使用すると、アレイをリモートで構
成し、監視することができます。詳細手順は、インストールについての該当の章を参
照してください。

5. サービスを起動したサーバを、コンソールの Managed Servers リストに追加します
（42 ページの「サーバを追加するには」を参照）。 

かならず Auto Discovery を選択し、ssmon パスワードを追加します。

6. コンソール ソフトウェアを使い、アクティブ サーバ上のストレージを確認して構成
し、そのサーバをリブートします。

デュアル アクティブアクティブ ストレージ サブシステム上でストレージ アレイが事
前構成されている場合があります。構成済みであるかどうかは、ツリー表示で確認す
る必要があります。

ストレージが未構成の場合、または構成を変更する場合は、1 台のサーバ上のすべての
LUN を構成してください。後で、MSCS ソフトウェアのインストール後に、Cluster
Administrator を使ってサーバ間のストレージを割り当てることができます。

7. NT Disk Administrator を使い、パーティションを作成して、アクティブ サーバ上の
LUN をフォーマットします。 
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a. 必要であれば、ディスクのドライブ文字を再割り当てします。 

パーティションは NTFS でフォーマットする必要があります。

Windows NT は、デュアル アクティブアクティブ コントローラ上の LUN をクラ
スタ内の両方のサーバ上にあるとみなします。パーティションと論理ドライブは 1
台のサーバ上にのみ作成できます。あとで、MSCS のインストール後に、Cluster
Administrator を使って 2 台のサーバ間でストレージを分配することができます。

2 台のサーバの共有 SCSI ストレージのドライブ文字は同じでなければなりませ
ん。一方のサーバに追加の CD-ROM ドライブや外部ハード ディスクがあるが、
もう一方にはない場合、共有ストレージのドライブ文字を再割り当てする必要が
あることもあります。このステップの後、他方のサーバをチェックして、ドライ
ブ文字が同じであることを確認します。

b. 共有ストレージに割り当てられたドライブ文字を書き留めます。

8. 第 2 サーバにアクセスし、Disk Administrator を起動し、第 2 サーバのドライブ文字
が第 1 サーバと同じであることを確認します。 

同じでない場合は、両サーバで同じになるようにドライブ文字を再割り当てします。

9. 第 2 サーバをシャットダウンします。

10. 第 1 サーバに MSCS ソフトウェアをインストールし、サーバをリブートします。 

11. Cluster Administrator を起動し、クラスタを認識することを確認します。

12. 第 2 サーバにアクセスし、第 1 サーバに結合することによりこのサーバに MSCS を
インストールしてから、リブートします。

13. 第 2 サーバをリブートし、両方のサーバがクラスタに含まれていることを Cluster
Administrator で確認します。

14. Cluster Administrator でディスク グループを調節します。 

定数ディスクとその他のディスク（ある場合）が、 初に構成した第 1 サーバの下の
1 つのディスク グループ内に一緒に含まれていることを確認します。この手順の詳細
は、MSCS の説明書を参照してください。

注 – 2 つの LUN を同じディスク グループ内に入れた後、ディスク グループが 1 つ
空になり、これは削除できます。

15. 第 1 サーバ上の定足ディスクを持つグループにサービスを追加します。

a. 両方のサーバで、3 つのサービス、Configuration Service Startup、Configuration
Service Monitor、および Configuration Service Server を停止し、それらを手動に
設定します。
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b. Cluster Administrator を使い、各サービスを、定足ディスクを持つグループへのリ
ソースとしてインストールします。 

以下に示す順序で各サービスを起動しますが、その名前は指示どおりの形式（2 語
を連結）でタイプします。各サービスをインストールした後、サービスをオンラ
インにし、アクティブ サーバ上で起動します。

サービスを一般サービスとして入力します。各リソースの従属性を入力するよう
求められます。このグループの従属性は以下のとおりです。

■ 定足ディスクに関連付けられたディスク
■ その他のディスク（このグループに追加されたものがある場合）
■ Configuration ServiceStartup
■ Configuration ServiceMonitor
■ Configuration ServiceServer

Configuration ServiceStartup は、グループ内に既に存在する 2 つのディスクに従
属します。Configuration ServiceMonitor は Configuration Service Startup に従属
し、Configuration ServiceServer は Configuration Service Monitor に従属します。

16. 2 台のクラスタ サーバをクラスタ IP アドレスに 1 つのアイコンとして表示するに
は、CLUSTER.TXT を編集します。

このファイルは、コンソールのファイルと同じ場所にあります。これは、コンソール
がインストールされているコンピュータのシステム ディスクにあります。ドライブ
C がシステム ディスクの場合、パスは次のようになります。

C:\Program Files\Sun\sscs

以下のテキストは、このファイルの内容を示しています。

17. このファイルの最後の行を編集して、まずクラスタの IP アドレスを挿入し、次にク
ラスタを構成する 2 台のサーバの IP アドレスを挿入します。 

a. 先頭のシャープ記号（#）を削除します。

#Edit this file to map the NT cluster IP address to several
#servers constituting the cluster.
#The format of the entry is:
#<Cluster IP Address>=<server1 IP Address>:<server2 IP Address>
#The IP address must be in dot form.
#Example: If the cluster IP address is 151.239.130.70 and the
#IP addresses of individual servers are 151.239.130.71 and
#151.239.130.72,the entry would be:
# 151.239.130.70=151.239.130.71:151.239.130.72
#
#IMPORTANT NOTE:
#Use only the Cluster IP address to configure an NT cluster
#server on the Configuration Service console.
#
#151.239.130.70=151.239.130.71:151.239.130.72
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18. コンソールを起動して、第 1 サーバを Managed Servers リストから削除し、クラス
タをサーバとしてこのリストに追加します。

19. Server List Setup 機能にアクセスします。42 ページの「サーバを追加するには」を
参照してください。

かならず Auto Discovery を選択し、ssmon パスワードを追加します。クラスタ名を
入力すると、ネットワークで DNS が使用可能な場合はプログラムによりその IP ア
ドレスが提供されます。

これで、クラスタ構成が動作するよう正しく設定されました。サービスを実行してい
るサーバに障害が発生した場合、そのディスク グループが第 2 サーバに移動され、
Cluster Administrator によってそのサーバ上でサービスが自動的に起動されます。

注 – 1 台のサーバが故障した場合、コンソールのクラスタ アイコンが紫色から灰色
に変わるまでに 大 15 分かかることがあり、再び紫色に戻るまでにさらに 10 分かか
る場合もあります。

片方のサーバ上にあるストレージの一部に負荷バランス構成を使用する場合は、
Cluster Administrator を使って、1 つまたは複数のディスク グループをもう一方のサー
バに移動する必要があります。
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付録 D

ホストのワールドワイド ネームの決
定（ファイバ チャネルのみ）

この付録では、アレイのホストのワールドワイド ネーム（WWN）、ワールドワイド
ノード ネーム（WWNN）、ワールドワイド ポート ネーム（WWPN）を決定する方
法について説明します。以下の手順が含まれています。

■ 219 ページの「WWN を決定するには」
■ 221 ページの「WWNN を決定するには」
■ 222 ページの「WWPN を決定するには」

▼ WWN を決定するには

LUN フィルタ機能を使用する前に、各 Sun StorEdge 3510 ファイバ チャネル アレイを
接続する HBA カードと、各カードに割り当てる WWN を識別しておくと便利です。

Solaris 動作環境

1. 使用しているコンピュータに新しい HBA デバイスをインストールした場合は、コン
ピュータを再起動してください。

2. 次のコマンドを入力します。

# luxadm probe
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3. 下方向に画面をスクロールして、ファイバ チャネル デバイスと関連する WWN を確
認します。

Linux と Windows NT/2000 

1. 特定のホストをブートし、BIOS のバージョンとホストに接続された HBA カードの
モデルを確認します。 

2. 適切なコマンド（一般には alt-q または control-a）を使用して、HBA カードの BIOS
にアクセスします。 

ホストに複数の HBA カードが存在する場合は、ストレージに接続されているカード
を選択します。 

3. カードをスキャンして、そこに接続されているデバイスを検出します（通常はスキャ
ン ファイバ デバイスかファイバ ディスク ユーティリティを使用）。

このノード名（または同様のレベル）がワールドワイド ネームです。

Qlogic カードの例を次に示します。

ID ベンダ  製品名 バージョン ノード名 ポート ID

0 Qlogic QLA22xx アダプタ B 210000E08B02DE2F 0000EF
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▼ WWNN を決定するには

1. Configuration Service メイン ウィンドウで  アレイ アイコンをダブルクリックす
るか、またはアレイ アイコンを選択して View → View Controller を選択します。

ノード名は View Controller Configuration ウィンドウの Node name フィールドに表
示されます。

注 – WWNN 情報はコンソールで生成される xml レポートにも含まれます。
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▼ WWPN を決定するには

1. Configuration Service メイン ウィンドウで  アレイ アイコンをダブルクリックす
るか、またはアレイ アイコンを選択して View → View Controller を選択します。

2. View Controller Parameters をクリックします。

RAID Controller Parameter ウィンドウが表示されます。Channel タブで、右にスク
ロールして WWPN を表示します。

注 – WWPN 情報はコンソールで生成される xml レポートにも含まれます。
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付録 E

電子メールと SNMP

Sun StorEdge Configuration Service はイベント完全監視機能と電子メール通知機能を
備えています。コンソールは、指定された電子メール アドレスのリストに SMTP 電子
メール メッセージを送信できます。電子メール システムの中には、Microsoft Exchange
などのように、スクリプトで構成またはプログラムすることにより、イベントに応じ
て管理者を呼び出すことができるものがあります。呼び出しサービスには、これらの
電子メール メッセージをページャーに送信できるものもあります。

エージェントは、イベントを動作環境のエラー ログに記録します。エージェントは、大
容量ストレージ イベントについての SNMPトラップを HP OpenView などのエンター
プライズ管理コンソールに送ることもできます。SNMP を使用する監視ソフトウェアの
リストは、http://wwws.sun.com/software/solaris/sunmanagementcenter の
Sun Management Center で入手できます。

この付録では、電子メール メッセージを送信できるようにコンソールをセットアップ
する方法を説明します。さらに、SNMP 管理コンソールへトラップを送信できるよう
にサーバを構成する方法、トラップ形式の説明、および SNMP に関する基本知識も提
供しています。Sun StorEdge Configuration Service を必要とせずに SNMP トラップ
を送信する別の方法についても説明します。この章には以下の項目が含まれます。

■ 224 ページの「各サーバへの電子メール メッセージの送信」
■ 224 ページの「各サーバに電子メール メッセージを送信するには」

■ 227 ページの「トラップを送信するためのサーバのセットアップ」
■ 227 ページの「コミュニティ文字列をチェックする」
■ 229 ページの「トラップの受信者を指定するには」
■ 230 ページの「Solaris 動作環境のサーバをセットアップするには」
■ 230 ページの「Linux 動作環境のサーバをセットアップするには」

■ 231 ページの「SNMP のメカニズム」
■ 235 ページの「Sun StorEdge Configuration Service を使用せずに SNMP ト

ラップを送信するには」
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各サーバへの電子メール メッセージの
送信
各被管理サーバに電子メール メッセージを送信するようにコンソールを構成するには、
Server List Setup 機能を使用します。

▼ 各サーバに電子メール メッセージを送信するには

1. File → Server List Setup を選択します。

Server Setup ウィンドウが表示されます。

 

2. Add をクリックします。

サーバが既に追加されている場合は、それを Available Servers リストに移動して Edit
をクリックします。

Add Server ウィンドウまたは Edit Server ウィンドウが表示されます。この 2 つの
ウィンドウに表示されるフィールドは同じです。
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3. サーバがまだ追加されていない場合は、Properties タブに情報を入力します。

詳細は、43 ページの「サーバーを追加します。」を参照してください。

4. 電子メールを使ってイベント メッセージを送信するには、Mailing Lists タブを選択
します。

Add Server ウィンドウが開き、Mailing Lists が選択された状態で表示されます。

a. 各ユーザについて、Mail Address フィールドに電子メール アドレスを入力します。

b. Severity リストボックスで、リストをスクロールして希望の項目を選択します。

c. Add to List をクリックします。

リストからユーザを削除するには、その電子メール アドレスを選択し、Delete
from List をクリックします。
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d. メール サーバを指定します。Setup Mail Server をクリックします。

Mail Server Setup ウィンドウが表示されます。

 

前のステップで指定した宛先アドレスに電子メール メッセージを配信する簡易メー
ル転送プロトコル（SMTP）メール サーバの IP アドレスまたは名前を入力します。

e. Mail Server ウィンドウでの情報の入力が完了したら、OK をクリックします。

Add Server ウィンドウまたは Edit Server ウィンドウが表示されます。

5. Add Server ウィンドウまたは Edit Server ウィンドウでの情報の入力が完了したら、
OK をクリックします。

Server Setup ウィンドウが表示されます。

6. さらにサーバを追加する場合は、各サーバについて、ステップ 2～5 を繰り返します。

7. 必要であれば、このコンソールで管理するサーバを Managed Servers リストに移動
します。

サーバを編集した場合は、それを Available Servers リストに戻す必要があります。

8. OK をクリックしてメイン ウィンドウに戻ります。
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トラップを送信するためのサーバの
セットアップ
ネットワーク上にエンタープライズ管理コンソール（たとえば、HP OpenView、
IBM NetView など）がある場合、イベントに関するトラップをコンソールに送るよう
にサーバを設定できます。このセクションでは、必要な構成手順について説明します。

注 – このセクションの手順は、SNMP トラップをほかのエンタープライズ管理コン
ソールに送信する場合にのみ必要です。

注意 – トラップを送信するためにセットアップしているものと同じサーバに HP
OpenView がインストールされている場合、初期化時のエラーを防ぐため、システム
リソースを再構成する必要があります。システム リソースを再構成する方法は、242
ページの「症状:HP OpenView をインストールできない、またはトラップ デーモン
が起動しない。」のトラブルシューティング項目を参照してください。

Windows NT サーバ

SNMP トラップを 1 つまたは複数のエンタープライズ管理コンソールに送信するよ
うに Windows NT サーバを構成するには、以下の動作が行われるようにサーバ上の
各 SNMP サービスを設定する必要があります。

■ サーバが、エンタープライズ管理コンソールのコミュニティ文字列またはコミュ
ニティ名をリストに表示する。

■ サーバが、エンタープライズ管理コンソールを、Windows NT エージェント ソフ
トウェアからのトラップの受信者としてリストに表示する。

▼ コミュニティ文字列をチェックする

デフォルトのコミュニティ名またはコミュニティ文字列 public を使用することがで
きます。ただし、public 以外のコミュニティ名を選択すると、指定されたコミュニ
ティ文字列を持つコンピュータだけに通信が制限されるため、より高いセキュリティ
が得られます。
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Windows NT 4.0 のコミュニティ文字列を設定するには、以下の手順を実行します。

1. コントロール パネルのウィンドウでネットワーク アイコンをダブルクリックして、
サービス タブが選択されていなければ選択します。

ネットワーク サービスのリストで SNMP サービスまでスクロールし、これをクリッ
クして選択し、プロパティ をクリックします。

Microsoft SNMP のプロパティ ウィンドウが表示されます。

注 – SNMP サービスがインストールされていない場合、これをインストールするには
Network ウィンドウで Add をクリックします。表示される Select Network Service
ウィンドウから SNMP サービスを選択できます。コンピュータが必要なファイルを
SNMP サービスからコピーできるように、Windows NT 4.0 CD を挿入する必要があ
ります。

2. Microsoft SNMP Properties ウィンドウで Security タブをクリックし、Security 設定
を表示します。

3. サーバに使用するコミュニティ名またはコミュニティ文字列が、Accepted
Community Names リスト内に指定されていることを確認します。

この名前がリストにない場合は、Add をクリックして Service Configuration ウィン
ドウを表示します。入力フィールドで新しい名前をタイプし、ウィンドウ内の Add
をクリックします。Security タブが表示され、新しい名前が Accepted Community
Names リスト内に表示されます。

注 – コミュニティ名またはコミュニティ文字列は大文字小文字を区別します。

4. (オプション) 必要であれば、デフォルト設定の Accept SNMP Packets from Any Host
（任意のホストから SNMP パケットを受け入れる）を Only Accept SNMP Packets
from These Hosts（これらのホストからのみ SNMP パケットを受け入れる）に変更
し、サーバ上のエージェントからトラップを受信するエンタープライズ管理コン
ピュータのネットワーク アドレスを追加することができます。

この設定を使用すると、Windows NT エージェントが情報を受け入れる先のコン
ピュータを指定できるため、より高いセキュリティが得られます。

Sun StorEdge Configuration Service コンソール ソフトウェアがインストールされた
コンピュータのネットワーク アドレスを下のリストに追加するには、Addをクリック
して Security Configuration ウィンドウにアクセスします。Entry ボックスに IP アド
レスを入力し、ウィンドウ内の Add をクリックします。Security タブが再度表示さ
れ、Configuration Service 管理コンソール コンピュータのアドレスが表示されます。

5. OK をクリックします。
228  Sun StorEdge 3000 Family Configuration Service 1.3 ユーザ ガイド • 2003 年 6 月



▼ トラップの受信者を指定するには

この手順では、サーバからのトラップの受信者としてエンタープライズ管理コンソー
ルをリストします。

注 – 手順を実行するには、トラップを受信するエンタープライズ管理コンソールの
IP アドレスが必要です。また、前のセクションで指定したものと同じコミュニティ
名が必要です。

エージェント トラップの受信者としてエンタープライズ管理コンソール コンピュー
タを指定するには、以下の手順を実行します。

1. Microsoft SNMP Properties ウィンドウで Traps タブをクリックし、Traps 設定を表
示します。

2. 前の手順の Security タブで指定したコミュニティ名と同じコミュニティ名が指定さ
れていることを確認します。

コミュニティ名を修正する必要がある場合は、Community Name フィールドに名前
を入力して Add をクリックします。入力フィールドにすでに入っている名前は、上
書き入力をしたあとも保持されます。名前を削除するには、それを選択して Remove
をクリックします。

3. エンタープライズ管理コンソールの IP アドレスを Trap Destinations リストに追加し
ます。

a. Add をクリックします。

Service Configuration ウィンドウが表示されます。

b. Entry フィールドに IP アドレスを入力し、Add をクリックします。

Traps タブが表示され、新しいネットワーク アドレスが Trap Destinations リスト
に表示されます。

c. 次の形式で各 IP アドレスを入力します。AAA.BBB.CCC.DDD

先行のゼロをタイプする必要はありません。正しい形式のアドレスの例:
192.168.100.1

4. オプションのトラップを別のエンタープライズ管理コンソールに送信する場合は、そ
のネットワーク管理ワークステーションのアドレスを入力します。

複数のエンタープライズ管理コンソールがある場合、それぞれのアドレスをここで指
定する必要があります。

5. OK をクリックして、設定を確認します。

6. Close をクリックして、Network ウィンドウを閉じます。
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7. Windows NT を終了し、サーバをリブートします。

Sun StorEdge Configuration Service をインストールする予定の場合は、ソフトウェ
アのインストールが終了するまでリブートする必要はありません。

▼ Solaris 動作環境のサーバをセットアップするには

Solaris 動作環境のシステムの場合、sstrapd という SNMP トラップ デーモンへの
インターフェイスを通して SNMP バージョン 1 トラップを生成できます。デフォル
トでは、このデーモンはブート プロセス中に自動的には起動しません。トラップ処
理を有効にするには、以下の手順を実行します。

1. 標準のテキスト エディタを使い、ファイル /var/opt/SUNWsscs/ssagent/ 
sstrapd.conf を作成します。

このファイルには、SNMP マネージャ コンソールの名前または IP アドレスが含まれ
ます。複数のコンソールがある場合は、それぞれを別の行に入力します。

2. ファイル /etc/init.d/ssagent を編集して、SNMP 関連のスタート セクションか
ら注釈記号を削除します。注釈行は、先頭に 2 重シャープ記号（##）が付いています。

3. 編集後、ファイルを保存します。

sstrapd デーモンは次回のブートで起動します。または、次のコマンドを実行して
即時に起動できます。

これにより、sstrapd デーモンが起動し、ほかの 2 つのデーモンが実行されていな
かった場合は、それらも起動します。以前にデーモンが実行されていたかどうかに関
わらず、この時点では、各デーモンのインスタンスが 1 つだけ動作しています。

▼ Linux 動作環境のサーバをセットアップするには

Linux 動作環境のシステムの場合、sstrapd という SNMP トラップ デーモンへのイ
ンターフェイスを通して SNMP バージョン 1 トラップを生成できます。デフォルト
では、このデーモンはブート プロセス中に自動的には起動しません。トラップ処理
を有効にするには、以下の手順を実行します。

1. 標準のテキスト エディタを使い、ファイル /var/opt/SUNWsscs/ssagent/sstrapd.conf
を作成します。

このファイルを作成する場合は、SNMP マネージャ コンソールのシステム名または
IP アドレス（各行に 1 つ）のどちらかを含める必要があります。このファイルには、
空白行とコメント行が含まれます。

/etc/init.d/ssagent uptrap
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2. ファイル /etc/init.d/ssagent を編集して、SNMP 関連のスタート セクションから注釈
記号を削除します。

注釈行は、先頭に 2 重シャープ記号（##）が付いています。

3. 編集後、ファイルを保存します。

sstrapd デーモンは次回のブートで起動します。または、次のコマンドを実行して
即時に起動できます。

これにより、sstrapd デーモンが起動し、ほかの 2 つのデーモンが実行されていな
かった場合は、それらも起動します。以前にデーモンが実行されていたかどうかに関
わらず、この時点では、各デーモンのインスタンスが 1 つだけ動作しています。

SNMP のメカニズム
簡易ネットワーク管理プロトコル（SNMP）は、ネットワーク管理においてもっとも
広く使用されているプロトコルの 1 つです。その名前が示すとおり、ネットワーク デバ
イスを比較的単純な方法で管理します。SNMP は簡単で、無応答のコネクションレ
ス プロトコルです。

SNMP は当初、インターネット プロトコルの総括、主に TCP/IP（伝送制御プロト
コル／インターネット プロトコル）転送プロトコルの下に働くように設計されまし
た。以来 SNMP は、ほかの一般的な転送プロトコル、たとえば、Novell の IPX/SPX
（Internet Packet Exchange/Sequenced Packet Exchange）などにも対応するように
導入されてきました。

SNMP トラップ メッセージ

エージェントは SNMP を使ってエンタープライズ管理システムに情報を送信します。

トラップを送信するようにサーバを設定すると、イベント情報がそのシステムに流れ
込むようになります。

トラップ メッセージには次の情報が含まれています。

■ OID（オブジェクト識別子）1.3.6.1.4.1.2294.1.2

■ Event Date（MM,DD,YY、たとえば 01,22,98）

■ Event Time（HH:MM:SS、たとえば 15:07:23）

■ Server Address and Name（IP アドレス名、たとえば 192.187.249.187 Administration）

/etc/init.d/ssagent uptrap
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■ Card Name

■ Event Severity （Informational、Warning、Critical）

■ テキスト メッセージ

表示される情報とその形式は、使用している SNMP 管理コンソールによって異なり
ます。

トラップを受信するには、ファイル RST_OID.MIB をエンタープライズ管理コンソー
ルにロードする必要があります。Solaris および Linux 動作環境では、このファイルは
/opt/SUNWsscs/ssagent にあります。Microsoft Windows では、このファイルは 
\Program Files\Sun\ssagent にあります。

エージェントとマネージャ

SNMP ソフトウェア モデルは、エージェントとマネージャから成ります。エージェ
ントは、被管理デバイス内の変数を監視できるよう有効にするソフトウェアです。
エージェント ソフトウェアは、管理されるデバイス内に組み込まれているか、デバ
イスが接続されているコンピュータ上で実行されます。

マネージャまたは管理コンソールは、変数に関する要求を SNMP を使ってエージェ
ントに送信するネットワーク監視ソフトウェアです。変数の値は変化するので、マ
ネージャはエージェントを定期的にポーリングします。SNMP マネージャは通常、
エージェントから受け取ったデータを解析し、グラフィカル表示でユーザに提示しま
す。データは、履歴やトレンド解析のためデータベースに保管できます。

SNMP マネージャの要求に応答することに加え、エージェントは非請求の通知また
はトランザクションラップを管理ステーションに送信することができます。これは、
通常のソフトウェアでの割り込みに似ています。

管理コンソールでは、トラップに応答してさまざまな活動が行われます。通常、ト
ラップはログに記録され、ログ情報は通知スキームを介して対象のユーザに転送され
ます。また、トラップの発生により SNMP マネージャは、ネットワーク全体の現在
のステータスを調べるためエージェントにさらに照会要求を送る、またはアプリケー
ションを起動するなど、その他の活動も開始します。

管理情報ベース（MIB）
ネットワーク上で、SNMP エージェントを備えた各デバイスが、それに関連付けら
れた 1 つまたは複数の変数またはオブジェクトを持っています。典型的な変数の例と
して、デバイスの名前を追跡する変数があります。これらの変数またはオブジェクト
は、Management Information Base（MIB）というテキスト ファイルの中で説明
されています。MIB は、管理される変数を正確にテキストで定義したものです。MIB
の定義手順は、国際標準化機構（ISO）のインターネット エンジニアリング タスク
フォース（IETF）により確立されています。
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SNMP オブジェクト

ネットワーク管理の変数のいくつかは、すべての LAN ネットワーク デバイスに共通
です。これらの変数の多くは標準化され、MIB-II 変数および MIB-II 拡張と呼ばれて
います。IETF では、標準 MIB-II カテゴリに属さない MIB 用の手順も定義していま
す。これらの変数はプライベート企業 MIB にリストされています。

変数は、プライベート エンタプライズ MIB のエントリにリストされています。たと
えば、オブジェクト ID 1.3.6.1.4.1.2294.1.2 は、Configuration Service の MIB の 1 つ
の下でエージェント バージョンを追跡するための変数のオブジェクト ID（OID）と
して定義されています。

図 E-1 は、OID がどのように派生するかを図示しています。チェックマークは OID
内のノードを示します。MIB では、特定の変数またはオブジェクトのデータはその
OID の下にあります。

Sun のツリー ノードは 2294 です。自身のデバイスを認識するエージェントの開発を
希望するプライベート企業は、固有のツリー ノードの取得を IETF に申請できます。

SNMP 要求タイプ

MIB データへのアクセスをサポートする SNMP 操作には、Get、GetNext、および
Set があります。Get は、指定されたインデックス値により、テーブル エントリ
フィールド値からスカラ値を取り出します。GetNext を使い、テーブル エントリの
インスタンスをトラバースします。各コマンドは、次の対象の列（またはフィール
ド）内の値を順次返します。Set 操作は、MIB 変数の値の作成や変更に使用します。

SNMP セキュリティ

変数を設定することによりセキュリティの問題が生じます。SNMP V1（バージョン
1）は単純なセキュリティ スキームを備えています。各プロトコル データ ユニット
（PDU）に、ユーザ名とパスワードの組み合わせのようなコミュニティ文字列が含
まれています。各エージェントを特定のコミュニティ文字列用に構成することができ
ます。エージェントは、要求 PDU 内のコミュニティ文字列が自身の構成内にあるコ
ミュニティ文字列に一致しない限り、受け取った要求に対して応答しません。
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図 E-1 MIB 変数のオブジェクト識別子
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▼ Sun StorEdge Configuration Service を使用せず
に SNMP トラップを送信するには

以下の手順は、Sun StorEdge Configuration Service を必要とせずに SNMP トラップ
を送信する別の方法です。

アレイは、大容量ストレージ イベントについての SNMPトラップを HP OpenView
などのエンタープライズ管理コンソールに送ることができます。以下の構成では、
SNMP トラップを送信するためにエージェントがインストールされている必要があ
りません。

1. テキスト エディタを開きます。

2. 使用しているネットワークに該当するように各変数値を置き換えて、次の情報をタイ
プします。

[SNMP_TRAP]
ENABLED=1
RECEIVER1=123.123.123.123

[EMAIL]
ENABLED=1
SUBJECT=RAID Event
SENDER_MAIL_BOX=someone@somecompany.com
SMTP_SERVER=123.123.123.123
RECEIVER1=somebody@somecompany.com

3. このファイルを agent.ini という名前で保存します。

4. ワークステーションからアレイに FTP を実行します。

5. ルートのユーザ名をタイプして Return キーを押します。

6. パスワードの入力を求められたら、Return キーを押します。

前にコントローラのパスワードを指定した場合は、ここでそのパスワードを入力する
必要があります。

7. ログインした後、/cfg ディレクトリにアクセスします。

8. このファイルをワークステーションから /cfg ディレクトリに入れます。

9. FTP セッションを終了します。

10. アレイの管理に使用している方法（コンソール、Telnet、端末セッションなど）を
使って、コントローラをリセットします。
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付録 F

トラブルシューティング

この付録では、以下の症状に関するトラブルシューティングの対応策を提供します。

■ 238 ページの「症状:Sun StorEdge Configuration Service のインストール時に、
java -version に対して 1.2.2 より前の Java Runtime Environment バージョンが出
力されるが、マシンには既に Java Runtime Environment 1.2.2、1.3、または 1.4
がインストールされている。」

■ 238 ページの「症状 : サーバが応答しない、またはサーバがダウンしている可能性
がある。」

■ 239 ページの「症状 : 既存の論理ドライブから論理ボリュームを追加しようとする
ときに、論理ドライブがリストに表示されない。」

■ 240 ページの「症状:DHCP 環境でのサーバの IP アドレスが変更された。」

■ 240 ページの「症状:サーバからトラップを受信できない。」

■ 242 ページの「症状:HP OpenView をインストールできない、またはトラップ
デーモンが起動しない。」

■ 242 ページの「症状 : ハードウェアを追加または交換したときに、コンソールに変
更が表示されない。」

■ 243 ページの「症状:Solaris 動作環境でのシステムに LG が存在しない。」

■ 243 ページの「症状:環境アラームが報告されない。」

■ 243 ページの「症状:コンソールの動作が遅い。」

■ 243 ページの「症状:Sun StorEdge Diagnostic Reporter が動作を停止した。」

■ 244 ページの「症状:（Solaris/Linux）オンライン ヘルプが表示されない。」
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症状:Sun StorEdge Configuration Service のインストール時に、
java -version に対して 1.2.2 より前の Java Runtime Environment 
バージョンが出力されるが、マシンには既に Java Runtime 
Environment 1.2.2、1.3、または 1.4 がインストールされている。 
■ /usr ディレクトリをチェックして、Java から、Java 1.1 以外の 新バージョンの

Java へのリンクがあることを確認します。

Java Runtime Environment のバージョンをチェックするには、次のように入力し
ます。

(Solaris OE）リンクが上記の 新バージョンの Java へのリンクではない場合は、
次のように入力します。

ここで、xxx は Java Runtime Environment の 新バージョンです。

症状:サーバが応答しない、またはサーバがダウンしている可能性
がある。

サーバ上でサービスが実行していることを確認します。

1. （Solaris OE）次のコマンドを入力します。

ssmon と ssserver の両方の名前が表示されるはずです。表示されない場合はス
テップ 2 に進み、表示された場合はステップ 4 に進みます。

(Microsoft Windows NT) 設定→コントロール パネル→サービスにアクセスし、
SUNWscsd Monitor、SUNWscsd Server、および SUNWscsd Startup のサービスが
起動していることを確認します。表示されない場合はステップ 2 に進み、表示された
場合はステップ 4 に進みます。

(Windows 2000) スタート→ Administrative Services →コンピュータの管理にアクセスし
ます。サービスとアプリケーションをクリックし、SUNWscsd Monitor、SUNWscsd
Server、および SUNWscsd Startup のサービスが起動していることを確認します。表
示されない場合はステップ 2 に進み、表示された場合はステップ 4 に進みます。

# cd /usr
ls | grep java

rm java
ln -s /usr/xxx /usr/java

# ps -e | grep ss
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2. (Solaris/Linux OE) デーモンを停止してから起動します。手順については、13 ページ
の「エージェントを起動または停止するには」を参照してください。

(Windows NT/2000）必要なサービスを右クリックして選択し、サービスを起動また
は停止します。

3. デーモン／サービスが正常に停止／起動しない場合は、再構成リブートを行います。

4. TCP/IP プロトコル ソフトウェアがロードされていることと、ネットワーク カードお
よびネットワーク接続が機能していることを確認します。

TCP/IP 接続性をテストするには、コマンド ラインで次のように入力します。

応答がない場合は、TCP/IP プロトコル サービスに問題があります。情報システム管
理部に連絡してください。

5. 指定されたサーバ名とパスワードが正しいことを確認します。

名前またはパスワードが正しくない場合は、そのエントリを編集して修正します。
Solaris OE については、14 ページの「管理（ユーザ）セキュリティ レベルとガイド
ライン」を参照してください。Windows NT/2000 については、23 ページの「管理
者（ユーザ）セキュリティ レベルとガイドライン」を参照してください。Linux OE
については、33 ページの「管理（ユーザ）セキュリティ レベルとガイドライン」を
参照してください。

パスワードは、ユーザのセットアップ手順で確立したものでなければなりません。

■ ユーザ（ssmon、ssadmin、ssconfig）が正しくセットアップされていることを
確認します。Windows NT の場合、ユーザが Act as a part of the operating system
と Log on as a batch job でセットアップされていることを確認します。

■ ネーム サービス（Windows NT ドメイン、および Solaris OE では NIS または
NIS+）を使用している場合、ユーザがネーム サービスに正しく追加されているこ
とを確認します。

■ Windows NT のドメインにユーザ名を入力した場合、ユーザ名が伝播されるまで
しばらく待ってください。

症状:既存の論理ドライブから論理ボリュームを追加しようとする
ときに、論理ドライブがリストに表示されない。

Select a Logical Drive の下に論理ドライブが表示されない場合、論理ドライブがマッ
プ解除されておらず、そのために選択できません。まず、論理ドライブをマップ解除
する必要があります。

# ping {サーバの IP アドレスまたはサーバ名}
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症状:DHCP 環境でのサーバの IP アドレスが変更された。

DHCP 環境では、サーバが 3 日より長くオフラインになっていた場合に、サーバの IP
アドレスが変更されることがまれにあります。

この場合、コンソールはサーバの IP アドレスを介してサーバと通信するため、その
新しい IP アドレスを通知される必要があります。

この状況に対処するには、サーバの新しい IP アドレスをコンソール ソフトウェアの
Edit Server ウィンドウに入力します。

1. File → Server List Setup を選択します。

2. サーバ名を Managed Servers リストから Available Servers リストに移動します。

Edit Server ウィンドウが表示されます。このウィンドウには、サーバが構成された
ときのサーバ名と IP アドレスが表示されます。

3. Available Servers リストからサーバ名を選択し、Edit をクリックします。

Edit Server ウィンドウが表示されます。このウィンドウには、サーバが構成された
ときのサーバ名と IP アドレスが表示されます。

4. ネットワーク アドレスが変更されている場合は、Get IP Addr by Name をクリック
します。 

サーバの名前はネットワークで使用するネーム サービスによって記録されているた
め、サーバ名を入力すると、その正しい IP アドレスが検索され、表示されます。そ
うでなければ、IP アドレスを入力する必要があります。

サーバに使用する名前がサーバのネットワーク名と同じでない場合や、ネーム サービ
スがまだ更新されていない場合は、IP アドレスを手動で入力する必要があります。

5. サーバの IP アドレスを入力した後、OK をクリックして変更したアドレスを指定
し、Server List Setup ウィンドウに戻ります。

6. サーバ名を Managed Servers リストに戻します。

7. OK をクリックして、Server List Setup ウィンドウを終了します。

症状:サーバからトラップを受信できない。

サーバからのトラップを HP OpenView などの SNMP 管理ワークステーションで受
信できない場合のトラブルシューティングには、以下の手順を利用してください。

1. サーバ上で SNMP サービスが起動していることを確認します。

次のコマンドを実行して、sstrapd が実行されていることを確認します。
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出力には、sstrapd の名前が含まれているはずです。含まれていない場合は、デー
モンの起動方法について、13 ページの「エージェントを起動または停止するには」
を参照してください。

Windows NT の場合は、コントロール パネル→サービスにアクセスし、SNMP サー
ビスがリストにあり、起動済みと示されていることを確認します。動作していない場
合は、サービスを起動します。詳細は、Windows NT の説明書を参照してください。

2. エンタープライズ管理コンソールの正しいターゲット アドレスとコミュニティ文字
列がサーバ上で正しくセットアップされていることを確認します。

エンタープライズ管理コンソールにトラップを送信できるよう Windows NT サーバ
をセットアップするための詳細手順は、227 ページの「トラップを送信するための
サーバのセットアップ」を参照してください。

3. MIB が SNMP 管理コンソールにロードされていることを確認します。

Solaris OE および Linux OE では、RST_OID.MIB ファイルは /opt/SUNWsscs/ssagent
にあります。Microsoft Windows では、このファイルは \Program Files\Sun\ssagent
にあります。MIB のロード方法については、使用している SNMP 管理コンソール（HP
OpenView など）の説明書を参照してください。

4. Windows NT の場合、Sun StorEdge Configuration Service の NT レジストリ エント
リをチェックします。 

エントリがない場合は、エージェントをサーバに再インストールします。

a. まず、

HKEY_LOCAL_MACHINE\SYSTEM\CurrentControlSet\Services\SNMP\
Parameters\ExtensionAgents 

 に、SSAGENT のエントリが含まれていることを確認します。

b. 次に、

HKEY_LOCAL_MACHINE\SOFTWARE\Sun\Sun StorEdge Configuration
Service Agent\SNMP Extension Agent\Current Version

が、次の完全パス名で拡張エージェント プログラムを指していることを確認します。

C:\PROGRA~1\Sun\ssagent\SSAGENT.DLL

C:\PROGRA~1\Sun\ssagent\ 

 はデフォルトのインストール ディレクトリです。 

プログラムを他のディレクトリにインストールした場合は、そのディレクトリを
ポイントするようにします。

# ps -e | grep ss
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c. 最後に、

SSAGENT.DLL 

 が C:\PROGRA~1\Sun\ssagent ディレクトリにあることを確認します。

症状:HP OpenView をインストールできない、またはトラップ 
デーモンが起動しない。

SNMP トラップを送信するようにセットアップしたサーバと同じサーバに HP OpenView
をインストールすると、トラップ デーモンと HP OpenView の両方を実行するには
十分なシステム リソースがありません。以下の手順で、システム リソースを再構成
してください。

1. /etc/system の最後に次の行を追加します。

2. サーバをリブートします。

症状:ハードウェアを追加または交換したときに、コンソールに変
更が表示されない。

ディスク ドライブ、テープ ドライブ、電源、ファンなど、新しい装置を追加したり、
故障したデバイスを交換した場合、コンソールには必ずしも更新された情報が表示さ
れません。ツリー表示やほかの関連表示に、デバイス ステータスの変更が反映され
ないことがあります。

新しいデバイスを追加した後、次回の定期スキャンを待たずにそのデバイスを認識さ
せるには、Server View ウィンドウで Rescan をクリックします。サーバが即座にイ
ンベントリを再スキャンし、コンソールでは、そのサーバのインベントリが更新さ
れ、変更がツリー表示に反映されます。インベントリを適時更新するには、手動ス
キャンを実行してください。

Rescan を複数回クリックする必要があることがあります。サーバが再スキャンのプ
ロセスにあるときに、コンソールからインベントリの要求が送信された場合、サーバ
は、現行のスキャンを終了していないため、 後に更新されたインベントリをコン
ソールに送ることがあります。

set shmsys:shminfo_shmmax=x2000000
set shmsys:shminfo_shmmin=1
set shmsys:shminfo_shmmni=256
set shmsys:shminfo_shmseg=256

set semsys:seminfo_semmap=256
set semsys:seminfo_semmni-=512
set semsys:seminfo_semmns=512
set semsys:seminfo_semms1=32
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症状:Solaris 動作環境でのシステムに LG が存在しない。

Sun StorEdge Configuration Service に LG が表示されない場合は、LG がラベル付け
されていて、Configuration Service から除外されていないことを確認します（インス
トールされている場合）。

症状:環境アラームが報告されない。

SCSI ベースの格納装置監視機能（SAF-TE カードなど）を備えた格納装置は、コンソー
ルに環境アラームを送信します。アラーム状態は、ドライブ、ファン、電源、または
バッテリの故障、あるいは異常温度により発生します。

環境アラームが発生した場合は、View Enclosure ウィンドウで Reset をクリックし
て、アラームをクリアする必要があります。ソフトウェアで Reset をクリックするに
は、構成セキュリティ特権を持っている必要があります。 

これらのストレージ格納装置の SAF-TE 監視仕様では、アラーム状態が発生した後、
そのアラームがリセットされない限り次のアラームを発生しないように要求されてい
ます。

アラームのリセット後、環境イベントが再び Event Log に表示されるようになります。

症状:コンソールの動作が遅い。

Windows NT でのコンソールは、コンソール ワークステーション上に少なくとも 10
メガバイトの空き仮想メモリ（物理メモリ＋ページ ファイル サイズ）を必要としま
す。コンソール プログラムは、物理メモリが多いほど応答が速くなります。その結果、
オペレーティング システムによる、ページ ファイルへの物理メモリからのメモリの
ページングが 小化されます。

メモリの使用量が、合計の使用可能仮想メモリ（物理メモリ＋ページ ファイル サイ
ズ）に達すると、過剰なページングにより問題が生じた結果、そのワークステーショ
ン上のすべてのアプリケーションのパフォーマンスが低下することがあります。

合計の仮想メモリを増やすため、物理メモリとページ ファイル サイズを増やしてく
ださい。ページ ファイル サイズを変更するには、コントロール パネル→システムを
選択し、表示されるシステムのプロパティウィンドウでパフォーマンスタブを選択し
ます。Windows NT では、パフォーマンスタブの仮想メモリセクションで、ページ
ファイル サイズを変更します。 

症状:Sun StorEdge Diagnostic Reporter が動作を停止した。

Sun StorEdge Diagnostic Reporter から電子メールを受け取らなくなった場合、Sun
StorEdge Diagnostic Reporter が動作を停止した可能性があるため、停止してから再
起動する必要があります。
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（Solaris OE）次の 3 つの場合に、Sun StorEdge Diagnostic Reporter が動作を停止
し、その状態を報告しなくなることがあります。対応策は、Diagnostic Reporter を
停止して再起動することです。

■ エージェントを、異常停止後または意図的な停止後に再起動すると、Sun StorEdge
Diagnostic Reporter が停止する。

■ Config Tool が実行中のときにデーモンが停止され再起動された場合、Config Tool
がこのデーモンと通信不能になることがある。

■ エージェントが異常停止した場合、または停止された場合、デーモンがこれを検
出せず、電子メールの送信を停止したが、Sun StorEdge Diagnostic Reporter が接
続状態にあると緑のステータス記号で示されている。

次のように入力して、Sun StorEdge Diagnostic Reporter を停止し、再起動してくだ
さい。

症状:（Solaris/Linux）オンライン ヘルプが表示されない。

オンライン ヘルプの表示に使用する Web ブラウザの絶対パス名が指定されているか
どうか確認します。

1. /opt/SUNWsscs/sscsconsole から 

2. Web ブラウザの絶対パス名を入力します。

# /etc/init.d/ssdgrptd stop 
# /etc/init.d ssdgrptd start

./config_sscon と入力します。
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付録 G

エラー コードとメッセージ

この付録は、エラー コードの一覧と、エラーおよびステータス メッセージ一の覧です。

エラー コード
Event Log （イベント ログ）に説明と共に示されるエラー コードは、各 2 文字の 4
つのフィールドで構成される 8 文字のコードです。後ろにダッシュと別の 8 文字の
コードが続くコードもあります。これらのダッシュやコードは内部使用を目的とした
ものです。

以下の表は、2 文字の各フィールドで使用されるエラー コードを説明しています。4
つの 2 文字フィールドの形式は次のとおりです。

SSMMmmEE

ここで

SS = Severity （重要度）フィールド

MM = Major （メジャー）フィールド

mm = Minor （マイナー）フィールド

EE = Error （エラー）フィールド

表 G-1 Severity フィールド

Severity フィールド 説明

01 Critical 

01 クリティカル
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02 Warning

02 警告

03 Informational

03 情報

表 G-2 Major フィールド

Major フィールド 説明

01 Not Used

01 未使用

03 Legacy

03 レガシー

04 RAIDCard Card message

04 RAIDCard カード メッセージ

05 JBOD (Just a bunch of disks) message

05 JBOD （多数のディスクだけ）メッセージ

06 SSMon monitor message

06 SSMon 監視メッセージ

07 dll/shared library message

07 dll／共有ライブラリ メッセージ

08 SSserver message

08 SSserver メッセージ

09 HBA (Host Bus Adapter) message

09 HBA （ホスト バス アダプタ）メッセージ

0A Server Communications message

0A サーバー通信メッセージ

0B Controller message

0B コントローラ メッセージ

表 G-1 Severity フィールド （続き）

Severity フィールド 説明
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Minor フィールドの定義を下表に示します。Error フィールドの定義が Minor フィー
ルドの定義によって異なるものがあり、その場合は参照先の表が示されています。

表 G-3 Minor フィールド

Minor 
フィールド 説明

01 Unknown

01 不明

02 248 ページの「Error フィールド:システム ドライブ状態」を参照してください。

03 249 ページの「Error フィールド:ディスク状態」を参照してください。

04 250 ページの「Error フィールド:SAF-TE 状態」を参照してください。

05 251 ページの「Error フィールド:テープ状態」を参照してください。

06 253 ページの「Error フィールド:冗長状態」を参照してください。

07 254 ページの「Error フィールド:内部状態」を参照してください。

08 254 ページの「Error フィールド:デバイス状態」を参照してください。

09 254 ページの「Error フィールド:初期化状態」を参照してください。 

0A 255 ページの「Error フィールド:無効なクライアント パラメータ」を参照し
てください。

0B 256 ページの「Error フィールド:伝送オープン」を参照してください。

0C 256 ページの「Error フィールド:伝送クローズ」を参照してください。

0D 256 ページの「Error フィールド:メモリ割り振り」を参照してください。

0E RaidCard fault detected.

0E RaidCard フォールトを検出

0F 257 ページの「Error フィールド:伝送」を参照してください。

10 258 ページの「Error フィールド:コマンド」を参照してください。

11 258 ページの「Error フィールド:コマンド」を参照してください。

12 258 ページの「Error フィールド:メイン通信」を参照してください。

13 259 ページの「Error フィールド:通信非同期」を参照してください。

14 259 ページの「Error フィールド:通信セキュリティ」を参照してください。

15 259 ページの「Error フィールド:タイムアウト」を参照してください。

16 260 ページの「Error フィールド:管理」を参照してください。

17 261 ページの「Error フィールド:ファームウェア」を参照してください。

18 261 ページの「Error フィールド:システム シャットダウン」を参照してくだ
さい。
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Error フィールド:システム ドライブ状態

19 Dynamic Growth fault detected. 

19 動的成長フォールトを検出 

1C 262 ページの「Error フィールド:Set Config」を参照してください。

1D 263 ページの「Error フィールド:コントローラ イベント」を参照してください。

1E 264 ページの「Error フィールド:ドライブ側イベント」を参照してください。

1F 265 ページの「Error フィールド:ホスト側イベント」を参照してください。

20 266 ページの「Error フィールド:論理ドライブ イベント」を参照してください。

23 266 ページの「サーバーのイベント管理／監視エラー」を参照してください。

表 G-4 システム ドライブ状態エラー

Error フィールド

01 Offline

01 オフライン

02 Degraded

02 低下

03 Online

03 オンライン

04 Unknown

04 不明

05 Parity Check

05 パリティ チェック

06 Reconstruction

06 再構築

07 Reconfiguration

07 再構成

08 Dynamic Growth

08 動的成長

表 G-3 Minor フィールド （続き）

Minor 
フィールド 説明
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Error フィールド:ディスク状態

09 Nonexistent

09 存在しない

0A Initialization

0A 初期化

表 G-5 ディスク状態エラー

Error フィールド 説明

01 Offline

01 オフライン

02 Degraded

02 低下

03 Online

03 オンライン

04 Unknown

04 不明

05 SMART

05 SMART

06 Dead

06 デッド

表 G-4 システム ドライブ状態エラー （続き）

Error フィールド
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Error フィールド:SAF-TE 状態
 

表 G-6 SAF-TE 状態エラー

Error フィールド 説明

01 Power

01 電源

02 Fan

02 ファン

03 Thermal

03 熱

04 Alarm

04 アラーム

05 Locked

05 ロック状態

06 Slot

06 Slot

07 Unknown

07 不明

08 Unable to get SAF-TE information

08 SAF-TE 情報を取得できない

09 Battery 

09 バッテリ 

0A Invalid Number of Slots

0A 無効なスロット数

0B Environmental Data Not Available

0B 環境データ使用不能
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Error フィールド:テープ状態

表 G-7 テープ状態エラー

Error フィールド 説明

01 Read

01 読み取り

02 Write

02 書き込み

03 Hard Error

03 ハード エラー

04 Media Error

04 メディア エラー

05 Read Failure

05 読み取り失敗

06 Write Failure

06 書き込み失敗

07 Media Life

07 メディア寿命

08 Not Upgradable

08 アップグレード不能

09 Write Protect

09 書き込み禁止

0A Nonremoval

0A 取り外し不能

0B Cleaning Media

0B クリーニング メディア

0C Unsupported Format

0C サポートされない形式

0D Snapped Tape

0D 切れたテープ

14 Clean Now

14 今クリーニングする
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15 Clean Periodic

15 定期クリーニングする

16 Expired Cleaning Media

16 期限切れクリーニング メディア

1E Hardware A

1E ハードウェア A

1F Hardware B

1F ハードウェア B

20 Interface

20 インターフェイス

21 Eject Media

21 メディアをイジェクトする

22 Down Load Fail

22 ダウンロード失敗

28 Loader Hardware A

28 ローダ ハードウェア A

29 Loader Tray Tape

29 ローダ トレイ テープ

2A Loader Hardware B

2A ローダ ハードウェア B

2B Loader Door

2B ローダ ドア

C8 Query Log Failed

C8 ログ照会の失敗

C9 Inquire Tape Failed

C9 テープ問い合わせの失敗

表 G-7 テープ状態エラー （続き）

Error フィールド 説明
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Error フィールド:冗長状態

表 G-8 冗長状態エラー

Error フィールド 説明

01 Mode OK

01 モード OK

02 No Memory for Negotiation

02 ネゴシエーション用メモリなし

03 Secondary Failure

03 セカンダリ故障

04 Secondary Removed

04 セカンダリを取り外した

05 Detected Removal of Secondary

05 セカンダリの取り外しを検出

06 Detected Insertion of Secondary

06 セカンダリの挿入を検出

07 Primary Failure

07 プライマリ故障

08 Primary Removed

08 プライマリを取り外した

09 Detected Removal of Primary

09 プライマリの取り外しを検出

0A Detected Insertion of Primary

0A プライマリの挿入を検出

0B Unknown State

0B 不明な状態

0C Partner Failed

0C パートナー故障

0D Partner Inserted

0D パートナーを挿入した

0E Partner Removed

0E パートナーを取り外した
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Error フィールド:内部状態
 

Error フィールド:デバイス状態

Error フィールド:初期化状態

表 G-9 内部状態エラー

Error フィールド 説明

01 No Memory

01 メモリなし

02 Semaphore

02 セマフォー

03 Thread

03 スレッド

04 No Devices

04 デバイスなし

表 G-10 デバイス状態エラー

Error フィールド 説明

01 Inquiry

01 問い合わせ

02 Unknown

02 不明

表 G-11 初期化状態エラー

Error フィールド 説明

01 dll Initializing

01 dll 初期化中

02 dll Initializing Failed

02 dll 初期化の失敗
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Error フィールド:無効なクライアント パラメータ

表 G-12 クライアント パラメータ エラー

Error フィールド 説明

01 Set Configuration – Configuration Miscompare

01 構成の設定 － 構成の比較誤り

02 Set Configuration – Configuration Device Invalid

02 構成の設定 － 構成デバイスが無効

03 Set Configuration – Enquire Miscompare

03 構成の設定 － Enquire 比較誤り

04 Set Configuration – Enquire2 Miscompare

04 構成の設定 － Enquire2 比較誤り

05 Incorrect Application Length

05 アプリケーションの長さが不正

06 Command not Supported

06 サポートされないコマンド

07 Invalid Command

07 無効なコマンド

08 Set Configuration – General Miscompare

08 構成の設定 － 一般の比較誤り

09 Invalid Length

09 無効な長さ

0A Invalid Card Identifier

0A 無効なカード識別子

0B Invalid Card Name

0B 無効なカード名

0C Invalid Parameter

0C 無効なパラメータ

0D Invalid Command for Card Type

0D カード タイプに対してコマンドが無効

0E Set Configuration – Invalid Additional Parameter 

0E 構成の設定 － 無効な追加パラメータ 
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Error フィールド:伝送オープン

Error フィールド:伝送クローズ

Error フィールド:メモリ割り振り

0F Set Configuration – Block Overlap

0F 構成の設定 － ブロックのオーバーラップ

10 Set Configuration – Device Information Invalid 

10 構成の設定 － デバイス情報が無効 

表 G-13 伝送オープン エラー

Error フィールド 説明

01 Open Transport

01 伝送オープン

表 G-14 伝送クローズ エラー

Error フィールド 説明

01 Close Transport

01 伝送クローズ

表 G-15 

Error フィールド 説明

01 Insufficient Memory

01 メモリ不足

02 Insufficient Memory for Administration Operation

02 管理操作のメモリが不足

表 G-12 クライアント パラメータ エラー （続き）

Error フィールド 説明
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Error フィールド:伝送

表 G-16 伝送フィールド エラー

Error フィールド 説明

01 Lock Fault

01 ロック フォールト

02 Insufficient Memory

02 メモリ不足

03 Acquire Lock Fault

03 ロック取得フォールト

04 Release Lock Fault

04 ロック解放フォールト

05 Invalid Command

05 無効なコマンド

06 Invalid Length

06 無効な長さ

07 Invalid Card Name

07 無効なカード名

08 Invalid Card Identification

08 無効なカード識別子

09 No Cards Found

09 カードが見つからない

0A No Devices Found

0A デバイスが見つからない

0B Open Fault

0B オープン フォールト

0C Card Name not Found

0C カード名が見つからない
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Error フィールド:コマンド

Error フィールド:メイン通信

Error フィールド:通信リンク

表 G-17 コマンド コード エラー

Error フィールド 説明

01 Lock Fault

01 ロック フォールト

表 G-18 メイン通信エラー

Error フィールド 説明

01 Socket Fault

01 ソケット フォールト

02 Report Fault

02 レポート フォールト

03 Thread Fault

03 スレッド フォールト

04 Lock Fault

04 ロック フォールト

05 System Fault

05 システム フォールト

表 G-19 通信リンク

Error フィールド 説明

01 Socket Fault

01 ソケット フォールト
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Error フィールド:通信非同期

Error フィールド:通信セキュリティ

Error フィールド:タイムアウト

表 G-20 通信非同期

Error フィールド 説明

01 Socket Fault

01 ソケット フォールト

02 Thread Fault

02 スレッド フォールト

03 Cold Link Fault

03 コールド リンク フォールト

04 Send Event Fault

04 イベント送信フォールト

表 G-21 通信セキュリティ

Error フィールド 説明

01 Security Violation

01 セキュリティ違反

表 G-22 タイムアウト エラー

Error フィールド 説明

01 Configuration Update

01 構成更新

02 Lock Timeout

02 ロック タイムアウト
付録 G エラー コードとメッセージ 259



Error フィールド:管理

表 G-23 管理エラー

Error フィールド 説明

01 Set Customer Name Fault

01 顧客名の設定フォールト

02 Set Configuration Ended

02 構成の設定終了

03 Initialize

03 初期化

04 Initialize Ended

04 初期化終了

05 Rebuild

05 再構築

06 Rebuild Ended

06 再構築終了

07 Parity Check

07 パリティ チェック

08 Parity Check Ended

08 パリティ チェック終了

09 Set SAF-TE Slot State

09 SAF-TE スロット状態の設定

0A Set SAF-TE Perform Slot

0A SAF-TE 実行スロットの設定

0B Set SAF-TE Send Global

0B SAF-TE グローバル送信の設定

0E Schedule Parity Check

0E パリティ チェックのスケジュール

0F Schedule Parity Check Ended

0F パリティ チェックのスケジュール終了

10 Set Controller Parameters

10 コントローラ パラメータの設定
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Error フィールド:ファームウェア

Error フィールド:システム シャットダウン

11 Firmware Download

11 ファームウェア ダウンロード

12 Consistency Check or Rebuild Ended

12 再構築の整合性検査終了

表 G-24 ファームウェア ダウンロード エラー

Error フィールド 説明

01 Not a SAF-TE Device

01 SAF-TE デバイスではない

02 Invalid Data Length

02 無効なデータ長

03 Download Failed

03 ダウンロード失敗

04 Check Sum Failed

04 チェックサム失敗

表 G-25 システム シャットダウン エラー

Error フィールド 説明

01 System Shutdown Failed

01 システム シャットダウン失敗

表 G-23 管理エラー （続き）

Error フィールド 説明
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Error フィールド:RDP パス変更

Error フィールド:Set Config

表 G-26 RDP パス変更エラー

Error フィールド 説明

01 RDP Path Failed

01 RDP パス失敗

02 RDP Path Restored

02 RDP パス回復

表 G-27 Set Config エラー

Error フィールド 説明

01 Set Configuration Thread creation Failed

01 構成設定のスレッド作成に失敗

02 Get Logical Drive List Command Failed

02 論理ドライブ リストの取得コマンドに失敗

03 Create Config Command Failed

03 構成の作成コマンドに失敗

04 Init Completion Status Command Failed

04 初期化完了状態コマンドに失敗

05 Get Configuration Command Failed

05 構成の取得コマンドに失敗

06 Change Volume Config Command Failed

06 ボリューム構成の変更コマンドに失敗

07 Delete Logical Drive Command Failed

07 論理ドライブの削除コマンドに失敗
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Error フィールド:コントローラ イベント

表 G-28 コントローラ イベント エラー

Error フィールド 説明

01 Controller Reset

01 コントローラ リセット

02 Controller DRAM Parity Error

02 コントローラ DRAM パリティ エラー

03 Redundant Controller Failed

03 冗長コントローラ故障

04 Controller Power Supply Failed

04 コントローラ電源故障

05 Controller Fan Failed

05 コントローラ ファン故障

06 Controller Temperature Alert

06 コントローラ温度アラート

07 Controller UPS AC Power Loss

07 コントローラ UPS AC 電源喪失

08 Controller Initialization Complete

08 コントローラ初期化完了

09 Controller Power Supply Back Online

09 コントローラ電源がオンラインに回復

0A Controller Fan Back Online

0A コントローラ ファンがオンラインに回復

0B Controller Temperature Normal

0B コントローラ温度正常

0C Controller UPS AC Power Back On

0C コントローラ UPS AC 電源が回復
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Error フィールド:ドライブ側イベント

表 G-29 ドライブ側イベント エラー

Error フィールド 説明

01 Drive Channel Select Timeout

01 ドライブ チャネルの選択タイムアウト

02 Drive Channel SCSI Bus Error

02 ドライブ チャネルの SCSI バス エラー

03 Drive Channel Unexpected Disconnect

03 ドライブ チャネルの予期しない切断

04 Drive Channel Negotiation Error

04 ドライブ チャネルのネゴシエーション エラー

05 Drive Channel Target Timed Out

05 ドライブ チャネルのターゲット タイムアウト

06 Drive Channel Parity Error

06 ドライブ チャネルのパリティ エラー

07 Drive Channel Data Under Or Overrun

07 ドライブ チャネルのデータ アンダーランまたはオーバーラン

08 Drive Channel Undefined Error

08 ドライブ チャネルの未定義エラー

09 Drive Channel SCSI Bus Reset Issued

09 ドライブ チャネルの SCSI バス リセット発行

0A Drive Channel Not Ready Error

0A ドライブ チャネルの準備未完了エラー

0B Drive Channel Target HW Error

0B ドライブ チャネルのターゲット HW エラー

0C Drive Channel Target Media Error

0C ドライブ チャネルのターゲット メディア エラー

0D Drive Channel Unexpected Unit Attention

0D ドライブ チャネルの予期しないユニット呼び出し

0E Drive Channel Unexpected Sense Data

0E ドライブ チャネルの予期しないセンス データ
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Error フィールド:ホスト側イベント

0F Drive Channel Block Reassign Fail

0F ドライブ チャネルのブロック再割り当て失敗

10 Drive Channel Block Reassign Success

10 ドライブ チャネルのブロック再割り当て成功

11 Drive Channel SCSI Aborted Command

11 ドライブ チャネル SCSI 中止コマンド

12 Drive Channel SCSI Channel Fail

12 ドライブ チャネルの SCSI チャネル障害

13 Drive Channel Smart Fail

13 ドライブ チャネルの SMART 障害

14 Drive Channel Scan SCSI Drive

14 ドライブ チャネルの SCSI ドライブのスキャン

表 G-30 ホスト側イベント エラー

Error フィールド 説明

01 Host Channel SCSI Bus Reset

01 ホスト チャネルの SCSI バス リセット

02 Host Channel SCSI Bus Device Reset

02 ホスト チャネルの SCSI バス デバイス リセット

03 Host Channel Abort Tag Message

03 ホスト チャネルのタグ中止メッセージ

04 Host Channel Parity Error

04 ホスト チャネルのパリティ エラー

05 Host Channel Reselect Timeout

05 ホスト チャネルの再選択タイムアウト

表 G-29 ドライブ側イベント エラー （続き）

Error フィールド 説明
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Error フィールド:論理ドライブ イベント

サーバーのイベント管理／監視エラー

表 G-31 論理ドライブ イベント エラー

Error フィールド 説明

01 Logical Drive SCSI Drive Fail

01 論理ドライブの SCSI ドライブ故障

02 Logical Drive Initialization Fail

02 論理ドライブの初期化失敗

03 Logical Drive Rebuild Fail

03 論理ドライブの再構築失敗

04 Logical Drive Initialization Commenced

04 論理ドライブの初期化開始

05 Logical Drive Initialization Completed

05 論理ドライブの初期化完了

06 Logical Drive Rebuild Commenced

06 論理ドライブの再構築開始

07 Logical Drive Rebuild Completed

07 論理ドライブの再構築完了

表 G-32 サーバのイベント管理／監視エラー

Error フィールド 説明

01 Server to Manage/Monitor has changed.

01 管理/監視用サーバが変更された。
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エラー メッセージとステータス
メッセージ256
エラー メッセージとステータス メッセージのほとんどは説明を必要としません。表 G-33
は、メッセージに使用されている用語をまとめたものです。表 G-34では、エラー メッセー
ジとステータス メッセージをリストしています。 

表 G-33 置換値

値 説明

Channel Card channel number indicating a SCSI channel. A value of 1 
indicates the first channel.

チャネル SCSI チャネルを示すカード チャネル番号。値 1 は、第 1 チャネル
を表す。

Fan Fan number.

ファン ファン番号

Enclosure Enclosure number.

格納装置 格納装置番号

LogicalArray Logical array number.

LogicalArray 論理アレイ番号

LogicalDrive Logical Drive number.

LogicalDrive 論理ドライブ番号

Lun LUN number.

Lun LUN 番号

Name A text name.

Name テキスト名

Power Power supply number.

電源 電源番号

Slot Slot number.

Slot スロット番号
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State State of a logical array or a device or an enclosure in text. The 
values are: Critical, Online, Offline, Critical Rebuild, Non Existent, 
Low Battery, Normal.

状態 論理アレイ、デバイス、または格納装置の状態（テキスト形式）。
値は次のとおりです。Critical、Online、Offline、Critical 
Rebuild、Non Existent、Low Battery、Normal。

Target A target or SCSI ID number. 

ターゲット ターゲットまたは SCSI ID 番号 

Temperature The temperature in centigrade.

温度 摂氏温度

表 G-34  エラー／ステータス メッセージ

エラー メッセージとステータス メッセージ

A SCSI Drive Failed (Ch:%d,Id:%d). Replace the defective drive.

SCSI ドライブ故障（Ch:%d,Id:%d）。故障ドライブを交換します。

A tape has been left in the autoloader by a previous hardware fault. Insert an empty 
magazine to clear the fault. If the fault does not clear, turn the autoloader off and then on 
again. If the problem persists, call the tape drive supplier helpline.

前のハードウェア フォールトにより、自動ローダ内にテープが残されています。空のマガジ
ンを挿入して、フォールトをクリアしてください。フォールトがクリアされない場合は、自
動ローダーをオフにしてからオンにします。問題が解決しない場合は、テープ ドライブの供
給元に連絡してください。

A user named ssconfig must be created for configuring SUNWsscs Diag Reporter.

ssconfig という名前のユーザを SUNWsscs Diag Reporter 用に作成する必要があります。

Abort Clone SCSI Drive.

SCSI ドライブのクローンを中止。

Abort Initialization.

初期化を中止。

Abort Parity Check.

パリティ チェックを中止。

Abort Rebuild.

再構築を中止。

表 G-33 置換値 （続き）

値 説明
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Abort/Clear-Queue/Abort-Tag Message received (SCSI Channel %d, SCSI ID %d, Target 
Lun %d). Possible failure of I/O module, cable, controller, or HBA.

中止/キューのクリア/タグ中止のメッセージ（SCSI Channel %d, SCSI ID %d, Target Lun 
%d）を受信。I/O モジュール、ケーブル、コントローラ、または HBA の故障の可能性があ
ります。

Access denied for one or more servers. Log in as ssconfig user, and then try the operation 
again.

1 つまたは複数のサーバへのアクセスが拒否されました。ssconfig ユーザとしてログイン
し、操作を再試行してください。

Access denied for one or more servers. Please log in as an ssadmin user and then try the 
operation again.

1 つまたは複数のサーバへのアクセスが拒否されました。ssadmin ユーザとしてログイン
し、操作を再試行してください。

Active trap events is empty.

アクティブ トラップ イベントが空です。

Add Physical drive %d:%d has started on logical drive LogicalDrive.

物理ドライブ %d:%d の追加を論理ドライブ LogicalDrive で開始しました。

Add Physical drive has completed on logical drive LogicalDrive.

物理ドライブの追加を論理ドライブ LogicalDrive で完了しました。

Add SCSI Drive into Logical Drive information.

論理ドライブに SCSI ドライブが追加された情報。

Agent Name is empty.

エージェント名が空です。

An error occurred while getting data from the server.

サーバーからデータを取得中にエラーが発生しました。

An HBA card with this WWN already exists.

この WWN で HBA カードが既に存在します。

Another instance of this program is already running!

このプログラムの別のインスタンスが既に実行中です!

Array Admin in Progress.

アレイの管理が進行中です。

At least one email address needs to be configured.

低 1 つの電子メール アドレスを設定する必要があります。

表 G-34  エラー／ステータス メッセージ （続き）
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Attempted to load a cartridge type, not supported by this drive. The cartridge has been 
automatically ejected. Attempted to load an unsupported tape format.

このドライブでサポートされていないカートリッジ タイプをロードしようとしました。カー
トリッジが自動的にイジェクトされました。サポートされていないテープ形式をロードしよ
うとしました。

Attempted to write to a write-protected cartridge. Remove the write-protection or use 
another tape.

書き込み禁止カートリッジに書き込みしようとしました。書き込み禁止を解除するか、別の
テープを使用してください。

Audible alarm has an unknown status

警告音が不明な状態にあります。

Audible alarm has been triggered.

警告音が起動されました。

Audible alarm has been turned off.

警告音がオフにされました。

Background check or rebuild operation in progress.

バックグラウンド チェックまたは再構築操作が進行中です。

Background initialization in progress.

バックグラウンド初期化が進行中です。

Background parity check in progress.

バックグラウンド パリティ チェックが進行中です。

Background rebuild operation in progress.

バックグラウンド再構築操作が進行中です。

Bad Block Encountered (Ch:%d,Id:%d). Sector number is %u. Informational message.

不良ブロックに遭遇しました（Ch:%d,Id:%d）。セクタ番号は %u です。情報メッセージ。

Block Reassignment Failure (Ch:%d,Id:%d). Defective drive. Replace.

ブロックの再割り当てに失敗（Ch:%d,Id:%d）。欠陥ドライブです。交換してください。

Block Reassignment Succeeded (Ch:%d,Id:%d.) Informational message. Drive may be 
failing.

ブロックの再割り当てに成功（Ch:%d,Id:%d）。情報メッセージ。不良ドライブの可能性が
あります。

Cannot accept the incoming connection.

着信接続を受け付けられません。

表 G-34  エラー／ステータス メッセージ （続き）
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Cannot allocate memory.

メモリを割り当てることができません。

Cannot bind TCP port with the opened TCP/IP communication.

開いた TCP/IP 通信に TCP ポートをバインドできません。

Cannot connect with the incoming connection.

着信接続に接続できません。

Cannot create a communication session for the incoming connection.

着信接続の通信セッションを作成できません。

Cannot create host LUN filter; no host IDs were selected.

ホスト LUN フィルタを作成できません; ホスト ID が選択されていません。

Cannot create standard host LUN mapping, no host IDs were selected.

標準ホスト LUN マッピングを作成できません; ホスト ID が選択されていません。

Cannot find the logical drive that was just created. It may have been aborted.

作成した論理ドライブが見つかりません。作成が中止された可能性があります。

Cannot get configuration from controller. The operation is canceled.

構成をコントローラから取得できません。操作はキャンセルされました。

Cannot get configuration in set configuration.

設定された構成で構成を取得できません。

Cannot listen on the opened TCP/IP communication.

開いた TCP/IP 通信をリッスンできません。

Cannot lock a resource.

リソースをロックできません。

Cannot open TCP/IP communication.

TCP/IP 通信をオープンできません。

Cannot perform IOCTL on the TCP/IP communication.

TCP/IP 通信上で IOCTL を実行できません。

Cannot query incoming data status of the connection.

接続の着信データ ステータスを照会できません。

Cannot receive data from the connected client.

接続されたクライアントからデータを受信できません。

表 G-34  エラー／ステータス メッセージ （続き）
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Cannot report status.

ステータスを報告できません。

Cannot send data to the connected client.

接続されたクライアントにデータを送信できません。

Change logical drive failure.

論理ドライブ変更の失敗。

Change logical volume failure.

論理ボリューム変更の失敗。

Change or set local/global standby drives successful.

ローカル/グローバルのスタンバイ ドライブを正常に変更または設定。

Changes made to Optimization will NOT take effect until all the logical drives are deleted 
and then the controller is RESET.

適化に対して行われた変更は、すべての論理ドライブが削除され、コントローラがリセッ
トされるまで有効に「なりません」。

Click View to select one file.

View をクリックし、ファイルを 1 つ選択してください。

Close transport fail at set configuration.

構成の設定時に伝送クローズに失敗。

Collect mail canceled by user.

ユーザがメールの収集をキャンセルしました。

Communication is reestablished with controller.

通信がコントローラで再確立されます。

Configuration information saved successfully!

構成情報が正常に保存されました!

Connect and Login command error

接続およびログイン コマンド エラー

Contact Fax number format is wrong.

連絡先ファックス番号の形式が不正です。

Contact Name is empty

連絡先名が空です。

表 G-34  エラー／ステータス メッセージ （続き）
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Contact Phone number format is wrong.

連絡先電話番号の形式が不正です。

Continue add drv on logical drive LogicalDrive.

論理ドライブ LogicalDrive へのドライブ追加を続けます。

Controller Event, Battery %s %s. Informational message.

コントローラ イベント、バッテリ %s %s。情報メッセージ。

Controller Event, Battery %s %s. Likely battery module error. If error persists, replace 
defective battery module.

コントローラ イベント、バッテリ %s %s。おそらくバッテリ モジュールのエラーです。エ
ラーが継続する場合は、欠陥バッテリ モジュールを交換してください。

Controller Event, Controller Init Complete. Controller has been rebooted. Informational 
message.

コントローラ イベント - コントローラの初期化完了。コントローラがリブートしました。情
報メッセージ。

Controller Event, Controller Reset. Informational Message.

コントローラ イベント - コントローラのリセット。情報メッセージ。

Controller Event, DRAM Parity Error. Likely controller error. If error persists, replace 
defective controller.

コントローラ イベント - DRAM パリティ エラー。おそらくコントローラ エラーです。エ
ラーが継続する場合は、欠陥コントローラを交換してください。

Controller Event, Fan Back On-line. Informational message.

コントローラ イベント - ファンがオンラインに回復。情報メッセージ。

Controller Event, Fan Failure Detected. Fan is integrated with power supply. Replace power 
supply. Check LED indicators to identify supply.

コントローラ イベント - ファン故障を検出。ファンが電源に統合されています。電源を交換
してください。LED インジケータをチェックして電源を識別してください。

Controller Event, Power Supply Back On-line. Informational message.

コントローラ イベント - 電源がオンラインに回復。情報メッセージ。

Controller Event, Power Supply Failure Detected. Replace power supply. Check LED 
indicators to identify supply.

コントローラ イベント ‐ 電源故障を検出。電源を交換してください。LED インジケータを
チェックして電源を識別してください。

表 G-34  エラー／ステータス メッセージ （続き）
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Controller Event, Redundant Controller Failure Detected. Likely controller error. If error 
persists, replace defective controller.

コントローラ イベント - 冗長コントローラ故障を検出。おそらくコントローラ エラーで
す。エラーが継続する場合は、欠陥コントローラを交換してください。

Controller Event, SDRAM Error. Likely controller error. If error persists, replace defective 
controller.

コントローラ イベント - SDRAM エラー。おそらくコントローラ エラーです。エラーが継
続する場合は、欠陥コントローラを交換してください。

Controller Event, Temperature Alert. Check room temperature, clogged or restricted 
airflow. Correct as necessary.

コントローラ イベント - 温度アラート。室温をチェックし、通気に問題がないか調べてくだ
さい。必要に応じて修正します。

Controller Event, Temperature Back to Normal. Informational message.

コントローラ イベント - 温度が正常に戻りました。情報メッセージ。

Controller Event, UPS AC Power Back On. Informational message.

コントローラ イベント - UPS AC 電源が回復。情報メッセージ。

Controller Event, UPS AC Power Loss Detected. Contact technical support.

コントローラ イベント - UPS AC 電源喪失を検出。テクニカル サポートに連絡してください。

Controller has been reset.

コントローラがリセットされました。

Controllers back in redundancy mode!

コントローラが冗長モードに戻りました!

Controllers back in redundancy mode!

コントローラが冗長モードに戻りました!

Copy & Replace has completed on Physical drive %d:%d.

コピーと交換が物理ドライブ %d:%d で完了しました。

Copy & Replace has started from Physical drive %d:%d to %d:%d.

コピーと交換を物理ドライブ %d:%d から %d:%d で開始しました。

Copy & Replace on Physical drive %d:%d has been aborted.

コピーと交換を物理ドライブ %d:%d で中止しました。

Create logical drive failure.

論理ドライブ作成の失敗。

表 G-34  エラー／ステータス メッセージ （続き）
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Create logical volume failure.

論理ボリューム作成の失敗。

Creating Host LUN filter Entry; please wait…

ホスト LUN フィルタ エントリを作成中。お待ちください…

Creating standard Host LUN mapping; please wait…

標準ホスト LUN マッピングを作成中。お待ちください…

Customer Fax number format is wrong.

顧客ファックス番号の形式が不正です。

Customer Name is empty.

顧客名が空です。

Customer Phone number format is wrong.

顧客電話番号の形式が不正です。

Data is at risk. Media performance of this tape is severely degraded. Copy any data you 
require from this tape. Do not use this tape again. Restart the operation with a different 
tape.

データ喪失の危険があります。このテープのメディア パフォーマンスが著しく低下していま
す。このテープから必要なデータをすべてコピーしてください。このテープは再使用しない
こと。別のテープを使って操作を再試行してください。

Data Under/Overrun(Ch:%d,Id:%d). Likely poorly seated or defective drive. If random 
drives, possible I/O module or cable failure on drive loop.

データ アンダーラン/オーバーラン（Ch:%d,Id:%d）。おそらく、ドライブの装着不良か、
欠陥ドライブが原因です。不特定の複数ドライブで発生する場合は、I/O モジュールまたは
ドライブ ループのケーブルの障害の可能性があります。

Decrypt mail canceled by user.

ユーザがメールの暗号解読をキャンセルしました。

Delete logical drive failure.

論理ドライブ削除の失敗。

Delete logical volume failure.

論理ボリューム削除の失敗。

Deleted disk successfully!

ディスクが正常に削除されました!

Deleting disk; please wait…

ディスクを削除中。お待ちください…
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Deleting Host LUN filter Entry; please wait…

ホスト LUN フィルタ エントリを削除中。お待ちください…

Deleting standard Host LUN mapping; please wait…

標準ホスト LUN マッピングを削除中。お待ちください…

Device at [Channel:Target] has failed the self-reliability test.

[Channel:Target] にあるデバイスが自己信頼性テストに失格しました。

Device information failed.

デバイス情報が使用不能。

Disk is labeled successfully.

ディスクは正常にラベル付けされています。

Door lock has an unknown status.

ドア ロックが不明な状態にあります。

Door locked.

ドアがロックされています。

Door unlocked.

ドアがロックされていません。

Download Firmware with Boot Record.

ファームウェアとブート レコードをダウンロードします。

Downloading Firmware to the devices

ファームウェアをデバイスにダウンロード中。

Downloading Firmware to the RAID Controller.

ファームウェアを RAID コントローラにダウンロード中。

Drive SCSI Ch:%d; Id:%d Likely poorly seated or defective drive. If random drives, possible 
I/O module or cable failure.

ドライブ SCSI Ch:%d、Id:%d。おそらく、ドライブの装着不良か、欠陥ドライブが原因で
す。不特定の複数ドライブで発生する場合は、I/O モジュールまたはケーブルの障害の可能
性があります。

Email address format is wrong.

電子メール アドレスの形式が不正です。

Enclosure #Enclosure state change: Name

格納装置 #Enclosure の状態に変更がありました。Name
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Enclosure #Enclosure, temperature threshold has changed from a State state to a State state.

格納装置 #Enclosure。温度しきい値が State 状態から State 状態に変わりました。

Engaging firmware; a controller reset is not necessary.

ファームウェアの起動中。コントローラのリセットは不要です。

Error in writing file, please try later!

ファイルへの書き込み中にエラー。後で再試行してください!

Error occurred. Reset the config file.

エラー発生。構成ファイルをリセットしてください。

Expand LD/LV information.

拡張 LD/LV 情報

Expand logical volume successfully.

論理ボリュームを正常に拡張。

Expansion has completed on logical drive LogicalDrive.

論理ドライブ LogicalDrive で拡張が完了しました。

Expansion has started on logical drive LogicalDrive.

論理ドライブ LogicalDrive で拡張を開始しました。

Expansion logical drive LogicalDrive has been aborted.

論理ドライブ LogicalDrive の拡張を中止しました。

Fan #Fan has an unknown status.

ファン #Fan が不明な状態にあります。

Fan #Fan is malfunctioning.

ファン #Fan が誤動作しています。

Fan #Fan is not present in the system.

ファン #Fan がシステムに存在していません。

Fan #Fan is operational.

ファン #Fan が動作可能です。

File I/O error. Configuration could not be restored!

ファイル I/O エラー。構成を復元できません!

Firmware downloaded to SAF-TE/SES device (Ch:%d,Id:%d) failed.

ファームウェアの SAF-TE/SES デバイス（Ch:%d,Id:%d）へのダウンロードに失敗。

表 G-34  エラー／ステータス メッセージ （続き）

エラー メッセージとステータス メッセージ
付録 G エラー コードとメッセージ 277



Firmware downloaded to SAF-TE/SES device (Ch:%d,Id:%d) successfully.

ファームウェアの SAF-TE/SES デバイス（Ch:%d,Id:%d）へのダウンロードに成功。

Firmware downloaded to SCSI drive (Ch:%d,Id:%d) failed.

ファームウェアの SCSI ドライブ（Ch:%d,Id:%d）へのダウンロードに失敗。

Firmware downloaded to SCSI drive (Ch:%d,Id:%d) successfully.

ファームウェアの SCSI ドライブ（Ch:%d,Id:%d）へのダウンロードに成功。

First select one Logical Drive!

初に 1 つの論理ドライブを選択してください!

First select one physical device.

初に 1 つの物理ドライブを選択してください!

First select one RAID controller.

初に 1 つの RAID コントローラを選択してください!

For RAID1 Logical Drive 'Add Drive'/'Copy and Replace' function is disabled.

RAID1 論理ドライブで、'ドライブの追加'／'コピーして交換' 機能が無効化されています。

Forward mail canceled by user.

メール転送がユーザによってキャンセルされました。

Generic File Mutex lock is not released.

汎用ファイル Mutex のロックが解除されていません。

Get logical drive list failure.

論理ドライブ リストの取得に失敗。

Getting Agent Options failed!

エージェント オプションの取得に失敗!

Getting Controller Parameters failed!

コントローラ パラメータの取得に失敗!

Getting Host LUN Assignments failed! Please try again

ホスト LUN 割り当ての取得に失敗! 再試行してください。

Getting the configuration failed!

構成の取得に失敗!
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Gross Phase/Signal Error Detected (Ch:%d). Check drive seating, cables, and I/O module. 
Replace as required. Redundant controllers failed to bind.

位相／信号の大誤差を検出（Ch:%d）。ドライブの装着、ケーブル、および I/O モジュール
をチェックしてください。必要に応じて交換します。冗長コントローラがバインドに失敗し
ました。

Group Name can not be empty

グループ名は空であってはなりません。

Host LUN filter Entry created successfully!

ホスト LUN フィルタ エントリが正常に作成されました!

Host LUN filter Entry deleted successfully!

ホスト LUN フィルタ エントリが正常に削除されました!

Host LUNs modified successfully.

ホスト LUN が正常に修正されました。

If file access is not properly coordinated when assigned to multiple hosts, data corruption 
and access contentions may occur.

複数のホストに割り当てる際にファイル アクセスを正しく調整しないと、データの破損やア
クセスの競合が起こることがあります。

If Minimum interval is \“0\” or \“*\”, then Content must be \“Event\”

小間隔が \“0\” または \“*\” の場合、内容は \“Event\” でなければなりません。

If the firmware download progress is interrupted the controllers/devices may become 
unusable.

ファームウェアのダウンロードの進行が中断された場合、コントローラ/デバイスが使用不
能になることがあります。

Initialization has completed on logical drive LogicalDrive.

論理ドライブ LogicalDrive の初期化が完了しました。

Initialization has started on logical drive LogicalDrive.

論理ドライブ LogicalDrive の初期化を開始しました。

Initialization on logical drive LogicalDrive has been aborted.

論理ドライブ LogicalDrive の初期化を中止しました。

Initialization operations have completed.

初期化操作が完了しました。
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Initialization, rebuild, expand, or add SCSI drive activities are in progress. Try again later.

SCSI ドライブの初期化、再構築、拡張、または追加の活動が進行中です。後で再試行して
ください。

Inserted failed primary controller.

故障プライマリ コントローラが挿入されました。

Inserted failed secondary controller.

故障セカンダリ コントローラが挿入されました。

Invalid data received.

無効なデータを受信しました。

Invalid server IP address!

無効なサーバ IP アドレス!

IP Address format error (must be xxx.xxx.xxx.xxx and 0 &amp;lt; xxx &amp;lt;255) !

IP アドレス形式エラー（有効な形式: xxx.xxx.xxx.xxx および 0 &amp;lt; xxx &amp;lt;255） !

IP Address is duplicated!

IP アドレスが重複しています!

IP Address is empty.

IP アドレスが空です。

Location is empty.

場所が空です。

Log in as \“ssconfig”\ user and try the operation again.

\"ssconfig"\ ユーザとしてログインし、操作を再試行してください。

Logical array LogicalArray has changed from a state state to a state state.

論理アレイ LogicalArray が state 状態から state 状態に変わりました。

Logical Drive %d, a SCSI Drive Failed. Replace defective drive.

論理ドライブ %d。SCSI ドライブ故障。欠陥ドライブを交換してください。

Logical Drive ID %d exceeds 2 TB size limitation for sequential optimized LD.

論理ドライブ ID %d。シーケンシャル 適化 LD の 2TB のサイズ制限を越えています。

Logical Drive ID %d exceeds 512 GB size limitation for random optimized LD.

論理ドライブ ID %d。ランダム 適化 LD の 512GB のサイズ制限を越えています。

Logical Drive ID %d, Rebuild Aborted. Informational message.

論理ドライブ ID %d。再構築中止。情報メッセージ。
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Logical Drive ID %d, Rebuild Completed. Informational message. Replace defective drive 
with new drive.

論理ドライブ ID %d。再構築完了。情報メッセージ。欠陥ドライブを新しいドライブと交換
してください。

Logical Drive ID LogicalDrive rebuild has aborted.

論理ドライブ ID LogicalDrive の再構築を中止しました。

Logical Drive ID LogicalDrive rebuild has completed.

論理ドライブ ID LogicalDrive の再構築が完了しました。

Logical Drive ID LogicalDrive rebuild has started.

論理ドライブ ID LogicalDrive の再構築を開始しました。

Logical Drive ID LogicalDrive, Add drive paused. Informational message.

論理ドライブ ID LogicalDrive。ドライブの追加が一時停止。情報メッセージ。

Logical Drive ID LogicalDrive, Add SCSI Drv Aborted. Informational message.

論理ドライブ ID LogicalDrive。SCSI ドライブの追加が中止。情報メッセージ。

Logical Drive ID LogicalDrive, Add SCSI Drv Completed. Informational message.

論理ドライブ ID LogicalDrive。SCSI ドライブの追加が完了。情報メッセージ。

Logical Drive ID LogicalDrive, Add SCSI Drv Failed. Non-recoverable error. Likely drive 
failure or a non-recoverable error on stripe. Run parity check on the logical drive. Contact 
technical support.

論理ドライブ ID LogicalDrive。SCSI ドライブの追加に失敗。回復不能エラー。おそらく、
ドライブの故障か、ストライプの回復不能エラーが原因です。論理ドライブにパリティ 
チェックを実行してください。テクニカル サポートに連絡してください。

Logical Drive ID LogicalDrive, Clone Aborted. Informational message.

論理ドライブ ID LogicalDrive。クローンを中止。情報メッセージ。

Logical Drive ID LogicalDrive, Clone Completed. Informational message.

論理ドライブ ID LogicalDrive。クローンが完了。情報メッセージ。

Logical Drive ID LogicalDrive, Clone Failed. Non-recoverable error. Likely drive failure or a 
non-recoverable error on stripe. Run parity check on the logical drive. Contact technical 
support.

論理ドライブ ID LogicalDrive。クローンに失敗。回復不能エラー。おそらく、ドライブの故
障か、ストライプの回復不能エラーが原因です。論理ドライブにパリティ チェックを実行し
てください。テクニカル サポートに連絡してください。

Logical Drive ID LogicalDrive, Expand Aborted. Informational message.

論理ドライブ ID LogicalDrive。拡張を中止。情報メッセージ。
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Logical Drive ID LogicalDrive, Expand Completed. Informational message.

論理ドライブ ID LogicalDrive。拡張が完了。情報メッセージ。

Logical Drive ID LogicalDrive, Expand Failed. Non-recoverable error. Likely drive failure or 
a non-recoverable error on stripe. Run parity check on the logical drive. Contact technical 
support.

論理ドライブ ID LogicalDrive。拡張に失敗。回復不能エラー。おそらく、ドライブの故障
か、ストライプの回復不能エラーが原因です。論理ドライブにパリティ チェックを実行して
ください。テクニカル サポートに連絡してください。

Logical Drive ID LogicalDrive, Initialization Aborted. Informational message.

論理ドライブ ID LogicalDrive。初期化を中止。情報メッセージ。

Logical Drive ID LogicalDrive, Initialization Completed. Informational message.

論理ドライブ ID LogicalDrive。初期化が完了。情報メッセージ。

Logical Drive ID LogicalDrive, Initialization Failed. Informational message. Possible 
defective drive or slot. User may have aborted operation.

論理ドライブ ID LogicalDrive。初期化に失敗。情報メッセージ。ドライブまたはスロットの
欠陥の可能性があります。ユーザが操作を中止した場合もあります。

Logical Drive ID LogicalDrive, Parity check aborted by user. Parity check should be run to 
completion in order to verify data integrity of the specified Logical Drive.

論理ドライブ ID LogicalDrive。ユーザがパリティ チェックを中止。指定した論理ドライブ
のデータの整合性を確認するには、パリティ チェックを完了する必要があります。

Logical Drive ID LogicalDrive, Parity Check Completed. Informational message.

論理ドライブ ID LogicalDrive。パリティ チェックが完了。情報メッセージ。

Logical Drive ID LogicalDrive, Rebuild Failed. Informational message. Possible defective 
drive or slot. User may have aborted operation.

論理ドライブ ID LogicalDrive。再構築に失敗。情報メッセージ。ドライブまたはスロットの
欠陥の可能性があります。ユーザが操作を中止した場合もあります。

Logical Drive ID LogicalDrive, Starting Add SCSI Drive Operation. Informational message.

論理ドライブ ID LogicalDrive。SCSI ドライブの追加操作を開始。情報メッセージ。

Logical Drive ID LogicalDrive, Starting Clone. Informational message.

論理ドライブ ID LogicalDrive。クローンを開始。情報メッセージ。

Logical Drive ID LogicalDrive, Starting Expansion. Informational message.

論理ドライブ ID LogicalDrive。拡張を開始。情報メッセージ。

Logical Drive ID LogicalDrive, Starting Initialization. Informational message.

論理ドライブ ID LogicalDrive。初期化を開始。情報メッセージ。

表 G-34  エラー／ステータス メッセージ （続き）

エラー メッセージとステータス メッセージ
282  Sun StorEdge 3000 Family Configuration Service 1.3 ユーザ ガイド • 2003 年 6 月



Logical Drive ID LogicalDrive, Starting Parity Check. Informational message.

論理ドライブ ID LogicalDrive。パリティ チェックを開始。情報メッセージ。

Logical Drive ID LogicalDrive, Starting Parity Check. Informational message.

論理ドライブ ID LogicalDrive。パリティ チェックを開始。情報メッセージ。

Logical Drive ID LogicalDrive, Starting Rebuild. Informational message.

論理ドライブ IDLogicalDrive。再構築を開始。情報メッセージ。

Logical Drive LogicalDrive has changed from a State state to a State state.

論理ドライブ LogicalDrive が State 状態から State 状態に変わりました。

Logical Drive LogicalDrive has changed from a State state to a State state.

論理ドライブ LogicalDrive が State 状態から State 状態に変わりました。

Logical Drive LogicalDrive, Parity Check Failed. Non-recoverable error. Likely drive failure 
or a non-recoverable error on stripe. Run parity check on the logical drive. Contact technical 
support. 
Note: If you manually aborted Parity Check, there is no risk of data corruption. There is no need to 
contact technical support.

論理ドライブ LogicalDrive。パリティ チェックに失敗。回復不能エラー。おそらく、ドライ
ブの故障か、ストライプの回復不能エラーが原因です。論理ドライブにパリティ チェックを
実行してください。テクニカル サポートに連絡してください。 
注:パリティ チェックを手動で中止した場合、データが破損することはありません。テクニ
カル サポートに連絡する必要はありません。

Logical Volume Components List. Total disks in this Logical Volume=

論理ボリューム コンポーネント リスト。この論理ボリューム内の合計ディスク数=

Login successful

ログイン成功

Login unsuccessful

ログイン失敗

Logout command error.

ログアウト コマンド エラー。

Mail information is empty

メール情報が空です。

Memory Allocation Error. Unable to load daemon.

メモリ割り振りエラー。デーモンをロードできません。

表 G-34  エラー／ステータス メッセージ （続き）

エラー メッセージとステータス メッセージ
付録 G エラー コードとメッセージ 283



Minimum interval between emails must be one of the following formats: \“*\” \“0\” 
“\nn\” \“nn:mm\”

電子メール間の 小間隔は、次のいずれかの形式でなくてはなりません: \“*\” \“0\” 
“\nn\” \“nn:mm\”

Minimum interval can’t meet Content value.

小間隔が Content 値に合いません。

Minimum interval format error.

小間隔の形式エラー。

Minimum interval format is HH[:MM].

小間隔の形式は、HH[:MM]。

Minimum interval is empty.

小間隔が空です。

Monitor Stopped.

モニタが停止。

Multiple IP assignment mechanisms are not supported. Select only one mechanism.

複数の IP 割り当て方式はサポートされていません。方式を 1 つだけ選択してください。

Mute beeper.

ビープ音を消音。

Mute controller beeper failure.

コントローラ ビープ音の消音に失敗。

Mute controller beeper.

コントローラ ビープ音を消音。

Mutex Lock is not released.

Mutex のロックが解除されていません。

Mutex Lock timeouts.

Mutex ロックがタイムアウト。

Mutex Lock(s) cannot be created!

Mutex ロックを作成できません!

Mutex Lock(s) change state failed!

Mutex ロックの状態の変更に失敗しました!
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Negotiation Error (Ch:%d,Id:%d). Check drive seating, cables, and I/O module. Replace as 
required.

ネゴシエーション エラー（Ch:%d,Id:%d）。ドライブの装着、ケーブル、および I/O モ
ジュールをチェックしてください。必要に応じて交換します。

New parity check schedule has been created.

新しいパリティ チェック スケジュールが作成されました。

No admin progress exists.

管理進行状況が存在しません。

No Admin progress was found. All activity should be complete!

管理進行状況が見つかりません。活動はすべて完了しています!

No array administration activity in progress!

進行中のアレイ管理活動はありません!

No more events to report.

これ以上報告するイベントはありません。

No new controller was found; you do not need to reboot the system.

新しいコントローラは見つかりませんでした。システムをリブートする必要はありません。

No rebuildable drive available.

再構築できるドライブはありません。

Not Ready Error Reported by Target (Ch:%d,Id:%d). Likely poorly seated or defective drive. 
Possible defective drive slot.

ターゲット（Ch:%d,Id:%d）からの準備未完了エラー。おそらく、ドライブの装着不良か、
欠陥ドライブが原因です。ドライブ スロットの欠陥の可能性があります。

Only the last partition of a LD/LV can be deleted.

LD/LV の 後のパーティションのみ削除できます。

Open transport fail at set configuration.

構成の設定時に伝送オープンに失敗。

Open transport, Lock fail, the original lock holder’s IP address is %s.

伝送をオープン、ロックに失敗。元のロックの保持者の IP アドレスは %s です。

Open transport, LogIn fail.

伝送をオープン、ログインに失敗。

Operation completed successfully.

操作が正常に完了しました。
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Operation failed.

操作に失敗しました。

Operation in progress.

操作が進行中です。

Operation on one of the servers failed.

サーバの 1 つで操作に失敗しました。

Out of the scope!

範囲外です!

Parity Check Aborted.

パリティ チェックを中止。

Parity check confirmation.

パリティ チェックの確認。

Parity check could not be started on logical drive LogicalDrive.

パリティ チェックを論理ドライブ LogicalDrive で開始できません。

Parity check has completed on logical drive LogicalDrive.

パリティ チェックが論理ドライブ LogicalDrive で完了しました。

Parity check has started on logical drive LogicalDrive.

パリティ チェックを論理ドライブ LogicalDrive で開始しました。

Parity check on logical drive LogicalDrive has been aborted.

パリティ チェックを論理ドライブ LogicalDrive で中止しました。

Parity check schedule has been removed.

パリティ チェック スケジュールが削除されました。

Parity check schedule has been updated.

パリティ チェック スケジュールが更新されました。

Parity Error (Ch:%d,Id:%d). Likely poorly seated or defective drive. If random drives, 
possible I/O module or cable failure.

パリティ エラー（Ch:%d,Id:%d）。おそらく、ドライブの装着不良か、欠陥ドライブが原因
です。不特定の複数ドライブで発生する場合は、I/O モジュールまたはケーブルの障害の可
能性があります。
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Parity Error (SCSI Channel %d, SCSI ID %d, Target Lun %d). Possible failure of I/O 
module, cable, controller, or HBA.

パリティ エラー（SCSI Channel %d, SCSI ID %d, Target Lun %d）。I/O モジュール、ケー
ブル、コントローラ、または HBA の故障の可能性があります。

Partition 0 cannot be deleted.

パーティション 0 は削除できません。

Partition table is full. New partitions cannot be added.

パーティション テーブルが一杯です。新しいパーティションは追加できません。

Password error!

パスワード エラー!

Password is empty.

パスワードが空です。

Port is invalid (port must be between 0 and 65535).

ポートが無効（有効なポート値: 0 ～ 65535）。

Port is invalid (port must be between 1270 and 1273).

ポートが無効（有効なポート値: 1270 ～ 1273）。

Power supply #Power has an unknown status.

電源 #Power が不明な状態にあります。

Power supply #Power is malfunctioning and has been switched off.

電源 #Power が誤動作し、オフになりました。

Power supply #Power is malfunctioning or disabled.

電源 #Power が誤動作しているか、使用不能です。

Power supply #Power is not present in the system.

電源 #Power がシステムに存在していません。

Power supply #Power is operational but disabled.

電源 #Powerが動作可能ですが、無効化されています。

Power supply #Power is operational.

電源 #Powerが動作可能です。

Power supply #Power is present in the system.

電源 #Power がシステムに存在しています。
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Primary controller failed!

プライマリ コントローラが故障!

Probe Agent command error!

エージェントの Probe コマンド エラー!

Progress Not Available.

進行状況が使用不能。

RAID Controller firmware checksum failed - corrupt firmware data.

RAID コントローラ ファームウェアのチェックサムに失敗 - ファームウェア データが損傷し
ています。

RAID Controller firmware download has failed.

RAID コントローラ ファームウェアのダウンロードに失敗しました。

RAID Controller firmware has been updated.

RAID コントローラ ファームウェアが更新されました。

RAID Controller is back online.

RAID コントローラがオンラインに回復しました。

Read config file error.

構成ファイル読み取りエラー。

Rebuild on logical drive LogicalDrive has been aborted.

論理ドライブ LogicalDrive で再構築を中止しました。

Rebuild or check operations have completed.

再構築またはチェック操作が完了。

Redundant Array State Change: Controller Failed.

冗長アレイの状態変化:コントローラの障害。

Redundant Array State Change: Controllers Back in Redundancy Mode.

冗長アレイの状態変化:コントローラが冗長モードに戻りました!

Removed a failed primary controller.

故障プライマリ コントローラが削除されました。

Removed a failed secondary controller.

故障セカンダリ コントローラが削除されました。
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Reselect Timeout (SCSI Channel %d, SCSI ID %d, Target Lun %d). Possible failure of I/O 
module, cable, controller, or HBA.

タイムアウトの再選択（SCSI Channel %d, SCSI ID %d, Target Lun %d）。I/O モジュー
ル、ケーブル、コントローラ、または HBA の故障の可能性があります。

Restoring configuration to the controller.

コントローラに構成を復元中。

Retry the configuration operation after the update is complete.

更新の完了後、構成操作を再試行してください。

SAF-TE/SES card Channel:Target firmware has been updated.

SAF-TE/SES カード Channel:Target のファームウェアが更新されました。

SAF-TE/SES card Channel:Target global status has been updated.

SAF-TE/SES カード Channel:Target のグローバル ステータスが更新されました。

SAF-TE/SES card Channel:Target slot perform status has been updated.

SAF-TE/SES カード Channel:Target のスロット実行ステータスが更新されました。

SAF-TE/SES card Channel:Target slot status has been updated.

SAF-TE/SES カード Channel:Target のスロット ステータスが更新されました。

Save a Copy in server.

コピーをサーバーに保存してください。

Saving configuration information; please wait…

構成情報の保存中。お待ちください…

Scan SCSI drive (%d.%d) has succeeded.

SCSI ドライブ（%d.%d）のスキャンに成功しました。

Scan SCSI Drive information.

SCSI ドライブのスキャン情報。

Scan SCSI Drive Successful (Ch:%d,Id:%d). Informational message.

SCSI ドライブのスキャンに成功（Ch:%d,Id:%d）。情報メッセージ。

Scheduled parity check could not be started on logical drive LogicalDrive.

スケジュールされたパリティ チェックを論理ドライブ LogicalDrive で開始できません。

Scheduled parity check has completed on logical drive LogicalDrive.

スケジュールされたパリティ チェックが論理ドライブ LogicalDrive で完了しました。
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Scheduled parity check has started on logical drive LogicalDrive.

スケジュールされたパリティ チェックを論理ドライブ LogicalDrive で開始しました。

Scheduled parity check skipped to next schedule due to incompletion of previous check.

スケジュールされたパリティ チェックが、前のチェックが未完了のため次のスケジュールに
スキップされました。

SCSI Aborted Command (Ch:%d,Id:%d). Informational message. Drive may be failing or 
defective slot.

SCSI でコマンド中止（Ch:%d,Id:%d）。情報メッセージ。不良ドライブまたは欠陥スロット
の可能性があります。

SCSI Bus Device Reset (SCSI Channel %d, SCSI ID %d, Target Lun %d). Possible failure of 
I/O module, cable, or HBA.

SCSI バス デバイス リセット（SCSI Channel %d, SCSI ID %d, Target Lun %d）。I/O モ
ジュール、ケーブル、または HBA の故障の可能性があります。

SCSI Bus Reset (SCSI Channel %d, SCSI ID %d, Target LUN %d). Possible failure of I/O 
module, cable, or HBA.

SCSI バス リセット（SCSI Channel %d, SCSI ID %d, Target Lun %d）。I/O モジュール、
ケーブル、または HBA の故障の可能性があります。

SCSI Bus Reset Issued (Ch:%d,Id:%d). Check drive seating, cables, and I/O module. 
Replace as required.

SCSI バスがリセットを発行（Ch:%d,Id:%d）。ドライブの装着、ケーブル、および I/O モ
ジュールをチェックしてください。必要に応じて交換します。

SCSI Channel Failure - Fibre Loop Connection. Failure Check drive path. Possible cable or 
module failure.

SCSI チャネル障害 - ファイバ ループ接続。障害。ドライブ パスをチェックしてください。
ケーブルまたはモジュールの故障の可能性があります。

SCSI Channel Failure - General. Check drive path.

SCSI チャネル障害 - 一般。ドライブ パスをチェックしてください。

SCSI Channel Failure - Redundant Loop/Path Failure. Check drive path. Possible cable or 
module failure.

SCSI チャネル障害 - 冗長ループ/パスの障害。ドライブ パスをチェックしてください。ケー
ブルまたはモジュールの故障の可能性があります。

SCSI Channel Failure (Ch:%d,Id:%d). Replace defective I/O or drive module.

SCSI チャネル障害（Ch:%d,Id%d）。欠陥 I/O またはドライブ モジュールを交換してくだ
さい。
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SCSI Channel Restored - Fibre Loop Connection Restored. Informational message.

SCSI チャネル回復 - ファイバ ループ接続が回復。情報メッセージ。

SCSI Channel Restored - Redundant Path Restored. Informational message.

SCSI チャネル回復 - 冗長パスが回復。情報メッセージ。

Secondary controller failed!

セカンダリ コントローラが故障!

Server Error.

サーバ エラー。

Server failed the operation due to insufficient memory.

サーバーが、メモリ不足のため操作を実行しませんでした。

Server Name is empty.

サーバ名が空です。

Server Not managed!

サーバが管理されていません!

Set controller parameter(s) successful.

コントローラ パラメータを正常に設定。

Set or add configuration failed.

構成の設定または追加に失敗。

Slot #Slot has had a device Name.

スロット #Slot には、デバイス Name がありました。

SMART Predictable Failure Detected (Ch:%d,Id:%d). Informational message. Drive may be 
failing.

SMART が予想故障を検出（Ch:%d,Id:%d）。情報メッセージ。不良ドライブの可能性があ
ります。

SMTP From address format is wrong or empty.

SMTP の From アドレスの形式が不正または空です。

SMTP From address format is wrong.

SMTP の From アドレスの形式が不正です。

SMTP Server address is empty.

SMTP サーバのアドレスが空です。
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Specify how often you want the parity checked.

パリティ チェックの実行頻度を指定してください。

Standard Configuration options provide a group of basic default RAID sets whereby the 
drive size, quantity, and assignments are preconfigured.

Standard Configuration オプションは、ドライブ サイズ、容量、割り当てが事前設定された
デフォルトの RAID セット グループを提供します。

Standard Configuration will replace the existing configuration.

Standard Configuration は既存の構成に置き換わります。

Standard Host LUN mapping created successfully!

標準ホスト LUN マッピングが正常に作成されました!

Standard Host LUN mapping deleted successfully!

標準ホスト LUN マッピングが正常に削除されました!

Standard maps are available to all connected hosts in certain configurations.

標準マップは、特定の構成内で接続されたすべてのホストに使用可能です。

Standby rebuild operation completed with an unknown error.

スタンバイの再構築操作が、不明なエラーで終了しました。

Standby rebuild operation in progress.

スタンバイの再構築操作が進行中です。

Startup state of the secondary controller.

セカンダリ コントローラの起動状態。

State Change Mutex lock is not released.

状態変化 Mutex のロックが解除されていません。

Sun StorEdge Configuration Service monitor daemon has started.

Sun StorEdge Configuration Service モニタ デーモンが起動しました。

Sun StorEdge Configuration Service server daemon has started.

Sun StorEdge Configuration Service サーバ デーモンが起動しました。

Sun StorEdge Configuration Service startup is complete.

Sun StorEdge Configuration Service が起動しました。

Sun StorEdge Configuration Service trap daemon has started.

Sun StorEdge Configuration Service トラップ デーモンが起動しました。
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System Administrator (ssconfig) has started irrevocable System Shutdown and Restart. 
SAVE all data and LOG OFF IMMEDIATELY.

システム管理者（ssconfig）が取り消しできないシステム シャットダウンおよび再起動を開
始しました。すべてのデータを保存して直ちにログオフしてください。

System ID is empty.

システム ID が空です。

Tape operation has stopped because an error occurred while reading or writing data, which 
the drive cannot correct.  

テープ操作が、データの読み取り/書き込み中にエラー発生のため停止しました。ドライブ
はこれを修正できません。  

TapeAlert notification. Device [Channel:Target].  

TapeAlert 通知。デバイス [Channel:Target]。  

Target HW Error Reported (Ch:%d,Id:%d). Likely poorly seated or defective drive. Possible 
defective drive slot.

ターゲット HW エラーの報告（Ch:%d,Id:%d）。おそらく、ドライブの装着不良か、欠陥ド
ライブが原因です。ドライブ スロットの欠陥の可能性があります。

Target Media Error Reported (Ch:%d,Id:%d). Likely poorly seated or defective drive. 
Possible defective drive slot.

ターゲット メディア エラーの報告（Ch:%d,Id:%d）。おそらく、ドライブの装着不良か、
欠陥ドライブが原因です。ドライブ スロットの欠陥の可能性があります。

Target Timed-out (Ch:%d,Id:%d). Check drive seating, cables, and I/O module. Replace as 
required.

ターゲット タイムアウト（Ch:%d,Id:%d）。ドライブの装着、ケーブル、および I/O モ
ジュールをチェックしてください。必要に応じて交換します。

Temperature change from TemperatureC to TemperatureC.

温度が TemperatureC から TemperatureC に変わりました。

The background command (s) has finished.

バックグラウンド コマンドが終了しました。

The background command(s) has been aborted.

バックグラウンド コマンドが中止されました。
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The changer mechanism is having difficulty communicating with the tape drive. Turn the 
autoloader off then on and restart the operation. If the problem persists, call the tape drive 
supplier helpline.

交換機構で、テープ ドライブとの通信に障害があります。自動ローダーをオフにしてからオ
ンにし、操作を再試行してください。問題が解決しない場合は、テープ ドライブの供給元に
連絡してください。

The configuration has been updated.

構成が更新されました。

The configuration was successfully updated. If new LDs/LVs were created, the server may 
need to be rebooted.

構成が正常に更新されました。新しい LD/LV を追加した場合は、サーバのリブートが必要
な場合もあります。

The Controller devices list changed.

コントローラ デバイス リストが変更されました。

The controller parameters have been updated.

コントローラのパラメータが更新されました。

The current user is ssconfig; you cannot log in again.

現在のユーザ ssconfig です。再ログインはできません。

The daemons are not responding.

デーモンが応答していません。

The device does not belong to the same HBA card. The operations cannot continue.

デバイスが同じ HBA カードに属していません。操作を続けられません。

The drive letter (mounted point) cannot be assigned.

ドライブ文字（マウント ポイント）を割り当てできません。

The encrypt key is empty.

暗号キーが空です。

The firmware does not support multiple IP assignment mechanisms.

ファームウェアは、複数の IP 割り当て方式をサポートしていません。

The firmware download failed because you have tried to use the incorrect firmware for this 
tape drive. Obtain the correct firmware and try again.

ファームウェアのダウンロードに失敗。このテープ ドライブに対応しないファームウェアの
使用を試みたためです。正しいファームウェアを取得して、再試行してください。
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The Host LUN filter map (StorEdge SN#%d LD %d Partition %d WWN:) has been created.

ホスト LUN フィルタ マップ（StorEdge SN#%d LD %d Partition %d WWN:）が作成され
ました。

The Host LUN filter map (StorEdge SN#%d LD %d Partition %d WWN:) has been deleted.

ホスト LUN フィルタ マップ（StorEdge SN#%d LD %d Partition %d WWN:）が削除され
ました。

The IP Address cannot be empty.

IP アドレスは空であってはなりません。

The last cleaning cartridge used in the tape drive has worn out. Discard the worn out 
cleaning cartridge, wait for the current operation to finish, and then use a new cleaning 
cartridge.

テープ ドライブで使用された 後のクリーニング カートリッジが消耗しています。消耗し
たクリーニング カートリッジを廃棄し、現在の操作が完了するまで待ってから、新しいク
リーニング カートリッジを挿入してください。

The LD# is moved up after you delete the LD, so it may not be consistent with the LD# 
shown in the RS-232 terminal window.

論理ドライブを削除した後でその LD# が移動されたため、この番号が RS-232 端末ウィンド
ウに表示される LD# と一致しない可能性があります。

The length of the Encrypt Key must be greater than 8 characters.

暗号化キーの長さは 8 文字よりも長くなければなりません。

The Mail Server field cannot be empty.

Mail Server フィールドは空であってはなりません。

The media has exceeded its specified life.

メディアがその仕様寿命を超えています。

The memory allocation Failed.

メモリの割り振りに失敗。

The mount point (drive letter) cannot be written into file (registry).

マウント ポイント（ドライブ文字）をファイル（レジストリ）に書き込めません。

The number of logical drives did not increase after creating a logical drive. (before:%d 
now:%d).

論理ドライブの数は論理ドライブの作成後も増加していません。（作成前:%d 作成後:%d）
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The operation failed because the autoloader door is open. Clear any obstructions from the 
autoloader door, eject the magazine, and then insert it again. If the fault does not clear, turn 
the autoloader off and then on again.

自動ローダのドアが開いているため、操作に失敗。自動ローダーのドアから障害物を取り除
き、マガジンをイジェクトしてから再挿入してください。フォールトがクリアされない場合
は、自動ローダをオフにしてからオンにします。

The operation failed because the tape in the drive has snapped. Discard the old tape. 
Restart the operation with a different tape.

ドライブ内のテープが切れたため操作に失敗。古いテープを廃棄してください。別のテープ
を使って操作を再試行してください。

The Selected Device list is empty!

選択されたデバイスのリストが空です!

The server already exists!

サーバが既に存在します!

The Server Name cannot be empty or only contain any extra spaces.

サーバー名は空であってはなりません。スペースだけを含むこともできません。

The server you selected might have already been shut down.

選択したサーバは既にシャットダウンされている可能性があります。

The set configuration failed because there is another conflicting operation.

競合する操作が存在するため、構成の設定に失敗しました。

The set configuration Failed.

構成の設定に失敗。

The tape cartridge is not data grade. Any data you backup to the tape is at risk. The drive 
has not been able to read the MRS stripes. Replace the cartridge with a data-grade tape.

テープ カートリッジがデータ品質ではありません。このテープにバックアップしたデータは
喪失する危険があります。ドライブは、MRS ストライプを読み取ることができません。
カートリッジをデータ品質のテープと交換してください。

The tape drive has a hardware fault, which is not read/write related. Turn the tape drive off 
and then on again and restart the operation. If the problem persists, call the tape drive 
supplier helpline.

テープ ドライブに、読み書きに関連しないハードウェア フォールトがあります。テープ ド
ライブをオフにしてからオンにし、操作を再試行してください。問題が解決しない場合は、
テープ ドライブの供給元に連絡してください。
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The tape drive has a hardware fault. Eject the tape or magazine, reset the drive (hold the 
unload button down for 5 seconds), and restart the operation.

テープ ドライブにハードウェア フォールトがあります。テープまたはマガジンをイジェク
トし、ドライブをリセットして（アンロード ボタンを 5 秒間押し続ける）、操作を再試行し
てください。

The tape drive has a problem with the SCSI interface. Check the cables and cable 
connections and restart the operation.

テープ ドライブに SCSI インターフェイスの問題があります。ケーブルとケーブル接続を
チェックし、操作を再試行してください。

The tape drive is due for routine cleaning. Wait for the current operation to finish and then 
use a cleaning cartridge.

テープ ドライブの定期クリーニング期限です。現在の操作が完了するまで待ってから、ク
リーニング カートリッジを使用してください。

The tape drive is having problems reading data. No data has been lost, but there has been a 
reduction in the capacity of the tape.

テープ ドライブでデータの読み込み時に問題が発生しました。データは失われていません
が、テープの容量が減少しています。

The tape drive needs cleaning. If the operation has stopped, eject the tape and clean the 
drive. If the operation has not stopped, wait for it to finish and then clean the drive.

テープ ドライブのクリーニングが必要です。操作が停止している場合は、テープをイジェク
トし、ドライブをクリーニングしてください。操作が停止していない場合は、完了するまで
待ってから、ドライブをクリーニングしてください。

The tape in the drive is a cleaning cartridge. If you want to backup or restore, insert a data-
grade tape.

ドライブに入っているテープはクリーニング カートリッジです。バックアップまたは復元操
作を実行するには、データ品質のテープを挿入してください。

The tape is damaged or the drive is faulty. The drive can no longer read data from the tape.
Call the tape supplier helpline.  

テープが損傷しているか、ドライブに欠陥があります。ドライブがテープからデータを読み
取りできなくなりました。

テープの供給元に連絡してください。  

The tape is from a faulty batch or the tape drive is faulty. Use a good tape to test the drive. 
If the problem persists, call the tape drive supplier helpline.

テープが欠陥グループからのものか、またはテープ ドライブに欠陥があります。良好なテー
プを使ってドライブをテストしてください。問題が解決しない場合は、テープ ドライブの供
給元に連絡してください。
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The tape operation failed. Eject and then reinsert the tape or magazine.

テープ操作に失敗。テープまたはマガジンをイジェクトしてから再挿入してください。

The WWN must be a Hex string that is less than 16 characters.

WWN は 16 文字より短い 16 進文字列でなければなりません。

There are no available disks to configure.

構成するために使用可能なディスクがありません。

There are no LDs/LVs to manage.

管理するための LD/LV がありません。

There are not enough available disks to add a new LD/LV or there are no available LDs to 
create a LV. LDs must be unmapped and partitions must be deleted prior to being used in 
LVs.

新しい LD/LV の追加先として使用できるディスクが足りないか、LV の作成先として使用で
きる LD がありません。LV に使用するには、LD のマッピングを解除し、パーティションを
削除する必要があります。

There is a map to more than one Host, therefore, the \“Map to Multiple Hosts”\ property 
cannot be unchecked. Remove the map to multiple hosts before changing this setting.

複数のホストへのマップがあるので、\"Map to Multiple Host"\ プロパティは選択解除する
ことができません。この設定を変更する前に複数のホストへのマップを削除してください。

There is a problem with the autoloader mechanism. Loader mechanism has detected a 
hardware fault.

自動ローダ機構に問題があります。ローダ機構がハードウェア フォールトを検出しました。

There is no spare or replacement drive. Rebuild cannot continue.

スペアまたは交換用ドライブがありません。再構築を続行できません。

This may cause data loss.

これにより、データが失われる可能性があります。

This operation can take up to one minute.

この操作には 長 1 分かかる場合があります。

This operation might take several seconds. Please wait...

この操作には数秒かかる場合があります。しばらくお待ちください...

This operation will add to the existing configuration.

この操作は既存の構成に追加します。

This operation will erase any existing configuration and data.

この操作は既存の構成とデータをすべて消去します。
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Unable to allocate memory for array inquiry. Unable to monitor this array.

アレイの問い合わせ用にメモリを割り振りできません。このアレイは監視できません。

Unable to determine local host, terminating!

ローカル ホストを特定できません。終了します!

Unable to eject cartridge because the tape drive is in use. Wait until the operation is 
complete before ejecting the cartridge.

テープ ドライブが使用中のため、カートリッジをイジェクトできません。操作が完了するま
で待ってから、カートリッジをイジェクトしてください。

Unable to inquire RAID controller.

RAID コントローラを問い合わせできません。

Unable to inquire SAF-TE device. SAF-TE monitoring for this enclosure disabled.

SAF-TE デバイスを問い合わせできません。この格納装置の SAF-TE 監視が無効化されてい
ます。

Unable to inquire tape device. This device will be removed.

テープ デバイスを問い合わせできません。このデバイスは削除されます。

Unable to issue Self-Reliability Query on device at [Channel:Target].

自己信頼性の照会を [Channel:Target] のデバイスで発行できません。

Unable to log events.

イベントをログに記録できません。

Unable to open bindings file -or- no bindings present. Check Bindings file.

バインド ファイルを開けません。または、バインドが存在しません。バインド ファイルを
チェックしてください。

Unable to open I/O transport layer

I/O トランスポート層を開けません。

Unable to query TapeAlert log data. TapeAlert monitoring disabled for this device.

TapeAlert ログ データを照会できません。このデバイスの TapeAlert 監視が無効化されてい
ます。

Unable to read license data.

ライセンス データを読み取れません。

Unable to read response from SMTP server.

SMTP サーバからの応答を読み取れません。
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Unable to send e-mail to SMTP server.

SMTP サーバに電子メールを送信できません。

Unable to toggle the speaker on the SAF-TE/SES managed enclosure.

SAF-TE/SES 管理格納装置のスピーカを切り替えられません。

Unable to validate recipient at SMTP server.

SMTP サーバで受信者を検証できません。

Unable to write license data.

ライセンス データを書き込みできません。

Undefined Error(Ch:%d,Id:%d). Contact technical support.

未定義エラー（Ch:%d,Id:%d）。テクニカル サポートに連絡してください。

Unexpected Disconnect(Ch:%d,Id:%d). Check drive seating, cables, and I/O module. 
Replace as required.

予期しない切断（Ch:%d,Id:%d）。ドライブの装着、ケーブル、および I/O モジュールを
チェックしてください。必要に応じて交換します。

Unexpected Sense Data Received from Target(Ch:%d,Id:%d). Likely poorly seated or 
defective drive. Possible defective drive slot.

予期しないセンス データをターゲット（Ch:%d,Id:%d）から受信。おそらく、ドライブの装
着不良か、欠陥ドライブが原因です。ドライブ スロットの欠陥の可能性があります。

Unexpected Unit Attention Received from Target(Ch:%d,Id:%d). Likely poorly seated or 
defective drive. Possible defective drive slot.

予期しないユニット呼び出しをターゲット（Ch:%d,Id:%d）から受信。おそらく、ドライブ
の装着不良か、欠陥ドライブが原因です。ドライブ スロットの欠陥の可能性があります。

UNMAPPED LUN, NOT AVAILABLE TO HOST

マップされていない LUN。ホストでは使用できません。

Username is empty.

ユーザ名が空です。

Wait for mutex failed.

Mutex の待機に失敗。

Write config file error.

構成ファイル書き込みエラー。

Wrong Fax number format.

不正なファックス番号形式。
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インストールおよびプログラム プロン
プト
表 G-35 はインストールおよびプログラム プロンプトの一覧です。 

Wrong Phone number format.

不正な電話番号形式。

You must first delete the host mapping for the partitions whose index number is greater 
before you can change this partition.

このパーティションを変更するには、先に、インデックス番号がより大きいパーティション
のホスト マッピングを削除する必要があります。

You must first delete the host mapping for this LD/LV before you can delete it.

この LD/LV を削除するには、先に、ホスト マッピングを削除する必要があります。

You must first delete the host mapping of the last partition before you can add a new 
partition.

新しいパーティションを追加するには、先に、 後のパーティションのホスト マッピングを
削除する必要があります。

You must have superuser/administrator privileges to run this program. exiting...

このプログラムを実行するには、スーパーユーザ/管理者の特権が必要です。終了していま
す…

表 G-35 インストールおよびプログラム プロンプト
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An existing configuration for this package is found. Do you want to 
restore it?

このパッケージの既存の構成が見つかりました。これを復元しますか?

Are you sure you want to continue?

続行してよろしいですか?

Are you sure you want to delete the log file?

このログ ファイルを削除してよろしいですか?
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Are you sure you want to delete the trap?

このトラップを削除してよろしいですか?

Are you sure you want to overwrite the file?

このファイルを上書きしてよろしいですか?

Are you sure you want to rebuild the drive?

このドライブを再構築してよろしいですか?

Are you sure you want to restore factory defaults?

工場出荷時デフォルトを復元してよろしいですか?

Before starting to use SUNWsscsConsole, run 
/opt/SUNWsscs/sscsconsole/config_sscon to input the 
pathname of the default Web browser to access HTML help files.

SUNWsscsConsole を使い始める前に、
/opt/SUNWsscs/sscsconsole/config_sscon を実行し、
HTML ヘルプ ファイルにアクセスするためのデフォルト Web ブラ
ウザのパス名を入力してください。

Begin downloading firmware to devices. Do you want to continue?

ファームウェアのデバイスへのダウンロードを開始します。続行し
ますか?

Cannot find the Java Runtime Environment 
$JRE_MAJOR.$JRE_MINOR or above! SUNWsscs Console needs 
JRE 1.2 or above to run. The Console will try to find it in 
/usr/java, /usr/jre, /usr/local/java, or /usr/local/jre. 
If you installed the JRE in a directory other than one mentioned 
above, make a link.

$JRE_MAJOR.$JRE_MINOR 以上の Java Runtime Environment が見
つかりません! SUNWsscs コンソールの実行には JRE 1.2 かそれ以
降が必要です。コンソールは、これを /usr/java、/usr/jre、
/usr/local/java、または /usr/local/jre で探します。この 
JRE を上記以外のディレクトリにインストールしてある場合は、リ
ンクを作成してください。

Changes made to this setting will NOT take effect until the 
controller is RESET. Prior to resetting the controller, the operation 
may not proceed normally. Do you want to RESET controller?

この設定に対して行われた変更は、コントローラがリセットされる
まで有効に「なりません」。コントローラをリセットしない限り、
操作が正常に進行しないことがあります。コントローラをリセット
しますか?
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Click View to select one file.

View をクリックし、ファイルを 1 つ選択してください。

Do you want to download firmware to the controller?

コントローラにファームウェアをダウンロードしますか?

Do you want to download firmware with boot record to the 
controller?

コントローラにファームウェアとブート レコードをダウンロードし
ますか?

Do you want to save the current event log file?

現在の Event Log ファイルを保存しますか?

Do you want to set up the mail server?

メール サーバをセットアップしますか?

Enter a Contact Name.

連絡先名を入力してください。

Enter a Customer Name.

顧客名を入力してください。

Enter a Location.

場所を入力してください。

Enter a mail address.

メール アドレスを入力してください。

Enter a System ID.

システム ID を入力してください。

Enter a valid gateway address.

有効なゲートウェイ アドレスを入力してください。

Enter a valid IP address.

有効な IP アドレスを入力してください。

Enter a valid network mask.

有効なネットワーク マスクを入力してください。

Enter SMTP server information.

SMTP サーバ情報を入力してください。
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Enter SMTP Server information.

SMTP サーバ情報を入力してください。

Enter the login password.

ログイン パスワードを入力してください。

Enter the ssconfig user password to login.

ssconfig ユーザのログイン パスワードを入力してください。

Install JRE 1.2.2, 1.3, or 1.4 before installing the console.

コンソールのインストール前に、JRE 1.2.2、1.3、または 1.4 をイン
ストールしてください。

Issue Reset to the controller?

コントローラにリセットを発行します。

Mapped LUNs exist! These must be deleted before creating new 
LDs/LVs. If you proceed, this operation overwrites the present 
configuration. Any existing LDs/LVs are deleted and all data is 
lost! If you want to keep your present configuration, use the \”Add 
LDs/LVs to the Current Configuration\” option. Do you want to 
continue?

マップされた LUN が存在します! これらを削除してから、新しい 
LD/LV を作成してください。このまま続行すると、この操作によっ
て現在の構成は上書きされます。既存の LD/LV はすべて削除さ
れ、データもすべて失われます! 現在の構成を保持する場合は、
\"Add LDs/LVs to the Current Configuration\" オプションを使用
します。続行しますか?

Please select a LD/LV!

LD/LV を選択してください!

Please select CH/ID.

CH/ID を選択してください。

Please select the Channel/ID of which you want to scan.

スキャンするドライブのチャネル/ID を選択してください。

Please specify at least one SSCS agent in command-line or in 
ssdgrcli.cfg.

コマンド ラインまたは ssdgrcli.cfg で、SSCS エージェントを少なく
とも 1 つ指定してください。
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Remove the package @PKG_NAME@ and then try to install this 
package.

パッケージ @PKG_NAME@ を削除してから、このパッケージのイ
ンストールを試みてください。

Select a LD/LV.

LD/LV を選択してください。

Select a Product ID before downloading firmware.

ファームウェアをダウンロードする前に、製品 ID を選択してくだ
さい。

Select Boot Record File.

ブート レコード ファイルを選択してください。

Select Configuration File.

構成ファイルを選択してください。

Select either AM or PM.

AM または PM を選択してください。

Select Firmware File.

ファームウェア ファイルを選択してください。

Select only ONE LD/LV!

LD/LV を 1 つだけ選択してください!

Select only one row to edit it.

編集するには 1 行だけ選択してください。

Select only one row to remove it.

削除するには 1 行だけ選択してください。

Select Server for Managing Controller.

管理コントローラ用サーバを選択してください。

Select the agent before clicking Remove.

Remove をクリックする前に、エージェントを選択してください。

Select the agent item before clicking Edit.

Edit をクリックする前に、エージェント項目を選択してください。

Select the Channel/ID of the drive you want to scan

スキャンするドライブのチャネル／ID を選択してください。
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Select the firmware file before downloading it

ファームウェア ファイルをダウンロードする前に、それを選択して
ください。

Select the Logical Drive(s)

論理ドライブを選択してください。

Select the server item before clicking Edit.

Edit をクリックする前に、サーバ項目を選択してください。

Select the server item before clicking Remove.

Remove をクリックする前に、サーバ項目を選択してください。

Select the Starting Day.

開始日を選択してください。

Select Timeout(Ch:%d,Id:%d). Likely poorly seated or defective 
drive. If random drives, possible I/O module or cable failure.

タイムアウトの選択（Ch:%d,Id:%d）。おそらく、ドライブの装着
不良か、欠陥ドライブが原因です。不特定の複数ドライブで発生す
る場合は、I/O モジュールまたはケーブルの障害の可能性がありま
す。

Specify Map Information.

マップ情報を指定してください。

SUNWsscsConsole needs JRE 1.2.2, 1.3, or 1.4 to run. The Console 
will try to find it in /usr/java, /usr/jre,/usr/local/java, or 
/usr/local/jre. If you installed the JRE in a directory other than 
one mentioned above, make a link.

SUNWsscsConsole の実行には JRE 1.2.2、1.3、または 1.4 が必要で
す。コンソールは、これを /usr/java、/usr/jre、
/usr/local/java、または /usr/local/jre で探します。この 
JRE を上記以外のディレクトリにインストールしてある場合は、リ
ンクを作成してください。

The client receives events only when it is running. Are you sure 
you want to exit?

クライアントは実行している間だけイベントを受信します。終了し
てよろしいですか?

The Content of Periodic Trap cannot be \“Event\”. Please select 
another one.

定期トラップの内容が \"Event\" であってはなりません。別のオプ
ションを選択してください。

表 G-35 インストールおよびプログラム プロンプト （続き）

インストールおよびプログラム プロンプト
306  Sun StorEdge 3000 Family Configuration Service 1.3 ユーザ ガイド • 2003 年 6 月



The controller needs to be reset for the new firmware to take effect. 
Do you want to reset the controller?

新しいファームウェアを有効にするには、コントローラをリセット
する必要があります。コントローラをリセットしますか?

The encrypt key you entered includes extra space in the beginning 
or at the end, which can cause encryption errors. Do you want to 
continue?

入力された暗号キーの先頭または末尾に、暗号化エラーの原因とな
る余分なスペースが含まれています。続行しますか?

This may cause data loss. Are you sure you want to move?

これにより、データが失われる可能性があります。移動してよろし
いですか?

This operation overwrites the present configuration. Any existing 
LDs/LVs are deleted and all data is lost! If you want to keep your 
present configuration, use the \“Add LDs/LVs to the Current 
Configuration\” option. Do you want to continue?

この操作によって現在の構成は上書きされます。既存の LD/LV は
すべて削除され、データもすべて失われます! 現在の構成を保持す
る場合は、\"Add LDs/LVs to the Current Configuration\" オプ
ションを使用します。続行しますか?

This operation overwrites the present configuration. Any existing 
LDs/LVs are deleted and all data is lost! If you want to keep your 
present configuration, use the \“Add LDs/LVs to the Current 
Configuration”\ option. Do you want to continue?

この操作によって現在の構成は上書きされます。既存の LD/LV は
すべて削除され、データもすべて失われます! 現在の構成を保持す
る場合は、\"Add LDs/LVs to the Current Configuration"\ オプ
ションを使用します。続行しますか?

This operation will result in the loss of current controller settings 
and data on ALL of the logical drives. Are you sure you want to 
restore factory defaults?

この操作の結果、現在のコントローラ設定と、すべての論理ドライ
ブ上のデータが喪失します。工場出荷時デフォルトを復元してよろ
しいですか?

This operation will result in the loss of data on ALL of the modified 
partitions. Do you want to continue?

この操作の結果、修正されたすべてのパーティション上のデータが
喪失します。続行しますか?
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To find out the java version currently installed, type “java-version”

現在インストールされている Java のバージョンを見るには、
“java-version” と入力します。

Trap information has been modified. Do you want to save it?

トラップ情報が修正されました。これを保存しますか?

You selected “Event” as the Trap Type, therefore, you must select at 
lease one Active trap event. 

トラップ タイプとして "Event" が選択されたので、 低 1 つのアク
ティブ トラップ イベントを選択する必要があります。 

You selected “My SMTP server needs authorization,” therefore, you 
must enter a Password.

“My SMTP server needs authorization” が選択されたので、パス
ワードを入力する必要があります。

You selected “My SMTP server needs authorization,” therefore, you 
must enter a Username.

“My SMTP server needs authorization” が選択されたので、ユー
ザ名を入力する必要があります。

You selected “use encrypt,” therefore, you must enter an encrypt 
key.

“use encrypt” が選択されたので、暗号化キーを入力する必要があ
ります。
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用語集

この付録は、本書で使用されている頭字語と RAID 用語の定義の一覧です。ディスク ド
ライブ、論理ドライブ、冗長コントローラの動作ステータスの定義も含まれています。

頭字語
ANSI 米国規格協会（American National Standards Institute）。

CH チャネル。

CISPR 国際無線障害特別委員会（International Special Committee on Radio 
Interference）。

EMU イベント監視ユニット（Event Monitoring Unit）。

FC-AL ファイバ チャネル調停ループ（Fibre Channel-Arbitrated Loop）。FC-AL は
ループまたはファブリックとして実装されます。ループは 大 126 ノードまで
含むことができ、1 台または 2 台のサーバからのみアクセス可能です。

FRU 現場交換可能ユニット（Field-Replaceable Unit）。

GB ギガバイト（Gigabyte）。1,000,000,000（10億）バイト。

GBIC ギガビット インターフェイス コンバータ（Gigabit Interface Converter）。ギ
ガビット イーサネット ポートまたはファイバ チャネルにプラグ接続するホッ
トスワップ可能な入出力デバイス。

HBA ホスト バス アダプタ（Host Bus Adapter）。

ID 識別子番号（Identifier number）。

IEC 国際電気標準会議（International Electrotechnical Commission）。

JBOD 単なるディスクの束（Just a Bunch of Disks）。（コントローラがないディスク
だけのアレイ ユニット）

LAN ローカル エリア ネットワーク（Local Area Network）。

LD 論理ドライブ（Logical drive）。
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LUN 論理ユニット番号（Logical unit number）。個別のデバイスをホストから識別
できるようにするために SCSI チャネル上で使用される一意の識別子。

LVD 低雑音、低電力、低振幅の伝送システムで、サポートされているサーバとスト
レージ デバイス間のデータ通信を可能にします。LVD 伝送では、2 本のワイヤ
を使用して銅線上に信号を送信し、25 メートル（82 フィート）以下のケーブル
が必要です。

MB メガバイト（Megabyte）。1,000,000 バイト（キャラクタ）のデータ。

NVRAM 不揮発性ランダム アクセス メモリ（Non-Volatile Random Access Memory）。主
電源が切断された後でもデータがそのまま保持されるように、バッテリが装備
された記憶装置。

PID プライマリ コントローラ識別子番号（Primary controller identifier number）。

RAID 独立ディスクの冗長アレイ（Redundant Array of Independent Disks）。複数
のドライブを組み合わせて単一の仮想ドライブにし、パフォーマンスと信頼性
を向上させる構成。

SAN ストレージ エリア ネットワーク（Storage Area Network）。ストレージ デバ
イスとサーバによる高速でオープン規格かつスケーラブルなネットワークで、
加速データアクセスを提供します。

SCSI SCSI（Small Computer Systems Interface）。ディスクやテープ デバイスを
ワークステーションに接続するための業界規格。

SES SCSI 格納装置サービス ドライバ（SCSI Enclosure Services driver）。SCSI 格
納装置サービス デバイスへのインターフェイス。これらのデバイスは、格納装
置内の物理状態を検知、監視します。また、格納装置のステータス報告および
構成機能（格納装置のインジケータ LED など）へのアクセスを可能にします。

SID セカンダリ コントローラ識別子番号（Secondary controller identifier number）。

S.M.A.R.T. 自己監視分析およびレポート テクノロジ（Self Monitoring Analysis and Reporting
Technology）。IDE/ATA および SCSI ハード ディスク ドライブ用の業界標準の信
頼性予告インジケータ。SMART 搭載のハード ディスク ドライブは、クリティカル
なデータを保護するためハード ディスク障害の早期警告を発します。

SMTP 簡易メール転送プロトコル（Simple Mail Transfer Protocol）。サーバ間で、ま
たはメール クライアントからメール サーバへ電子メール メッセージを送信す
るためのプロトコル。メッセージは、POP または IMAP を使用して電子メール
クライアント側で受信されます。

SNMP 簡易ネットワーク管理プロトコル（Simple Network Management Protocol）。
複雑なネットワークを管理するための規約セット。SNMP は、プロトコル デー
タ ユニット（PDU）と呼ばれるメッセージを、ネットワーク上の異なる部分に
送信します。エージェントと呼ばれる SNMP 準拠デバイスは、自身に関する
データを管理情報ベース（MIB）に格納し、SNMP 要求に対してこのデータを
返します。

WWN Worldwide name（ワールドワイド ネーム）。アレイ システムと Solaris 動作
環境のシステムの両方において、アレイ ボリュームを識別するため使用される
番号。
310  Sun StorEdge 3000 Family Configuration Service 1.3 ユーザ ガイド • 2003 年 6 月



用語
アクティブアクティブ

コントローラ 一対のコンポーネント。たとえば、両方のコントローラが正常動作していると
きにタスクまたはタスク セットを共有する、フォールト トレラント ストレー
ジ システム内のストレージ コントローラなど。一対のコンポーネントの片方が
故障した場合、他方がすべての負荷を処理します。デュアルアクティブ コント
ローラとも呼ばれるこのコントローラは、同じデバイス セットに接続され、単
一のコントローラよりも高い I/O パフォーマンスとフォールト トレランスを提
供します。

自動再構築 ドライブが故障した後、データが自動的に再構築され、スタンバイ（スペア）
ドライブに書き込まれるプロセス。故障ドライブの代わりに新しいドライブを
手動でインストールするときにも自動再構築が実行されます。再構築プロセス
がリセットにより中断された場合、Array Administration → Rebuild を使って
再構築プロセスを再開できます。

バックグラウンド レート バックグラウンド レートとは、アレイ管理活動（故障ドライブの再構築、パリ
ティ チェック、初期化など）に割り当てられた、使用可能なアレイ コントロー
ラ CPU 時間のパーセンテージ。バックグラウンド レートが 100% に設定され
ている場合、アレイ管理活動がほかのシステム活動よりも優先されます。0% の
場合は、アレイ コントローラにほかの活動がないときにのみアレイ管理活動が
実行されます。

キャッシング データを、ディスク上の指定済み領域、または RAM（ランダムアクセスメモ
リー）に格納すること。キャッシングにより、RAID システム、ディスク ドラ
イブ、コンピュータやサーバ、その他の周辺デバイスの動作が速くなります。

チャネル ストレージ デバイスとストレージ コントローラまたは I/O アダプタの間で、
データおよび制御情報の転送に使用されるパス。また、ディスク アレイ コント
ローラ上の 1 つの SCSI バスも指します。各ディスク アレイ コントローラは、
少なくとも 1 つのチャネルを提供します。

ファブリック 1 つまたは複数のスイッチ周辺に構築されたファイバ チャネル ネットワーク。

ファブリック スイッチ ファブリック スイッチは、ソースから行き先へのデータ転送を能動的に方向付
けして各接続を調停するルーティング エンジンとして機能します。ファブリッ
ク スイッチ経由でのノードあたりの帯域幅は、ノード数が追加されても一定に
保たれ、スイッチ ポート上のノードは 高 100 MBps のデータ パスを使って
データの送受信を行います。

フェイルオーバー フォールト トレラント システムの動作モード。1 つのコンポーネントに障害が
発生した場合、その機能が冗長コンポーネントによって継続されます。

フォールト トレランス 障害が検出された場合に、バックアップ システムをオンラインにして使用する
などの方法で、データの可用性を中断せずに内部ハードウェアの問題に対処す
る能力。多くのストレージ システムは、1 台のディスク ドライブが故障した場
合に RAID アーキテクチャを使用することにより、データの喪失を防ぐフォー
ルト トレランスを提供します。RAID 1（ミラーリング）、RAID 3 または 5
（パリティ付きストライピング）、RAID 6 または 1+0（ミラーリングとストラ
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イピング）技術を使用し、アレイ コントローラは、故障ドライブからデータを
再構築し、それをスタンバイまたは交換用ドライブに書き込むことができま
す。

フォールト トレラント

論理ドライブ 1 台のドライブが故障した際、RAID 1、3、5、または 6（RAID 1+0 とも呼ばれ
る）を使用して、データを保護する論理ドライブ。

ファイバ チャネル 広範囲のハードウェアに導入される、コスト効率のよいギガビット通信リン
ク。

グループ グループとは、複数のサーバを 1 つのカテゴリにまとめるための新しいデータ オブ
ジェクト。概念的にはドメインに似ており、Configuration Service 内でサーバを整
理できます。管理する全サーバをリニア ツリーで表すのではなく、Configuration
Service のオペレータは、サーバを類似セットまたはグループとして整理できます。

グループは必須ではありません。たとえば、グループなしで 15 台のサーバを持つ
ように、または 10 台のサーバから成る 1 つのグループとトップ レベルにさらに 5
台のサーバを持つように Configuration Service を設定できます。Configuration
Service では任意の組み合わせが可能です。

グループの数と 1 つのグループ内に許可されるサーバの数は、使用可能なシス
テム メモリーによってのみ制限されます。サーバがあるグループのメンバーで
あり、ユーザがそのグループをグループ リストボックスから削除した場合、そ
のグループ内の全サーバは、Configuration Service により「グループなし」カ
テゴリに再割り当てされます。Configuration Service は、メイン ウィンドウに
表示されるツリーを自動的に再マップします。

ホット スペア RAID 1 または RAID 5 構成内のドライブで、データを含まず、ほかのドライブ
が故障した場合のスタンバイとして機能するもの。

ホットスワップ可能 システムに電源が入り、動作状態のまま、現場交換可能ユニット（FRU）を取
り外して交換できる能力。

論理ドライブ 複数の独立の物理ドライブによるアレイで、ホストには 1 つの大容量ドライブ
のように見えます。

LUN マッピング ストレージからサーバに提示される仮想 LUN を変更する能力。この機能によ
り、ローカル ディスク ドライブを必要とせずに、サーバが SAN からブートで
きるなどの利点が得られます。各サーバは、ブートするために LUN 0 を必要と
します。

LUN マスキング 管理者が HBA を特定の LUN に動的にマップできるようにする機能。これによ
り、個々のサーバまたは複数のサーバが、個々のドライブまたは複数のドライ
ブにアクセスでき、同じドライブへの不要なサーバ アクセスを抑止できます。

ミラーリング（RAID 1） 1 つのディスク ドライブに書き込まれたデータが、同時に別のディスク ドライ
ブにも書き込まれます。一方のディスクが故障した場合、他方のディスクを使
用してシステムを稼動し、故障したディスクを再構築できます。ディスク ミラー
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リングによる主な利点は 100% のデータ冗長性です。ディスクはミラーリング
されているので、ディスクの 1 つが故障しても問題にはなりません。両方のディ
スクに常に同じデータが格納され、どちらか 1 つが動作ディスクとなります。

ディスク ミラーリングは 100% の冗長性を提供しますが、システムの各ドライ
ブを二重化するため高価です。

N ポート ポイントツーポイントまたはファブリック接続内のファイバ チャネル ポート。

アウトオブバンド データ パス上にない接続やデバイスのこと。

パリティ チェック フォールト トレラント アレイ（RAID 1、3、5、6 または 1+0）の冗長データの
保全性をチェックするプロセス。論理ドライブでのパリティ チェック手順で
は、論理ドライブの RAID ストライプ セットのそれぞれについて、データ ス
トライプのパリティを再計算し、格納されているパリティとこれを比較しま
す。不一致があった場合はエラーが報告され、新しい正しいパリティが、格納
されているパリティと置き換えられます。

パーティション ホストの動作環境に対して単一の物理ドライブとして提示される、ディスク ス
トレージ領域の 1 つのセクション。システム ドライブまたは LUN とも呼ばれ
ます。論理ドライブは 1 つまたは複数の物理ドライブで構成されます。

パートナー グループ 相互接続している一対のコントローラ ユニット。一対のコントローラ ユニット
に相互接続している拡張ユニットも、パートナー グループの一部になれます。

物理アレイ 物理アレイとは、Configuration Service 内で 1 つまたは複数の論理ドライブの
一部となる、物理ドライブのグループ。物理ドライブのグループが、物理ドラ
イブの全容量を使用せずに 1 つの論理ドライブとして構成されている場合、
Configuration Service では、この同じ物理アレイのドライブを、残り容量で作
成される残りの論理ドライブに一緒に使用する必要があります。

論理ドライブの作成に使用された残りのドライブ容量が複数の物理ドライブ上に
ある場合、 New Configuration ウィンドウでの Add Disk ボタンがAdd Array に
変わります。この物理ドライブはスライスされているため、アレイとして選択
する必要があります。個別に選択することはできません。

RAID 独立ディスクの冗長アレイ（Redundant Array of Independent Disks）。ディス
ク ストレージ領域の増大、パフォーマンス向上、データの冗長バックアップな
どを提供するため、複数のディスク ドライブを一緒に動作するように配置した
構成。この機能のさまざまな組み合わせが RAID レベルで定義されています。
RAID レベルの詳細は、189 ページの「RAID の基本」を参照してください。
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読み取りポリシー 読み取りポリシーには以下の種類があります。

No Cash 読み取りポリシーを指定した場合、コントローラは読み取りキャッシュ
にデータを格納しません。

Normal を指定した場合、現在のコントローラは、現在のドライブに対して前
方読み取りキャッシングを使用しません。

読み取りポリシーを Read Ahead に設定すると、コントローラは複数の隣接デー
タ ブロックを自動的に読み取ります。この設定は、シーケンシャル読み取りの
アプリケーションに も効果的です。

再構築 ディスクの再構築とは、ディスクが故障する前のディスク上のデータを再構築
するプロセス。再構築は、データに冗長性があるアレイにおいてのみ実行可能
です。

再構築の詳細は、311 ページの「自動再構築」を参照してください。再構築レー
トについては、311 ページの「バックグラウンド レート」を参照してください。

スパンニング ディスクのスパンニングでは、ファームウェアのストライピング機能を利用
し、本来は独立の 2 つの RAID 論理ドライブ全体に渡りデータをストライプし
ます。スパンした 2 つの論理ドライブは、動作環境に対して 1 つの論理ドライ
ブとして提示されます。スパンニングには次の利点があります。

組み合わせたフォールト トレラント論理ドライブ内で、2 つ同時に発生したド
ライブの故障をサポートする（各論理ドライブに故障ドライブが 1 つと仮定し
た場合）。

スピンドル数が増すので、パフォーマンスも向上する。

スパンニングの欠点は、各論理ドライブがフォールト トレランスを個別に処理
するため、冗長 RAID レベルの RAID オーバーヘッドが増大することです。

スタンバイ ドライブ 論理ドライブに関連付けられた物理ドライブが故障した場合に、データの自動
再構築をサポートするスペアとして指定されているドライブ。別のドライブと
交換するスタンバイ ドライブは、少なくとも故障したドライブと同じサイズで
なくてはなりません。また、RAID 1、3、5、または 1+0 内のドライブが故障し
た場合にのみ効果があります。

状態 ディスク ドライブ、論理ドライブ、または冗長コントローラの現在の動作状態。
ストレージ システムは、ドライブ、論理ドライブ、および冗長コントローラの
状態をその不揮発性メモリーに格納します。この情報はシステムの電源中断後
も保持されます。

ストライプ サイズ これは、1 つの論理ドライブの各物理ドライブに渡りストライプされるデータ
の量（キロバイト単位）です。値は 8 キロバイト増分で設定され、値の範囲は
8～64 キロバイトです。一般に、大きいストライプ サイズを使用すると、主に
シーケンシャル読み取りを行うシステムに効果的です。

既存のドライブのストライプ サイズを変更するには、データのバックアップを
作成し、ストライプ サイズを再定義し、ストレージを再構成した後、全データ
を復元する必要があります。
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ストライピング 論理ドライブ内の異なるすべての SCSI ドライブで、入力データのシーケンシャル
ブロックを格納すること。たとえば、論理ドライブ内に SCSI ドライブが 3 台
ある場合、データは次のように格納されます。

SCSI ドライブ 1 にブロック 1

SCSI ドライブ 2 にブロック 2

SCSI ドライブ 3 にブロック 3

SCSI ドライブ 1 にブロック 4

SCSI ドライブ 2 にブロック 5、以下同様。

この方法でデータを書き込むと、複数のドライブが同時に作動し、データの読み
取りと格納を行うため、ディスク システムのスループットが増大します。RAID
0、3、5、1+0 はすべて、ストライピングを使用します。

ターミネータ SCSI バスを終端処理するための部品。ターミネータは無線周波信号を吸収して、
エネルギーがケーブル プラントに反射するのを防ぎます。

ボリューム 論理ユニット番号または LUN とも呼ばれるボリュームは、データ ストレージ
用にユニットとしてグループ化される 1 つまたは複数のドライブ。

ライトバック キャッシュ キャッシュ書き込み手法の 1 つ。アレイ コントローラが、ディスクに書き込む
データを受け取り、これをメモリー バッファに格納し、データが実際にディス
ク ドライブに書き込まれるまで待たず直ちに、書き込み操作が完了したという
信号をホスト動作環境に送信します。コントローラは、ビジーでなければ、こ
のデータを短時間内にディスク ドライブに書き込みます。

ライトバック キャッシングでは、書き込み操作とコントローラ カードのスルー
プットが向上します。ただし、停電時にはデータ喪失の危険性があるので、ラ
イトバック キャッシングを行うストレージ システムでは、UPS またはバッテ
リ バックアップ キャッシュを装備しています。UPS は、キャッシュ メモリ内
のデータがディスク ドライブに書き込まれるまで十分な時間の電力を供給しま
す。バッテリ バックアップ キャッシュでは、バッテリにより、メモリー デー
タを 大 48 時間まで保持できる電力が供給されます。

書き込みポリシー システムの書き込み操作を制御するためのキャッシュ書き込み手法。書き込みポ
リシーのオプションには、write-back キャッシュおよび write-through キャッ
シュがあります。

ライトスルー キャッシュ キャッシュ書き込み手法の 1 つ。アレイ コントローラが、ホスト動作環境にプ
ロセスが完了したことを送信する前に、データをディスク ドライブに書き込み
ます。ライトスルー キャッシュは、ライトバック キャッシュよりも、書き込み
操作とスループットのパフォーマンスは低くなりますが、電源故障時における
データ喪失の危険性が 小で、より安全な手法です。
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